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About this manual

This training manual is prepared for geo-scientists who want to learn how to use
OpendTect seismic interpretation software. The OpendTect suite of software
tools consists of two parts: a free (open source) part and a commercial (closed
source) part that is protected by license managing software. The free part con-
sists of a base system called OpendTect that can be optionally extended with free
plugins. The commercial software consists of a software layer on top of
OpendTect called OpendTect Pro that offers extra functionality for professional
seismic interpreters.

OpendTect Pro can be further extended with a range of commercial plug-ins for
special work flows. This manual teaches both parts. Theory and background of
some of the more advanced work flows are given but the focus is on hands-on
exercises that are executed on “F3 Demo”, a 3D seismic data set from offshore
the Netherlands. Manual and data set are released free-of-charge for self-train-
ing. The same material is used by dGB Earth Sciences, the company behind
OpendTect, in commercial training classes.

To follow the free exercises in Part 1 of this manual you need to install OpendTect
and download F3 Demo. To follow the commercial exercises in Part 2 you need to
install OpendTect Pro and all of the commercial plug-ins. For details, please fol-
low the instructions for F3 Demo Training on the website.




OpendTect is supported on Linux (64 bits), Mac OS X 10.14 (Mojave) and 10.15
(Catalina) and Windows 10 & 11 (64 bits). The latest version of OpendTect +
plug-ins can be downloaded from the Download page. The full instructions for
installation can be found via the Install page and in the Administrator's Manual:

« Installing OpendTect on Windows

« Installing OpendTect on Linux

« Installing OpendTect on Mac OS X

o]
| — —

OpendTect itself runs without license keys but the commercial plug-ins are pro-
tected by FlexNet license managing software. Entitlement is stored in FlexNet
license keys that are checked whenever you run one of the commercial plug-ins.
A warning message is given in case you are not entitled to run the software (e.g.
when a colleague grabbed the last license before you). F3 Demo is a special data
set. No license checks are made if you work on this data set. In other words all
exercises in this manual can be performed without license keys.

The training manual consists of two parts:
Part | — Free Software

e OpendTect
e Setup asurvey & data loading
» Basic interaction
 Attribute analysis & cross-plots
» Well to Seismic Tie
* Interpretation of horizons & faults
e Time-Depth conversion




Part Il - Commercial Software*

OpendTect Pro
» Setup a survey and get data from Petrel
» Basemap interaction
» Grab and share 3D pdfimages
» Seismic facies tracking (Thalweg tracker)
» AVO attributes & Angle stacks
Attributes & filters
 Structurally oriented filters & attributes (Dip-Steering)
» Frequency enhancement (Spectral Bluing)
» Flat spot enhancement (Fluid Contact Finder)
» Object detection (Neural Networks)
HorizonCube & sequence stratigraphy
» Global Interpretation (HorizonCube, Well Correlation Panel)
» Sequence stratigraphic interpretation (SSIS)
Seismic Predictions
» Band-limited inversion (Colored Inversion)
 Full-bandwidth inversion (Deterministic Inversion)
» Stochastic inversion (MPSI)**

*Not all commercial extensions are introduced in this manual. For training of Syn-
thRock (stochastic pseudo-well modeling & HitCube inversion) and Velocity
Model Building (pre-stack NMO & RMO picking) please contact dGB. For XField
(potential field — gravity & EM - modeling) please contact the developers ARK
CLS.

**Multi-Point-Stochastic-Inversion is introduced in this manual. For a more com-
plete (commercial) training class please contact dGB.




Licenses

The OpendTect suite of software products is released under a triple licensing
policy:

» GNU /GPL license — grants access to the free (open source) part only.

» OpendTect Pro license — grants access to both parts free (open source)
and commercial (closed source).

» Academic license — grants access to both parts to Universities for education
and R&D only.

Under the GNU / GPL license, OpendTect is completely free-of-charge, including
for commercial use.

The OpendTect Pro license gives access to OpendTect Pro and the (closed
source) plug-ins. Licenses can either be bought (permanent license) or rented on
a monthly or annual basis. The closed source parts of OpendTect are protected
by FlexNet license keys.

Feature Description Access Support Access Support

* Data visualization
* Horizon tracking
e Fault interpretation
* Basic Attributes
OpendTect * Spectral Decomposition V x V V
* RGBA

* Time-Depth conversion
... etc

Colop
* AVOAttrib.
Free . LTFAttAri b. V x V x
R e MLV filter
Plugins ¢ RSpecAttrib.
* ExternalAttrib.
... etc Not developed by dGB Not developed by dGB

PetrelDirect

* Basemap
* PDF3D

OpendtectPro | .- x x V V
¢ Thalweg tracker
coo BT

Dip Steering
Neural Networks

Commercial : ;‘SOI;IZOnCube x x V V
Plugins +  Colored Inversion

* CLAS

... etc

Under the academic license agreement Universities can obtain free licenses for
OpendTect Pro and the commercial plug-ins for R&D and educational purposes.

For more information please visit the website at the Download page.




About F3 Demo dataset

Yondon
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Google maps showing the location of the
F3 Demo dataset (brown-filled rectangle)

F3 is a block in the Dutch sector of the North Sea. The block is covered by 3D
seismic that was acquired to explore for oil and gas in the Upper-Jurassic — Lower
Cretaceous strata, which are found below the interval selected for this demo set.
The upper 1200ms of the demo set consists of reflectors belonging to the Mio-
cene, Pliocene, and Pleistocene. The large-scale sigmoidal bedding is readily
apparent, and consists of the deposits of a large fluviodeltaic system that drained
large parts of the Baltic Sea region (Sgrensen et al, 1997; Overeem et al, 2001).

The deltaic package consists of sand and shale, with an overall high porosity (20-
33%). Some carbonate-cemented streaks are present. A number of interesting
features can be observed in this package. The most striking feature is the large-
scale sigmoidal bedding, with text-book quality downlap, toplap, onlap, and trun-
cation structures. Bright spots are also clearly visible, and are caused by biogenic
gas pockets. They are not uncommon in this part of the North Sea. Several seis-
mic facies can be distinguished: transparent, chaotic, linear, shingles. Well logs
show the transparent facies to consist of a rather uniform lithology, which can be
either sand or shale. The chaotic facies likely represents slumped deposits. The
shingles at the base of the clinoforms have been shown to consist of sandy tur-
bidites.

The original F3 dataset is rather noisy, to remove the noise, a dip-steered median
filter with a radius of two traces was applied to the data. The median filtered data




(exercise 2.3.1 Dip-Steering) was subsequently inverted to acoustic impedance
using the industry standard Strata software. A number of horizons were mapped
on a loose grid to study the sigmoidal shaped structures. Continuous horizons
were created from these coarse grid interpretations by interpolation with an
inverse distance interpolation algorithm. Within the survey, four vertical wells are
present. All wells had sonic and gamma ray logs. Only two wells (F2-1 and F3-2)
had density logs. These logs were used to train a neural network that was then
applied to the other two wells (F3-4 and F6-1) to predict density from sonic and
gamma-ray logs. Porosity in all cases was calculated from density using the for-
mula: Porosity = (2.65 — Density) / (2.65 — 1.05).

The F3 Block is available, along with other datasets, via the Open Seismic Repos-
itory on the TerraNubis website.

References

Overeem, |, G. J. Weltje, C. Bishop-Kay, and S. B. Kroonenberg (2001) The Late
Cenozoic Eridanos delta system in the Southern North Sea basin: a climate sig-
nal in sediment supply? Basin Research, 13, 293-312.

Sarensen, J.C., Gregersen, U, Breiner, M and Michelsen, O. (1997) High fre-
quency sequence stratigraphy of upper Cenozoic deposits. Mar. Petrol. Geol.,
14, 99-123.
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Support Options

There are several ways of getting help with OpendTect’s interactions and work-
flows.

User Mailing List

There is an active User Community. The users mailing list is for sharing inform-
ation relevant to OpendTect users. Anyone on this list can send e- mails to all
OpendTect users e.g. to pose or answer questions, suggest workflows,
announce innovations etc. Please do not use this mailing list for support ques-
tions.

Support

For support questions please contact OpendTect's support team at: sup-
port@dgbes.com

Social Media

flin

There are OpendTect user groups on Facebook and LinkedIn.

|"-._

Documentation

All user-documentations can be accessed online as either HTML or PDF, or via
Help menu in the UI.

Via the software

-11-



Help

Documentation 4 OpendTect F1
How-To Instructions dGB Plugins Fz
Aftributes I : -, %

Cnline Suppart
Keyboard shortcuts ?
About

Legal ..

The help menu

The Help Button in each window will automatically pop-up the most appropriate
(sub-)chapter of the user manual.

User Documentation

——

The user documentation is structured in the same way as OpendTect itself. There
are separate documents for OpendTect and the plug-ins.

Plugins Documentation

A documentation for all commercial plugins in OpendTect.

How-to Manual

-12 -


https://doc.opendtect.org/6.6.0/doc/od_userdoc/Default.htm
https://doc.opendtect.org/6.6.0/doc/dgb_userdoc/Default.htm

This document describes various workflows in OpendTect + plug-ins. We
describe the purpose, what software is needed (OpendTect only, or OpendTect +
one or more plug-ins), and how to do it.

Tutorial videos

At videos.opendtect.org the user can find different demo, training workflow and
webinar videos like: Survey Setup & Load SEG-Y, Horizon tracking, Machine
Learning webinars, Fault planes, SSIS interpretation, Dip steered median filter,
Chimney Cube etc...

-13-


https://doc.opendtect.org/6.6.0/doc/HTML_WF/Default.htm
https://www.youtube.com/channel/UCiaLX2p5rCcovOK_NAwpaOQ
https://videos.opendtect.org/

1 Part I: Free Software
1.1 About OpendTect

What is supported?

OpendTect version 6.6 supports all tools you expect to find in a seismic inter-
pretation system. Key features include:

o 2D, 3D Post-stack & Pre-stack seismic data
o 2D & 3D viewers

» Volume rendering & RGB(A) blending
e Seismic attributes & cross-plots

» Spectral decomposition

» Movie-style parameter testing
 Distributed computing

» Rock-physics library

» Horizon trackers

e Faults

o Well-tie

e Depth Conversion

» Geobodies and ... alot more ...

" OpendTect Pro V6.2.0/win64: F3_Demo_2016_trainin: 1g_v6 - [Scene 1] — O

) Survey Analysis Processing Scene View Utilities Help Estimages _ & x
LQiueqBaT-Anna SEXeS
BET Jotesls  [2] 4mmp B Similarity

. Tree scene 1

1

Elements Color
Scene 1
v W Inline
é v 425
e Continuous_.
o 4Dipsteere. Bl
& |~ @ Crossine
v 775
- Continuous _..
4Dipsteere. Bl
v @ Zslice
v 1108
Steered Simi_.. I
- @ volume
v ~ RandomLine
v Random Line 1
7aAlCube Std Il
4Dipsteers... BN
2D Line
® 3D Horizon
2D Horizon
E‘ Fault
FaultStickSet
@ Body
> Well
FO3-4

‘..&,,t\‘ ‘\d

@
Y,
“

F03-2
Fo2-1
# Pointget
[ Polygon
W Shapefile
S Prestack Events
Annotations

As stated before all functionality listed above is available free-of-charge when
OpendTect is run under the open source GNU/GPL license. This system can be
extended with other free software systems and several open source plugins. dGB
developed links to Madagascar and GMT (see below). Several open source plu-

-14 -



Free 3rd Party Plugins.
Madagascar
W
kd
9

MADAGASCA

The Madagascar link integrates OpendTect with Madagascar, an open source
seismic processing package that is widely used in R&D circles.

Generic Mapping Tool (GMT)

GMT is an open source collection of tools for manipulating Geographic and
Cartesian data sets and producing encapsulated postscript (eps.) file illustrations
ranging from simple x-y plots via contour maps to artificially illuminated
surfaces and 3-D perspectives views.

-15-



1.2 Set up a Survey & Load Data

In this Chapter you will learn how to set up a new survey (a project) and how to
load seismic data, horizons and well data using industry-standard file formats
such as SEGY, LAS and ASCII.

In many oil companies setting up surveys and loading data is done by specialists.
OpendTect Pro users who want to use OpendTect in combination with Petrel*
can simply copy the Petrel project information to setup the OpendTect survey
(Exercise 2.1.1a). They can then either work directly on the Petrel data store, or
they can copy data from Petrel into OpendTect and back to Petrel when they are
finished. The first option saves disk space but ties the Petrel license. The second
option saves money as it allows you to work with many OpendTect interpreters on
a project without tying the Petrel license. In addition to the PetrelDirect link in
OpendTect Pro there are also several commercial plug-ins that support easy pro-
ject setup and data 10 to and from SeisWorks/OpenWorks**, GeoFrame-I[ESX***
data stores.

Since not everybody needs (or wants) to know how to do this it is possible to skip
this entire Chapter. F3 Demo is already set up for OpendTect, hence there is no
need to start from scratch. Simply go to the next Chapter to start your training.

The raw data for our new survey are located in a folder called Raw_Data in the F3
Demo directory.

*Is a mark of Schlumberger.
** Registered Trademark of Landmark Graphics Corporation.
*** Registered Trademark of Schlumberger.
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1.2.1 Survey Definition

What you should know about OpendTect surveys

A survey is defined by a 3D grid of Inline, Cross-line numbers and Z sample
rate in time, or depth.

Inline, Cross-line numbers are linked to X,Y rectangular coordinates via a
single linear transformation.

Surveys can be set-up for 3D seismic only, for 2D seismic only and for 2D
and 3D seismic data.

The Z dimension (time or depth) as defined in the survey setup determines
the primary display axis in OpendTect. Data in the other dimension can be
visualized in new (3D visualization) scenes in which the data is transformed
on-the-fly using a given velocity field.

3D seismic must fall inside the defined survey boundaries.

Itis possible to load 3D seismic data sets with varying orientations and
sample rates inside one survey. All data sets are mapped onto the defined
grid.

2D seismic lines can stick outside the defined survey boundaries. The grid
dimensions as defined in the survey setup are used in gridding operations,
e.g. when creating a 3D horizon from a 2D horizon.

Surveys can be set up in different ways

1.

> w

Manually: You enter the required information such as the specification of
the 3D grid and the inline, cross-line to X, Y co-ordinate transformation by
hand. The latter is specified:
a. Either in the form of two linear functions.
b. Or, as three points (usually the corner points of the survey outline).
Two of the points must lie on the same inline. OpendTect derives the
linear transformation functions from the specified points.

. SEGY Scan: SEGY data usually contains inline, cross-line and X,Y co-

ordinate information in the trace headers. As not all SEGY data adheres to
the standard (SEGY Revision1) OpendTect supports tools to help you ana-
lyze and where needed correct SEGY files.

Copy from another survey..

Set up for 2D only: For 2D seismic surveys OpendTect only requires X, Y
co-ordinates to be correct. You can set it up with a fake inline, cross-line
grid.

Using Commercial Tools: There are commercial links to SeisWork-
s/OpenWorks, GeoFrame-IESX and Petrel.

-17 -



1.2.2 SEG-Y Scan Setup & Load

What you should know about SEG-Y

SEG-Y is the industry standard seismic data format that was defined ori-
ginally as a tape format.

It consists of a EBCIDIC Header with general information like data format,
trace length and sample rate, followed by a binary Header (descriptive data
typed in by the seismic processor — not very trustworthy) and seismic
traces. Each trace consists of two parts: a trace header followed by trace
data.

Not all SEG-Y files (especially older files) adhere to the standard definition,
which is called SEG-Y — Rev. 1 (Revision 1).

Before loading SEG-Y data you must verify that the information OpendTect
needs (inline, cross-line and X,Y co-ordinates) is stored in the trace head-
ers where OpendTect expect these.

If not, you specify where the information is located. If the information is not
present at all you can create the information using OpendTect’s trace
header manipulation tools.

If you run into problems, please check this page from the user doc with pos-
sible solutions: UserDoc.

What you should know about SEG-Y in OpendTect

OpendTect can work directly on SEG-Y data files.

The advantage is that there is no data duplication.

To use this option OpendTect must scan the SEG-Y file to construct a table
with inline, cross-line information from the trace headers.

-18-



1.2.2a Survey Setup & Load SEG-Y

Required licenses: OpendTect.

Exercise objective:

Set up a new OpendTect survey and load 3D seismic data from SEGY using the SEGY scan wizard.

m Analysis P
Select/Setup ...

Session v
Workflow: Iamart -

1. Go to Survey > Select/Setup. . List of all Surveys in this Survey Data Root

directory.
- - @ Survey Setup and Selection
or click on the Survey Setup icon Q . o saver ot oo .| [Comers 6 5
:ﬁm:;gﬁ_zmum I‘Zl F3 Demo 2020 ‘\
F3_Demo_2020_old = . [— :
2. Click on the New Survey icon ¢ . Wooma A = G
w
o} 100300 Tourtzse
When starting OpendTect for the first time, you O biomoton Shows | Biog
arrive directly in the Survey Setup & Selection [ sn-line zange : 100 - 750 - 1; Total: es1
window.

Location

z\Surveys\F3_Demo_2020

Ocncel| @ ©

Workflow cont’d:

R @ Create New Survey = O X
3. Specify a Survey name and

Specify new survey parameters

Survey name”My New Surveyﬂ

Available data [] 3D 2D

Initial setupl & Scan SEG-Yfile(s) |
i Set for 2D only

! Scan Mavigation Data

43 Copy from other survey

T Read from Survey Setup file
3 Enter by hand

z Domain O Depth

(a) select Scan SEG-Y file(s),

(b) set Time for Z Domain,

(c) Press Next. Ocancel @

OpendTect display scenes are in Time or Depth. Transformation is done on-the-fly using a given
velocity model. In the Survey Setup you choose the primary Z Domain. In the case of depth
survey, Z Domain should be Depth.
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Workflow cont’d:

4. Go to the Rawdata directory of F3 Demo and Select the Input SEG-Y file: \Raw

data\Seismic_data.sgy.

-
Input file *=wildcard © Select... |~ Edi
Data type (30 Seismic Data
Quick scan result Actually use ol |
SEG-Y revision 0 =0
Data format From file header 4
Number of samples 1 1000 1=
2 range start [0 Step |1
In-line range from header
Cross-line range
@ Select (one of) the
X-coordinate range
Y-coordinate range: « - 1 F3Demo_2020 > Rawdata - [+]
Organize *  New folder ]
~- Google Dr# ~
ETAP_Feb202 Faults = =
ML_Exercises Surface data 0.1% 5
tmp Well_data [ Zeros
Training Man Seismic_datasgy |
& Onelrive
v < >
File name: [Seismic_data.say <] SEGY files (“sgy “SGY *segy)
Com ] o
@ox  Qcancel @

Workflow cont’d:

5. The import wizard makes a quick scan of the SEG-Y volume and automatically fills-in
relevant parameters for survey set-up and import.

If needed, the parameters
required for SEG-Y import
(under the Actually Use column)
can be changed manually.

The bottom part shows the
extracted geometry of the
survey and the histogram of
seismic amplitudes from the
quick scan of the input SEG-Y
volume.

Input file *=wildcard |C:\Surveys\F3_Demo_2020\Ravdata\Seismic_data sqy O Select
Data type [H3D Seismic Data
Quick scan result Actually use 2
SEG-Y revision 1 i ~|| &
Data format 3 - Integer (16 bits) 3 - Integer (16 bits) Q)
Number of samples 462 (600515 traces) 462 1000 %
Z range 0.004 - 1.848 - 0.004 (5 or m) Start |0.004 Step |0.004
In-line range 100 - 750
Cross-line range 300 - 1250
X-coordinate range 605834.80 - 629576.30
Y-coordinate range 607355640 - 609046320
Resulting %Jnrmy setup c01260 0.1% |5
[ Zeros
T 10000 5000 0 000 10000

100300

Value

(B ] Ot @
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Workflow cont’d:

6. Optionally, click on the icon to scan the entire input SEG-Y file.

7. Click on the Q icon to examine in detail, first ‘1000’ traces (changeable) of the file.

Input file *=wildcard |C:\Surveys\F3_Demo_2020\Rawdata\Seismic_data.sgy © Select ...
Data type 13D Seismic Data

Edit option can be used if the SEG-Y
fle needs to be modified. You can | 1 Quickscan reult - Actually e
g revision
update b”?ary headersl and trace Data format 3 - Integer (16 bits) 3 - Integer (16 bits)
headers using mathematical formulae | e o samples 462 (so0st5 races) 62 =
and information from other headers. Zrange 0.004 - 1,848 - 0.004 (5 or m) Start [0.004 Step [0.004

In-line range 100 - 750
Cross-ine range 300 - 1250
X-coordinate range 605834.80 - 620576.30

¥-coordinate range 6073556.40 - 6090463.20

Scanning the entire SEG-Y file
is useful when the survey Resulting survey setup [ 0.1% =

geometry extracted from the 2=
quick scan looks doubtful.
- Tz 10000 -5000 Va“i 5000 10000
Dcurcel| @
= PR 30 e from Seure dsaray -
Workflow cont’d: N
-
-
8. Examiner window: <!
Use this to find out
what is inside the file.
2009)
9. Check the Inline, cgz Bypd’“";'“" 'T“:fl;f;n TSTEV. 1 standard peaitions) :
H cf X=coox 7
Crossline and X/¥ o el | .. | Dump of EBCIDIC and LA
coordlnates_ - find the S0 line: 2 (sfoyte inz) Binary headers 0
Correspondlng byte gié }OO:‘BDU = (605835.5,6073556.5) - e .7”“”“
and observe the e —e=
associated plot. 213 1 Voo ot 203026788 1
Trace header information £| trac (trace sequence number within line)
i . b
10. Optionally, check [t ract : 5
Seismic viewer and § firacr] 1 |
. . 9 [fidr] 100 100 500
histogram windows. P m— 0 ,
17 [ep] 300 301 H 4001
21 [cdp) 300 301 k
25 [cdpt] 0 0
Trace header name + 2 [f,i; | b ' , | 1G22 (12221 [Pl ‘
aye 200 400 600 800 1000
byte position. 31 [vs] [} 0 o
‘ » Range: [1,951] (N=1000)
. ©) Close | | § Help
FIrSt 1000 Trace header NOS' C:\Local_Surveys\F3_Demao_2015_training_vé\Rawdata\Seismic_data.sgy
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Workflow cont’d:

11. Click on OK. Optionally, click on the k4 icon to save the import set-up parameters.

up from Si - [m] *
Input file *=wildcard C:\Surveys\F3_Demo_2020\Rawdata\Seismic_data.sqy O select ...  #Edit ...
Data type (3D Seismic Data ~

Quick scan result Actually use > m
SEG-Y revision 1 1 v
Data format 3 - Integer (16 bits) 3 - Integer (16 bits) o 1Y
Number of samples 462 (600515 traces) 462 BECTE
Zrange 0.004 - 1.848 - 0.004 (s or m) Start |0.004 Step 0.004 ale XY

In-line range 100 - 750

Cross-line range 300 - 1250

X-coordinate range 605834.80 - 629576.30
Y-coordinate range 6073556.40 - 6090463.20

Resulting survey setup 2504250 0.1% 3
: [ Zeros
100300 100/1250 10000 -3000 valu;} 5000 10000
Dcancel @
Workflow cont’d:
12. Survey definition is set now. Click on OK to proceed further.
@ Edit Survey Parameters - o X

Survey name My new Survey
Location on disk C:\Surveys
Survey type Both2Dand 3D~
Ranges/coordinate settings Enter below ~

“ Survey ranges @ Coordinate settings 2 1/C to X/Y transformation <% Coordinate System

Inline range (100 [7][750 2] step [1 :| Nr. In-lines: 651
Cross-line range (300 2] (1250 2] step 1 +| Nr. Cross-lines: 951
Zrange |4 |:1848 | Step |4 millisecond ~

Display depths in @ Meter (O Feet

Seismic Reference Datum (m) |0

= Apply

€ cancel e

Free space on disk: 52.56 GB
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Workflow cont’d:

13. Go inside the newly created survey by either double-clicking on it or clicking on Select.

14. Press Yes when asked to import the
SEG-Y file used to set-up the survey.

s
)survey Data Root ... [C:\Surveys 0w
F3_Demo_2020 o )
F3_Demo_2020_20jul21 pe My New Survey =
F3_Demo_2020_old - 2
My_New_Survey u 7504300 I G
My_survey AL
)
Y
[ ] Specify
o] 100700 10011250

o Import the SEG-Y data used for survey setup now?

oo Oromen_Ztoee_Biay_
N In-line range : 100 - 750 - 1; Total: 651
Cross-line range : 300 - 1250 - 1; Teotal: 951
Z range (ms) : 4 - 1848 - 4; Total: 462
Inl/Crl bin size : 25.00 / 25.00 (m/line)
CRS : Unlocated XY

Area : 386.93 (sg km)
Survey type : Both 2D and 3D
In-line Orientation : 88.40 Degrees from N
Location : C:\Surveys\My New_survey

L

Dot @

Workflow cont’d:

15. Keep the default Yes (import) toggled on, in front of Copy data. Optionally, it is possible to
make a link to the input SEG-Y file in OpendTect.
16. Specify an Output Cube name (by default name of the input file is copied here).

17. Press Import.

@ Import 3D Volume

Importing C:\Surveys\F3_Demo_2020\Rawdata\Seismic_data.sgy

Copy data O No (scan&link)

Volume subselection |— © Select ...

Null traces @ Discard O Pass

[ Scale values:  Shift/Factor

Output Cube | Seismic_data || © select ... “cavs v [ Depth

L] Execute in Batch Options ...

O @
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Workflow cont’d:

18. Once the import is finished, press OK on the notification window. Next, OpendTect will
automatically open the option to change the Z-scaling of the newly created survey. Move
the slider to set an appropriate Z scaling factor and press OK.

GBS

= Infarmation

0 The cube is available for work.

The cube has varying cross-line ranges.

In-line range: 100 - 750 (step 1).
Xline range: 300 - 1250 {step 1)

Z start: 0.004 step: 0.004
Mumber of samples: 462

Gaps: Gaps present.

PSS Y ¥

-

@& ~

m = =

Cross-line
Tree scene 1
Elements
Scene 1
[ @ Inline

[ @ Cross-line

[ @ Z-slice
@ Volume

[ ' Random...

[ 2D Line
[ ® 3D Heri
1 2 Horl
A% Fault
[ ® Faultset
[4' Faultsti
[ @ Body

A well
4% PointSet
[ Polygon
[ % shapefile
5 Prestac.,
Annotations

Step K il 110D Sefsmic 1 R E@r - A
fiit
.l
.
Ay
500 ino— 00 1000 1 -
P 1 i P
Ay
Set Z scallng factor E.
=l
|Appa|entvebdw (ms) B s | | [ €
X Fit to scene| # To Home By
] Save as Default
Sox | @
b |

1]

/ }

1

IEEEEE

[free mem] 22.8/31.8 GB [§] -

Workflow cont’d:

19. Check in the seismic manager the

newly imported cube; Survey >
Manage > Seismic > 3D.

:‘:' Analysis Processing Scene View Utiliies Help

{4 SelectSetup .. | Th . &
Session » -
In-line 5406 - Step| 10
Import »
Export ¥
| . Attribute Sets
(i ' | & Bodies ..
Exit Color Tables
X | @ Zslce |, Cross-plot Data ..
® \olume Faults
& | ~ Randoml ‘ -
2D Line . FaultStickSets ...
N 7| # 3D Horizor w, Geometry 2D ..
£ 4 2D Horizol| 4
Fault e Horizons
FaultStick§ “% Layer Properties
= ® Body #, PickSets/Polygons ...
9 el . | ™ Probabiity Density Functions
[~] [ Polygon Random Lines ..
5 St Prestack B
@~ i
AL & Seismics Prestack
-

= &

@ Manage 3D Seismics

Check info an seismic volume; e.g.
inline/crossline ranges, storage etc.

O- Filter [* '3
[ > Seismic_data < ¢
-
n
OpendTect automatically W
marks the imported seismic
volume as the default data. =
L
®
A
<
SEGY
In-line range: 100 - 750 [1] o
[cross-line range: 300 - 1250 [1]
lArea: 375.31 (sgq km)
Time range(ms): 4 - 1848 [4]
Storage: 16 bit signed
File name: Seismic_data.cbvs
[Location: C:\Surveys\My New_Survey\Seismics
Size: 540.64 MB
[Last modified: Fri 20 Aug 2021, 17:01:53
created by: assia
[Created at: Fri 20 Aug 2021, 17:00:3%
o

(Do ]| @

Free space on disk: 52.51 GB
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Workflow cont’d:

Tips:

» Changing the default Z-scale setting manually at any time
= Saving color settings with the loaded data set

* Manually making a seismic cube the default data set

Win-line!

Changing the Z-scale at any time: @ Cro¢ Add Default Data
; 5—7" Add and Select Data
.. OlU™ Add at Well Location -
1. Add an inline: . Bar Add Color Biended

* Right-click in the tree on Inline > Add and Select Data. =
« Left-click on the selected seismic data or press OK in
the window that pops-up after step 1.
2. Go to View > Z-scale.
3. Use the slider to change Z. Toggle on Save as default and

press OK.
—— e
Utilities Help Set scaling factor
Work Area ...
[ ZScie | seporent ity (i) P
Viewer 2D ...
X Fit t To H
Stereo Viewing * |2 Fitto scene| | # To Home|
Toolbars v

Workflow cont’d:

-s005 [ stes | megic

Saving color settings with stored volumes: = Matteo terrain cube
B! Matteo terrain cube red
= Matteo terrain linear
Vi Pastel
1. Select a color bar. w1 Porosity
I Pressure

¥i Rainbow

2. Right-click on the color-bar and select Ranges/Clipping. 7™~/ ks ece

. . 5005 [ oo

3. Change the Percentage clipped and Apply a few times. Flipped

When satisfied Press Close.
Manage ...

4. By default, clipping is used meaning every line will be scaled Set as default
slightly different. To set the extreme values: manually Epmenn e
overwrite the values next to the color bar and press Enter. e

5. Right-click on an attribute in the tree and select Save Color wqmm:m:w : :

(& scaling) Settings to save it as default for this attribute.
w42y (@[ © coe | @rer
] Seismic_datas
Cross-line Select Attribute 3

2D Line

zsice
\;éo;t:]rggm Line ) IS i’ '99 0 0 Bg 0 0

« Remove
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Workflow cont’d: This is just for information purpose and
is not part of the current exercise.

2D Seismics
2D Prestack Seismics

Manually setting a default data set :

1. Press the Manage Seismic icon and Select
3D Seismics or go to Survey > Manage >
Seismics > 3D.

2. Select a Seismic data set from the list and
click on the Default -, " icon. The default
file is marked by the >< symbol.

The advantage of having a default data set is that it
saves many clicks to select data in various places in
OpendTect. For example in this exercise we used
option “Add and Select " to see the data. We then had
to select the data. From now on we can use “Add
default data” for in-lines, crosslines and Z-slices.

3D Prestack Seismics

@ Manage 3D Seismics.

0o- Filter [* 7
[0> seismic_data < | ¢
=]
o
- )
iz
Y
L&
L)
-
=
0 In-line range: 100 - 750 [1] e
Cross-line range: 300 - 1250 [1)
Area: 375.31 (=q km)

Time range(ms): 4 - 1848 [4]

Storage: 16 bit signed

File name: Seismic_data.chvs
C:\Surveys\My_New_Survey\Seismics

d: Fri 20 Aug 2021, 17:01:53

Created by: assia
Created at: Fri 20 Aug 2021, 17:00:39 v

= ol

(O] @

Free space on disk: 52.50 GB
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1.2.2b Load SEG-Y

Required licenses: OpendTect.

Exercise objective:
Load a seismic SEG-Y volume in OpendTect.

c‘, Analysis Processing Scenes View Utilities Help

Workflow: (7 SelectSenp ki 2 M-S o w1 M PN @ Cd
Session L7
Attribute ,
1. Go to Survey > Import > Export * | ColorTable
. . Manage * | Cross-plot Data >
Seismic > SEG-Y > 3D { Prwsd | ram i
et FaultStickSets ’
; Vi ~ [T~ Randem[ Horizon '
_or cllck“'o_n the SEG-Y import X | oo o Muie Funcions >
icon &% in the OpendTect - | 2 3DHonzon  PickSets/Polygons ’
. SEGY %?u:onzur Probability Density Functions *
main toolbar. W s I T SimpleFie »
4 .\?\?r‘:}, Velocity Functions * @ cBvS »
= Wavelets > 3
Pickset e R EPetre.lDlrecl b
= .| D Polygon @ GPR DIT
v I ?nn:{::[uancsk E HorizonCube surface data & 0
L] Prestack Event T ¥ Pre-Stack2D
® -
’J 22 PreStack 3D ...

t] -
Workflow cont’d:
2. Go to the Rawdata directory of F3 Demo and Select the Input SEG-Y file: \Raw
data\Seismic_data.sgy.
a
Import 3D Seismic Data
Input file *=wildcard *'Edit
@ Select (one of) the SEG-Y fileis)
— v 1 « F3_Dem. * Rawdata * - (9]
il ]
SEG-Y revision Organize = Mew folder - o @ = o
Data format 0 Desktop
Number of samples Bocuments Faults H w0
& Cownloads Surface data E
Z range b Music Well_data Hi®=tic
In-line range & Pictures Seismic_datasgy O use (x,Y)
Cross-line range B videos
X-coordinate range ‘ L= ()
i - Google Drive
Y-coordinate range R
625 (19216 [o.% 2
d34 (19216
- [ Zeros
¢ 046 (119216
=y 039 (W\192.16
na¢ 052 (192,16
- users (\\192.1
= data (19211 |4
0 v < 31
File name: | Seismic_data.sgy | |SEG-Y files (“sgy “5GY *segy) ~
Open Cancel Dciose @
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Workflow cont’d:

3. The import wizard makes a quick scan of part of the seismic volume and automatically fills
in relevant parameters required for import.

Import 3D Seismic Data
Input file *=wildcard C:\Surveys\F3_Demo_2020\Rawdata\Seismic_data.sgy O Select ... #Edit ...
If needed, the parameters
required for SEG-Y IITIpOl't Quick scam result Actually use il |
SEGY revision |1 1 o ==
(under the Actuaﬂy Use column) Data format 3 - Integer (16 bits) 3 - Integer (16 bits) ¥ f
can be Changed manua”y' Number of samples 462 (600515 traces) 462 : 1000
7 range 0.004 - 1.848 - 0.004 (s or m) Start 0,004 Step [0.004 ® Usel/C
In-line range 100 - 750 O Use (X,Y)
Cross-line range 300 - 1250
X-coordinate range G05835.52 - 620122.55 [Calculated]
Y-coordinate range 6073556.38 - 6090463.17 [Calculated]
0.1% =
[ Zeros

In the bottom part, histogram of
seismic amplitudes of traces
used for the quick scan can be
seen.

— [T
10000 0 5000 10000

Qcese | @

Workflow cont’d:

4. Optionally, click on the icon to scan the entire input SEG-Y file.

5. Click on the q icon to examine in detail, first “1000’ traces (changeable) of the file.

@ Import SEG-Y Data - o X

Import 3D Seismic Data

Input fila *=wildcard C:\Surveys\F3_Demo_2020\Rawdata\Selsmic_data.say O select ...  #'Edit
Full scan result Actually use il |

SEG-Y revision 1 1 e E

Data format 3 - Integer (16 bits) 3 - Integer (16 bits) ~| [

Number of samples 462 (600515 traces) 462 2| [w0o0 2

7 range 0.004 - 1.848 - 0.004 (s or m) Start 0.004 | step [0.004 ® Use [/C

In-line range 100 - 750 O Use (X,Y)

Cross-line range 300 - 1250
X-coordinate range 605416.71 - 629576.26 [Calculated]

Y-coordinate range 6073556.38 - 6000463.17 [Calculated]

0.1% =

Now in the bottom part, O Zeros
histogram of seismic amplitudes
of all the traces in the input

SEG-Y volume can be seen.

Qo @
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L e : —
Workflow cont’d:
-

6. Examiner window: =
Use this to find out
what is inside the file.

7. Check the Inline, TGOS Byt posftions (in AGditien To FEV.
Crossline and X/Y o o o T’
coordinates : find the §§ e N oy
Corresponding byte gié 100/300 = (605835.5/6073556.5)
and observe the Gii 7507300 = (608201 q55. 6pas798.5)

e
[

2009)

1 standard peositionsa):

Dump of EBCIDIC and
Binary headers

Vale

Value range 75840 | 635

ean/Sul devistion [1.1750
Median/RHS [0
Harmber of values (462000

51 6o
5616229

associated plot. £l

Trace header information

Ve | Count: -3069.1350 | 36138,

tracl (irace sequence number within ine)

| Trace header Plot

. 1 2
8. Optionally, check [t fract - 5 1
Seismic viewer and §fracr] 1 2
. . 9 [fidr] 100 100 600
histogram windows. rrTrp— 0 ,
17 [ep] 300 301 400
21 [edp) 300 301 200
25 [cdpt] ] (1] |
Trace header name + 29 [;id'; ; ]
byte position 31 [ws] [} 0 0 !

First 1000 Trace header Nos.

200 400 600 800 1000

Range: [1,951] (N=1000)

8 Ciose| | #d Help

Ci\Local_Surveys\F3_Demo_2015_training_vé\Rawdata\Seismic_data.sgy

Workflow cont’d:

9. Click on Next in the Import SEG-Y Data window.

Import 3D Seismic Data
Input file *=wildcard |C: ys\F3_Demo_2020\Rawdata\Seismic_data.sgy | |© Select ...| | #/Edit ...
Full scan result Actually use 2 &
SEGY revision 1 1 | =
Data format 3 - Integer (16 bits) 3 - Integer (16 bits) ~1 Q)
Number of samples 462 (600515 traces) 262 2 (1000 =
Z range 004 - 1,848 - 0.004 (s or m) Start |0.004 Step |0.004 ® Use I/C
In-line range 100 - 750 O Use (X,¥)
Cross-line range 300 - 1250
X-coordinate range 605416.71 - 629576.26 [Calculated]
Y-coordinate range 6073556.38 - 6090463.17 [Calculated]
0% 3
[ Zeros
Qcose @
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Workflow cont’d:

10. Keep the default Yes (import) toggled on, in front of Copy data. Optionally, it is possible to
make a link to the input SEG-Y file in OpendTect.

11. Specify an Output Cube name (by default name of the input file is copied here).

12. Press Import.

@ Import 3D Volume _ O X

Importing C:\Surveys\F3_Demo_2020\Rawdata\Seismic_data.sgy

|Oopy data @ Yes (import)| O No (scan&link)

Volume subselection |- | © select ...

Null traces ® Discard O Pass

[ Scale values: ~ Shift/Factor

Output Cube [Seismic_data -] © select ... |& cBvs v [ Depth

[] Execute in Batch Options ...

0 Cancel 0

Workflow cont’d:
@ Manage 3D Seismics
13. Close the Import SEG-Y Data o- Filter ¥ =
window. [ > Seismic_data < ¢
=
14. Check in the seismic manager the g
newly imported cube; Survey > u
Manage > Seismic > 3D. i
YJEME Analysis Processing Scenes View Utilties Help %
&7 Select/Setup Ly = ":-@ = e [f] > & %
Session > = L
Import r Al
Export , bt
Manage il v, Attribute Sets g
{ Pre-load ' | & Bodies o In-line range: 100 - 750 [1] )
Cross-line range: 300 - 1250 [1)
(R | SIS Area: 375.31 (sq km)
= ~ Random L £, Cross-plot Data Time range(ms): 4 - 1848 [4]
2D Line ult Storage: 16 bit signed
- “ 3D Horizon * File name: Seismic_data.cbvs
® 20 Horizor |+ Fault Stick Set Location: C:\Surveys\My New_Survey\Seismics
V- Fault ®, Geometry 2D Size: 540.64 MB ) i
» ggr;suck * Horizon » Last modified: Fri 20 Aug 2021, 17:01:53
- Well ", Layer Properties ... Created by: assia
i Pickset |, PickSets/Polygons .. Created at: Fri 20 Ang 2021, 17:00:39 v
2~ gz?e‘)ggg“;”‘{ ;rnb:hnlt{ Density Functions B [=]
- Annotati andom Lines R . .
uy |« Annotatons = Check info on seismic volume; e.g.
(17?”' B Soamcs Presiack , m—. inline/crossline ranges, storage etc.
(2]

Free space on disk: 64.88 GB
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1.2.3 Import Horizon

What you should know about OpendTect horizons

e There are two kinds:
e 2D horizons (from 2D seismic)
» 3D horizons (from 3D seismic)
» Each kind has two types:
» Geometric grids
 Attribute grids
« Attribute grids are stored as “Surface Data” with the geometric grid to which
they belong.
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1.2.3a Horizon

Required licenses: OpendTect.

Exercise objective:
Import (geometric) horizons from ASCII files. | &G r@ oo
| Session L R = — T -
% Import v AHributeSel‘ - .! M=o [RGB L]
Workflow: % Export . Eolar T‘Iabled”
4 4 Manage v ross-plot Data J
L Predoad > s :
. q aultStickSet e
1. Go to Survey>Import>Horizon>ASCII> e e .
1) Edt zons. T .
Geometry 3D. & [ ©® volume me Functions Dy ::Cci:;g ¥ single 3D Horizon
9- [ & Random L Navigation Data / 20 Geometry  * From ZMap ... Bulk 3D Horizon ...
[ &9 20 Line PointSets/Polygons * T Attributes 3D ... [
2. Inthe Import window, select the horizon '° Epdiy  Smpints )
as Input Ascii file: \Rawdata\Surface_data\ |, = = e unctons ;
F3-Horizon- FS6 xyt for example. @ | O s el ’
@- g & WE‘:’ ES ::;;;;m Model
i B4 PointSet  porzoncube Data .
HH ‘r" E [’f"gmﬁ“'n Prestack Events ...
[ # Import Horizon E@E‘
InputASCII File \Rawdata\Surface_data\F3-Horizon-FS6.1 Q, Examine
Fl ~
Aftribute(s) to import | l_f_ﬁ
Workflow cont’d:  CODDS\F3. Derno eaining RawdotaSuface date\F3-Horzan P56t - o x
File [N
3. Examine the file to determine the 5 *
header contents and to check details
for the Format Definition.
Keep this window open to fill in the
Format Definition.
4. Specify the header size (number of
lines): here, set it to No header.
Optionally define attribute(s) to be 2 Z 9
loaded as Horizon Data in the same time £ Rekoad
as the geometry : use the g icon.
You can add as many attribute as you 4 Import Horizon L= e
need They Wi” be Iisted and you can INPULASCI| File '\Rawdata\Surface_data\F 3-Horizon-FS6.nt O Select I Q Examine
decide to select them for loading. 1
Aftribute(s) to import E
Attributes can also be imported and =
added to an already existing horizon by 2
choosing: Survey > Import > Horizon > —
B File heauer_ ==
Attribute 3D... —
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Workflow cont’d:

5.

To set the Format Definition, click on Define : assign to each quantity the corresponding

column in the file.

Optionally, click on Scan Input File to test the loading parameters.

Close the scan report

Format definition |<Incomplete=

# Format Definition =18

Specify Necessary Information

B ]
Scan Input File

Area subselection l/ ) Select

Undefined Value |1e30

Xy E|Posm’nn col:1 5 [col2 £
Z |cok3 = Unit ms[lmlhseconrz]

Stop reading at

i« (@ ] (O corcel] [ @ 1o |

Workflow cont’d:

10.

11.

Specify if the undefined parts should be
filled: select No.

@ Import Horizon

= o X

Input ASCII file P0\Rawdata\Surface_data\F3-Horizon-F56.xyt| © Select .. Q\Examine

-
Attribute(s) to import o
Name the Output Horizon and select a =
color for display. L
[ Horizon is in Depth domain
To automatically load the horizon in the 3D Fleheader (Nohender | [
_scene,”tog_gle on the “Display after oot dokion e S
import” option. e
Area subselection |106/612-748/1248 (462 samples) © select ...
PTESS Import Fill undefined parts O Yes @ No
Output Hcmzon -] © select ..
Tied to Level — =
Base color [N = DarkOrange -
Qo= @ ©
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1.2.4 Import Well Data

What you should know about well data:

Wells are defined by a well name and a well track.
Optionally the following information can be added:

e Time-Depth Curves.

o Markers.

e Logs.
Time-Depth curves can be modified (stretched and squeezed) in the Well-
tie module (synthetic-to-seismic matching module).
New logs can be created in the Well manager using OpendTect’s Rock-
physics library and math & logic manipulations.
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1.2.4a Well Data

Required licenses: OpendTect.

Exercise objective:
To load well data from ASCII and LAS files.

EIE] Analysis Processing Scene View Ulilies CLAS Help

£ SelectSetup Lo L. Crossdine O Step (
Session L -

-::_ Altribute
Export * | Color Table
Manage * | Cross-plot Data &
Workflow: Prewed | Faus :

Exit FauRStickSets
=T wrvonme— | Horizons. 4
~ Random L Mute Functions »

1. First import the well track by & | um | pesaspoygms 5
choosing Survey > Import > Wells > B e SEIEYEmen]
ASCII > Track. = ._;a:nﬁ:f"“ Ay funetind
2| Ewer T T
. 1~ D:);;;'Dﬂﬂ HorizonCube surface data Simple Multi-Wel
2. Select the Well track file: /Rawdata/ g | 5 prosiack| Prosiock Buont 2t '
« Annotations [ PetreiDirect C
Well_data/F02-01_welltrack.txt for - J2 vsP (sEGY)
example.
@ Import Well Track
Input type Well Track file (XYZ) ~
Wjed s |We|| Track file Vell_data\F02-01_DT_TVDSS.bt]| | © Select ... |, Examine

Directional or Vertical
Well, you can manually
add the well head
coordinates. Format definition |<Incomplete> [Z)efine ...

>

File header No header >

Workflow cont’d:

3. Click on the Examine button. npuetveel| Wellll kil ) e

Well Track file Well_data\F02-01_DT_TVDSS.txt| €) Select ...
File header No header v | |

@ CASurveys\F3_Demo_2020\Rawdata\Well_data\F02-01_DT T..

0.0000 1.5693 Cad
5.0000 6.7446
O 10.0000 11.9193
15.0000 17.0952
20.0000 22.2688
25.0000 27.4367

4. Define the Format Definition for the well track: col-1: X, col-2: Y, col-3: Z and col-4: MD.
The default units are in meters, but can be modified from the drop-down menu.

@ rormat Definition = m} X
File header No header v| = Specify Necessary Information
X/Y v leot1 2] |02 2]
Format definition |<Defined> [Z [TVDSS]] [col:3 (2] Unit ' m (Meter) -
First Coordinate {m) [MD] :col:4 :] Unit m (Meter) >
[] Reference Datum Elevation [KB] (m ) 0 [ stop reading at

[ Total Depth [TD] ( m ) = Qcancel @
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Workflow cont’d:

5. Select the Depth to time model

file: /Rawdata/Well_data/F02- Depth o Time model file Vell_data\F02-01_TD.bdt

01_TD.txt.

File header Mo header

6. Examine the file.

v | |

7. Define the Format Definition for Format definition | <incomplete= | []:5] Define |

the Depth to time model;, col-1:
Depth in m, col-2: TWT in sec.

@ Format Definition

Specify Necessary Information

Undefined Value 1e30

MD ~ Depth |col:1 ' Unit m (Meter) ~

TWT ~ Time col:2 5 Unit s (Secands) ~

[[] stop reading at

=)

(S]] Oane @

model for this well.

If you uncheck the Depth to Time model file, you will be able to add a constant velocity

Workflow cont’d:

8. Is this checkshot data? Tick yes.

Advanced options are optional

9. Provide an output name.

10. Once done, press the Import button.

Depth to Time model file _Nell_data\FO?—O1_DT_TVDSS.bct| 6 select ... O\ Examine
File header No header v| =
Format definition | <Defined> | Define
[ 1s this checkshot data? ® Yes|] O no
Advanced/Optional ...
Output Well | F02-01] ~ | 1E select ...
[ Display after import [@import || Bciose @ ®
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Workflow cont’d:

11. Display the well in the survey:
right click on Well > Load and
select your well.

FaultStickSet @ Select Wells - m} x
® Body Sellect Input Wells

A well + Filter *

i point Add ... F02-01

) Polyc Az Tie Well to Seismic ... a
W Shar  Pick New Trajectory ... o]
=% Prestack Events T

Annotations

[B5] oo ©

...ys\My_New_Survey\WellInfo\F02-01.well

12. To import the logs files: click on @ Manage Wells - 0 X
the Manage Well Data icon O~ Fiter[* o 0- Log
%, and click on Import. O Fo2-01 (=) ;
Alternatively, follow Survey > a (=)
Import > Wells > ASCII > Logs. " i
t
+
RS ATy Tmport .. | | Create ...
Workflow cont’d:
13. Press the Import button, then select las file: /Rawdata/Well_data/F02-01_logs.las.
14. Toggle MD.
15. Highlight all logs needed to import
16. Select Curve in the name after log
& Import Well Logs = m] X

17. Click on Import.

Input (pseudo-)LAS logs file :vdata\WeII_data\Fnz—[Jl_Iogs.Ias: O, Examine

Depth interval to load (empty=all) :30 | |3150 (m)
Depth values are O TVDSS

Undefined value in logs -999.25 |

Curve Unit Description
1 [ CALI in Caliper_1 (Caliper)
2 RHOB gfcc Density_1 (Density)
3 GR APL Gamma Ray_math (Gamma Ray)
4 DT us/ft P-wave_1 (P-wave) -

Name log after ® Curve | Description

Add to Well [F02-01 | © select ...

O ©
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Workflow cont’d:

18. In the well manager, click the Edit
Markers icon.
In this exercise, we will import markers
from an existing file. It is also possible to
add markers manually.

@ Manage Wells

O~ Filter [* 0O Log
[JFo2-01 O Ocau E
[ rRHOB
8 (Oer =
Oor [}
(] UNKNOWN
)
ﬁ‘.‘ l:\
& &
+
4
o T % % b G| Import ..  Create ...
| = Edit Well Markers = =l b3
Name MD{m) TVD(m) TVDSS(m) Color Regional marker
Marker 1
Marker 2
Marker 3
Marker 4
Marker 5

Update display Export ... 12 in Feet

Set as regional markers ..] [,

Q@ ox | O cancel| @ Help

Workflow cont’d:

19. Select the input file: /RawData/ Well
_data/F02-01_markers.ixt.

20. Define the Format Definition:

@ Import Markers
Input ASCII file

File header

Format definition

Existing markers (if any)

fa\F02-01_markers.bd]

No header v | |

<Incomplete> Define ...
@® Replace O Keep

[] Assign random colors to|markers

@@ Qcanoel 0

l

' Format Definition == o]
Specify Necessary Information
MD E Depth |col'1 = Unit m (Meter) E

Marker name col:2 <

Stop reading at

[ @0k |[© cancel] | @Hep
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Workflow cont’d:

21. Select / Modify a color for each marker by double-clicking on the appropriate row in

the Color column.

22. Press OK.

23. Once done, close the dialogs and return to OpendTect scene.

= Edit Well Markers

Name: MD(m) TVD(m)
Marker 1 Seasurface 30 30
Marker 2 MFS11 553.6 553.6
Marker 3 FS11 576.02276611  576.02276611
Marker 4 MFS10 683.31 683.31
Marker 5 MF39 716.65002441  716.65002441
Marker 6 MFS8 748.49 748.49
Marker 7 FS8 795.00915527 795.00915527
Marker § Name 869.93659863 | 869.93659663
Marker 9 FS7 942 27575684 94227575684

Marker 10 Truncation  1051.41040039 1051.41040039
Marker 11 Top Foresets 1094.97290039 1094.97290039
Marker 12 FS# 1106 93835449 1106 93835449
[Update dispiay] [ import . | [ Export . |

(5ot as regionai markers .| [

s
TVDSS(m)  Color tegional marke * |
a - ]
e
54602276611 [ — =
653 31 - -l
686.65002441 Fl
718.49 - Fl
76500015527 [ — =
839.93859863 -l
912.27575684 - -l
1021.41040039 — =
1064.97290039 - =
1076 93835449 R~
Z in Feet
[ ©@ox ] O Cancel | | @ Help ]

Workflow cont’d:

24.In the scene, display the log and/or
markers on the well : right click on the
well in the tree and follow Display
>Properties.

25. In the left- , center- or right-log tab, select
the log to display and the properties.

[=] Display properties of: F02-1

Left Log | Centerlog RightLlog  Markers  Track
| Select log Gamma Ray iz
Specify data range ~| O Flip

Log range (min/max) |0 1140 [ Logarithmic

26. Open the Markers tab: toggle on the
desired markers and set the marker size
etc.

wel

i
¥ PickSel
Q Polygon CLAS LogPlot 2D Log Viewer
= Prestack iy, 130 wel to Seismic .. Show g

@ Annotations
! Create Altribute Log

Fraata | an Cohe

Show Amplitude Spectrum *
————

a Display properties of: F02-1

LeftLog Center Log  Right Log Track

Marker size |15 5
Marker color - M Blue [ use single color
Shape Cylinder ~ | Height |1 =

Name size Normal
Name color || [Cwhite
-

[ W Seasurface
[~ I MFs11

[ W Fs11

1 @ MrFs10

4 O mrs9
[l MFs8

~ [] Dynamic

same as markers

Display markers

Reset all

- st

Apply Current to all wells

Il Save

[ Save as Default
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1.2.5 Multi-Well Import

Different options are available to import multiple wells in OpendTect

(-] OpendTect Pro V6.6.4 (Windows) : tst2del - [Scene 1]

ZJ Survey Analysis Processing

Scene  View Utilities TerraMubis Help

.47 Select/Setup ... . 4
Session L4
CEICY Y ] §
- Import 3 Attribute Set 3
% Export » Color Table ...
4 I Manage 4 Cross-plot Data L4
.. Pre-load 4 Faults 4
1 R FaultStickSets 4
-
v FaultSet 4
MO ="
— i 3
7 T Harizons
: .;-; Random Li Mute Functions L4
N - ] 2D Line Navigation Data / 2D Geometry ~ *
G @ 3D Horizor PointSets/Polygons 3
-4 2D Horizor Probability Density Functions 4
A Fault Seismic Data ’ _\6_05
. - # FaultSet Velocity Functions »
ick€
ﬁ FaultSticks Wavelets >
] Bod
® sody Wells v T asco
D -| B4 wl Well locati
i PointSet Pre-Trained Model ... el locations ...
Bulk Track ...
[ Polygon Shapefile ... -
|‘ @ Shapefile Py . 12 vsP(SEG-Y) ... Directional wells ...
1 —
- Ls
& Prestack B Prestack Events ... [ 093
E‘ Annotations Markers ...
Depth/Time Model ...

e Import > Wells > Bulk...

e Track: if the track information of more than one well is in the same file,
use this option. The names of the wells need to be in a column.

» Directional wells: allows for the import of multiple well tracks following
the same principle as for Bulk Well track. In this case, after reading
the file, the well tracks are listed in a table that can be QC-ed and
edited prior to actual import.

» Logs: allows for the simultaneous loading of several LAS files.

» Markers: as for well track.

» Time/Depth Model: as for well track.

Important notice: when you have finished with this Chapter do NOT continue in
the survey you have just created but return to the original F3 Demo data set as
this data set is much richer.
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1.3 Basic Interaction

This Chapter deals with basic interactions. You will learn how to display seismic
data on in-lines and cross-lines, how to move lines in the 3D scene, how to zoom
in and rotate a scene and how to create random lines.

What you should know about the user interface

OpendTect supports multiple 3D scenes.
Each scene has its own Z-axis (time, depth, flattened on a single horizon,
Wheeler-transformed).
There are three interaction modes for 3D scenes, each has its own cursor:
1. Position mode for positioning & moving display elements (arrow
cursor)
2. View mode for zoom, rotate and pan (hand cursor)
3. Interpretation mode for picking and editing data points (cross
cursor).
Each Scene has its own tree from which data objects are added to the
scene and from where they can be manipulated.
The tree does NOT show the entire data base of all stored data in the
survey as in some other software systems. The tree shows which ele-
ments have been loaded or processed on-the fly. These elements reside in
memory and are available for visualization and further manipulations.
Most display elements (lines, horizons, slices) have multiple layers for com-
paring and co-rendering information.
Data for display can be loaded from stored files, or processed on-the-fly.
If you have the memory: use it! Pre-load seismic data to speed up visu-
alization and on-the-fly processing.
Display elements can be manipulated in the 3D scene (right-click menu) or
from the tree (right-click menu).
Seismic sections displayed in the 3D scene also be displayed in separate
2D (flat) viewers.
If you have an OpendTect Pro license: use the basemapto interact with the
system.
Functionality can be accessed via Menus, Icons and short-keys.

Short-keys and Mouse-controls

OpendTect supports a range of short-keys to speed up various interactions.
Mouse controls and a number of short-keys can be modified from the Utilities
menu, option Settings --> Keyboard shortcuts. The default settings of the most
important short-keys and mouse-controls are given in the table below. This table
is also available from the menu Help with the option "Keyboard shortcuts.
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View Mode
Pan Middle Click + Drag

Rotate Shift + Middle Click + Drag Interpretation Mode
Scroll Wheel

Zoom injout Pick seed Left Click

Ctrl + Middle Click +Drag Remove seed/pick Ctrl + Left Click onseed/pick
Activate Polygon Selection |y
Multi Selection v + Ctrl + Left Click
Move Single Selection Left Click+Drag
New Shift + Left Click
Finish Double Left Click
Ctrl + Left Click onexisting fault stick {outside seeds)
Left Click on existing seed

Position Mode
Activate element Left Click
De-activate element Left Click outside active element
Draggers —applied to Active Inline, Crossline, Z-slice or Random Line

Browse,/Resize Volume perpendicular-to-plane | Left Click +Drag in Active Volume Faultstick
Resize Left Click+Drag (green) Anchors Select (to edit)
Rotate (if possible) Ctrl + Left Click+Drag

perpendicular-to-plane Left Click+Drag

parallel-to-plane Shift + Left Click+ Drag

orizon Tracking
Tracking menu Ctrl + Right Click
Autotrack k

Retrack Cirl +k

Lock / Unlock 1/u

Clear Selection a

Basemap

Inline
Crossline

Random line A
Delete Selection d

Show all Shortkeys Shift+?

Save selected object Ctrl+ s

Save as selected object Shift + Ctrl + 5
Undo /Redo Ctrl+ z f Ctrl +y
Toggle J Print 3D graphics stats g/G

Pop up Command Controller Ctrl+r

Toggle between “infull”/ “at section” selected item display

inline/crossline/z-slice momwm.m_..ﬂmn_a o um n ﬂ— l—lm_n.ﬂ U —\l O
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1.3.1 Tree, Scene & Elements

Each 3D scene has a tree and each tree controls a set of display elements: In-
lines, Cross-lines, Horizons, Wells etc. Via the tree a user controls what is dis-
played in the 3D scene. (OpendTect Pro users can also do this via the basemap.)
Display elements can be toggled on and off and display parameters can be
changed from the tree menu, which is opened by right-clicking on the element.

Section elements such as In-line, Cross-line can be filled up to 8 layers deep with
data for co-rendering. The layers can be moved up and down in the tree. For co-
rendering the user can change the layer's transparency and / or change the opa-
city curve of the chosen color bar.

Display elements can be filled with stored data and data that is calculated on-the-
fly. The latter option is used to test attributes and to evaluate their parameters
before (optionally) computing an attribute volume in batch mode. This way of
working improves efficiency.

Elements Color
Scene 1 Tree o x
--iy' In-line
= 425
4Dipste... 1
# Crosstline
w Z-slice
@ voumt Display
20 Lin] €lement
@ 3D Holrzom
@ 2D Horizon
Fault
Fault Stick Set
@ Body
L Well

=\ Prestack Events
+- Annotations
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1.3.1a Display An Inline

Required licenses: OpendTect.

Exercise objective:
Display an inline in the 3D scene.

Scene 1
Workflow: ”] Add Default Data
. ] o CPAI:  Add and Select Data
1. Right-click on Inline in the tree and select Add @ Volume  Add at Well Location ...
and Select Data. 7 Randd  Aqd Color Blended

2. In the pop up window, select 4 Dip steered

median filter. ) Select o o)
Select first layer
3. Click OK to display data in the scene.
@ stored [ 10riginal seismics o
3D UVQ 6 biased Texture+Energy+SystemsTracts =
Steering 3D UVQ Texture+HC attribs+ Energy disk
4 Dip steered median filter

Attributes 5 ChimneyCube
7a Al Cube Std
= 7b Al Cube from HorizonCube

O Daracibilihn fram UQ AIA

=
= Filter | *

L oK ]l [O c;neel] [ @ Help ]

Visualization and processing goes faster when you load the relevant data set(s)
into memory. If you do not have sufficient memory to load an entire volume load
only the part you intend to work on. Another way to reduce memory consumption
is to re-scale data to 8-bit during pre-load.
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1.3.1b Pre-load Data

Required licenses: OpendTect.

Exercise objective:
Pre-load data In the lower-right corner of the
main window you can see how
much memory is free.

[free mem) 23.8/31.7 GB .
Workflow: 5
. . - TJEIETl Avalysis Processing Scene Vie
1. Use it only if you have sufficient memory. To Pre- & seecusoup | puy s
. . ession O il
load a stored seismic cube go to Survey > Pre- fmpm = z
load > Seismic. B Color |
lanage »
i 4 Horizons
& hﬁE(—mﬂ HorizonCube ..
“ Seismic Data Pre-load Manager = o X
o- -
2. Click on Add Cube. (5 Loaa 20 Dataset

% Unload Checked ..

@

Workflow cont’d: -
To reduce memory consumption:

3. Select 4 Dip steered median filter as input cube. 1) load in a smaller volume range
Optionally, specify a volume subselection and the | 2) load in a different format e.g. as 8-bit

loading format. Press OK.

 Positions = a X
=1 R
IM::::% ‘3#"”'”‘““’ Py I 000 — o Specify Positions
Volume subselection 100/300-75 [Bselea] votme lection | Range ~| I = =
Load as [0- aute - In-line Range | 100 [<||750 < ‘ Step |1 <
SN 73 T Cross-line Range [300 =) [1250% ‘ step [1 B
) TimeRange (ms) [0 (2] [1848[2] step [+ 2]

@ Cancel| | (@) Help

- 64 bit signed

Data format on disk: 16 bit signed. E stimated memory usage: 546.73 MB
= Sciamic Dot Prc-fosc Mansger oo

4Dip steered median fier [Badscuve..
[E9Ad820 patase..

o Unioad checked ..

> @

Geee](@ver)
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1.3.2 View, Position and Interpretation Mode

OpendTect distinguishes three possible modes of operation for the 3D scene:

» Position Mode for (re-)positioning, moving and resizing display elements.
The cursor in this mode is an arrow.
» View Mode for rotating, panning and zooming. The cursor in this mode

cursor is a hand.
 Interpretation Mode for picking and editing data points. The cursor in this

mode is a cross.

e {h
Use . or {a j icons to toggle between Position and View modes.

L]

Use oricon to toggle between Interpretation and View modes.

- 46 -



1.3.2a Position, Zoom, Pan, Rotate

Required licenses: OpendTect.

Exercise objective:
Learn how to zoom, pan, & rotate a 3D scene and how to move a seismic line.

Workflow:

1. Click on shift + the mouse wheel and drag
to rotate your display. To pan the scene
(i.e. move the scene horizontally &
vertically) press the scroll wheel (keep it
pressed on) and move the mouse. \

P
\ l:‘Il

2. Zoomin and out by scrolling the mouse
wheel. Or press Ctrl + the mouse wheel
(keep it pressed on) and move the mouse
back and forth.

Workflow cont’d:

Positioning elements

Elements Colof
Scene 1

A - H In-lin

3. Click on In-line in the tree > Add Default PATR Add Dofaut Dala ]

& Z-slice Add and Select Data

Data. @ Volum  Add at Well Location ...

~ Rand - Add Color Blended

7 Survey Analysis Processing Sce

B D I —
L L o T3 V2N -
4. Sele_ct the inline in the tree by clicking on iz Bt 4mmp
the line number 425. Tree stene 1 B
h Elements Colo
- - T .y . - 5:9)121
5. Fill in 250 (the new inline position) line F e Er:
number in the Slice Position toolbar. X || ¢ crovnina— ™

Use available memory: pre-load 2D, 3D, pre-stack seismic, T - o
Horizon and HorizonCube for quicker access. D semameanten
Survey > Pre-oad > Seismics =

m/\nalym Processing Scene Vie

L7 Select/Setup ... T: « ‘ O i

Session »

Import 4

Export 2

Manage » =
e 9

Exit 4] Horizons .
pj TTWPCTUSSTINE @) HorizonCube

i 7_clira
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Workflow cont’d:

Positioning elements

6. Rotate the view so you see the inline
such that it is displayed from its side' or
'end on' as much as possible in the
scene.

7. Leftclick (keep the button pressed) on
the inline in the scene and drag it to the
desired location and let it go.

8. To undo press Ctrl + Z.

If the seismic is pre-loaded the display
is uploaded instantaneously, movie-

style.

Workflow cont’d:

Positioning elements

9. From the tree, right-click on the
updated inline number and select
Display > Position option in the
pop-up menu list.

10. Position the inline at 195 and
click OK.

=& Zslic  pyplicate

= @ Volun Display Prestack Data »

Scene 1
=y In-line
v Add %
# Cros| TV 1 +istogram .

0 [
?/2 Reset Manipulation

Gridiines ...
4/ Properties ..
|/ Resolution  »

= [v] 34 Correlate with Wells
Y/ g Lock Treeitem

./ ?Snlf == Remove from Tree

@) Positioning o [@]=

Specify the element's positlofn
v

in-ine 19573
Cross-line Range 300 = 1250 <
Z Range (ms) 0 31848 £

= Apply
\O CanceIJ \ @ Help J

ks
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Workflow cont’d:

Positioning elements

11. Scrolling: Right-click on an In-line
number and select Display > Position.
Press Scroll. Elements are moved either
manually (select Control Manual) or
automatically (select Control Auto).

@) Positioning o e =
Specify the element's position
In-ine nr 195 <
Cross-line Range 300 1250 < )
& scrolling =8 EoR =x=|

Z Range (ms)

Control scrolling through In-line

Scroll step 1
OOK “ Control |
<< Step Back \Auto
@b
12. Default keyboard short cuts to move a Help
slice backwards/forwards are x and z. To Settings 21 Look and Feel ...
change this go to Ultilities > Settings > Tools g
Installation » |~ Advanced »
Keyboard shortcuts. Show Log File . | Language )
Workflow cont’d:
Positioning elements
- . Z-slice
13. In the element tree right-click on Volume = Volume! \
and select Add. This will insert an empty element in the tree. ¥ [EERIEN

Add Color Blended
Randurrrmrre:

14. Select a stored volume: right-click on <right-click> and go to Select Attribute

> Stored Cubes > 4 Dip steered median filter.

- [v] 425
v| <right-click> ra
# Cross-line
& Z-slice
= @ Volume
=] 343-506 / 656..

Display
Remove

7 2D Line Attributes

“ 3D Horizon
42D Horizon
Fault
FaultStickSet
@ Body
L well
X PickSet
[ Polygon
=\ Prestack Events

. Annntatinne

15. Left-click and drag an in-line/cross-line/z-slice, you can then go quickly

through the entire volume.

£ <right-olior— e L
~ Random Line Stored Cube _*

Steering Cube *

1 Original Seismics
5 ChimneyCube
Ta Al Cube Std
7b Al Cube from HorizonCube
8a PorosityCube from HC-NN
8b Gamma from HorizonCube
9-1 Similarity on FEF seismic
9-2 Dip-steered diffusion filter
9-3 Fault enhancement filter
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Workflow cont’d:

Look at what you have from all sides. Note that the data values are read out and displayed
in both methods (view mode and position mode), these values are displayed at the bottom
of the screen.

Show crossline 1000 in a similar manner.

= OpendTect Pro V6.2.0/win64: F3_Demo_2016 treining v6 - [Scene 1] - 8 X
Sunvey Analysis Processing Scene View Utiiies Help Estimages -8 x

GiwqBiana SEFT-AS
[ | ‘ 2 bk

In-line 120 % Step

Tree scene 1 5
Elements Cotor
Scene 1
¥ indine
# Crossine
 Zslice
~ @ Voume
v [ 343-506/656-9.
[ 4Dipsteere.. 11
~ Random Line
20 Line
< 3D Horizon
2D Horizon
Faul
FaultStickSet

IR LY Y

AR>S 9 >

wel
i pointSet
> Polygon
% shapefile
S\ Prestack Events
Annotations

[ -

3430938 (621622, 6080075, 659) Value = 3360 lfree mem| 427968

Workflow cont’d:

Show a part of a Z-slice at 700 ms TWT

Ci -li
16. Right-click on Z-slice > Add Default Data. ;'gz.r_é’f-s re /I
= Volu

A |
= [¥] < Add and Select Data

17. Rotate the view so you see the Z slice from

above. Shift + Middle Click + Drag. 5 @ Z-slice
S
18. Make the frame smaller by dragging the green ® Volumy "p =
handle points of the frame. (If the handles are 714 Reset Manipulation | gy s
not apparent click on the relevant slice to 7 handd & Lok Tresitem e e —
‘activate' them). @ 3D Ho == RemovefomTree gosoiution »
) Positioning o || &S

19. Right-click on the Z-slice number > Display >

Specify the element's position

In-line Range 100 = 472 £

Cross-line Range 300 5 900 %

Z (ms) 700 = || Scroll...

| ¥ Apply

) Cancel | @Hep |

-50-




1.3.3 Random lines

What you need to know about random lines

» Random lines can me moved (left-click + drag) and rotated (Ctrl left-click
+ drag) through a volume.

» For movie-style inspection of the data it is recommended to load the data
into memory (pre-load exercise 1.3.1b)

» Random lines can be created in different ways:

Easiest: Add default data to get a line positioned in the center of the
volume and start moving rotating

Drawn on time-slices or horizons (OpendTect Pro users can do this in
the basemap).

Through wells: A random line can be created by connecting the
selected wells. By right clicking on the random line in the tree, and
selecting Create from wells, a dialog box appears with a list of wells
that can be selected in order to set up the random line path. This
option is useful for the Well Correlation Panel.

From Existing: This option allows the generation of a random line
from an existing random line. There is an option available to generate
arandom line at some distance away from an existing random geo-
metry and store itin a new random line geometry.

From Polygons: allows creating a random line definition from pre-
viously created polygons.

From Table: allows creating a random line in defining its nodes in a
table. Each node is defined by its x/y coordinates and Inline/Crossline
information.
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 Random lines can be optionally saved in the data base.

~ iRandom.| Tal-% |

20 L Add Default Data
“ 3DH  Add Stored ...
Add Color Blended *

[ Polygon
=: Prestack Events

Interactive ..

From Existing ...
From Polygon ..

From Table ...
From Wells __.
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1.3.3a Random Line

Required licenses: OpendTect.

Exercise objective:

Workflow:

1. Pre-load the stored 4 Dip
steered median filter cube (see
exercise 1.3.1b).

2. Add arandom line: right-click
on the tree item (OpendTect
Pro users can also do this from
the basemap).

3. Resize the display element:
left-click + drag on the green
anchors (this is optional but for
the sake of this exercise let's
doit).

Add a random line and move & rotate this through a 3D seismic volume.

~ ‘R;nQnm Lina!

ISRz Nl Add Default Data

@ 3DH  Add Stored ..

@ 2D0H
Fault
Fault, New

Add Color Blended *

»

Workflow cont’d:

4. Push the line through the
seismic volume: left-click +
drag.

5. Rotate thé line: Ctrl left-click +
drag.

6. Push the line through the
volume in the new direction:
left-click + drag.
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Workflow cont’d:

7. Insert a node: right-click on
the element in the scene, or the
entry in the tree and

8. Use the green anchors to
position the node: left-click +
drag

9. As before, now push and rotate
the crooked line through the
volume using left-click + drag
and Ctrl left-click + drag,
respectively.

Add
———— oy g
= /&v: Duplcate ¥ Properties
=i Reset Manipulation Resolution  »
—— —  Create 2D Gid 2 Posiion X

& seess
Save as 2D = S
Correlate with Wells >

N

Lock Treeitem
Hide
3 Export to Google KML

Remove from Tree
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1.3.3b Random Line Through Wells

Required licenses: OpendTect.

1.

Exercise objective:
Create a random line through existing wells.

Workflow:

Right-click on Random line >
New > From Wells.

Select all four available wells and
change the well's order
accordingly: F03-4, F03-2, F02-1,
F06-1, using Change order
arrows.

Press the Preview button to see
the updated geometry in the
scene.

Give a hame to the newly created
Random line and click OK.

& Z-slice
‘ Volume
~ [Rapdom T'ina
v op| Add Default Data
@ 3p Add Stored.
4 2D/ Add Color Blended *

Fay Interactive ...
[N FaultStickSet From Existing
@ Body From Polygon
Well From Table .
¥ PickSet From Wells ..
D Polygon
/) Create Random line =B @
Select wells to set up the random line path
I:l Well Name
[ Fo2-1 |1. Change
I Fo32 Selact 2' order
| Fo34
Fo6-1 [E] 3 @
[ |, )
5
Use only wells' top position @) Yes No
| Extend outward (m) | 2500
e ]
Output Random Line E” € Select ]
v | Display Random Line on creation
I Q ok © Cancel @ Help
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1.3.4 Save & Restore Session

Use Survey > Session > Save.../Restore.../Auto load... to restart your inter-
pretation at a later moment. The graphic scene(s), elements in the tree(s), current
attribute set and neural network are all saved and restored.

When clicking Auto load, choose Enable and then Use one for this survey. Select
one session amongst the available ones. The session will restore itself auto-
matically the next time you start OpendTect.

Elements that contain attributes that were calculated on the fly can only be
restored if the attribute definition is still valid at the time of saving the session. If
not, you will get a warning message stating that the attribute cannot be restored.

Attribute calculations take time. A Session restore will go much faster if you
retrieve the data from disk instead of recalculating it on the fly. So, before you
save a session think whether you can retrieve the data from disk (e.g. a horizon
attribute can be saved as Horizon data with the parent horizon. The same display
can thus be restored much faster if you save the attribute first and then select it
from Horizon data before saving the session).
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1.4 Seismic Interpretation

In this Chapter you will learn basic interpretation tasks such as tying wells, track-
ing horizons and interpreting faults.
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1.4.1 Well-to-Seismic Tie

Tying a seismic volume to well data is a major task in interpretation projects. It is
typically done at the start of a project to determine which seismic events cor-
respond to which geologic markers.

We will assume that all data (inputs for the tie) have been prepared already. The
inputs are:

e 3D seismic Volume

» Aninitial wavelet (if there is none, you can create either synthetic or
stochastic wavelets, in OpendTect)

» Well data (either sonic and density logs, or an impedance log, and geologic
markers)

» (Seismic horizons are optional)
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1.4.1a Well Tie

Required licenses: OpendTect.

Exercise objective:
Tie a well to the seismic and extract a deterministic wavelet.

Workflow: - Well
# Pick  Add ..
. . . ) I D Poly 45 Tie Wellto Seismic
- > d
1. Right-click on Well in the tree > Tie Well to Seismic... B PreS | Now WellTrack .
Annotatrorrs———
Tip:

Well to seismic tie module can be also launched via:
- Analysis > Wells > Tie Well to Seismic...
- Right-click on a well name in the tree > Tie Well To Seismic...

7 Survey | Analysis | Processing Scene View Utilities CLAS Help 4 A We||'
Ly il {4 Attibutes , ~Eg @ > B Lk [v] F06-1 i
[vI|F03-4
Tree ‘% Volume Builder ..
% Elef B Cross-plot Data , i F03-2 Dz ry) ’
- "¢ ¥ F02-1 CLAS LogPlot
gIAEes il A | Edit Logs i PickSet iy Tie Wellto Seismic
& N & Layer Modeling » | A Tie Wellto Seismic ... 0 Pol il -
- { olygon Create Attribute Log ...
xx S i N
| e T S Prestack Create Log Cube ..
- | q: nnotations ¢ it welltrack
@-| 77 sss 8 c
~ 4 Z, Thalweg Tracker ... SENE )
Velocity Model Building ~ * o Lock Treeitem
A Well Correlation Panel . == Remove from Tree

Workflow cont’d:

2. In the Tie Well to Seismic window: choose F03-4 well, check the options to be as
shown below and click Run.

- Tie Well To Seismics - oIEN
Select Data to tie Well to Seismic
Well (& [Fo3-4 v] © Select ...
Seismic | 3D Volume >
[+ Input Cube Aé ‘e | 4 Dip steered median filter v | © Select ...
Density Density ~| kg/m3 (Kg/m3) ~ 2| B
PWave | Sonic > us/m (Microsecon ~ | ¥ Sonic 3 B

Use existing depth/time model

Reference wavelet | stat 120 ~| | A, Manage Wavelets ... |\ Extract ...

[] Save as Default ) Close| @ Help
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Workflow cont’d:

" Tie F03-4 to 4 Dip steered median filter

- O
Sonic Al Synthetic: Seismics
59 4500000 027256 08 2,5 75 10 125 14
A S| e e84 | v624]
oo ||| 1109 31100 1100
1Ro0 1200 12007 ii%i
100 1300 1300 E I } I ‘E
£~ F ;
- i 368 T ismic—
11?[’7 52 2100 2200 2300 FeP | | 9%570s6 025 0 0.0250 os 1657 Syn{rFIS)etiC seismic Extracted sefeimss
4 Zintime Wavelet | stat 120 - 7 Track | Peak ortrough ¥ | Apply Changes Undo Clear picks = Clear last pick
Ozinmeter  Extracted |Og$ Computed |ogs NrTraces Quality Control .. |Match markers and horizons
OK/Save info ... Help Cancel

Al:3872880.25m/s x kg/m3 Reflectivity:0.00442575 MD:1414.09m TVD:1414.00m TVDSS:1379.90m TWT:1399.83ms

Markers are loaded by default.

28000 BLG X

Workflow cont’d:

3. Click on q icon to load already mapped horizons to be displayed on the extracted
seismic traces: Check horizons from Demo 1 to Demo 7 and click OK.

= L) Load 3D Horizon(s) - B [ x|

Synthetic: i

| rl?a‘g% Select input 3D Horizon (s)

s
99 —d 8 9 12 L
| : o =2
| [
i (m] « Filter * R
i %’
[l Demo 1> MFS4 NI= D\
Demo 2 -> FS6 4
' Demo 3 —> Top Foresets G
k‘é Demo 4 —> Truncation 2
Demo 4 —> Truncation trim & fill g
o .
T EERE

©
3
S

X @

.
| 40
1400 Demo 5 —> FS7 R R R | 2
| [v] Demo 6 —> FS8 5 5 ]
[~] Demo 7 — shallow v =
< >
1500 500 !
ry et
8/51 chosen
1570
S v
| |"Wfrse2 2100 2200 2300917 || 067056 0025 0 0.025 0051557 ‘ (ms) nline
Density Reflectivity
Zintime Wavelet | stat 120 = Track [Peak ortrough ~ | |AppijChanges| | Undo Clear picks | |Clear last pick
[ Zin meter NrTraces[s | Quality Control ...| |Match markers and horizons
OK/Save info ... Help Cancel
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Workflow cont’d:

4. Zoom in using middle-mouse scroll button and pan by pressing middle-mouse button:
hold and drag up/down until you have a display to pick matching events.

" Tie F03-4 to 4 Dip steered median filter - a x
“3312[(5’2) agusmscgo 5824569 || 334 (7;5;) Asugu;‘u 6027286 3 12 Ti-j
=T )
F3S1) ‘. ;r> ----- = J
o e T oo Tk
3 - 500 00 =F ? % ? ? ? =
1 +
Tr Trr===== === ---- =5 Tuncatio] e e dondonn] =t
o T ><Top Fores: %
C ..
00 00 || s00 20 S 5 5 > > |9
- N
FS FSOr e sme S e e S =g =S e
MF MFS|
FS4 FS4
FS3r=-=2 P FSg====zp=3 'JE § % \i 1 \%
We 200 2200 290098 || $80s6 0028 o 00260 ool fnline=>
Density | Reflectivity |
M Zintime ‘Wavelet stat 120 v Track Peakortrough ¥ Apply Changes Undo Clear pigks  Clear last pick
[ Zin meter NrTraces Quality Control .| |Match markers and horizons
OK/Save info ... Help Cancel
Sonic:1e30us/m Density:1e30kg/m3 MD:421.19m TVD:421.15m TVDSS:387.05m TWT:411.91ms
Workflow cont’d:
. . ) . ™Y
5. Activate pick mode with the icon ©g
Synthetics Seismics z B
= . 0 125 G
6. Pick matching events on the 4958 =
extracted seismic then synthetic -
traces (or synthetic then extracted 6001 e
seismic). 2
unca -t
7. Optionally, to change your picks: 7007 |i|
click Clear picks or Clear last pick if —
needed.
=

800

975

TWT (ms)

Track Peakortrough - Apply Changes

info Help

Seismic™

Undo [ Clear picks [[Clear last pick|

Display additional information ... Match markers and horizons

Cancel

VD:554.18m TVDSS:520.08m TWT:545.42ms
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Workflow cont’d:

8. After picking the events, click Apply
Changes to reflect the changes.
9. If not satisfied with the result, click

Undo to revert the most recent step.

Synthetics

Seismics

4956

As only the previous step can be reverted
using Undo button, it is recommended to
save intermediate T/D (Time/Depth) curves
by clicking on the iﬁf icon and exporting to
a text file.

Saved T/D curves can be (re-)imported at
any time via the same window or via Well

800

VWY
vt

900

F

Defio2-->FS6

975,

M an ager. TWT (ms) Seismic~
Track Peak ortrough  ~ | Apply Changes Clear picks| Clear last pick
Display additional information ... Match markers and horizons
N
info ... Help Cancel
VD:554.18m TVDSS:520.08m TWT:545.42ms
t) -
Workflow cont’d:
10. Click on Quality Control to check the Cross-Correlation Coefficient.
 Tie F03-4to 4 Dip steered median fifter - o x
Sonic Al Y 2 B
3917521 450 500 5824559 || 3343759 4500000 6027256 fNT
416 2#5—J——4152 46 23WJ——4162 =
MESk=== . @
Fstr=== --1 g
O I - a*
Fogrm== -
- -] (=)
& =T soo
o - — = a4
Tr=== =] - Tf== v e 1+
Togt==- e Togt=+ S %
1% > xe
= s =3
= 1
800] = 800 800] T 800 800 ‘
el = [ ~
Fsgr=---=zf g Fsg
MFS] MFS
Fsd Fs4
1000
10001 1000 10001 1000
Fs3 O = -
ESoR== LLL » LLLLLI LL LLLLLLL 1081
W In-line—
Won om0 2000 2009 | Do o0 o ooae0 ot ms) ine
Density Refiecthity
K zin time Wavelet | stat 120 = Track |Peak ortrough v | [Apply Changes' | Undo Clear picks | Clear last pick
[ Zin meter NrTraces[s 2] Match markers and horizons
OK/Save info Help Cancel

Sonic:1e30us/m Density:1e30kg/m3 MD:421.19m TVD:421.15m TVDSS:387.05m TWT.411.91ms
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Workflow cont’d:

11. Choose Compute Data between
Markers and select top and bottom
markers, for example FS11 and FS3,

Cross-checking parameters

_— |

Compute Data between Markers

| [FS11 ~||FS3

Set active Wavelet

® Initial - stat 120 O Estimated

Cross-Correlation Coefficient: 0.5960489 |

0
to define a window of interest. ’ e
. = 025
Note that Cross-Correlation 3 U%%WXJW\ L A
Coefficient, the graph and the ora onm S, I.’ l'H.HlU
Estimated wavelet are immediately  syeiciossmesae assseasisn |l 1!.0 L
updated. Estimated wavelet length (ms) 120 Lags (ms)
@ Close| | @ Help
= Cross-checking parameters - olEd
Compute Data between Markers ~||FS11 ~||FS3 -
12. Optionally, switch to Estimated
e g . . Set active Wavelet Cross-Correlation Coefficient: 0.6532883
(deterministic) wavelet option: see ittt 120 @ Ei]
that the synthetic traces change in "o
the main Tie Well to Seismic window. _— s
The scaler applied to the seismic has I
also changed and should be close to @4 & O L & 229 L
1 Synthetic to seismic scaler: 0.98019022 0 5,3
. 200 -100 0 100 200
Estimated wavelet length (ms) | 120 Lags (ms)
@ver
Workflow cont’d:

Click on icon to save:

* Acoustic Impedance, Reflectivity and Synthetic as well logs or as seismic cubes.
+ The initial (loaded) and/or estimated wavelet.

L Tie F03-4 to 4 Dip steered median filter - 0 “
Sonic Al Synthetics Seismics 2
(B 60 S0 et oo 05 25 5 75 10 125 1:.@
e "~ Save current data - ] X
MFS| L]
e ! Check the items to be saved ; ; Ee ]
600
=
Log(s) M Al Reflectivity (/] Synthetic r % é' Q
. Saveas @ Log O Seismic cube ) b ~
L X
.
| L B
A , % [ % 5
200 Output Name [v] with suffix |from well tie > S N
1 Wavelet
ME
'S4 i Sample interval (ms) [1
=
< = Initial wavelet | stat 120 v|| € Select...
ko 210 ) Seismic
Density Deterministic wavelet [lerministic wavelet from well F03-4 v |[ &) Select...
M Zintime picks Clear last pick
O Close 0 HEIP nmarkers and horizons
OK/Save info ... Help Cancel
Sonic:458.79837036us/m Density:2165.28588867kg/m3 MD:684.35m TVD:684.31m TVDSS:650.21m TWT:682.92ms
I
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Workflow cont’d:

13. Click on OK/Save button to save the T/D curve as an active T/D model of the tied well.

= Tie F03-4 to 4 Dip steered median filter

- o x
Sonic Synthetic i
309676 450 500 5842978 || 332 301 . Tt
sor L0 £ s 07| sor7
Fs1 - Fs1 o
MFS] |®
Fs 2
3 &
o0l oLV o0
(=%
- ™ 3 LR
- - 4 o
700 7855 - 700 7007 Top Forgeets \
800 800 00 = s é. é. } } é
Fsgr=s= -- Fegr===
166 900 || M6 9007
1948358 21002200 2302902° %’tfémao 00250 0.0250.051753° (ms) ine
Density Reflectivity
Zintime Wavelet  stat 120 - Track Peakortrough v Apply Changes Undo Clearpicks  Clear last pick
[ zin meter NrTraces Quality Control .. |Match markers and horizons:
OK/Save info .. Help % Cancel
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1.4.2 Horizon Tracking

What you should know about horizon tracking in OpendTect

There are several horizon trackers in OpendTect to support a variety of work
flows using 2D and 3D viewers. The following trackers exist:

» 3D auto-tracker. This interactive tracker is the primary tool for tracking hori-
zons in OpendTect. It operates in the 3D scene and tracks amplitude dif-
ferences along maxima, minima or zero-crossings. Optionally, the tracker
also tracks using similarity or correlations and using seismic dip (only if you
have a Dip-Steering license). The tracker supports two methods: comparing
with (picked) seed traces and comparing with parents (neighbors). The
seed trace option is used in a work flow in which the user continuously
points additional seeds and QC's the tracked results. First areas with the
largest confidence are tracked before the constraints are relaxed and the
exercise is repeated. Typically multiple passes are made through the entire
data set. Any remaining holes are filled in later stage using a gridding
algorithm (e.g. OpendTect dip-steered gridder, see below). The advantage
of this work flow is that the horizon is QC-ed while you are interpreting and
that you save time on editing. In cases where the event is easy to track the
parent method in which positions are compared against neighbors is pre-
ferred. The tracker extends the horizon further out from the starting pos-
itions but the risk of loop-skipping increases.

e 2D auto-tracker. This interactive tracker is similar to the 3D tracker. The
main difference is that it operates only along seismic sections. The lines are
either displayed in the 3D scene, or in a flat (2D) viewer. Use this tracker to
interpret 2D seismic data and/or to interpret 3D seismic lines in a grid, e.g.
to interpret every 10th inline and crossline.

» 2D line drawing. This option is used to manually pick horizons in areas
where auto-tracking is not feasible.
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» 3D dip-steered tracker. This tracker requires a dip-steering license. It cre-
ates a single horizon from multiple picked seed positions by inverting the
dip field (given in the form of a Steering Cube). This tracker can be used
e.g. to create a quick geologic model with minimal input from the interpreter.

» 3D dip-steered gridding. This tool requires a dip-steering license. This
gridder interpolates holes in a horizon using a inverse-distance solution that
honors the dip field (given in the form of a Steering Cube). The gridder is typ-
ically used to fill in holes left by the 3D auto-tracker and to fill in areas that
were not interpreted (2D auto-tracker).

» Thalweg Tracker. This tracker requires an OpendTect Pro license. It tracks
bodies and horizons either by adding one single position at the time (fol-
lowing the Thalweg: the path of least resistance) or by adding positions to
the edges (margin tracking). It is used for seismic facies tracking, e.g. for
mapping channels, see exercise 2.1.4 in Part 2.
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1.4.2a 3D Auto-track

Required licenses: OpendTect.

Exercise objective:

Interpret a horizon using 3D auto tracking

Workflow: .
Survey > Pre-Load > Seismic...

For details on pre-loading see Exercise 1.3.1b.

1. Pre-load 4 Dip steered median filter.

2. Right-click on Random Line > Add Default - Random Line

. . i 2D Line Add Default Data
Data'. The d_ata dlsplayed is 4 Dip steered @ 3D Horizon Add Stored _
median filter in the middle of the survey. igu:"”m" e
A A ) ) FaultStickSet New b
3. Right-click on 3D Horizon in the tree > New > _
Auto and Manual Tracking. oHor
Fault Add at Sections Only
FaultSti Add Color Blended ...
4. The Horizon Tracking Setup control center © 5 New : > | AutoandManual Tracking .
H . ) Track Unconformity
pops up (nEXt Sllde)' D z::?;so? Thalweg Tracker ...
¥ Shapefile From Well Markers ..
&\ Prestack Events With Constant Z

Annotations

You can interpret on inlines, crosslines and random lines, in the 3D scene and 2D viewer.

Workflow cont’d:

5. Choose the tracking mode: Section Auto-track (from seeds) and Select Seed Trace as

traCkIng method. “ Horizon Tracking Settings - <New Horizon 1> - O X

Mode  Event Correlation  Properties  DipSteer

sl @® Section Auto-trac

(O Manual Draw

@ | enoa

»
@re
Method:
+ Seed trace: compares amplitudes against the seed reference (recommended for most
horizons)

« Adjacent parent: compares amplitudes against the last tracked position (increased risk of
loop-skips; recommended for easy horizons).
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Workflow cont’d:

6. Click on the Event tab.

7. Select event type Peak and leave the search window as default for now.

' Horizon Tracking Settings - <New Horizon 1> = m} X

Mode Event Correlation Properties DipSteer

s Event type wvA [JvD Display after picking a seed
Threshold type | Relative difference v
o Allowed difference (%) t25 |
(44 [ =i/ =7 '
Search window (ms) »-3 < »8 s ‘\:| Symmetric
-
Data Display window (ms) |-16  |5/(16 5| [] Symmetric

Nr Traces t5

Picked on: 4 Dip steered median filter

ANNNAN
@

Use the green lines in the waveform display to change the search window

It is possible to change the event type during the interpretation

Workflow cont’d:

8. Click on the Correlation tab.
9. Setthe use Correlation toggle to Yes.

10. Set the Correlation threshold to 60%.

" Horizon Tracking Settings - <New Horizon 1>

Mode Event Properties  DipSteer

Use Correlation @ Yes (O No WVA [JVD

compare window (ms)[-40_=][40 [z]Osymmeric [k B B B P

Correlation threshold (%) :SDO 5 Snap to Event
(>4 - — -
Data Display window (ms) .-48 5 ‘_48 £ ‘[] Symmetric

NrTraces :5 >

[Ooee] | @wer

Tracking with correlation is more accurate, but it takes more time to compute.
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Workflow cont’d:

11. Set the selection of Steering to No.

' Horizon Tracking Settings - <New Horizon 1>

Mode Event  Correlation Properties DipSteer

Use Steering O Yes @ No

3 P&y | PCA 1M Select Pre-load

y @ @

@ e

This option is only available if you have a dip-steering license.

It ensures that the correlation window follows the seismic reflectors by steering the window
along the pre-calculated dip. This option lowers the risk of loop-skips, especially in areas with
steep dips.

Workflow cont’d:

12. Optionally edit the display properties.

=+ Horizon Tracking Settings - <New Horizon 1> = m] X

Mode Event  Correlation DipSteer

Horizon Color

Linewiatn [ 3
= Seed Shape/Color | Cube v
P> -
g Seed Size I 2
~
Parents Selections
Locked | [

@

We recommend the Horizon Tracking setup window to stay open during the entire
interpretation session. Parameters can thus be adjust at all times. To re-open the window,
use the % icon in the toolbar in the lower section of OpendTect main window.
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Workflow cont’d:

13. Pick a seed on a Max event (as selected earlier) on the displayed random line.

14. Click on the €& Auto-Track icon in the Horizon Tracking Setup window.

In horizon picking mode, the cursor is a cross. You need to have the horizon active in order to
interpret. You can make it active by clicking on it in the 3D scene or on its name in the tree.

Workflow cont’d:

15. QC the auto-tracked horizon patch:
a. Select the new horizon in the tree.
b. Setthe display of the horizon to “sections only”. press the shortcut v/V key.
c. Move the random line through the patch: click and drag the line.

16. If the horizon patch looks OK but is rather small: change the amplitude correlation
parameters and redo.
In this case, change the correlate window to [-20, 20] ms.

17. Click on the Retrack-All icon €2 in the Horizon Tracking Setup window.

Correlation window [-40;40]ms Correlation window [-20;20]ms
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Workflow cont’d:

18. When satisfied with a patch, right-click on it > Tracking > Lock, so that it can no longer
be changed. Alternatively, Ctrl + right-click on it > Lock.

19. To continue, pick another seed in an empty area and repeat the exercise.

Add »
Tracking 4 Start Tracking -
Tools * | % Change Settings ..
Workflows * | v Enable Tracking
Save Lock
Save as Unlock
o Lock Treeitem Seeds [
Hide Select Parents

Show Parents Path
Select Children
Delete Selected Children —

Remove from Tree

Workflow cont’d:

20. Click on the auto-track icon €% to track more from the new seed (previously auto-
tracked horizon patch remains untouched).

One seed

Two seeds

100
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Workflow cont’d:

21. Repeat this workflow (add seeds, auto-track, QC, lock) until you have filled the entire
area with horizon patches of good confidence.

22. Now lower the constraints in the amplitude and correlation tabs.

23. Repeat steps 21 and 22 until the tracker cannot fill in holes any further without
making mistakes.

What to do when something went wrong?
There are three ways to change the results:
+ UseUndo ™ and Redo ™ cons, or CTRL-Z/ CRTL-Y shortcuts.

+ Select the area to remove with the selection & icon and press the % delete icon.

+ Use the tracking history to remove all positions (children) following the last good position
(parent). How to do this is explained next.

Workflow cont’d:

How to see the tracking history

24. Right-click in the 3D scene on a bad position on the auto-tracked horizon and Go to
Tracking > Show Parents Path.

25. Alternatively, ctrl + right-click on the bad position on the auto-tracked horizon and
select Show Parents Path.

=% Start Auto Tracking
<> Retrack From Seeds
@ Select With Polygon

Add -",‘ Select Parents
Display » Show Parents Path
Tracking @l  Start Tracking . gr'e‘:‘sc:"‘ldt@"
- b iear selection
Tools * % Change Settings ... O B St
Workflows » R elete Selecte
Enable Tracking ~ Ulds
& Save Lock Redo
# Save as Unlock @ Lock
o Lock Treeitem Seeds » & Unlock
Hide Select Parents Show Locked
N LR LRI Show Parents Path & Save
4 Select Children &l SaveAs ...

Delete Selected Children

Display Only at Sections
% Show Settings ...
4 %

Ctrl + rightclick pops up the dedicated menu containing all the tools required for 3D
horizon tracking. This menu minimizes the need to use the horizon tracking set-up window,
e.g. for auto-tracking or re-tracking from seeds.
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Workflow cont’d:

26. The nodes of the random line that appears in the 3D scene shows the tracking path
to the selected position (Parents Path).

Y

Add >

| Display 4
Tracking 4 Start Tracking
Tools ' |3 Change Settings ...
Workflows * | v Enable Tracking
Save Lock

@ Saveas Unlock

g Lock Treeitem Seeds

Hide

AT

Remove from Tree

Select Parents

Show Parents Path

Select Children

Delete Selected Children

Each node (in Green) of the random line, corresponds to a parent seed.

Each parent path is added in the tree under the Random line item and can be saved.

Workflow cont’d:

27. Additionally, the Parents Path random line is automatically displayed in a 2D viewer.
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Workflow cont’d:

28. Locate the parent position where the interpretation went off-track: Ctrl + right-click on
this position on the horizon patch (or in the 2D viewer) and select Select Children.

29. The samples tracked from this bad parent position are highlighted in the scene.
Either, right-click on them > Tracking > Delete Selected Children
or Ctrl + right-click on them > Delete Selected.

it 4
‘f Adcr

25 Display £ S
Start Tracking ...
Tools * |% Change Settings ...
Workflows * | v Enable Tracking
= Save Lock
& Save as Unlock
o Lock Treeitem Seeds
Hide Select Parents
== Remove from Tree Show Parents Path
Select Children

Delete Selected Children

Workflow for “fast” auto-tracking using “Adjacent Parent” tracking method

1. Select Adjacent Parent method in the Mode tab. Mode | Event | Correlation

@ Section Auto-track

2. Go to the Event tab and Select Relative difference as
Threshold type.

Manual Draw

Method |Adjacent Parent  ~

3. Define the allowed differences by clicking on Steps ...
(5] Horizon Tracking Settings SEEN
- Mode Event Correlation | Properties | DipSteer
— Event type Max v vJWVA  [IVD
u [Frestesme bommaranete | Patches tracked with the Adjacent
o REERheEE e d Parent method tend to be much
~ Searchwindow ()8 BJ|8 )0 Symmetri larger than with the Seed Trace
Data Display Window (ms) -16 = 16 |+ [] Symmetric method, especially if you use
Nriracesls multiple steps (next slide)
| @ Close| | @Help
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Workflow cont’d:

4. Specify the allowed differences (in %) as shown on the picture. In this example any
sample of the horizon is tracked in at-most 5 steps.

In the first step only 1% difference between neighbors is allowed. If the program is able to
find a new sample in the neighborhood with less than 1% amplitude difference, that sample
is included in the horizon and tracking moves on. Otherwise, the amplitude difference
criteria of next steps are utilized.

Be aware that loosening the constraints too much may result in loop-skips.

Event type [Peak )
Threshold fype (Relafive difference ~| Adjust the amplitude and correlation

Allowed difference (% parameters in case the tracker stops tracking

too soon.
Search window (ms) -20 [ 20 - Symmetric

5. Follow steps 8-29 of the previous workflow based on the Seed Trace method.
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1.4.2b Tracking In 2D Viewer

Exercise objective:

Interpret a 2D horizon using a 2D viewer

Workflow:

1. Add a 2D line to the 3D scene: right-click on
2D line and go Add.

2. Select the Well correlation - Line and change
the action to Load default data.

3. Once the 2D line is loaded, right-click on the
attribute name (i.e. Seis) in the tree and go
Display > 2D viewer.

~ Random Line
2D Line

@ 3D Horif  Add...
2D Hori! Create 2D Grid from 3D ...
Fault Extract from 3D ...
FanltStickSef

-~ Select 2D Lines - olEd

[u] » Filter | *

[¥] well correlation-Line ]~

&)

2D Line v
4 [v] Well corr... =
Vi[Seis ta
@ 3D Horizi  Select Attribute >
2D Horiz( Save Color Settings
Fault Display * ks Histogram
FaultSticl Remove &  Amplitude Spectrum ...
® 5\;’"‘?’ F-K Spectrum .
el
3 Change Transparency ... o o
i PickSet e In a 2D viewer, you can interpret
[ Polygon — . M
S PrestackE . T 2D Viewer - Wiggle 2D and 3D seismic.
L] -
Workflow cont’d:

2D viewer

20 Viewer - Line: Well correlation-Line - olEN

MR NOAT

3D scene

»

20000 36041
T

B8 %

]

174855

TrcNe=1004 (621012, 6083318, 208)  Vai=-398 (Sers)

it
Distance™

ReliSP=130
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Workflow cont’d:

<1 2D Horizon
4. In the 2D viewer, right-click on 2D horizon and select Fault Add ...
W FaultSet Track New ...

Track new.
FaultStickSe Create from 3D ...

5. In the Horizon tracking settings, leave the parameters as
default.

6. Optionally, close the Horizon tracking setting window

' Horizon Tracking Settings - <New 20 Horizon 1> = o x
Moge  Event  Comelation  Properies  DipSteer
- ® Section Auto-rack
™ =
. ) O Manual Draw - ™ Horizon Tracking Settings - <New 20 Herizon 1> - o X
Mod Event [+ Hati P i DipSte:
H Method | AgjacentParent + o lode orrelation Toperties ipSteer
e - Eventtype Peak = B wva CvD
®7 Irwacking fails O Exrapolate @ Stop O o~ Hori i i =
. L Thresholdtyge Relative imer " Horizon Tracking Settings - <New 20 Horizon 1> o x
—~ Alowed difference [Im[zq Mode  Event  Corelation  Properies  DipSteer
c - = - P
oo Searchwingow(ms)[&_ %] [ Sy Use Comelation @ Yes () Mo HMwwa Ovo

( - - - r
- . = =
I = Compare window (ms) 40 5|40 - Symmetric
Diata Display window (ms) |-16 |3 |16 pan (ms)| L | ] sym
wrraorss T Comelation threshold (%) [60.0 12 1 Snap to Event

4 - y
Data Display window (ms) 48 (3[48 % |[] Symmetic

Mr Traces (5

o=

Workflow cont’d:

6. Pick a seed on a Max event (as selected earlier) on the line.

7. Interpret the full line.
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Workflow cont’d:

8. In some areas the horizon does not propagate well and you may want to switch to the
manual drawing mode.

Workflow cont’d:

9. Re-open the horizon tracking settings: right-click on the <New 2D Horizon> and
Tracking = Change Settings.

10. Change the tracking mode to Manual Draw and select the Snap to event option. The
event type is defined as previously.

4 2D Horizon
7| <New 2D Horiz... =
Fault Display v

W FaunSet Tracking C Start Tracking ™ Hori . ings - <N . _
FaulStickSat Tools * | v Enable Tracking o JizchngSeting=ce 20 L o X

® Body LT D " /@ Change Seftings .. Mode  Ewvent Comelaion  Properies  DipSteer

L wel Reload Seads R = _

= PoiniSet W Seve — O Section Auto-track
Polygor Seve

o " a o Cj | ® Manual Draw [ Snap to Event

¥ Shapefile o Lock Treeitem

By Prostack Bvants | Romova from Tree ) lethod | AdjacentParent -

44
== |iftracking fails () Extrapolate Stop
.

@rer
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Workflow cont’d:

11. Draw the line where you want to interpret.

Workflow cont’d:

12. Once you are done, release the left-click button from your mouse: the line will be
automatically converted into the horizon and snapped to the Max event.
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Workflow cont’d:

13.

14.

When satisfied of the interpretation,
save the 2D horizon: right-click on
the <New 2D Horizon> in the 2D
viewer tree and select Save as (at
this point Save and Save as are
equivalent) and specify an output
name.

Close the 2D viewer.

The 2D line and the newly
interpreted 2D horizon are
displayed in the 3D scene.

2D Horizon

¥ <New 2D Horiz.. ==

Fault
FaultSet
FaultStickSet

® Body

L Well

25 PointSet

[ Polygon

@ Shapefile

=y Prestack Events

laza

Display
Tracking
Tools
‘Workflows

Reload

Save

Save as ...

Lock Treeitem
Remove from Tree

= Qutput selection
Output 20 Horizon 20_Horizor|

¥ Replace intree

o |
~ | © Select

| @ oK | |@ Cancel| | @@ Help

Note: A 3D horizon as well as Fault stick sets can also be interpreted in the 2D viewer.

Workflow cont’d:

1.

2.

3D horizon interpretation using a 2D viewer

The horizon type you are interpreting is 3D horizon.

The tracking modes are similar but on the contrary to the 2D tracking, the auto-tracking

option is ON while tracking a 3D horizon in a 2D viewer.

For auto-tracking the horizon, recommendation is to use the Seed trace method in
combination with the section auto-track option (see previous exercise 1.4.2a for more

details).

In the 2D viewer, while tracking a 3D horizon, you can switch inline/crossline by either
typing the line number or using the arrows and the step to interpret a grid like you would

do in the 3D scene.
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1.4.3 Fault Interpretation

What you should know about faults in OpendTect

We distinguish between fault sticks and fault planes.

Fault planes can be mapped directly from line to line (only advisable for
large faults that can be recognized easily).

Alternatively, faults sticks are picked and stored in a fault stick set from
which fault planes are created by manually grouping the sticks.

In the current version (5.0) you can pick horizontal and vertical fault sticks
but you cannot combine sticks from different orientations.
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1.4.3a Fault Planes

Required licenses: OpendTect.

Exercise objective:
Pick a major fault plane.

Workflow:

1. Right-click on In-line in the tree > Add Default Data; 4 Dip
steered median filter.

2. Change In-line position and step: enter manually 250 and 10
in the Inline and Step fields, respectively, of the navigation
toolbar.

3. Click on . to have

Add Default Data

v
& Z-slice Add and Select Data
® Volum  Add at Well Location ..

~ Rand¢
< 2D Lit AddCoIorBIendfed

in-line 250 +Step 10 C|« )

an In-line view.

[\ 9 Viewinine |
% @ View Cross-line

’ ;| ® ViewZ

<=l gy View North

Q- @ View North Z

| A major fault (highlighted
with black arrows) is present | -

| throughout almost the entire

| geologic section.

S —

Workflow cont’d:

[Fautt
Faulty Add..
© Body IIETIN

4. Right-click on Fault in the tree > New. N

= Annotations

6. Enter an Output Fault name and click OK.

e Fault
287 143a_Fault - ‘
<right-clic__Add >

FaultStickSet Display e

M Histogram ...
b \?V%(Ijly @ Save ¥ Properties ...
i Pickset | Saveas..
> Polygon o Lock Treeitem Only at Horizons

S Prestack Even . Remove from Tree

= Fauilt
A <New Fault 1> B8] ‘
<right-click:  Add »
; ; FaultStickSet Display »
5. Right-click on the newly added Fault > Save e W Save
as.. # Pickset
> Polygon o Lock Treeitem

S Prestack Events!

& Annotations

L)

Output Fault| 143a_Fault

7. Right-click on the saved Fault name >
Display > toggle on Only at Sections.

v Fault Planes
v Fault Sticks
v Use Single Color

== Remove from Tree

- oW

Output selection

v| © Select ...

Replace intree

@ Cancel @ Help
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Workflow cont’d:

8. Pick the fault on the first In-line: either Left-click + drag or Left-click to pick and double-
click to end a stick.

9. Edit as needed: Leftclick + drag seeds, Ctrl + Left-click to remove seeds, \ or Ctrl +Z
to undo the last action, 7N or Ctrl + Y to redo.

7 Suvey Analysis Processing Scene View Utilies Help Estimages

G ileN ALaSEXT-BAR
3 Mo g == ivind2e0 [Tlotegt 2] fm ) ra N Ko ming
Tree scene 1 ey
e To be able to pick faults make sure that: e
8 |" L 1) Position modeh is selected. X
¢ B2 4 Dip st . . #
5 s | 2) The fault is selected in the tree.
- Zeme| 3) Edit Sticks icon |-« is toggled on. e
1 oron , A
<

H | @ snapotic
E‘ & Prestack Events
Annotations

In-line 250: 4 Dip

EHe
Steered median filter.

24011120 (626231, 6077628, 678) Value =132 In-line: 240 Picking

Workflow cont’d:

10. Move the In-line to a new location (for example 240): Click on «» in the navigation
toolbar or use short keys (Z and X by default) to move the In-line backward and forward.

11. Repeat steps 8, 9 and 10 for every 10t inline in the range 100-250.

7 Suvey Analysis Processing Scene View Utiities Help Estimages

e Y AAASEXT-eAD

A M g == indine2¢0 [2fsten)
Tree scene 1 & =
N e Color i
® | scenet -
v ¥ Indine
é v E240 .
= sDipstes . 11 .
¥ Cross-line i
&| ©zeice =
@ Volume !
W 7 racomune )
9 2D Line A
“ 3D Horizon -
A 20 Horizon E,
=1L 8 roun
- voumrar m €
<right-click> §1
L] Faurstciset
@ | ® Bogy
* PointSet
H [ Polygon
@ Shapefile
E‘ & PrestackEvents.
Annotatons
JE 5 T — In-line 240: 4 Diph
o © a | B & . )
240120 (826231, 8077628, 679) Vaue =132 nine: 240 Picing steered median filter.
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Workflow cont’d:

12. Right-click on the fault name in the tree > Display > toggle off Only at Sections, to see the
fault plane in 3D. (Shortcut key: v)

= Fault
cHri| 143a Fault —
¥ <right-clic__ Add
FaultStickSet Display &) & Histogram ..
S \?Vﬁy @ Save > Properties ...
* PickSet # Saveas v Only at Sections
[ Polygon o Lock Treeitem Only at Horizons

v Fault Planes
v Fault Sticks

v Use Single C

N Prestack Even . Remove from Tree
@ Annotations "

13. Optionally display the seismic data along the fault. Right-click > Select Attribute > Stored
Cubes > 4 Dip steered median filter.

Fault
= [¥] 143a_Fault -

o] <rioht-click>ME T}
° Eiﬂhsm SelectAttribute * | Stored Cube » [IERSTT ETE ro)
We“y Display " | Attibutes 3D UVQ 6 biased Texture+Energy+SystemsTracts
“ PickSet MEMLLS Steering Cube * | 3D UVQ Texture+HC attribs+ Energy disk
Q Polygon _ 4 Dip steered median fitter
t) -
Workflow cont’d:

= Fault
il 143a Fault] -
v <right-clic ~ Add

FaultStickSet Display

® Body

14. Don’t forget to Save your work regularly.

Well
. * PickSet & Saveas .
15. To delete sticks from a fault plane, use Select and Remove O Polygon 8 Lock Treeitem

& Prestack Even

: == Remove from Tree
Annotations .

icons as shown below.

Surve)

LA
3 by g = nind2e0 Fhtedt
N Tree scene 1 ]
Elements Golor it
& | scenen -,
~ @ Inine
| vom L
= 4Dipstee. 11 .
: # Cross-ine g
@ | ®oin
® Volume
W |~ Randomuine <«
<9 2DLine A
“ 30Horzon -
L 20 Horizon E
- = <
. T
(7
*x i PointSet
| Deoen e S
@ Shapefle
E &\ Prestack Events

Annotations

Select sticks & and
Remove Selected

./ Sticks & icons allow
] emeene | 4y salact and remove

24011110 (625969, 6077620, 667)

In-line 240: 4 Dip

fault sticks.

steered median filter.
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1.4.3b Fault Sticks

Required licenses: OpendTect.

Exercise objective:

Workflow:

1. Right-click on In-line in the tree >
Add Default Data; 4 Dip steered

Pick a set of fault sticks and group these into fault planes.

wiindine!
Aoy Add Default Data

& Zslice Addand Select Data
@ Volum  Add at Well Location ...

median filter. r ZRS”L"; Add Color Blended L LM ¥ ViewInine
’ 9 W View Cross-line
2. Drag inline position to 110 in the @ ViewZ
Position mode 9§ . | View North
« °|® ViewNorth Z
3. Click on . to have an inline view.
4. Reduce the displayed area to the
faulted part as shown in the picture:
Left-click + drag the green square
in the upper right corner.
Workflow cont’d:
) . _ _ [FaultStickSet
5. Right-click on FaultStickSet in the tree ® \E;Vo?ly Add ...
e
and select New. U New |
= FaultStickSet
. . L : -
6. Right-click on the newly added o Bogy e e :
FaultStickSet > Save as... b Wel B Save
“ PickSet —
O Polygon
X Prestack Events g Lock Treeitem
SIS = Remove from Tree
7. Enter an Output Fault Stick Set name - Ouputseiecton - omw
and click OK Output FaultStickSet | FauttStickSet_01 v| © select.. @ dcB
’ ¥/ Replace in free
@ Cancel @ Help
FaultStickSet
ight-cli - oy N TR poperi
8. Right-click on the saved FaultStickSet ] _ Y & ons
name > Display > Only at Sections. g Egkggr: # Saveas..
N Preystack Events | = LockTreeitem
@ Annotations == Remove from Tree
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Workflow cont’d:

9. Pick the first fault stick: either Left-click + drag or Left-click to pick and double-click
to end a stick.

10. Edit as needed: Left-click + drag seeds, Ctrl + Left-click to remove seeds, ™ or
Ctrl + Z to undo the last action, 7 or Ctrl + Y to redo.

©F Sumey Analysis Processing Scene View Utiities Help Estimages & x

Qile|ExnnaSEFT

2 @ = mndm Eleli Elemm ? rEg @ b B AN
9 17 i A SN NN AL L ENNEE N w
@ | s | To be able to pick fault sticks make sure that. |«
: D e 1) Position mode E is selected.
| gr" 2) The fault stick set is selected in the tree. |
- /R‘;:&::“Lms <«
4 | 9 2Dline A
@ 3D Horizon .
BN 4 2D Horizon AN
: .. Faul - c"
® |
® - K wel
X PointSet
*® [ Polygon \
H ; g:‘::t::fsvams = =
> Annotations S \
R SR
#\: - UNa inline 110: 4 Dip
% = ‘g;:-_:f. T L S| steered mediarkfilter
@ |CopySelectionto ~ | Fault ~ |CreateSingleNew  ~ seiec | [l . S =~
110/661 (614859, 6074059, 1488) Value =208 In-line: 110 Pickina [free mem] 4.3/7.9 GB 0
Workflow cont’d:
= | FaultStickSet |
—-
® Body Display 4
" el
11. Save your work regularly. Bl - S -
D Polygon - -
, L N Prestack Events | & Lock Treeitem
12. Interpret several fault sticks on inline 110. @ Annotations T TR
7 Survey Analysis Processing Scene - 8 %
Lilwai xaal Tips:
&g = medmisen | L The fault stick closest to the mouse cursor is highlighted with a
Tree scene 1 q . . 9 g . o
; Semens ot thick line. Press Ctrl to make it active and editable. 1
Scene 1 - - . . -
& oo - Click on a seed of any stick to make it active and editable.
w | Qe n | - Press Shift to end a stick (alternative to double-click).
- | @ zsice e T e = o = F ey
.| ®voume L — e R e — 2 !
B o ‘ s N
@ 3D Horizon : < - - g ,.. i; i ?
A 4 2D Horizon - = > al— - ¢ = =
3| ::::sm\se( / z = N
s ‘:Yaunsncxse(_m - ] q -
® - A well
¥ PointSet
®x [ Polygon
L i
> :\nnmncns
inline 110: 4 Dip
steered median filter.
o¢® @ CopySelectionto - | Fault v CreateSingleNew Select . >i . 5| n
110/660 (614823, 6074058, 1491) Value = 487 In-line: 110 Picking [free mem] 4.3/7.9 GB m'
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Workflow cont’d:

13. Move to inline 120: Click on «- in the navigation toolbar or use short keys (Z and X
by default) to move the inline backward and forward. Continue the interpretation for

* Suwvey Analysis Processing Scene View Utilities Help Estimages

GilwbE Zana SEXFT-AS
2 g == inine120 Jsterf10 =] 4m mp [s00 I a0 [ruseismics R == B
s FTNE N R T Y e A T T AN T
¥ emens Gotr _:‘-I;_\‘,h o\ A.f-\':/.' - fﬁl_54¢"§44§'§‘§-\;,:\_ N ‘~%‘-f_; 54 i
Scene 1 ‘__--’-." ) -_‘_ﬁ# -~ e o B \- R [ o~ "
@[ e o A R — o -d,’./“?f_-i"”—"_,,_«; ]
=4 cm,:i"'s‘m' mn - > —— —— - N e 7 )
M e : 5 =,
9| Sr.. «
P 20 Line A
@ 3D Horizon .
,! - 4 2D Horizon E )
B[ i raurctse e
B o ;/auusncnsa(_m -
@ - o Well
# | O ronen o a3
Y @ Shapefile .
5| e Select sticks &2 and
Remove Selected "
/ Sticks & icons allow inline 120: 4 Dip
to select and remove | steered median filter. L
o CnD‘/Geleﬂiul\ln fault sticks.
120/674 (615165, 6074317, 1. [free mem] 4.3/7.9 GB &J |
Workflow cont’d:

14. Add an empty Z-slice* to the scene and
Drag it to 1500 ms. Click on ) to have a
North oriented top view and resize with the
green anchors to cover more or less the
area you interpreted.

¥ Zis1sfistepd  [H4mmp| 065 I [0.95 [m Similarity
Tree scene 1 &)
Elements
Scene 1
W In-ine

@ Cross-line
® Z-slice

~ Random Line
F 2D Line

“ 3D Horizon
“ 2D Horizon

Fault
FaultStickSet
Body
Well

& PickSet

[ Polygon

S Prestack Ev
HH | = Annotations

We have finished picking sticks. In the
next phase sticks will be grouped into
planes. To facilitate this process we will
display a fault discontinuity attribute on
a time-slice through the sticks.

2 ¥ 1516
‘| Mo1Si. m

8 |~ ¥ ViewIn-line
% | @ View Cross-line
]| ® ViewZ
“=! |y View North
g - ViewNorthZ |

@ | & Body

*Positioning an empty
slice is faster than
positioning a slice with
data."With pre-loaded
data the speed
difference is negligible.
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Workflow cont’d:

15. Add 9-7 Similarity on FEF seismic from Stored attribute list.

3 ‘ 5
ot \/

Observe that separately interpreted fault
planes when co-rendered with a 5|m|Iar|ty
attribute on a Z-slice.

- TN

sticks can be easily grouped into fault
Fault 1 ﬂi

Workflow cont’d:

16. Select sticks located along the same lineament by clicking on & icon and:
- Ctrl + Left-click to select/de-select sticks one by one;
- Left-click + drag to select/de-select a group of sticks;
- Ctrl + Left-click + drag around several groups of sticks for multi-group selection.

Draw a polygon
to group fault
sticks located
along the same
lineament.

Sticks that are

not currently
selected
1 remain V|olet

\.' Copy Selectionto v|Fault v|Create Single New v v| setect... Il ¥ .\ 9 \ - \
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Workflow cont’d:

17. Choose Copy Selection to > Fault > Create Single New and type in a new hame in the
toolbar. Optionally choose a fault color. Then click [E.

o’ |&? |Copy Selectionto v|Fault v|Create Single New v|Fault_01A V| Select ... Iil}(lil 9 \ | W

iR Sy

18. Repeat previous two
steps to create more
fault planes.
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1.4.4 Velocity Gridding & Time-Depth Con-
version

What you should know about Velocity Gridding and TD conversion

o Time-Depth conversion is performed on-the-fly by transforming the Z-axis
of the scene using a given velocity field.
» Velocities are given in the form of:
» Velocity volume.
e The TD curve of the specified well.
» A user-defined linear velocity function.
» 3D velocity volumes can be created in the Volume Builder.

What you will learn in this Chapter

How to load a stacking velocity function.

How to grid stacking velocities and create a 3D velocity volume.
How to display the volume on the fly and batch processing.
How to batch-process cubes for depth survey.

How to batch-process horizons for a depth survey.

How to set-up a new depth survey.
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1.4.4a Stacking Velocities

Required licenses: OpendTect.

Exercise objective:
Import stacking velocity functions.

Workflow:
1. Go to Survey > Import >

Velocity Functions > ASCII...
to import a velocity function.

Survey | Analysis Processing Scene View Utilities Help Estimages

£y Select/Setup ...
Session »

Import »
Export »
Manage »
Pre-load L4

Exit

& Z-slice
® Vvolume
~ Random Line
2D Line
@ 3D Horizon
4 2D Horizon
Fault
FaultStickSet
@® Body
L Well
= PointSet
[ Polygon
¥ Shapefile
X\ Prestack E...
Annotations

LA S
=~ SEG-Y

2 Sten 0 =
AttributeSet

Color Table ...
Cross-plot Data
Faults

FaultStickSets
Horizons

Mute Functions
PointSets/Polygons
Probability Density Functions
Seismics

Velocity Functions
Wavelets

Wells

Shapefile ...
HorizonCube surface data ...
Prestack Event ...

|

T AsCll ..

Workflow cont’d:

e r—

Has statics O Yes @ No

File header No header <

Format definition | <Incomplete>

Output Velocity

) Import Velocity Function

Input ASCII File tawdata\Velocity_functions.txt| € Select ..

Define

@ Import| @ Cancel @ Help

- oM

v| 6 Select .
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Workflow cont’d:

4. Set File header to Fixed size consisting of 2 lines.

= Import Velocity Function = = n
Input ASCII File lawdata\Velocity_functions.txt| | € Select ... | Q, Examine

Velocity type Vrms v

Has statics O Yes @ No
- Format Definition - o IEH

Specify Necessary Information

XY v Position col1 2 col2

Z col:3 % Unit ms (Miliseconds) v

File header ? Vims col4 &
Header size (number of lines) O Stop reading at
Format definition <Incomplete> Deﬁne :

) @ Cancel| | @ Help

Output Velocity v | © Select

@ Import| @ Cancel @ Help

Workflow cont’d:

and click Import.

= Import Velocity Function - 0 n

Input ASCII File lawdata\Velocity_functionstxt| € Select ... @, Examine
Velocity type Vims v

Has statics O Yes ® No

File header Fixed size z| =
Header size (number of lines) 2 5
Format definition <Defined> Deﬁne .
Output Velocityl Vims_function v| © Select ...

) Cancel @ Help
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1.4.4b Grid Stacking Velocities

Required licenses: OpendTect.

Exercise objective:
Specify the gridding workflow to grid the stacking velocity functions.

Workflow:
1. Launch the volume builder module accessible from the icon

%

/# Volume Builder: Setup

Available steps Used steps

Body shape painter

Lateral Smoother

Smoother

Horizon-based painter - Simple

Horizon-based painter - Advanced

Input Volume |§|
WellLog Interpolator

Fault Painter

HorizonCube-Well Interpolator

Voxel Connectivity Filter

On OK, store As

[] |© select .|

Name for this step

7| Process on OK I & ok ] [O Cancel] [ @ Help ]
Workflow cont’d:
) Edit step =5 EcE =<
Velocity gridder
Interpolate along Z-slices E]
3. In the following window, choose
Triangulation as an algorithm type. O —
Add ...
4. Add velocity source. Remove
Properties

[ Q ok ] OCancelH @ Help l
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Workflow cont’d:

5. Choose Type: Stored Functions and select the

was imported in the previous exercise.

6. Click OK to proceed.

input function Virms_function that

‘f\ Add velocity function source

(=% HoR ==

Type|Stored Functions |~

Input | Vrms_function

| [6 Select ...

[Go][@oows] @7 |

N
Workflow cont’d:
(= Edit step = Eoh =%
Velocity gridder
Interpolate along Z-slices B
Algorithm Triangulation a
Velocity sources
Vrms_function Add ...
Remove
Properties ...
7. Name this step (e.g. Triangulation of
Virms function).
Name for this step | Triangulation of Vrms function| |

8. Click OK.

| @ox | OCancelH @ Help }

T
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Workflow cont’d:

9. Store the setup as Grid velocity function.

10. Toggle off Process on OK and press OK.

' Volume Builder: Setup

Horizon-based painter - Advanced
Velocity gridder

Input Volume

WellLog Interpolator

Fault Painter

HorizonCube-Well Interpolator
Voxel Connectivity Filter

-

Available steps Used steps ~
Body shape painter Triangulation of Vrms function f d
Lateral Smoother
Smoother l éxl
Horizon-based painter - Simple

On OK, store As | Grid velocity function

I~|| © Select I

I Q ok ] OCanceIH @ Help ]

Workflow cont’d:

11. Add default inline to the scene.

12. Right-click on it > Add >
Volume Builder Attribute.

13. Select Grid velocity function and press OK
to display the attribute on-the fly.

Elements Color

Scene 1
§iIn-line;

P Add Dofaut Dala ]
& Z-slice] Add and Select Data
@ Volume  Add at Well Location

~ Rando  aqq Color Blende

2D | ine- -
Elements Color
Scenel
4 § In-line
4 [V]425
@4  Add Y|4 Attribute
# Cross-|  Display > | &y Volume Builder Attribute
¥ Z-slice | .
Duplicate € HorizonCube Display
® volum Reset Manipulation -
Systems Tracts Display
~ Randg Display Prestack Data  » i sy
2DLIN 4 Correlate with Wells...
@ 3DHo
4 2D Ho @ Lock Treeitem

Fault | == Remove from Tree

) Load Volume Processing Setup |- |- (&)

Select input Volume Processing Setup

Fiter *
Grid P-Impedance logs using HC
Grid ity function

HC_well_interpolator_4_wells_Al_inv_«¢ Iﬁ
HC_well_interpolator_4_wells_Al_train _ £
New_HC_well_interpolator_4_wells_Al ~ il
Steering ‘ﬁ
Steering_6.1

test T [_

« il »

I Qo |© CanceIH @Hep |
...5\Misc\Grid_velocity_function.vpsetup
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Workflow cont’d:

The result should be similar to the one shown below

N
Workflow cont’d:
Scenes View Utiities Help
. . . Create Seismic Output » Attributes D
14. Go to Processing > Create Seismic Output >  Croale Horizon Ouipul » | 20 <-> 3D o
. (Re-)Start Batch Job ... Angle Mute Function .
VOIume Bu"der » Dip Steering , | % Bayesian Classification ..
= GMT Mapping Tool ... From Well Logs ...
@ HorizonCube > Prestack Processing »
Madagascar .. STty 4

| ssis ,

= W _ Re-sort Scanned SEG-Y

15. In the pop up window, select Grid Velocity function for Volume Builder setup and specify
an output name, e.g. Vrms, and press OK to start batch processing.

¥ Volume Builder: Create output o H (=] |@
Volume Builder setup | Grid velocity function B“Q Select " & Edit ..
Volume subselection - € Select ...
Output Cube | Vrms] | [O Select ] & CBVS ]

Batch execution Single Process B . Options ...
@0k | @ cancel| | @tep |
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1.4.4c TD Conversion On-the-fly

Required licenses: OpendTect.

Exercise objective:
Create a depth scene and perform velocity conversion.

. View Utiities Help
Workflow: o
1. Go to Scenes > New [Depth]. | Now Map View
New [Depth]
New [Horizon Flattened] »
( New [Wheeler]

Cascade
Tile 4
Properties ...

Save scene to 3D PDF »

v Scene 1

2. A window pops-up asking you to select or create a velocity model. Click on Edit...

# Velocity model - a X

Select velocity model to base scene on

Z transform | Velocity volume v
Velocity model (m/s) ;é) ‘i‘-_-;, Velocity model (INT) ~| € Select ..
Depth Range (m) [0 | [2100 Step [ N

© Cancel| | @ Help

Workflow cont’d:
3. Select the velocity cube i.e. Velocity model (RMS) and specify the velocity type (RMS).
4. Press OK and OpendTect will scan the file to compute the depth range for the new scene.

5. Press OKin the Velocity Model window and a new depth scene will appear.

™ Specify velocity information [ = H o} \
Velocity cube @ ") Velocity model (RMS) [1[© setect ]
Velocity type [Vims B ) Velocity model — a X
Select velocity model to base scene on
Has statics ) Yes @ No
7 wansform | Velocity volume =
Velocity model (m/s) f&| [ [ Velocity model (INT) V]| © select .| | Edi.
Depth Range (m) |0 ‘ |2100 ] Step ‘5| N
QoK [O Cancel‘ [ @ Help I € Cancel | () Help
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Workflow cont’d:

6. In the depth scene, display any stored volume on the inline 425. You will notice that the
scene now shows data in depth, which has been converted from time data using the
interval velocity you, selected. This is done on-the-fly.

Suvey Analysis Processing Scene View Utiies Help Estimages
@ Fi oo
Qi-aBEET-AD
Cross-line 0 2 Stop s ra 11 Seismics. C e g LB
<=-|-E

“Troe scene 1 7 |7 scone 1

5 Depth (using VelocityT2D") =) =) T
Elements Colo ~ :
Scene 1

W In-line -
@ Cross-ine
© Zsice a0

® Volume
~ Random Line
2D Line
© 3D Horizon
4 2D Horizon
Faut 1000

LA 1Y ¥

AR>S :>A

8
z

¥ PointSet
D Polygon
@ Shapefie
& Prestack Events
Annotations.

< >

@
Q

I <+ %

Dept

Tree scene 7

TR o
Depth (using 'Vel.
@ In-line
@ Cross-line
® Z-slice
@ Voume
~ Random Lin

20 Line
“ 3D Horizon
4 2D Horizon

FaultStickS et
® Body

Wel
* PointSet

[ Poiygon 3
@ Shapefile
& Prestack Events v [ D]

< >

liree mem) £.9/15.9.GB [

Workflow cont’d:

Conversion of Vrms to Vint

7. Go to Processing > Create Seismic output > Velocity > Velocity conversion...

Scene View Utilities Help
| Create Seismic Output » Attributes O

Create Horizon Output » 2D <=> 3D »
L Wells 4 Angle Mute Function .
(Re-)Start Batch Job "4 Bayesian Classification ...
#+ Dip Steering » From Well Logs ...

| == GMT Mapping Tool .. Prestack Processing ’

@ HorizonCube , - jon ..
Madagascar - Volume Builder Velocity Conversion

= ssis Re-sort Scanned ?EG—Y

8. Fill the fields as shown below and click OK.

) Velocity conversion [E=8 o =™

Velocity conversion

Input velocity model (2] s [ Velocity model (RMIS) ] [© Select | [ Edit... |

Area subselection - © Select ...
Ouput veocty type

Output Cube [Vin{ ][© select | & cBYS Fl

1+ Execution Options ... b

| Q ok ”OCancelH @ Help I
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Workflow cont’d:

- . T . El its Col
9. Right-click on an inline in the scene > Add and Select Data. | scene:
.a 'c"rl'lgl Add Default Data

L XA Y Add and Select Data

10. Select the new converted interval velocity. ® Volume - Add af Well Localon ...
+/ Randol - adq Color Blended

2D Ling =y

= select o | ® | @ 3D Horizon

Select first layer = gg ;Innzon

¢

FaultStickSet

@ Stored Spec Decomp FFT -

System Tracts ® Body

Steering tl_lux_fixtest_DELME
Velocity model (INT)
Attributes | Velocity model (RMS)
Vint
b] Voxel Test -

Filter *

QoK || cancel| | @ Hep

11. Right-click on an inline 425 in the scene > Add > Attribute.

Elements
“ Select = oR =5 Scene 1
2 In-li
Select first layer pair
i
o Stored Spec Decomp FFT z ¥ Cross  Display * | Volume Processing Aftribute
System Tracts ; s 0750 & HorizonCube Display
Steering tf_lux_fixtest DELME folum - Reset Manipulation 51 Systems Tracts Display
Velagity model (INT) 7 parct Display Prestack Data »
Atributes IR RMS @ 3p = Correlate with Wells
%I Voxel Test S @ 2D H(@ Lock
« i » Fault| & Remove from Tree
Fanltomm
Filter *
QoK || @ cancel|| @ Hep

Workflow cont’d:

Velocity model (RMS) | Velocity model (INT) |
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1.4.4d TD Volume Conversion In Batch

Required licenses: OpendTect.

Exercise objective:

Workflow:
1. Launch the time-depth conversion dialog.

Scenes View Utites Help

Create Seismic Output » Aftributes
Create Horizon Output » 2D <=> 3D
(Re-)Start Batch Job ... Angle Mute Function ...

Dip Steering »

Fault Extraction ... From Well Logs ...

Prestack Processing

L |

GMT Mapping Tool ...

@  HorizonCube » Velocity

Madagascar ... Volume Builder ...

P4 Bayesian Classification ...

Use the velocity volume to time-depth convert volumes in batch mode.

2 re A A
29
v . -

I 1 Seismics

Time - Depth Conversion ...

Velocity Conversion ...

In general, the depth volume does not change laterally from the original cube
(thus InL/XL step stays the same) but the depth Z range can be larger.

Workflow cont’d:

3. Define the depth range and the step

4. Selectthe Time volume to be converted

2. Select the Velocity Model (in this case, Velocity Model (INT)).

# Time to depth volume conversion

Time/Depth conversion

Direction @ Time to Depth O Depth to Time

Z transform Velocity volume <

Velocity model (m/s) né = lVeIocnty model (INT)

Depth Range (m)IO | [2100 | step El

Input Time Volume né B [4 Dip steered median filter

Area subselection |-

Output Depth Volume

 Execution Options ...

- m} X
v|| @ select .| | Edit .
|
v'I € Select .
© Select ...
~| | © select ...| @ cBYS -
€ Cancel | @) Help
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Workflow cont’d:

5. Specify the new output depth volume (e.g. D-4_DSMF).

6. Click on OK. The volume will be saved in depth and stored in the
time survey

# Time to depth volume conversion - (m} X

Time/Depth conversion

Direction @ Time to Depth O Depth to Time

Z transform | Velocity volume v
Velocity model (m/s) = *3 | Velocity model (INT) v| & select ...| | Edit ...
Depth Range (m) [0 |[2100 | step[s \
Input Time Volume Aé = [4 Dip steered median filter v‘ © Select ...
Area subselection [ | © Select ..
Output Depth Volume | D-4_DSMF| v| © select... @ cBVS ~

i+ Execution Options ...

© Cancel | g Help

Workflow cont’d:

7. To display the new depth volume, go to the depth scene. Click on the scenes,
Select New [Depth].

8. A new window will pop up, Make sure all inputs are correct, and then Press Ok.

) Velocity model - (m] X

Select velocity model to base scene on

Z transform  Velocity volume v

Velocity model (m/s) *i&, | Velocity model (INT) v| © Select...| | Edit ...

Depth Range (m) [0 |[2100 | step[d] \

€ Cancel | () Help
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Workflow cont’d:

9. Right click on inline > Add and Select data

10. In the pop-up dialog, Select the depth volume.

11. Hit Ok, and a new depth volume will be displayed

Elements Color
Dep sing ‘Velocity...

w! Add Default Data

N
“WAN| Add and Select Data

@ Volu  Add at Well Location ...
~ Rar  add Color Blended
X7 2D ke

T

.
) Select

Selectfirstlayer

Stored
Steering

Attributes

T

[0k | [© cancel] [ @ Heir |
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1.4.4e TD Horizon Conversion In Batch

Exercise objective:
Use the velocity volume to time-depth convert horizons in batch mode.

In order to display the horizons in depth survey we will need to first export them
from time survey using velocity model.

Workflow:

1. Go to Survey > Export > Horizons > ASCI| 3D.

m Analysis Processing Scene View Utilities Help

147 Select/Setup ... N3 =, _ @l
Session » - S

Import y P1E .‘ 0 [ ]g I 1Seism
| Expot | >

Faults
Manage » FaultStickSets 4
Pre-load 4 Geometry 2D L
Bxit T ASCI2D .

Mute Functions »

ST :25(’ PickSets/Polygons >
7] < Probability Density Functions »

& Cross-lin Seismics »
b4 Z-slice Wavelets »

PetrelDirect »

Workflow cont’d:

2. Select an input Demo 0 --> FS4.

' Export Horizon folfe )=
3. Setthe output type to X/Y. Input Horizon |Demoo~>F54 - [© setect...
Calculated attributes
Area subselection 100/300-750/1250 (463 samples) [6 Select...
Header [No -
Output ASCII File @ Select ]

-103 -



Workflow cont’d:

4. Specify output Z: Transformed.

5. Depth conversion: Velocity volume.
6. Select a velocity model (volume).

7. Z-units: setthem to meter.

8. Give it a name and Expott (by default

it will be store in the survey main
directory).

Note that if you have already calculated
attributes in time survey, you select
some or all to be exported in the white
rectangle.

! Export Horizon

N
Input Horizon n‘g Demo 0-->FS4

Calculated attributes

Depth conversion |Velocityvolume  ~

Velocity model (m/s) LE, QJ [Velocity model (inT)

oo

- |© select..|

Area subselection 100/300-750/1250 (463 samples) © select...
Output Type |X/Y -
oupuz

- |© select...]]| edit...

Header [No -

| © select...

Output ASCII :-relDemo 0_FS4

) close | | @ Help
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1.4.4f Setup Survey For Depth Converted Data

Exercise objective:
Set up a new depth survey to work with depth converted data (e.g. seismic, horizons etc.).

Analysis Pr

Workflow: Select/Setup ..
Session 4
1. Go to Survey > Select/Setup...> or click on this Q 'Empog ’
. Xpo >
icon. | Manage 4
Pre-load *

Exit

@ Survey Setup and Selection —oIEd

) Survey Data Root .| | Y:\Demo-Surveys WX

” F3_Demo_2016_training_v6 | '/
) G

»

2. Clickon g iconin the Survey Setup and
Selection window.

@ Select | Q) Cancel @ Help

Workflow cont’d:

3. Give a name to the new depth survey: - =
F3_Demo_Depth. © Create New Survey — “

Specify new survey parameters

Survey name |F3_Demo_Depth

4. Choose Copy from other survey.
Available data [v] 3D 2D

Initial setup | & Scan SEG-Y file(s)

4 Set for 2D only

|5 Copy from other survey |
5. Select Depth for Z Domain and Meter for units. @ Enter by hand

6. Click Next.
Z Domain () Time |® Depth

Depth unit[® Meter] O Feet

€) Cancel @ Help
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Workflow cont’d:

7. Choose the time survey and click OK.

Select Data Root and Survey - O “
Data Root | Y:\Demo-Surveys © Select ...
[F3_Demo_2016_training_v6 N
v
< >
O cage @

Workflow cont’d:

8. Change the Z range: 0-2100,
step 5 in meters.

9. Click OK to create the survey.

Survey name
Location on disk
Survey type

Ranges/coordinate settings

Edit Survey Parameters

F3_Demo_Depth

Y:\Demo-Surveys

Both 2D and 3D ~

Enter below -

Survey ranges: In-line Range 100 5 750 S| Step 1 =
Cross-line range 300 S 1250 '3/ Step 1 s
Zrange 0 2100 Step 5 meter ~
Display depths in @ meter feet
Seismic Reference Datum (m) 0
Coordinate settings: (® Easy () Advanced Define Coordinate System
First In-line/Cross-line 100 300 = (X,Y) 605835.51668886 | 6073556.38221996
Another position on above In-line | 100 1250 = (X)Y) 629576.25771336 6074219.892946
Position not on above In-line 750 1250 = (X,Y) 629122.54650645 | 6090463.1688065
w Apply

Free space on disk: 1.55 TB
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1.4.4g Import TD Converted Volumes And Hori-
zons

Exercise objective:
Import the newly time-depth converted volumes and horizons into the new depth survey.

Workflow:
Here we assume that the time-depth converted seismic volume is saved in OpendTect’s
native CVBS format, in the time survey. We are working now in the depth survey.

1. Survey > Import > Seismic > CBVS > from file....

"-,VSurvey Analysis Processing Scene View Utilities Help Estimages
= N =
£y Select/Setup ... e A =
»

Session
“ Sten 0 = 0 .‘l_!l_ul l[‘,‘ 8040 K1 Seismics
Import 4 AttributeSet v |
Export » Color Table
Manage b Cross-plot Data »
Pre-load 4 Faults »
Exit FaultStickSets »
= e — Horizons »
e ; S:I"fni Mute Functions »
P u e
~ Random Line, PmntSe{s/Polygons »
. v 7 2D Line Probability Density Functions » |
% | 4« @ 3D Horizon Seismics > T Simple File > | 5
; 4[v]Demo6-..|  Velocity Functions ' (@& cBVS ’ From File .. .
L V] Z values Wavelets ’ PetrelDirect  » From Other Survey ... |-
= .
- i'zu';"”m” Wels * |G} GPR:DZT ... N
* IN-lind
(-] FautStickset  Srapefile sv | SECY ’ &
& ~| ®Body HorizonCube surface data ...
L Well Prestack Event ...
Workflow cont’d:

2. Click on Select and browse to the location of F3-Demo (Depth survey).
3. Select the depth volume that was created in the exercise 1.4.4.e (D-4_DSMF.cvbs).

4. Keep the default Use in place option (which means the physical location of the stored
volume will remain in the time survey).

- Import CBVS cube - oiEN
(First) CBVS file name | W:\F3_Demo|Seismics\D-4_DSMF.cbvs | © Select ..
Cube type Input data cube v

Import mode © Copy the data

Output Cube [D-4 DSMF |v| © Select. | [ Depth

&/ Run k 8 Close| @ Help
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Workflow cont’d:

Similarly, import horizons: Survey > Import > Horizons > ASCIl > Geometry 3D...

7 Survey | Analysis Processing Scene View Utilities Help Estimages

£ Select/Setup ...

EAS

Session
2 Sten 0 =t N [:l 11 Seismics 5
Import » AttributeSet
Export ’ Color Table ..
Manage 4 Cross-plot Data
| Pre-load » Faults
Exit FaultStickSets
] e Horizons T ASCII 2D >
& \‘ Volume LEID (FUIBTEIE T ASCII 3D > Single 3D Horizon ...
PointSets/Polygons -
~ Random Line d T Attributes 3D ... Bulk 3D Horizon ...
N 1 9D Line Probability Density Functions PetrelDirect N [
% | < 3D Horizon Seismics
4 2D Horizon Velocity Functions
2L Fault Wavelets
8- FaultStickSet Wells 00 w0
iy b d 5\;’::’ Shapefile .. i
. HorizonCube surface data ...
& PointSet
> Polygon Prestack Event ... N
x @ Shapefile
R E & Prestack E...
B Annotations
Workflow cont’d:
XY ~| Position col1 %/ col2
Z col3 2] Unit [m (Meter) -
rS
& Import Horizon =)
InputASCII File Y\F3_Demo_2015\Demo 0_fS4 e Select Q Examine
5. Click on Select and browse to .
the location of FS4 horizon. ey SV P
=
1N
File header [Noheader
6. Press on Define to Specify Format definition <Defined> [3) Define ..
the necessary information for import,
relating columns with XY and Z. i —
Fill undefined parts () Yes @ Nc
Output Horizon |Demo 0_FS4 v @ Select..| | ¥ dGB v
7. Give the output horizon a name and el )
press import_ Base color | NN | (W Crimson -
Display after import
(@]
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Workflow cont’d:

8. Right-click on 3D Horizon > Add.

@y Survey Analysis Processing Scene View

ilwab - AS

Cross-line 0

Tree scene 1

- Step0

Elements

Colo

Ty Ve

r 4
2 <

w9g N\
< & « &

:
r

T

Scene 1

&y’ In-line

W Cross-line

W Z-slice

® Vvolume

~ Random Line

7/ 2D Line

=
Add at Sections Only ...
Add Color Blended ...

’ New »
. Well
i PointSet
[ Polygon
¥ Shapefile
&\ Prestack Events
Annotations
&

Workflow cont’d:

9. Select the justimported
FS4 Horizon.

10. Press OK.

-
@ Select Input Horizon (s)

® - Filter *

V| Demo 0_FS4

&)

Area subselection 425/300-425/1250 (421 samples)

...F3_Demo_Depth\Surfaces\Demo_0_FS4.hor

g ?OK © cancel | | @) Help
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Workflow cont’d:

11. FS4 Horizon is displayed
in full in the Depth survey.
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1.5 Attribute Analysis & Cross-plots

What are seismic attributes?

Seismic attributes are all the measured, computed or implied quantities obtained
from the seismic data. The two main reasons for using seismic attributes:

1.

2.

Visualization (qualitative)
» Toremove extraneous information in the hope of revealing trends or
patterns not visible in the original data.
Data integration (quantitative)
» To obtain information carriers from different sources that can be integ-
rated by statistical methods.

What you should know about Attributes in OpendTect

1.

2.

>

o O

Attributes can be computed from post-stack 2D and 3D data and from pre-
stack data.
Attribute definition and computation are two separate steps:

» Step 1: Define how to compute the (2D or 3D) attribute in the cor-
responding “Attribute Set” window (input > algorithm > parameters >
output).

» Step 2: Compute the algorithm either on-the-fly on the display ele-
ment of choice (inline, crossline, Z-slice, horizon, sub-volume, point-
sets, fault plane, 3D geobody), or in batch mode to create an attribute
volume (via the Processing menu).

Attributes can be chained (output attribute 1 is input to attribute 2).

You can create your own attributes using chaining, mathematics and logical
manipulations.

Attribute parameters can be tested in a movie-style manner.

Attribute time gates (vertical window) and step outs (lateral step in multi-
trace attributes) are specified relative to any evaluation point (x, y, z) where
the attribute is to be computed (Step 2, see above).

A time-gate of 30ms that is defined as [-10, 20] means the software will
extract data from a time-gate between 10ms above the evaluation point to
20ms below the evaluation point. The extracted data is resampled to
sample rate defined in the survey.

. Filters are a just another group of attributes, hence are treated as attributes.
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What attributes are supported?

Since it is possible to create one’s own attributes using chaining, math & logic the
number of attributes supported in OpendTect is without limit. To put order in the
attribute maze, dGB supports an Attribute Table on their website. The table maps
attributes versus application domains and is ordered in attribute classes.

Please note that will find both free and commercial attributes described in the
table. OS (Open Source) labels attributes offered in the free functionality.

Amplitude-based

Attributes Information
Energy « Description: sum of Amplitudes Squared in a time-gate
« Plugin: 0S, OD

« Stratigraphic: highlights packages with different reflection strengths
« Siliciclastics: energy may correlate with lithology & porosity

« Fluids: enhances Bright Spots

« Other: use Sqrt output option to control output dynamic range

« References

Scaling « Description: various functions to correct amplitudes vs. time

« Plugin: 0S, 0D

« Structural: scaling can be tuned to facilitate structural interpretation

« Fluids: AGC time-gates smaller than 500ms should be avoided in quantitative interpretation
« Other: do not apply in workflows that require preservation of original amplitudes

« References

Event « Description: quantifies the shape of an event or relative distance between events
« Plugin: 0S, OD

« Structural: useful to determine horizon quality

« Stratigraphic: useful inputs for 3D NN facies classifications

« References

Strata « Description: returns statistical property (min, max, sum etc.) of an attribute in an interval defined along one horizon or between two horizons
Amplitude « Plugin: 0S, 0D

« Stratigraphic: useful to characterize intervals

« References

Frequency-based
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The application domains (organized in columns) are:

Structural
Stratigraphic
Siliciclastic
Carbonates
Fluids

Noise
Others

The attribute classes (rows) are:

Amplitude based
Frequency based
Multi-trace based
Impedance based
Dip & azimuth based
Processing & Filters
Meta-attributes
HorizonCube & SSIS
Pre-stack attributes
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The following list shows which attributes are useful for a specific task.

» Noise reduction:Dip Steered Median Filter, Frequency Filter, Gap Decon-
volution

» Frequency enhancement (spectral balancing):Seismic Spectral Blueing

» Fault detection:Similarity, Fault Enhancement Filter, Ridge Enhancement
Filter, Curvature, Dip, Variance, Fault Extraction

» Fracture prediction:Curvature, Azimuthal AVO, Fracture, Inversion to
Anisotropic Parameters

» Layer thickness estimation:Spectral Decomposition, Instantaneous
Attributes

» Porosity estimation:Deterministic Inversion, NN Rock Properties Pre-
diction

» Net-pay:Seismic Coloured Inversion, Stratal Amplitude, Net-pay

» HC presence detection:AVO Attributes, Frequency Attenuation, Energy
((far-near) x far), Sweetness, Fluid Contact Finder, Seismic Feature
Enhancement

» HC saturation estimation:Gas Chimneys, Three Term Inversion?

» Oil vs. Gas prediction:Gas Chimneys, Three Term Inversion, NN Clas-
sification, Spectral Decomposition

» Predicting Clastic Lithofacies (sand-silt-shale):

» Simple:Energy ((far-near) x far), Frequency, Phase
» Advanced:Waveform Segmentation, Volumetric Segmentation,
Fingerprint, Deterministic Inversion, NN Rock Properties Prediction

» Predicting Carbonate Lithofacies:Waveform Segmentation, Volumetric
Segmentation, Fingerprint, Deterministic Inversion, NN Classification

» Mapping seismic geomorphology: Lithology (see above): Similarity
(indicates erosional incision), Dip Attributes, Spectral Decomposition
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1.5.1 Bright Spot Detection and Visualization

What you should know about bright spot detection OpendTect

Bright spots are seismic anomalies that are often related to hydrocarbons. How
the seismic response varies as a result of a change in fluid-content depends on
the geologic setting and rock-physics / fluid properties. Forward modeling helps
to increase the understanding of the seismic behavior as a function of changes in
rock and fluid properties. such understanding is important for selecting the
optimal attributes and tools for qualitative and quantitative analysis of bright
spots.

OpendTect offers a range of pre- and post-stack analysis tools to investigate
bright spots, especially in the domain of commercial plugins. Examples are seis-
mic inversion plugins and hydrocarbon anomaly enhancement techniques such
as Fluid Contact Finder and Seismic Feature Enhancement.

Seismic attribute analysis is a simple and effective tool to enhance bright spots
and to study their areal extent in 3 dimensions. In the exercise a gas-related
bright spot is visualized in 3D using volume rendering of the energy attribute. The
volume rendered object can be saved as a 3D object for further study, e.g. to com-
pute the body's volume.
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1.5.1a Bright Spot

Required licenses: OpendTect.

Exercise objective:

Isolate an amplitude anomaly (bright-spot) using attribute analysis and visualize the
anomaly in 3D using volume rendering
Workflow:

1.

Launch the attribute set window: click on the Attribute 3D icon 4 and select 3D.
2. Define the Energy attribute with default parameters.

File

Attribute Set 3D - olEN
> [ X
P a ek -
Attribute set | <not saved> Basic lenergy J 2
Energy [-28,+28] Input Data [4 Dip steered median filter v||© select
Time gate (ms) -28 28
Compute gradient () Yes @ No
Output Energy
+
{
4
z¥
-
Atribute Name  Energy [-28,+28] Add as new [l
] Save on Close @Close | @ Help

-116 -




Workflow cont’d:

3. Provide an attribute name as Energy [-28,+28] and press Add as new.

S Attribute Set 3D - olEd
File
> [ X
PSS DA My -
Atiribute set <not saved> Basic v| Energy v ?
Energy [-28,+28] Input Data |4 Dip steered median fitter v © Select
Time gate (ms) |-28 28

Compute gradient () Yes @ No

Output Energy -
Defined
attribute(s)

appears 4

here. 3

1)

Altribute Name |Eneray [-28, +28]| | Add as new ||*‘
v] Save on Close @Close | @ Help

There are no restrictions on the length of the name: it may contain spaces. It is
recommended to use a hame that contains all essential information of the attribute. It
helps you remember what this attribute does, and prevents having to go back to this
attribute window to see the exact definition of the attribute.

Workflow cont’d:

4. Tick the Save on Close box and press Close.
Alternatively, press the Save asicon g and press Close.

5. Provide a (new) name for the attribute set like my first attribute set and press OK.

Attribute Name  Energy [-28,+28] Addas new [l

o

= save Attribute as  — O [HESM

Select output Attribute

&
File Fiter |-

Q'Qﬁ.dmﬂg..v )

X d

Addas new| [l

o

Name
@ Cancel | @ Help
i

i
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Workflow cont’d:

Scene 1 ‘

2 @in-lins
. . . Mcfl AddDefautData ]
6. In the tree, right-click on In-line and T
select Add Default Data. Eg’; e ocaon -
aW 1.';1-7‘3(1
7. Change the inline position to 250: select
the inline in the tree and type the position ini 250/ [ |ptep 1 2 m mp| (4500 | ]
using the position toolbar.
= ) In-line ‘
" | YT
8. A_dd an extra attnpu.te layer to |_n||ne 250: @crs Dispy D o m
right-click on the inline number in the tree Slom e iy | @ HorizonGube Dispiay
and go Add > Attribute. 7 Randd oy Presiack Data » [ SYSeEe pEee DEPEY
© 3 e i Correlate with Wells
42D Hc g Lock Treeitem
9. The attributes available are organized in FautSmemore from 7o
three categories: Stored, Steering and _
Attributes (from the active attribute set and = Sefect - Ea
calculated on-the-fly). SelectLayer2
Go to the Attributes section, select your O Stored
attribute Energy [-28,+28] and click Ok. O steering
s
ﬁé
Ocancel @ Help
Workflow cont’d:

Results should look like this.
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Workflow cont’d:

Color-bar

Visualizing the results is almost as important as the results themselves. Therefore, try

The color-bar is displayed by default above the 3D scene and can be edited by selecting
a new color-scheme.

1. Click on the attribute from the tree and change the color-bar.
Try: Chimney, Faults and Grey scales.

A AR CELE
300857 J343010/ 11 seismics v

Dip2 )
I Double Rainbow

-y In-line "
= M 250 - Erc:s::gl;e/ Tasty
E eIg) -28,+28] ;] m Experimental
V] 4 Dip steered ... 11 11 Extremes
1 Faults
¥ Flames

| Grey scales
1 Greyn

Workflow cont’d:

32373 M 2aa731 aSeismics
Flipped

Ranges/Clipping
Manage .
Set as default

2. Right-click on the color bar: select Manage...

Edit color markers
from the main window

The color can be edited by double clicking on |

one black marker below the histogram. To add | |~ S SEL A mlal__
a new marker, double click at the position you
want, select the appropriate color and click Ok. Colortable | Status "

Matteo ter... Default

Drag the marker to change its position. Right- e

click on a marker and chose Remove color to Porosity  Defaul

Pressure Defauit

Add, remove, change color tables

delete it. Rainbow .. Defaul

From the table RedWht . Defauk e -
Right-click in the white section of the color-bar 22:{25'9 EB’EEEE Seamentation [one Vn )
displayed under the histogram and chose Edit | | sukso Dot Undefined color Tranep 0% &
markers... In the table that pops up, the colors UVQs Ex... Default «|  Marker color

and position of every marker can be edited: for Remove .. | Import .. Fip | |Saveas.
a specific marker, you can type in a new QoK | ©cancel | @Hep
position and change the color by double-

clicking on the used color. When right-clicking .

on a marker, you can either delete the selected
marker or add a new one above or below.
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Workflow cont’d:

Segmented vs Continuous

The color-bar can be continuous or
segmented. When changing the Segmentation
from None to fixed, you define the number of
the segment. Segmented color-bars are in
particular used when displaying a discrete EET

attribute, for example a Neural Network result: Matteo ter

Pastel

SunRise

alters the parts of the spectrum that are Ty
displayed. Drag the seeds up to modify the
transparency. You need to have a seed at each
extremity of the histogram: add new seeds by
double-clicking on the red line and drag the
seed laterally and vertically. To remove a seed,
do ctrl+click on the seed.

Remove

one color corresponding to one class. Porosity
Pressure

Rainbow

Rainbow

Transparency Red-Whit
. o g Red-Whit...

The red line in the histogram represents the Sandshale
o o Seismics

transparency: changing the transparency line Similarity

Status

Default
Default
Defauit
Default
Default
Defauit
Defautt
Default
Defauit
Default
Default
Default
Default
Default
Default

Import ...

Add, remove, change color tables

Manage ColorTable - olEd
= e
|Segmematlcn None V|
Undefined color Transp 0% =
9 Marker color
Flip Save as
@oK | ©@cancel @ Help

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, .
Workflow cont’d:
3. Press Cancel to close the color-bar manager.
. . o . - O
The undefined color is the color that will be Manage ColorTable L
used for undefined values. You can adjust jts | | A moe: chenee eoeriedes
transparency. Colo bl [ Stis -
atteo ter. efaul
The changes you are making are applied in the | | Pae " Defaut
same time in your scene: you can actually QC | | ey, Dot
the color-bar edition. Rainbow .. Dofau - .
Red-Whit... Default k ﬂ
O d th th I _b dt RZd—Wh:t... sz:zl‘[
nce yOu are one wi € color ar e ||ng, SandShale Default Segmentation None M
T i i Seismics Default
you can save it with another name or overwrite Simerty Do Undefined color ronsp [
the color-bar you were using (not| | jukee e
a 2 a Mark I
recommended) by just clickihg OK and | | UYasEx.. Defaut v] Tamereoer
Continue. If you do not wish to save the Remove .| |meor == [ |[Savwas
modifications, click on Cancel. QoK @ Hep
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Workflow cont’d:

4. Right-click on the color-bar and select Set as default: it will set the specific color bar
by default for all the attributes to be displayed that do not have a specific color bar

attached to them.
309857' r Flipped

Ranges/Clipping ...
Manage ...
Set as default

5. Optionally, right-click on a stored attribute (volume) in the tree and select Save
Color Settings to save the color-bar and the color range: it will be used when loading
this specific attribute again.

Scene 1
= iy In-line
= [v] 250
[v] Energy [-28,+28] m
2 -

# Cross-line Select Attribute »
& Z-slice Save Color Seftings
® Volume Move »
~ Random Line Display 5

;2D Line

@ 3D Horizon - Rem9ve

The color-bar right-click menu allows you to flip the color bar, change the
Ranges/Clipping (to set the scaling values symmetrical around zero), Manage the color
bar, Set as default.

Workflow cont’d:

Evaluate attribute parameters

Now we are going to evaluate the Time gate parameter of the energy attribute by
interactively (movie-style) evaluating its parameter settings:

1. Open the Attribute Set window: click on the Attribute . %‘ggg
seticon , | and select 3D. & Eneray [-28,+28] K]
2. Activate the Energy [-28,+28] attribute displayed on [v] 4 Dip steered ... 11
inline 250 in the tree.
3. In the Attribute Set window, select the Energy attribute
again and press the Evaluate attribute icon 'gﬁ = eaaeanove — O B
= Attribute Set 3D Evaluate Time gate v

File Initial value -28 28

S IATT IR

Attribute set | <not saved> Basic ~| Energy v

Increment -4 4

Energy [-28,+28] Input Data 4 Dip steered median filter v Nr of steps 2 < | Calculate
Time gate (ms) 28 28
Compute gradient ) Yes  © No SiorelsHCEslon ACCont

Output Energy

@ Accept| | @ Help
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Workflow cont’d:

® paluateatribite — O IEM
4. Select the parameter to evaluate: Time gate Set parameters
(in this case, there is only one type of
parameter to evaluate so it is selected by Evaluate Time gate >
defautt). Initial value -4 4
5. Provide the parameters for the time gate as Increment -4 4

shown in the image on the right.
Nr of steps 10 % Calculate

6. Press the Calculate button. Slice

7. The slider becomes active once the on-the- Store slices on 'Accept
fly processing is finished.
Move the slider to see the results for a
certain slider position, corresponding to a Accept| | @ Help
time gate in this case: observe the changes E
in the 3D scene (see the following slides, for
instance).

Slice | U

If an attribute is defined using a time gate and/or
a step out, these parameters can be evaluated

the same way. Time gate [-16,16]

Store slices on 'Accept’

Workflow cont’d:

8. Evaluate the attribute by moving the slider position.

Time gate [-8,+8]ms

@ Evaluate attribute  — &
Set parameters
Evaluate Time gate
Initial value -4 4

Increment -4 4

Nr of steps 10 3 | Calculate

Store slices on 'Accept’

Time gate [-8,8]

: @ Accept ‘ @ Help
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Workflow cont’d:

Time gate [-20,+20]ms

@ Evaluate attribute

Set parameters

Evaluate Time gate
Initial value -4
Increment -4

Nr of steps 10 < Calculate

Store slices on "Accept’
Time gate [-20,20]

[QAccept‘ @ Help

Workflow cont’d:

Time gate [-36,+36]ms

@ Evaluate attribute

Set parameters
Evaluate Time gate

Initial value -4

Increment -4

| Nr of steps 10 + | Calculate

Store slices on 'Accept’

Time gate [-36,36]

[QAcceptl @ Help

If you Accept at this point, [-36,36]ms will become the time gate of the attribute that you
were evaluating. In this manner, you decide the optimum time gate.

You may also say that this might be a too large time gate for this feature when compared
with a narrow time gate e.g. [-16,16]ms.
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Workflow cont’d:

. . & Baluateattribute  — O [HESM
9. Once the best time gate has been decided, press e ——
Accept to update the attribute with the selected time —
gate valuate Time gate
Initial value -4 4
10. Update the attribute name according to the selected Increment| -4 4
time gate Nr of steps 10 < Calculate
Slice | U =
11. Optionally, click on the & icon to save the attribute set S
window or tick the Save on close box, and close the Time gate [-20,20]
window. e
N
Workflow cont’d:

Create a seismic output

So far, everything was done in memory. We are now going to calculate and store the
Energy attribute on disk as an OpendTect volume.

1. Click on the Create Seismic Output icon g and select 3D or go to Processing >
Create > Seismic Output > Attribute > Single Attribute > 3D

isScene View Utilities Help

Y reate eismic UN : - Single Aftribute » PN
reate Horizon Output * = ¢ ;
= p 2D <=>3D 7 * | Multi Attribute ... mL
e 4 Wells 4 Angle Mute Function ... MultiCube DataStore ... | l
(Re-)Start Batch Job ... | P4 Bayesian Classification ... ~ Along Horizon »
~ Dip Steering N From Well Logs ... =, Between Horizons »
- GMT Mapping Tool ... Prestack Processing »
e | @ HorizonCube » Yelocky ; ’
0 Madagascar Volume Builder ...
e SISg Re-sort Scanned SEG-Y ...
L —
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Workflow cont’d:

2. Select Energy as the Quantity to output.
3. Select a volume sub-selection:
Inline range: 100 — 300, Crossline range: 900 — | = Position - olENl|
1150, Time range: 432 - 600 ms Specify Position
Press OK.
] Volume subselection Range -
4. Press OK to start the processing. ‘ . . .
In-line Range 100 2 300 2 Step 1 =
r
& Create Volume Attribute Cross-line Range 900 2 1150 2 Step 1 S
|Quantltyto output Energy [-16,+16] | v||© Select .. Time Range (ms) 432 S 600 < Step 4 S
Volume subselection ' 100/900-300/1150 (43 samples) © Select ... )
- | @OK | @ Cancel | @ Help
Null traces @® Discard () Pass
[[] Scale values: ~ Shift/F actor
[ output Cube Energy [-16,+16] | v| © select ... @ CBVS v
Batch execution Single Process v| |44 Options ...
@OK | @ Cancel @ Help

By default the processing is single-machine, To speed up, you can use the multi-
machine processing (requires plugin).

Workflow cont’d:

Volume Rendeting

The objective of the last step of this exercise is to fully visualize the bright-spot in 3D.

1. Right-click on Volume and Add. It will insert an empty volume in the tree which is
centrally positioned in the scene.

2. Position the volume: Right-click on <343-506 / 656-893 / 692-1156> and go to
Display > Position.

i _v/4 Dip ... 1

Vol
S rE——
S R Add Color Blended
4Dip... 11

« @ Volume
4 [V1/343-506 / 656-893 / 692-1154

Y] <right-click>

>

~ Random Line Display * | M Histogram ...
2D Line Duplicate »* Properties ...
“ 3D Horizon Reset Manipulation # Position
¥ 2D Horizon o Lock Treeitem
Fault
FaultStickSet == Remove from Tree

-125-




Workflow cont’d:

3. It will launch a position dialog: fill in the ranges:
Inline range: 100 — 300, Crossline range 900 — 1150, Time range: 432 — 600ms.
Press OK.

4. Select Energy from the window in the Stored category and Press OK again.

= Positioning - O n

Specify the element’s position

In-line Range 100 3/ 300 3 &%

- Select - oIEd

Select Layer 1

9-1 Similarity on FEF seismic A

9-2 Dip-steered diffusion filter

, O e 0 Help Steering 9-3 Fault enhancement filter

9-7 Thickness UVQ6 segment slice520
) Attributes 9-8 UVQ6 Hor 4-8 seament
energy [-28,+28]

SEG
= < >

™
'S Fiter |-

Cross-line Range 900 5 1150 2

Z Range (ms) 432 3 600 <

v

© Cancel = @ Help

BA

Workflow cont’d:

5. Change the color-bar to Chimney and optionally adjust the color range.

[ .
280000 I ‘810000( = Chimney 5

6. In Position modeh , leftclick (keep pressed) and drag to re-position the surfaces of
the volume or just scroll through in this manner to view the contents.

Attributes calculated on the fly can
be displayed using the volume
rendering. For large volumes, it is
recommended to store them prior
displaying to save time.
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1.5.2 Spectral Decomposition

What you should know about spectral decomposition

Spectral decomposition is used to study seismic data at a sub-seismic resolution
or to study attenuation effects caused by hydrocarbons. The method produces a
continuous time-frequency spectrum of a seismic trace. It can be done either by
using Fast Fourier Transformation (FFT) or by using Continuous Wavelet Trans-
formation (CWT). The details on both methods have been extensively described
in literature. In general, the technique separates the time series into its amplitude
and frequency components. The FFT involves explicit use of windows, which can
be a disadvantage in some cases. The CWT uses a mother wavelet which is
extended and compressed for computing the time-frequency spectra. It is equi-
valent to a temporal narrow band filtering. Depending upon the purpose, one of
the algorithms can be selected.

» FFT is used to delineate the stratigraphic/structural information along an

interpreted horizon.
» CWT is preferably used to delineate hydrocarbon attenuations and thick-

ness changes along an interpreted horizon.
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1.5.2a Spectral Decomposition

Required licenses: OpendTect.

Exercise objective:
Study paleo-geomorphological features by displaying 3 iso-frequencies simultaneously with
color stacking.

Workflow:
2D Line
1. Right-click on 3D Horizon in the tree and click on Add
color blended... e
Choose horizon Demo 1->MFS4 from the list of horizons. ngt( o

2. Optionally, to speed up the exercise, click Select for area sub-selection and set

inline range to 200-650; crossline range to 500-1000.
Press OK to apply the changes and then click OK to display the horizon.

' Select Input Horizon (s) e B \
- * . —
! ik ' Position o -E- e
Demo 0 --> FS4 B
¥ Demo 1 —> MFS = Specify Position
rr | L) Demo 2 > FS6 a
& Demo 3 > Top Foresets
= |5 pamo 4 —> Truncation x Area subselection Range ] =
Demo 4 —> Truncation trim & fill
Demo 5 > FS7 In-line Range 200 = 650 < Step 1
Demo 6 > FS8

Cross-line Range 500 5 1000 = Step 1 :

) Cancel| | § Help

Demo 7 --> shallow

Area subselection  100/300-750/1250 (463 samples) ) Select - F
© cancel| | @ Help

emo_2015\Surfaces\Demo_1_—__ MFS4.hor

Workflow cont’d:

In the tree, the horizon appears with 4 separate attribute layers. The three lowest attribute
layers represent the RGB channels (see color flags next to each layer). Three attributes can
thus be blended into a single display.

! OpendTect Pro V6.0.0pre7-20151016/win64: F3_Demo_2015 - [Scene 1]
Survey Analysis Processing Scene View Utilties Help

Al b QB 2 TR - »| crossiine step)

11 Seismics M

N Tree scene 1 s
Eloments Colot

® | scenet

@ In-ine

& | wcussine

. @ Zslice

= ® Volume

~ Random Line
4
9
'

/

Faul
FaulStickSet

Wel
i Pickset
[ Polygon
S Prestack Events
Annotations

liree mem] 4.37.9 GB [
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Workflow cont’d:

3. To define 3 different attributes that will be loaded to the RGB channels of the horizon,

open an attribute set 3D: click on the , | icon.

@) Attribute Set 3D

2 o |1 T

"P'!‘tdr:&affL
Attribute set | <not saved> <A | Spectral Decomposition -2
Input Data 4 Dip steered median fiter | |© Select

Transform type © FFT CWT

Display Time/Frequency panel

Output frequency (Hz 50 < Step 50 =

Adtribute Name Add s new| [l

| Save on Cose

[ @cCiose || @Hew

When the extraction of an
attribute is done on a horizon,
choosing the right time gate
is critical. The time gate
represents the interval of
investigation. If a

symmetrical time gate is
chosen (e.g. [-28, +28ms])
the attribute will highlight
geological features above
and below the horizon. When
an asymmetrical time gate is
chosen (e.g. [-8, 24ms] or
[24, 8ms]) the attribute
response will highlight
geological features below or
above the horizon.

Workflow cont’d:

5. Right-click on Inline in the tree > Add Default Data
Inline 425 will be added to the scene.

Tree scene 1

Elements
Scene 1

t Data
Add at Well Location
Add Color Blended

Ad

6. Reduce Z ranges of the section, so that it just covers the horizon interval: select the

inline and drag the green anchor vertically.

7. Right-click on the 4 Dip Steered Median Filter attribute and select Display > Amplitude

Spectrum...
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Workflow cont’d:

8. Within the amplitude spectrum, identify the frequencies to be used as the low, middle
and high frequencies: the low frequency can be selected as being the first peak (e.g.
24Hz), while the high frequency as the last peak (e.g. 64 Hz).

After choosing the frequencies, close Amplitude spectrum window.

) Amplitude Spectrum for 4 Dip steered median filter o || B
| |

0 2 g[r)equency (HZ)S 100 125
Display between frequencies 0 125 Gridline step 25
Value(frequency, power) 23.7025¢ -5.38955 [v¥| Normalize (v dB scale N
iDlspIay cepstrum B Export ..

Workflow cont’d:

9. Back to the attribute set window: create the first Spectral Decomposition attribute and
set the input data to 4 Dip Steered Median Filter.

10. Set output frequency to 24Hz with a step of 4Hz.

11. Give a name to a new attribute, e.g. SD_24Hz[-8,24ms], and press Add as new.

= Attribute Set 3D o @ .
File
> [ &£
*PSVE R e
Attribute set | <not saved> Frequency [v] Spectral Decomposition &2
SD_24Hz[-8,24ms] Input Data[4 Dip steered median filter 7] |© select
Transform type @ FFT cwr
Time gate (ms) -8 24

Display Time/Frequency panel

Output frequency (Hz|240 5 Step 40 <

A

Attribute Name| SD_24Hz[-8, 24ms] | IAdd as newl a

7| Save on Glose [ @ciose | [ @ Hep
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Workflow cont’d:

12. In the same manner, create the other two attributes for middle (44Hz) and high (64Hz)
frequencies: change the output frequency value and the attribute name respectively.
Click Add as new every time when a new attribute was defined.

13. Click on Close.
Optionally, give a name to the new attribute set, e.g.. Spectral Decomposition (if Save
on Close is toggled on).

@) Attribute Set 30 o [@=
> [ X
P EE R MWL
Altribute set <not saved> Frequency [v] Spectral Decomposition 2
Input Data |4 Dip steered median fitter [+] |© setect
Transform type @ FFT O CWT
Time gate (ms) -8 24

Display Time/Frequency panel

Output frequency (Hz|24,0 = Step 4,0

t
¥
!
N
Attribute Neme [SD_24H2(-8,24ms] | [Add as new] ]
@rep |
Workflow cont’d:
[EITESIE) Scene View Utilties Help
i . . Create Sexmlc Output * hos * gtan 1 ~| ‘ _&\ = &
14. To convert your attributes into Horizon Data. ...
" i (Re-)Start Batch Job .. Horizon Curvature ... [JERINN
go to Processing > Create Horizon Output > D Seaing , | Stratal Ampiitude ..
Attributes > 3D. = GMT Mapping Tool lsocnon

@ HorizonCube »
Madagascar ..
£ ssIs >

15. Select the SD_24Hz_[-8,24]ms attribute to output and the Demo7->MSF4 horizon on
which it will be output and press Run.

16. Process the two other attributes in similar way.

) Select [E=R ]
! Calculate Horizon Data from 3D =@ Select Quantity to output
Quantity to output SD_24Hz[-8,24ms] B |0 Select >
Stored
Atribute Name SD_24Hz[-8,24ms] AT gg,g::;{gé:::}
Fill undefined parts ©) Yes @ No Ig
c )
aleulate on Horizon iy [Demo 1—> MFS4 [+]|© Select I@
Batch execution Single Process 3 [ = Options ]
' © Close l [ @ Help | ) oK I O Cancel| | @il J
L J L J X

Saving as Horizon Data is faster than calculating on the fly along a horizon. Moreover, the
process is done in batch, so can be preferred simultaneously for other Horizon Data.
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Workflow cont’d:
5[] Demo 1 —> ...
] <right-click>

. . 7| <right-click> ==
17. Display the three new Horizon Data D it ko> =
on Demot-> MFS4. rightclick the text 20 torzo SRV soed Cuoo
adjacent to the red channel > Select attribute > _ feutSick  oispay »| SteeringCube  »
. ! Save as Horizon Data »
Horizon Data and select SD_24Hz_[-8,24]ms. . W =
—_ — 2 PickSet
[ Polygon Remove Steering 2D Data »
&\ Prestack Events
Annotations Z values
) Horizon Data oo s
Select one or more attributes to be displayed
on the horizon. After loading, use 'Page Up'
and "Page Down' buttons to scroll.
Make sure the atiribute treeitem is selected
and that the mouse pointer is in the scene.
Fiter *
SD_24Hz[-8,24]ms
SD_44Hz[-8,24]Jms
SD_64Hz[-8,24]ms
[ o [[ccence
18. In the same manner, select SD_44Hz_[-,24]ms - @ 3D Horizon|
- n = [v| Demo 1 > M
data for the green channel and select 7| <right-click>
SD_64Hz_[-8,24]ms for the blue channel. . 2%‘32:32
7] SD_24Hz_[-...
@ 2D Horizon
Workflow cont’d:

19. When blending the three inputs, the results should be similar to the one shown on the
figure.

Some extra steps:

« Try to flip the green channel : right-click on the color bar, a menu pops up which allows you
to flip the color bar).

7105.71 36337.9| I 1 Seismics

Ranges/Clipping ..

« What do you notice? Do you see one feature better than the other ones? Which paleo-
geomorphological features can you interpret? What can you conclude in terms of
depositional environments, water depth, litho-facies, and direction of currents?
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Workflow cont’d:

We normally create RGB with three channels; Red, Green and Blue. A fourth attribute (called
Alpha channel) can be optionally added to highlight structural features like faults/fractures.

20. To define ‘Similarity’ attribute and add it to the fourth layer, open the Attribute set 3D

window with the , :| icon and select Similarity.

21. Select Extension: All Directions.

@) Attribute Set 3D

22. Select Min for Output statistics. ' ~® & el & Wik
Aftribute set | <not saved> <AI> [+] similarity F?
S0 240 Zims] [ mput Data 4 Dip steered median frer -] © seect...
23. Give it a name (M[n_s,‘m[la[flfy) 3'%5%".?1,75‘%} Time gete (ms) 28 |28
i [Eesin Ao 7|
and click Add as new. S ”:“ :
tepout [inl4 4 crif 2
Steering None ]
24, Close the Attribute set window. .
¥
2t
T —|
(oo i S| T i
9 Sevo on Ciose @
N

Workflow cont’d:

25. Right-click on the fourth element on Demo 1--> MFS4 > Select attribute > Attributes 3D

and select Min_Similarity.

@ 3D Horizon

= [v] Demo 1 -> M -
&) <right-click> B _
GEVICIIFEE  Select Attribute il Stored Cubes [ 5
2 So_tdte [ *

SD_24H ove

v 1

@ 2D Horizon 2| Display * | SteeringCubes
Fautt Save as Horizon Data Stored 2D Data
FaultStickSet Tools > | Attributes 2D

@ Body

Remove Steering 2D Data *
Well T Horizon Data (3)
i PickSet I
™ Palvnnn Zveles

SD_24Hz_[-8,24]ms
SD_44Hz_[-8,24]ms
SD_64Hz_[-8,24]ms

»
»

What do you notice? Do you see any structural features (faults, fractures)?

Extra Step: After processing several frequencies to a seismic volume, use PgUP and
\ to toggle between the processed frequencies for the different channels.

X
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1.5.3 Cross-plots

What you should know about cross-plots in OpendTect

The cross-plot tool in OpendTect creates 2D cross-plots for analyzing rela-
tionships between seismic data and well data. Two types of cross-plots are typ-
ically analyzed: seismic attributes vs. seismic attributes and seismic attributes vs.
well logs. The data points are extracted in a given volume or in a region of interest
e.g. by drawing a polygon. The extracted data is displayed in a spreadsheet. The
spreadsheet is then used to manipulate and plot the data.

= Well attribute data

o= = ]

B2 XYY x|l == :Show 100.0% *

Show Inkcrl 27l F

Well data:F02-1,F03-2,F03-4,F06-1 / Attributes

X-Coord Y-Coord
F03-4 623255.82555838 6082552.10243577
F03-4 £23255.82344775 ©082552.10682858
F03-4 623255.82533617 6082552.11121738
F03-4 623255.82922554 €082592.11560619
F03-4 623255.82911396 6082592.12
F03-4 623255.82500334 6082552.12438381

F03-4 €23255.8288917¢6 ©082552.1287731

z (ms)
565.45
570.45
571.45
572.45
573.45
574.45
575.45

“MD (m)
568.57357178
569.57357178
570.57357178
571.87357178
572.97357178
573.57357178
574.97357178

Porosity

0.33620995
0.34664613
0.35052142
0.35206923
0.35128462
0.35052854
0.34973079

[1 Original Seismics *
2683

2854.14648438
2755.22412109

3122

2031.60766602
718.10535702

-653.72827148

The cross-plotting tool has several functionalities. These include the following:

» Scattered plots

» Density plots (useful when larger number of data points are selected)

» Regression fit
o Multi-data selection

* Interactive on-the-fly Geo-body extraction
» Creating Probability Density Functions for rock property predictions

» Vertical variograms analysis

» Extracting pointsets for Neural Network prediction

» ASCII file output

» Quick cross-plot snapshots
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6500000
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1.5.3a Attributes - Attributes

Required licenses: OpendTect.

Exercise objective:

the iso-frequency attributes

Workflow:

color blended. ..

2. Launch the Attribute Set 3D w
window: click on the

;| icon.
A

Aftribute set | <not saved>

3. Choose Spectral
Decomposition from the list
of attributes.

¥ Save on Close

1. Right-click on 3D Horizon in the tree and click on Add

Choose horizon Demo-6 -> FS8 from the list of horizons.

Analyze the attribute response of the bright-spot amplitude anomaly by cross-plotting

' 2D Line
< 3D Horlzon|
2D Horizor, Load ...
Fault Add at Sections Only .

[SUoRa Add Color Biended .
9 Body Track New ...
“ Well o _

=8 Mo “<~|

ad K2 X LY 150

<A

=] ‘simitarity
Reference
Input Data | Reference shift
Sample value
Time gate (ms) Scaling
Semblance
Similarity
Systems Tract
Stepout | Texture
Texture - Directional
Steering None |+

Extension

Output statistic Average =

Attribute Name [Add &s new| [l

[Scwse || @Hep

Workflow cont’d:

&) Attribute Set 3D

pd K 2N Y 1S

Attribute set | <not saved> <Al> [v] |spectral Decomposition

FFT [-12,12]ms 24Hz Input Data 4 Dip steered median fiter

Transform type @ FFT cwT

Tmo gt (1)

[Display Time/Frequency panel|

Output frequency (Hz [24,0 < Step 40 <

[ [+ [ee] [

Attribute Name [FFT [-12,12]ms 24Hz

[Save on Close|

[E=8 8cE =
alira
] [© setect .|
| [Add as new| Fj
Qciose || @ Help
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Workflow cont’d:

7. In similar way define two more Spectral Decomposition attributes of 44Hz and 64Hz.

8. Give them appropriate names, e.g. FFT [-12,12]ms 44Hz and FFT [-12,12]ms 64Hz,
each time pressing Add as new.

9. Uncheck Save on Close and press Close.

= Attribute Set 3D [E=SEGE =<~
File

2 [ X

L AR LT IS
Adtribute set | <not saved> <AI> [+] 'Spectral Decomposition 2
FFT [-12,12Jms 24Hz Input Data 4 Dip steered median fitter [+]|© select
FFT [-12,12]ms 44Hz
FFT [12,12]ms 64Hz Transform type © FFT cwt
Time gate (ms) -12 12

Display Time/Frequency panel

oup remncy 0000 5 s 40 _1] Optionally save the
N attribute set. In this
! case “Save on close”
24/ should be checked.
Attribute Name |FFT [-12,12jms 64Hz | [[Add as e [ia
o
N

Workflow cont’d:

10. Apply these three attributes on the &35 ™
horizon (red-24Hz, green-44Hz, and 7 <ontoico m
blue-64Hz): ”DiH”'" _ e
- - orizon Attribute e tored Cub »
right-click on the red channel and go = fau " | tow I T
Select attribute > Attributes 3D > FFT [ etoay " 2% " SteeringCubes > | FFT [-12,12Ims 4dHz

Y Wl Save as Horizon Data Stored 2D Data * | FFT [-12,12]ms 64Hz

12,12]ms 24Hz. Tools » | Attributes 2D

Remove Steering 2D Data »
Horizon Data (0)

Z values

nts

11. In the same manner select for the green (44Hz) and blue (64Hz) channels.

12. Click on the View icon iy and select View North Z to observe the result.

< | View Cross-line

® ViewZ

~ I View North

il View North Z
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Workflow cont’d:

13. Right-click on the Polygon in the tree > New.

14. Type in the name Shallow bright spot and Press OK.

[>Polygon|

X Prestacl Add ...
&) Annotationsm\

(% Create New Polygon ol o=
Name for new Polygon [Shallow bright spot

Color E] = Magenta [+
I Q ok l © Cancel| | @) Help

b

v

Workflow cont’d:

15. Use left mouse button to outline a polygon.

[ Shalow brighialed

N Prestack Event  Display >
# Annotations Calculate Volume

16. When finished, right-click on this newly added polygon
. = Save
in the Tree and select Close Polygon. | e
Create Body ...
& Lock
(G Export to Google KML ...
Delete from Database
%/ Remove from Tree

¥ g -
N Prestack Event  Display '
& Annotations Calculate Volume ...
. B . * Save
17. Right-click again on the polygon name and Save. B oS
Create Body ...
& Lock
(G Export to Google KML ..
Delete from Databasef
% Remove from Tree =

v
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Workflow cont’d:

18. Go to the menu Analysis > Cross-plot Data

> Attributes Vs Attributes...
or click on the cross-plot | | icon.

19. Select the three attributes just created.

Survey Processing Scene View Utilities Help

|+ Altributes " | Cross-line 0 ~ Ster

oy
Tre ‘% Volume Builder ...

b Els Cross-plot Data & 1.4 Well logs vs Attributes ...

- L Wells Bl & Attributes vs Attributes ..

| Layer Modeling »

Open Cross-plot ...

“‘1 Attribute cross-plotting

525 Eal =X

Select attributes and locations for cross-plot

V]~ Attribute

V] FFT [-12,12]ms 24Hz
v! FFT [-12,12]ms 44Hz
V| FFT [-12,12)ms 64Hz,
T 1[0_deefle_me_as_you_see_semblance]

[0_test HC_well_interpolator]

[1 Original Seismics]

[3D UVQ 6 biased Texture+Energy+SystemsTracts]
3D UVQ Texture+HC attribs+ Energy disk]

5 @

748 [+ Step 9 :

Select locations by Range
In-line Range 100 =

Cross-line Range 300 = 1245 < Step 9 =

Time Range (ms) 0 < /1600 = Step 400 [

Location filters - © Select ...

[ @ox HOCancelH @ Help ‘

b
Workflow cont’d:

20. Select location by — Polygon.

21. Select Shallow Bright Spot polygon.

22 Change Inline & Cross line steps to | Aoueaosploting S8 808

1 and time step to 4ms.

23. Click Select for Location filter.

Select attributes and locations for cross-plot

v~ Attribute

Y| FFT [-12,12]ms 24Hz

7| FFT [-12,12]ms 44Hz

v| FFT [-12,12]ms 64Hz
[000_mmp_test]
[00_nrg_mmp_test]
[0_deelte_me_as_you_see_semblance]
[0_test_HC_well_interpolator]
[1 Original Seismics]

Select locations by |Polygon ﬂ

Polygon Shallow Bright Spot

In-line/Cross-line Step _
Time Range (ms) 0 <1600 = Step

| Q ok ﬁQCancelH @ Help ]

]

Location filters -
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Workflow cont’d:

24. Check the Horizon option.
25. Select the horizon Demo6 -> FS8.

26. Click OK in both windows to proceed.

= e =

Specify Filter

Random -
Subsample
Range
Well
Polygon

Tabl
7] Horizon ]

Body i

Horizon Demo 6 --> FS8 B

Select @ On Horizon To a 2nd Horizon

10

Extra Z (ms) O 3 |0 -

l @ ok [OcanceIJL @ Help j

Workflow cont’d:

27. In the pop-up spreadsheet, select FFT [-12,12]Jms 24Hz to be displayed along X-axis:
click on FFT [-12,12]Jms 24Hz column and then click on Xicon.

28. Assign FFT [-12,12]ms 44Hz to Y-axis: click on FFT [-12,12]ms 44Hz column and then
click on Yy icon.

) Attribute data =N EoE =
B> (KDY Y. [ b b = oonison S e 2 b

area 100/945-286/1134 (401 samples) / On ‘Demo 6 —-> FS8&

X-Coord Y-Coord Z (ms) [X] FFT [-12,12]§[Y] FFT [-12,42| FFT [-12,12]ms *
170/1030 624029.5406... 6075815.513... 529.19 2364.31713867 [ZakBgf:krlici N 806492333984

17211029 624003.1544... 6075864.794... 530.11 3204.86523438 [LECLEMVATEN 5500.46044922
267/993 623037.1936... 6078213668... 525.91 3726.45654297 [[LETEECIENEEN 12096 81542. .
267/997 623137.1546... 6078216.461... 526.07 5122.43896484 [LERLEEEPEM 12621.10839...
266/983 622787.9801... 6078181.604... 526.76 554901123047 [EUCIYEVITEAN 11063.40527...
2671962 622262.4957... 6078192.016... 524.34 5601.13818359 ELICRALECIERN 11131.1875 ~

) Close || @ Help
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Workflow cont’d:

29. Optionally add more attributes to the Y-axis by selecting a column and pressing Y. icon. Or
remove the selection by pressing Unselect icon. Y _

30. Click on the Save icon to save the crossplot data and provide a name and click OK.

31. Press Cross-plot icon

v .
ot

to plot the selected data.

) Attribute data

“‘ XY, Y. [ X @up ¥ o = snowzson [

(= Eol =X~

| Show Inv/Crl =7

<

area 100/945-286/1134 (401 samples) / On 'Demo 6 --> FS8&'

) Create Output
Specify Output

(E=8 HoN =X

Outputto ) Text file @ OpendTect object

Fiter * f...

crossplolSD_24Hz 44Hz =

L)
=

Neme [crossplot_SD_2atz_d4tz |
Qcance\‘[ @ Help

Y-Coord

6075815.513...
6075864.794...
6078213.668...
6078216.461...
6078181.694...
6078192.016...

Z (ms)
529.19
530.11
52591
526.07
526.76
524.34

[X] FFT [-12,12] |[¥] FFT [-12,12| FFT [-12,12]ms “
2364.31713867
3294.86523438
372645654297
5122.43896484
5549.01123047
5601.13818359

6293.77832031 8064.92333984
4638.68017578 5500.46044922
6094.88916016 12096.81542...
6856.9453125 12621.10839...
4505.34326172 11063.40527...
3499.75439453 11131.1875 e

&
Workﬂow cont’d . /% area 102/932-291/1133 (401 samples) / On'Demo 6 --> FS8' Cross-plot [o e =)
snow5000% [ ¥ [Selectony vi -] & ¥ Bl @@ # B & B
- 125000
3 =094
" 100000
32. To have a better feel of the data's behavior B oo
. =1 . M
toggle the density plot Ig button in the o
scattered cross-plot window. 50000
25000
0
’ 20000 TR L1z, 12ms BA s oo
¥ Selected: 0
/% area 102/932-291/1132 (401 samples) / Pn ‘Demo 6 --> FS8' Cross-plot [E=RiEcE =
Showf100,00%| < [E] Y2 | [Selectonf YT -] R = K1 R 8 = & &
1 [t [ Rainbow [
@| 12500
3 =094
P
100000
; 75000
[T 50000
25000
T
Y Selected: 0
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Workflow cont’d:

33. Click on [ ] icon to reverse the selection
tool.

34. Using the selection tool @draw
a free-hand polygon, as shown
in green color on the figure.

35. Click Show points in 3D scene 3 button

36. In the pop-up window choose an option
Selected Points to display the selected
scattered data and Press OK.

18) area 102/932-291/1133 (401 samples) / On ‘Demo o @]
showli00,0088) > (5] Y| [Select only Y1 [-
1 1 [wRainbow
51
» 125000
3 =094
P00
100000
£
:\‘J_ 50000
-
=
25000 -l
oL
0 20000 40000 60000 80000 1000001
FFT [-12,12)ms 24Hz
Y Selected: 8257
= Display Properties [E=8 =8 5|
Display @ Selected Points Al points with attribute
[©K ][O Conce

Workflow cont’d:

37. In the scene, right-click on the green colored

displayed picks > Save as Pickset...

38. Give it a name, e.g. High amplitudes, and press OK.

4 Properties ...
Create Body

(= Create New PickSet oo

Selection Group [l No 1 [
Name for new PickSet] High amplitudes
Color : m Crimson Fl

| @ok |[© cancel [ @ Help ‘
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Workflow cont’d:

39. In the Cross-plot window click on @ icon
to remove the previous selection.

40. Draw a new polygon as shown
on the figure.

41. Click Show points in 3D scene :* button

42. Choose an option Selected Points to display
the selected scattered data > Press OK.

) area 102/932-291/1133 (401 samples) / On ‘Demo 6 --> FS8' Cross-plot

1 M1 [wRainbow

o @=
‘Show(i00,00% -+ (5] Y | [Select only Y1 [ G) R3&
5]

125000
[

r=094
P
100000

75000

50000

FFT[-12,12)ms 44rz

25000

0 20000 40000 60000 80000 100000
FFT [-12,12)ms 24Hz
Y Selected: 6056
/) Display Properties == 5G]

Display @ Selected Points All points with attribute

© cancel

Workflow cont’d:

43. In the scene, right-click on the green colored
displayed picks > Save as Pickset...

44. Give it a name, e.g. Low amplitudes and press OK.

4 Properties ...
Create Body »
Save as Pickset ... ¥

Remove points inside polygon

(&) Create New PickSet (== 80E =

Selection Group [l No 1 ]
Name for new PickSet| Low amplitudes |
Color @ = BlueViolet 3

| ©ox |[@ cancel| [ @Hep |
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Workflow cont’d:

Some extra steps:
» The scattered data selected in the previous figure can be displayed as pick sets. Note that the

separation of frequency highlights two different regions of the bright spot.

» The cross-plot has helped to identify the changes in the gas pocket that are possibly due to
differences in saturation/thicknesses. Optionally, you can repeat the exercise to cross-plot all
three attributes together FFT 24Hz, 44Hz and 64Hz.
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1.5.3b Attributes - Wells

Required licenses: OpendTect.

Exercise objective:
Analyze relationships between seismic attributes and well logs using cross-plots.
Workflow: |
1. Launch the Attribute Set window A > 3D or follow Analysis > Attributes > 3D.
2. Define Instantaneous Amplitude attribute: Select Instantaneous from the list of attributes
and keep all the default parameters for this exercise.
3. Typein a name, e.g. Inst_Amplitude, and Add as new, so that the attribute appears in the
list of defined attributes on the left-hand side.

) Attribute Set 3D [o o=
File
> [ b.¢
2P R Ry b
Altribute set | <not saved> <Al> [» [instantaneous 1?7
Ins_Amplitude Input Data |4 Dip steered median fitter [£] [© sstect .|
Output |Amplitude -l
+
&
z¥
—
[Attribute Neme |Inst_Amplitude | [Ada es new! |5l
Save on Close [@cose | [ @Hep

Workflow cont’d:

4. In similar way define two more attributes: Energy and Dominant Frequency (Listed
under “Frequency” option in the attribute list), using all the default parameters.

5. Close the window.

! Attribute Set 3D

File
2 IR TLY TS

=5 Eon <"

Atribute set <not saved> <Al ] [Frequency o ?
Inst_Amplitude Input Data 4 Dip steered median filter [+] | © select ‘
Energy
Dominant_Frequency Time gate (ms) -28 28
Normalize ©) Yes @ No
Window/Taper CosTaper [] [ View

Taper length% 5

Output Dominant frequency [=]

]

-

4]

=

Adtribute Name [Dominant_Frequency [adaas nev] [Zai

FEAT

Save on Close

If the Save on Close box is ticked, the attribute set will be automatically stored when closing.
\When closing an unsaved attribute set, you will the have the option to store it.
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Analysis | Processing Scene View Utilities Help Estimages
Lt
Workflow cont’d:

+| Attributes b |
& Volume Builder 4 ] 4 Sten 0 4
. i Cross-plot Data * A Welllogs vs Attributes ..
6. Go to the menu Analysis > Cross-plot Data > Wels » 0 Atributes vs Aftibutes

Layer Modeling »

Well logs Vs Attributes. ..
or click on the cross-plot

Open Cross-plot ...

Fluid Contact Finder

Neural Networks >
[ SsIs >
(2, Thalweg Tracker .

7 F1 Velocity Model Building 4
Well Correlation Panel

/',5,\ icon.

s runzun
7. Select the three defined attributes in the [Famewacessem =
Attribute section. - pmbe :
IOU,H:ngmD,(eSﬂ
[0_deelte_me_as_you_see_semblance]
[0_test_HC_well_interpolator]
[1 Original Seismics] e
Vi~ Well UiRd Log
v F02-1 V! Density
v F03-2 vl Sonic
7 F03-4 | Gamma Ray
7| F06-1 | Porosity
| P-Impedance
< P-Impedance_rel
i \E/)Znsﬂy,emted
Extract Between |Markers [+] £ Extract in time Step (m) 1
Selected zone Truncation [o] Fsa |
Distance aboves/below (m) 0 0
Log resampling method Take Nearest Sample [+
Radius around wells (m) 25
Filter position - © Select
@OK || Qcancel | @Hep
Workflow cont’d:
= Attribute/Well Cross-plotting o o=
8. Select all available wells and logs. . e :
v E%E’%m_m‘TW
. . mmp_test]
Use Ctrl+A shortcut to select all items from the list or O
tick the box on top of the item list. [ Oraina Semest .
Zilnd Well v~ Log
v Density
9. Extract between the Truncation and FS4 markers. E’”v“y

¥| P-Impedance
| P-Impedance_rel

7| Density_edited

10. Press OK button to proceed.

Extract Between Markers [¥] 1 Extractin time Step (m) 1
‘Selected zone | Truncation v| FS4 hd
Distance above/below (m) 0 0

Log resampling method Take Nearest Sample [+]
Radius around wells (m) |25

Filter position - © Select

© ool [ @10
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Workflow cont’d:

11. In the pop-up spreadsheet, select GR log to be displayed along X-axis: click on GR log
column and then on

X button.

12. Assign Dominant frequency attribute to Y-axis: click on Dominant Frequency column
and then on Yyicon.

13. Press Cross-plot button };, to plot the selected data.

) Well attribute data

F03-4 623239... 608259.
F03-4 623265... 608257
F03-4 623255... 608259
F03-4 623255... 608259,
F03-4 623265... 608257

F03-4 623239... 608259
F03-4 623239... 608259,
F03-4 623255... 608259,
F03-4 623265... 608257

well: F03-4

F03-4 623239... 608259..
F03-4 623255... 608259..
F03-4 623265... 608257 .
F03-4 623239... 608259..
F03-4 623265... 608257 ..
F03-4 623255... 608259..

F03-4 623239... 608259...

X-Coord Y-Coord Z (ms)

146.9
146.9
146.9
14713
147.13
147.13
147.37
147.37
147.37
1476
1476
147.6
147.83
147.83
147.83
148.07

* MD(m)
662.53
662.53
662.53
663.53
663.53.
663.53.
664.53
664.53
664.53
665.53
665.53
665.53
666.53
666.53
666.53

667.53...

Density
2111.7
21117
21117
2092.6
20926
20926
21377

21377
21377
21504

21504
21504
2177.9
2177.9
21779
21593

Sonic
489.19

489.19...
489.19. ..

500.03
500.03.
500.03.

47442 .
47442,
47442
46720
467.20...

467.20
451.61

451.61...
45161...

462.21

= Y_ % @mmp |4 s = snowi000%[FT

Well data:F02-1,F03-2,

Porosity ~ P-Imped:
5185  0.3363.. 4312050
51.85  0.3363.. 4312050
51.85  0.3363.. 4312050
57.806... 0.3483 4204080
57.806... 0.3483 4204080
57.806... 0.3483 4204080
56.085.. 03201 . 4500510
56.085... 0.3201 4500510
56.085... 0.3201 4500510
58.785... 0.3121 4626120
58.785... 0.3121 4626120
58.785... 0.3121 4626120
62.35 0.2950 4824330
62.35 0.2950 4824330
62.35 0.2950 4824330

...60.929... 0.3066... 4679120

03-4,F06-1 / Attributes

P-Imped: Vp
-78652... 20442
-78652... 2044.2
-78652... 2044.2

-53108... 1999.8.
-53108... 1999.8.
-53108... 19998
-21256... 2107.8
-21256... 21078
-21256... 21078
14698 21407
14698.... 21407
14698.... 2140.7.
52805, 22142
52805, 22142
52805, 22142
91507.... 2163.5...

Density_
21246...
21246...
21246...
2126.0...
2126.0...
2126.0...
21279...
21279. .
21279. .
21297
21297
21297...
21315...
21315

21315

21334...

Inst_Amg  Energy

2280.5
376.86
1680.4

1611.9.

356.73.
22928
15436
336.53
23012
316.47
1475.7
23055
2306.0
1408.5
296.79

24899...

i
&l
H

670482
499611

123512
123451
502202
662454
123395.
504850

123343
647528
640624
123296
510159,

Workflow cont’d:

14. By default, it will plot scattered points of all
wells vs. selected attribute(s). Select one
well from the combo-box to cross-plot an

individual well.

) Well data02-1,F03-2,£03-4706-1 / Attrbutes Cross-plot
ectony Y1 [+ & &' ] @ @R & 3

[E=3 808 ==

0 60
Gamma Ray
¥ Selected: 0

Additionally:

Repeat the steps 12 to 14 by selecting exclusively logs for the X axis and for the Y
axis. Optionally select consecutively two logs to be displayed on the Y axis. The
second log will be displayed as Y2.

When selecting different X and Y quantities in the table, the crossplot display window
will be automatically updated. Use the 4= and * arrows to change the Y column to
the next (or previous) column.
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1.5.3c Bayesian Inversion

Exercise objective:

Perform a Bayesian inversion to predict whether a similar bright spot as the one we have
studied exist elsewhere along the same horizon.

Workflow:

1. Open the cross-plot data saved in the exercise 1.4.3: Analysis > Cross-plot Data > Open
Cross-plot.

2. Select the cross-plot data and click OK.

= OpendTect Pro V6.0.0pre7-20151016/win64: F3_Demo_2015 - [Scene 1] i@} Load Positioned Vector Data Er &=
@ Survey Processing Scene View Uilities Help Select input Positioned Vector Data
Q F | +|| Attributes * | Cross-ine 0 ~ Ste|
‘% Volume Builder "
‘Tre B Fiter
& | Cross-plot Data & i Well logs vs Aftributes - crossplot SD_24Hz_44Hz (=)
f A Wells » |k Aftributes vs Attributes Xplot-Well-Seismic-from-Import
| & Layer Modeling 3 Open Cross-plot ... _— [;
é | = Fluid Contact Finder ... \Z
b= ¢ | 2+ Neural Networks 4
F: ssIs 4 [:
= | 2, Thalweg Tracker ..
- 1 Velocity Model Building  * lﬁ] © cancel| [ @ Help
_..\Features\crossplot_SD_24Hz_44Hz pvds

Workflow cont’d:

3. Inthe spreadsheet, select FFT [-12,12Jms 24Hz to be displayed along X-axis: click on
FFT [-12,12]ms 24Hz column and then on X button.

4. Click on FFT [-12,12]ms 44Hz column and then on Y icon.
5. Press Cross-plot button L to plot the selected data.

“ crossplotSD_24Hz_44Hz oo =
== Y_ % @mp |4 s = snowzson =[] Show InVCr =7

area 100/945-286/1134 (401 samples) / On ‘Demo 6 —> FS8'

X-Coord Y-Coord Z (ms) [X] FFT [-12,12]Jms 24 | [Y] FFT [-12,12]ms 4¢|| FFT [-12,12Jms 64Hz *
170/1030 624020.54069026  6075815.5136924  529.19 8064 92333984
17211029 624003.15440207 6075864 79457039  530.11 3204 86523438 5500.46044922
267/993 623037.19363058  6078213.66824719  525.91 3726.45654297 12096.81542069
267/997 623137.15464542  6078216.46197656  526.07 512243806484 12621.10839844
266/983 622787.98911072  6078181.60426859  526.76 5549.01123047 11063.40527344
2671962 622262.49576557  6078192.01684455  524.34 5601.13818359 11131.1875
158/1034 624137.877912 6075518.43155973  529.79 583996044922 15774.79492188
266/987 622887.05012556  6078184.48799796  527.04 6591.56501797 11367.41992188
2661979 622686.02809588  6078178.90053921  526.85 6729.35253906 10554.22949219
20311014 623606.66206194  GO76628.99739551  539.08 6751.80648438 9672.45410156
2691005 623335.68064061  6078272.02874565  526.38 7178.66804531 9048.19921875
2671001 623237.11566026  6078219.25570593  525.22 7191.24316406 14525.93554688
I

e
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Workflow cont’d:

6. To have a better feel of the data's behavior toggle the density plot ]E button in the

scattered cross-plot window.

= area 102/932-291/1133 (401 samples) / On 'Demo 6 --> FS8' Cross-plot E=n ol =<~ = area 102/932-291/1133 (401 samples) / On ‘Demo 6 --> FS8' Cross-plot B=n ol =<~
Show 50,00% :IE'V; Selectony Y1 [-] & ¥ K1 @ @ = & 3 Show[i00,00% = [ES] Y2 | [Selectony VI -] & * K1 @ B FR & B
| 125000 1 [Tt [wRainbow
s =094 | 125000
o B
100000 .
100000
2
\.z 75000 g 75000
5 — £
; 50000 é 50000
25000 25000
= 0
0 20000 40000 60000 80000 100000 0 20000 40000 60000 80000 100000
FFT [-12,12]ms 24Hz FFT [-12,12]ms 24Hz
Y Selected: 0 Y Selected: 0
Scattered cross-plot Density cross-plot
N
Workflow cont’d:
7. Click on icon to reverse the selection tool.
8. Using the selection tool (& draw a free-hand polygon, as shown in green color on the
figure. K]
9. Click on Create Probablh‘ty Density @) area 102/932-291/1133 (401 samples) / On 'Demo 6 --> FS8ross-plot @] =]
Function (PDF) icon P(x). Showli0000% = [E5) Y2 | Selectony Y1 -] & # [@ [k @ R & %
1 [T | Rainbow [+
s 125000
: r=0.94
100000
g 75000
H
E 50000
=
n
25000 {
0
0 20000 40000 60000 80000 100000
FFT [-12,12]ms 24Hz

Y Selected: 8257
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Workflow cont’d:

10. In the pop-up window choose an option Selected Region.

11. Select Spectral Decomposition attribute 24Hz and 44Hz.

12. Provide an output name, e.g. pdf_bright_amplitudes, and click OK.

/# Create Probability Density Function
Create PDF from [Selected region -]

Attribute |FFT [-12,12]ms 24Hz|v»| Range 0O
More ->

2= Hos =

100000 Nr of Bins |25 —

125000 Nr of Bins 25 =

<- Less

Output PDF [ pdf_bright_amplitudes

-] [© select ...

|_OOK HOCancelH @ Help ]

N

Workflow cont’d:

13. In the Cross-plot window click on ﬁ to remove the points inside the selected area.

14. Draw a new polygon as shown on the figure (left mouse button down and drag).

15. Click on Create Probability Density

Function (PDF) iCOﬂ P(X) . @) area 102/932-291/1133 (401 samples) / On ‘Demo 6 --> FS8' Cross-plot 5
Show(100,00% = [E5) Y2 | [Sslectony V1 ] & ¥ @ R[ER & b
1 [i .1 w1 Rainbow 3
a| 125000
; r=0.94
P(x)
100000
£ 75000
¥
>
£
~
5
. 50000
i
i
o
25000
0 [__._ :
0 20000 80000 100000

40000 60000
FFT [-12,12)ms 24Hz
Y Selected: 6056
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Workflow cont’d:

16. In the pop-up window choose an option Selected Region.

17. Provide an output name, e.g. pdf_low_amplitudes, and click OK.

18. Close the cross-plot windows.

‘“f Create Probability Density Function = (=]

Create PDF from [Selected region ]
Attribute FFT [-12,12]ms 24HZE| Range 0 100000 Nr of Bins 25 s
Attribute FFT [-12,12]ms 44sz| Range 0 125000 Nr of Bins 25 -

(o ] [<iess |
Output PDF [ pdf_low_amplitudes [v| | © select ...

LOOK HOCancelH @ Help \

Workflow cont’d:

’-; Analysis Processing Scene View Utilities Hel

19. Go to Survey > Manage > Probability @ Ssectsetp.. 43 23 55 - o crossined

Session »

Density Functions. e , e
Export N Color
‘ !, Attribute Sets ...
il > | & Bodies ...
Exit Color Tables ...
e le' Cross-plot Data ...
andom
< | 50D Line | FAUMS
@ 3D Horizd "+ FaultStickSets ..
V- 4 2D Horizq W, Geometry 2D
< Eaunsz . Horizons >
e Bi:y ' 3, Layer Properties ...
L Well i, PickSets/Polygons .

ELCL.SC@ « Probability Density Functions ..
Q 2°‘Y?°“k | Random Lines ..
restacl n—
= Annotations | s Sefsmics ’

20 There you can browselEdit PDFS (= Manage Probability Density Function
click on using the icon ¥ or double | - Fiter 7
C"Ck on the PDF [ crossplot exercise 3.3.3 10a

crossplot exercise 3.3.3 10a smoothed
crossplot exercise 3.3.3 10b

crossplot exercise 3.3.3 10b smoothed
Density vs. Sonic
pdf_bright_amplitudes
pdf_low_amplitudes
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Workflow cont’d:

21. View the PDF distribution by clicking the ﬂf) icon
in the Values tab.

22. Smooth the function using the icon Af .

23. Press Ok and save the smoothed PDF
with a new name or overwrite the existing file.

24. In the same way smooth the second PDF and
close the Probability Density Function manager

) Edit Probability Density Function |- |- =)- [[meam]

Edit "crossplot exercise 3.3.3 10a' at SD44 = 3000

Names Values
2500 7500 12500 @ -~ 'n —
147000 O 0 0 0
141000 0 0 0 0
135000 0 0 0 0
129000 0 0 0 0
123000 0 0 0 0~
< UL} »

I QoK ] OCanceIH @ Help |

window.
@) Probability Density F.. [ o || & | &

0 25000 50000 75000 T000Q

100000
.

25000

¥ SpaaHz SD24Hz = |

Workflow cont’d:

Scene View Utilities Help

Create Horizon Output *
(Re-)Start Batch Job ...

~+ Dip Steering
= GMT Mapping Tool ...
{ @ HorizonCube >
Madagascar ...
|E SsIsS >

e

25. Go to Processing > Create
Seismic Output > Attributes >
Single Attribute > 3D...

| Creaio Seismic Output » - Single Aliribute

» | P& Bayesian Classification

D) ...

2D <=> 3D 4
Angle Mute Function ..

Mutti Aftribute .
MuttiCube DataStore ...
= Along Horizon »
™, Between Horizons »

From Well Logs ...
Prestack Processing »
Velocity »
Volume Builder ..

Re-sort Scanned SEG-Y .

26. Select Spectral Decomposition attribute of 24Hz and limit the processing range to in-
line 530 — 750, cross-line 660 — 1040 and Z range 500 — 700ms to save processing

time. Click OK to start batch processing.

Output Cube FFT [-12,12]ms 24Hz

3 .,', Options .

] [© select ] @ cBVS Fl

Batch execution Single Process

' Create Volume Attribute ?HE
Quantity to output FFT [-12,12]ms 24Hz F|[© setect .
Volume subselection 530/660-750/1040 (51 samples) ‘
Null traces @ Discard Pass
Scale values:  Shift/Factor

QoK | @ cancel [ @Hebp |

[F=8 Eo8 =

 Position

Specify Position

Volume subselection Range

5@

In-line Range (530 < |750 < Step 1

Cross-line Range 660 </ 1040 < Step 1 =

Time Range (ms) 500 = 700] + Step 4 —

@ oK HOCanceIW[ @Hebp |

27. In the same way process Spectral Decomposition attribute of 44Hz.
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Workflow cont’d:

[N scene View Utiities Help

28. Go to Processing > Create seismic output > s .
Bayesian classification to launch the Bayesian |  Create Horizon Outout » | 2D <=>3D ,
inversion (Re-)Start Batch Job .. Angle Mute Function ...

. ~+ Dip Steering Ml Bayesian Classification ...
= GMT Mapping Tool From Well Logs ...
& HorizonCube o Prestack Processing »
| 5
Madagascar ... Velocity >
= SSIS R Volume Builder ...
Re-sort Scanned SEG-Y .

!I—Dne—'_
29. Select both previously created and smoothed PDF (to add additional PDF click on

More).
@) Bayesian classification - PDFs o | @ &% = Bayesian classification - PDFs =t
[1] Specify PDF input [1] Specify PDF input
Input PDF 1 | pdf_bright_amplitudes B Input PDF 1 pdf_bright_amplitudes E] e Select,,.‘
More -> Input PDF 2 | pdf_low_amplitudes E]
[ More > [ <Less |
{OcancelH @ Next H @ Help J \OCanceIH @ Next ” @Hep |
&
Workflow cont’d:

30. Provide a weight for each: 1 for the first and 0.8 for the second. Then press Next.

) Bayesian classification - Scaling o || B &

[2] Normalization/Scaling

Normalize Input PDFs @ Yes No
A priori weights @ Constant Variable
For 'pdf_bright_amplitudes"
For 'pdf_low_amplitudes’

Normalize output @ Yes No

iO<BackH_ONexl "I @ Help ‘

The weight functions can be constant as well as variable that
can be input in form of volumes. For instance the weight could
be a function of the well distance, or the vertical distance to
the target.
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Workflow cont’d:

31. Select input volumes corresponding to each attribute.

/v‘* Bayesian classification- Seismics

[3] Specify Seismic input

=1 EoR ==

~||© select ..

Input for 'FFT [-12,12]ms 24Hz" |FFT [-12,12]ms 24Hz

Input for 'FFT [-12,12]ms 44Hz' [FFT [12,12Jms 44Hz

=] |© Select ...

[0<Back”_QNexl I[ ) Help ]

Workflow cont’d:

32. Check the outputs you want to generate, provide the desired names and hit Go.

* Bayesian classification- Output

[4] Select and specify output

v| P: 'pdf_bright_amplitudes' |Probability_bright

B [@ Select } @ CBVS

V| P: 'pdf_low_amplitudes’ |Probability_low

~](© select | @ cBvs

v| Classification: Class |C[ass

||| © Select .| & CBVS

[v] Classification: Confidence |Confidence

][ sees. | s

[v] Determination strength |Determination_strength

[ [ [ [ E]

|| © select .| @ cCBVS

Volume subselection -

[0<Back]@eo ][ @ Help ]
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Workflow cont’d:

33. Right-click on 3D Horizon in the tree > Load > Select Demo6 --> FS8 horizon to

display.

34. Right-click on the Demo6 --> FS8 horizon in the tree > Add > Attribute and select one

of probability attributes from the list.

4 @ 3D Horizon

& Z-slice

@ Volume

~ Random Line
I/ 2D Line

4 [v]Demo 6 -
VIZw Add
' 2D Horiz Display

* .| Atftribute
»
Fault Tracking 4
»
»

Contour Display

Horizon Data
FaultStic Tools

@ Body Workflows
Well

+* PointSelf  ,

[ Polygon| ™

@ Shapefi @l Saveas ..

N Prestact @ Lock Treeitem

Annotations| == Remove from Tree

Reload

Save

35. One by one display all five attributes that were output.
See if other similar bright spots can be recognized.

Change the color bars if need be.

Workflow cont’d:

The “P” is the probability volume associated

to each PDF distribution.

The “Classification; Class” returns
an integer corresponding to the
most| likely PDF at each sample
location.

The “Classification: Confidence” returns the
distance between the most

likely and second most likely PDF distribution.

The determination strength gives a number
related to the relative position in
the most likely position (Histogram count).
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2 Part Il:
Commercial Software

Under a commercial, or academic license agreement OpendTect, the open
source seismic interpretation platform, can be extended with a range of closed
source extensions. These extensions are protected by FlexNet license keys. All
extensions, also the ones developed by other vendors are licensed through dGB.

For purchase/maintenance fees please contact dGB via info@dgbes.com.
As stated before the exercises in this manual can be executed without license

keys as OpendTect does not check license keys when the survey you work on is
F3 Demo.
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2.1 OpendTect Pro

What you should know about OpendTect Pro

OpendTect Pro is a commercial layer (closed source, FlexNet license key pro-
tected) that extends the free OpendTect software with extra functionality. All com-
mercial plugins require an OpendTect Pro license to run.

Among others OpendTect Pro offers:

» PetrelDirect, a two-way seamless connection to Petrel,

An interactive basemap with mapping functionality;

PDF3D plugin for sharing 3D images (see below);

A Thalweg tracker for tracking seismic facies;

An accurate ray-tracer for AVO attributes and Angle Stacks.
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2.1.1 PetrelDirect

What you should know about PetrelDirect

PetrelDirect is a two-way data connectivity solution that enables OpendTect to
work directly on a Petrel data store. Data can either be linked (no data duplic-
ation) or copied. The advantage of copying data is that usage of the Petrel license
is restricted to a minimum. Apart from linking / copying data PetrelDirect can also
be used to set up an OpendTect survey.

The following features are supported with full two-way access:

* 3D seismic volumes
¢ 3D horizons and horizon attributes
e 2D seismic lines

e Fault stick sets

 Wavelets

One-way access: Petrel > OpendTect is supported for:
» Wells: tracks, logs, markers (time/depth curves and/or checkshot data is

automatically transferred with the track if present)
» 3D Seismic pre-stack data.
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2.1.1a Set up PetrelDirect Plugin

Required licenses: OpendTect Pro.

Exercise objective:

To check the setup and verify that the PetrelDirect plugin is installed in OpendTect and Petrel*.

The PetrelDirect plugin allows OpendTect Pro users to seamlessly exchange data with the Petrel* data store of a
running Petrel* project. The data exchange exercise between Petrel and OpendTect can be replicated only if the
PetrelDirect Plugin is installed and OpendTect Pro and Petrel licenses are available.

OpendTect:

1. The PetrelDirect plugin is a part of OpendTect ]
Pro. Once OpendTect Pro is installed, Start A =
OpendTect r— - o x

| Plugn name [Pereiorecs (sase)

Froduct [OpendToct Pro

2. Verify that the PetrelDirect plugin is installed
and license is active: OpendTect > Ultilities >
Installation > Plugins > OpendTect Pro. Select
PetrelDirect

Lirary name [dGePetrelaccess.al

Informaton |Dizect daza access from and

FevEDrEG (S
PetreDirect Tows) (GU1)

Load 8 plug ..

* Petrel is a mark of Schiumberger (]

Petrel*:

To be able to use PetrelDirect functionality in Opendtect Pro, Data access for OpendTect (dGB) plugin must be installed
in Petrel*. Installation can be done either via Windows installer (.msi file) or Plugin Installer Package (PIP file).

Via Windows installer (.msi file):

The Windows installer does both the first-time plugin installation and an update of already
installed plugin to a newer version without any extra actions.

1. Download the .msi file from the dGB's download page in the OpendTect Pro plugin for Petrel*

2. Run the .msi file and follow the instructions.

3. Start Petrel*

4. Go to the Seismic Interpretation tab and observe that OpendTect toolbar is present:

*Petfei is a mark of Schiumberger
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Petrel*:

To be able to use the PetrelDirect functionality in Opendtect Pro, Data access for OpendTect (dGB) plugin must be installed
in Petrel*. Installation can be done either via Windows installer (.msi file) or Plugin Installer Package (PIP file).

Via Plugin Installer Package (PIP file):

For the plugin to update to a newer version, any old version must be EEFCFEEDTT=——
uninstalled first:

1. Start Petrel*
2. In Petrel* main window: go to File > Options > Plugin Manager:
3. In Ocean Plugin Manager window: uninstall the old version

of Data access for OpendTect (dGB) plugin by selecting it and
clicking the Uninstall button.

4. Close Petrel*

® Ocen Plug-in Manager

o ® ¢

Flugins Store  Securlty

‘Ynur installed plug-ns (1)

o

*Petre.’ is a mark of Schlumberger

Petrel*:

To be able to use PetrelDirect functionality in Opendtect Pro, Data access for OpendTect (dGB) plugin must be installed in
Petrel*. Installation can be done either via Windows installer (.msi file) or Plugin Installer Package (PIP file).

Via Plugin Installer Package (PIP file): SR
nl
For a first-time installation, or once the plugin version is uninstalled: ,.'";l )
1. Download the PIP file from the dGB's download page in the B
OpendTect Pro plugin for Petrel*. [QT;

2. Start Petrel*
3. In Petrel* main window: go to File > Options > Plugin Manager:

ma

In Ocean Plugin Manager window:

4. Click on Install plugin button

5. Locate the PIP file and click Open

6. Once the installation is finished, click Close in both windows
7

8

=9

Restart Petrel*
Go to Seismic Interpretation tab and check that the OpendTect toolbar is present

ing

i 5 Surface atributes | %
¥ N St g 4
Velume  Mixer ) T Geobody § o Gury
sttibutes - 4 Meulnet - interpretation - (=3} & | adsce edting @
Aibutes Volume interpretation Structure | Structural fr.. | Depth Utiities

S8 L 4 Waveetsobex
]
S— ) E:
B | seismic (cefaut) - o E@ Log conditioning
-@ 0| welitie - @ Well tie adkting

Setup % | Seismic-well calibration 1 | 2D/3Dimerpeetation %

Insert
Dema0 -

*Petre.’ is a mark of Schlumberger
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Link OpendTect and Petrel* projects

PetrelDirect status button B- helps monitor the status of the connection to Petrel*. Clicking the button will open the settings
window. The drop-down menu next to it allows to directly control the status of the connection:

. - disabled (drop-down menu next to it allows to Enable connection)

* & - uninitialized (connection is enabled, i.e. will be activated once PetrelDirect is used; drop-down menu next to it allows to
either Disable connection or Initialize now)

« 4 - active (drop-down menu next to it allows to Disable connection)

If the connection is enabled and left initialized, the PetrelDirect status will become active once Petrel is used

1. Start Petrel* and Select the Project of interest.

2. Start OpendTect. At startup, the Petrel connection [X] is disabled (in the
lower right corner of the main OpendTect window). Select Enable from the
drop-down menu. When the connection is enabled, the PetrelDirect status
icon becomes active []

3. Select Initialize. The icon turns pgindicating that the connection has been
established between Petrel and OpendTect.

* Petrel is a mark of Schlumberger

Choosing the preferred Communication Port (TCP/IP)

Petrel:

By default the plugin should use the TCP/IP port 57375; if this port is not available or accessible,
it can be changed in two ways:

1. From the Petrel plugin user interface, which is available under the 'Seismic interpretation' tab in
the Petrel* ribbon.

Seismic Interpretation

9 &

Log conditianing

' @& o B @ %
= X fa ion =
isent  Geobody Structure Make  Polygon G n
4B Well tie editing - interpretation toois- | ) Q€ Manager Ay Map-based volumes | sumace  eamng (@B Surtace editing - Lr OperdTea
well caioration 20730 interpretation = | Mesh Attributes Volume interpretation Structre | Structural famewark Deptn Uteities Gury CpenaTect

(B setings forOpendTct comnecticn -~ o x

IP Communication Port 737

| OpendTect installation direciory |C\Progian Fles\OpendTects 6.0 Select ..

=
2. By adding an environment variable DTECT_PETREL_PORT, and setting the value to the
preferred port number which is available for access.

OpendTect:

The Petrel* connection setting can be set and modified in the PetrelDirect status window. The
TCP port number must be the same as the port number specified on the Petrel* side. The default
value of 57375 should work in most cases. L

Link siaius (98] (Ackve)

16 perto 7T

Disable comection an enor @ Yes No

Enatle comection at stanp ® Yes No

* © Al O Close @ Help
Petrel is a mark of Schiumberger
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Required licenses: OpendTect Pro.

2.1.1b Set up Survey using PetrelDirect

Exercise objective:

To show how an OpendTect survey can be quickly set up from an existing Petrel* project

using PetrelDirect.

Workflow:

1. Choose Select/Setup option under the Survey menu

or click on the Survey Setup icon Q .

2. Click on the Create New Survey icon ¢ in the i

Survey Setup and Selection window.

*Petre.’ is a mark of Schlumberger

Import
Export
Manage
Pre-load

Exit

=) Survey Setup and Selection x
El5urvey Data Root ... | [C:\Surveys |o @
AusNW_Shallow-Demo_2018_PdC F3 Demo 20 G
AusNW_Shallow-Demo_PdG [
F3_Demo_2018_PdG . ose |G

F3_Demo_2020
F3_Demo_2020_20jul21
F3_Demo_Fault_Extraction_2018_
Groningen_Petrel_model_depth_mn
Groningen_Petrel_model_depth_m
My_New_Survey
Survey_from_Petrel

Sil o [EICT Y|

100/300 owzse

Workflow cont’d:

3. Specify a Survey name; select Use
PetrelDirect; Set Time for Z Domain and
press Next.

4. Select a seismic data set from the
Petrel project to set up the OpendTect
survey

5. Press OK.

@ Get survey setup from Petrel = m] X

Base the OpendTect survey on

v 5 Seismic
Input Seismic Survey F3 Demo
F3 Demo ~ In Seismic ~
[Tx] O @

@ Create New Survey - O X

Specify new survey parameters

Survey name HSurvey From Petrel ”

Available data [4] 3D 2D

Initial setup [ Use PetrelDirect
= Scan SEG-Y file(s)
4 Set for 2D only
1! Scan Navigation Data
K Copy from other survey
T Read from Survey Setup file
) Enter by hand

Z Domain @ Time | O Depth

QCanceI 0
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Workflow cont’d:

6. You would see the survey
information filled-in
automatically from the selected
Petrel* project set-up. Press
OK to set-up the survey.

7. Apop-up message asking if you
want to proceed with the data
import. Select No, if you don’t
want to proceed with bulk data
import from Petrel.

o Proceed to import all listed data?

=

@ Edit Survey Parameters

Survey name Survey From Petrel

Location on disk C

\Surveys
Survey type Both 2D and 3D~
Ranges/coordinate settings Enter below v

1= Survey ranges @ Coordinate settings 2 1/C to X/Y transformation @ Coordinate System

Inine range (100 2] (750 2] step [1 2| Nr. In-lines: 651
Cross-line range \300 = \1250 <) Step \1 +| Nr. Cross-lines: 951
Zrange 0 (1848 |step 4 millisecond v

Display depths in ® Meter (O Feet

Seismic Reference Datum (m) 0 ]

= Apply

[Eo ] Ocne @

Free space on disk: 35.97 GB
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2.1.1c Import data from Petrel using PetrelDirect

Required licenses: OpendTect Pro.

Exercise objective:
Import data from Petrel* to OpendTect using PetrelDirect.

Introduction
PetrelDirect is an OpendTect Pro feature for direct data transfer between CigandTect and Petrel* projects. Reading data from a
Petrel* project is available in various OpendTect workflows via insert icon , which allows to either access data directly from a
Petrel* data store via links or physically data copy to an OpendTect project:

Link to Petrel*:

+ no data duplication;
+ data is available only when the Petrel* project is running and PetrelDirect connection is active (i.e. Petrel* license is tied).
OpendTect copy:
+ physical copy data in OpendTect format;
« no restrictions on data access (i.e. Petrel” license is not tied and data is accessible to all users).
Either method gives full potential for manipufatfgn, interpretation and processing. Writing data to a Petrel* project is also available
in various OpendTect workflows by choosing PetrelDirect output format.

PetrelDirect support the following objects:

+ Full two-way access (Petrel* <> OpendTect):

Faults and FaultStickSets, 3D horizons, 2D and 3D seismic, Wavelets, Wells (tracks, time-depth models and logs)
+ One way access (Petrel* > OpendTect):

2D horizons, 3D prestack seismic, Wells (markers)

Batch processing for importing objects is now available for Faults, FaultSticks, Horizons and Seismic Cubes.

A check box to use the original name is provided which should be checked in case the same needs to remain identical to the
object in the Petrel project. Any name entered into the field adjacent to this will be used as the 'base name' for the objects.

The following exercises will cover some examples of data exchange between Petrel and Opendtect .

Exercise objective:

Use PetrelDirect to import all data in one go from Petrel* to OpendTect at Survey creation.

Workflow: o Proceed to import all listed data?
oo

1. Perform the same steps as in Exercise 2.1.1b to set g
up an OpendTect survey using PetrelDirect, except s omsee aioeas

the last step. At the pop-up message asking if you e —
want to proceed with the data import, Select Yes, to :m E:WH
proceed with bulk data import from Petrel. 24
[ 6 Block
2 A Fos-1
2. Select All Objects in the Datatypes and Hit OK. For a T oo
large amount of data you can use the ‘Execute in gst’w;n';%”:iéfm
Batch’ option. s

[ ¥ Demo 0 > F54 Petrel

B Demo 1> MFS4 Petrel

[ ¢ Demo 2 > FS6 Petrel

& Demo 3 > Top Foresets Petrel
[] ¥ Demo 4 —> Truncation Petrel
[ @ Demo § --> F57 Petrel

() 84 Dermo 6 > F58 Petrel

Note that ‘Datatypes’ and ‘Filter’ can be used to list %Eﬁi,,ﬁﬁ‘;ﬁfw
. [] @ tstadel_Inter_Dema 0 -> FS4
and select only the data of interest to be loaded. 2@ e i ard—> o
) Execute in Batch Options
Q| @

*Petre.’ is a mark of Schlumberger
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Exercise objective:
Use PetrelDirect to import 3D seismic from Petrel* to OpendTect.

Petrel* 3D seismic cube can be accessed in OpendTect by clicking on PetrelDirect insert icon & in the following places:

+» Manage 3D Seismics window (Survey > Manage > Seismics > 3D... or click on §f, icon in the Manage Data toolbar)

« Select window when adding a seismic attribute display at In-line/Cross-line/Z-slice/3D Horizon in the 3D scene

= Other workflows, including attribute definition and processing, etc.

Petrel* seismic data must have compatible geometry with OpendTect survey set up. The easiest way to achieve this is to get survey
set up from Petrel* when setting up a survey and choose an appropriate Petrel* seismic survey folder as the geometry source.

Workflow:

1. Perform the same steps as in Exercise 2.1.1b to set
up an OpendTect project using PetrelDirect.

Pkt Pobrgos.
P Densty Factions
Seai

2. Select Survey < Import < Seismic Data < PetrelDirect
< Cube. Select the Seismic cube from the Import
Petrel Seismic Cube window.

Nelocky Forctims:
Miaroels

3. Create either Link to Petrel* or OpendTect Copy. Note S = =2
that the Link to Petrel option, requires Petrel License "8 ot e
to be able to use the seismic in OpendTect. BB v s ez
Vahume subselection |100/300- 750/ 1250 (463 sameles) © Select
4. Keep the default parameters. Tick Use Original Name =~ m :
Output Cube and Hit Run. T Clmomiem com o g
' Eelo= e

*
Petrel is a mark of Schlumberger N by G Pl OpeseiTeet comection

Exercise objective:
Use PetrelDirect to import Faults from Petrel* to OpendTect.

Petrel* fault interpretation can be accessed in OpendTect as Faults by clicking on PetrelDirect insert icon % in the following places:
*Manage Fault window (Survey > Manage > Faults... or clickon _ icon in the Manage Data toolbar)

*Select Input Fault(s) window when adding Fault(s) to the 3D scetw; 2D viewer or Basemap by right click on Fault in the tree > Add)
This workflow is similar to import FaultStickSets from Petrel to OpendTect.

Workflow:

1. Perform the same steps as in Exercise 2.1.1b to set = sl i oo Ui T o
up an OpendTect project using PetrelDirect. ] _swnn i A =3

2. Select Survey < Import < Faults < PetrelDirect. Select 123 oma nDaa
the Fault from the Import Fault window. — — -

- = Filter = 2

3. Create either Link to Petrel* or OpendTect Copy. Note | - = e e g
that the Link to Petrel option, requires Petrel Licenseto . .. . :
be able to use the Fault in OpendTect. ) Use gl M. Fackt 1AL 20 G et

[ Execute in Batch - Options
4. Keep the default parameters. Tick Use Original Name R

Output Cube and Hit Run.

Note that OpendTect does not support crossing fault sticks (a fault plane cannot cross itself). If faults were picked on inlines,
crosslines and horizontal slices, only the largest subset of the three will be used to import the faults. Manual editing (removing
unwanted sticks) is possible after import and might be required in some cases.

* Petrel is a mark of Schlumberger
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Exercise objective:
Use PetrelDirect to import 3D Surfaces from Petrel* to OpendTect.

Petrel 3D horizons and surfaces can be accessed in OpendTect by clicking on PetrelDirect insert icon &  in the following places:

+ Manage 3D Horizons window (Survey > Manage > Horizons > 3D... or click on 4 icon in the Manage Data toolbar)

= Select Input Horizon(s) window when adding 3D Horizon to the 3D scene, 2D viewer or Basemap by right click on 3D Horizon in the tree > Add)
= Other workflows, including 3D Horizon gridding and filtering, creating flattened scene, etc.

This workflow is similar to import 2D Horizon from Petrel to OpendTect.

Workflow:

1. Perform the same steps as in Exercise 2.1.1b to set
up an OpendTect project using PetrelDirect.

2. Select Survey < Import < Horizon < PetrelDirect< 3D
Horizons. Select the Horizon (s) from the Import Petrel
Horizon window.

3. Create either Link to Petrel* or OpendTect Copy. Note
that the Link to Petrel option, requires Petrel License to
be able to use the Horizon in OpendTect.

Hortacn progeties/airdes;

Create O Linkto Petrel # GpendTect Gopy
5 s Ol Mo Hotzon O st

4. Keep the default parameters. Tick Use Original Name Breen
Horizon and Hit Run.

OpendTect project is based on a particular 3D survey set up. Petrel* 3D horizons associated with 3D seismic surveys which
geometries are different and Petrel* surfaces based on grids which are different are snapped to an OpendTect grid during import.

[Ern ] ©ce @

*
Petrel is a mark of Schiumberger

Exercise objective:

Use PetrelDirect to import Wells from Petrel* to OpendTect.

Petrel well data (deviation survey, time-depth model, logs and well tops) can be accessed in OpendTect by clicking on PetrelDirect
insert icon g in the following places:

* Manage Wwvell window (Survey > Manage > Wells... or click on 4 icon in the Manage Data toolbar)

* Load Well(s) window when adding well(s) to the 3D scene or Basemap by right click on Well in the tree > Add)

» Other workflows, including well-to-seismic tie, Log attribute definition and processing, etc.

Workflow:

1. Perform the same steps as in Exercise 2.1.1b to set

[=3 Filtes

up an OpendTect project using PetrelDirect. e,

2. Select Survey < Import < Wells < PetrelDirect. Select e E e
the Wells(s) from the Import Petrel Well window. w::;::ﬂ; il

3. Create either Link to Petrel* or OpendTect Copy. Note T

that the Link to Petrel option, requires Petrel License to
be able to use the Wells in OpendTect.

4. Keep the default parameters and Hit OK.

Selection of well logs and markers can be done using the Filters, Show only
common logs/markers switch, then Select buttons.

Create O Link to Petrel @ OpendTect Copy

3 cancel | @

*Perref is a mark of Schiumberger
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Exercise objective:

Use PetrelDirect to import Wavelet from Petrel* to OpendTect.

Petrel* wavelets can be accessed in OpendTect by clicking on PetrelDirect insert icon in the following places:
* Manage Wavelets window (Survey > Manage > Wavelets or click on @ icon in the Manage Data toolbar)

Workflow:

1. Perform the same steps as in Exercise 2.1.1b to set
up an OpendTect project using PetrelDirect.

2. Select Survey < Import < Wavelets < PetrelDirect.
Select the Wavelets (s) from the Import Petrel Wavelet

Wl ndOW. @ Import Petrel Wavelet
- =7,
~ [ seismic
3. Create either Link to Petrel* or OpendTect Copy. Note e
that the Link to Petrel option, requires Petrel License to ™" e
be able to use the Wavelet(s) in OpendTect. e ey (e e ===
oo @
4. Keep the default parameters and Hit Run. Gccad o, s Lo o A cope o .

* Petrel is a mark of Schiumberger

Exercise objective:
Use PetrelDirect to import Pointsets and Polygons from Petrel* to OpendTect.

Petrel pointsets and polygons can be accessed in OpendTect by clicking on PetrelDirect insert icon & in the following places:

» Manage Pointset/Polygons Windows (Survey > Manage > Pointsets/Polygons... or click on the “, icon in the Manage

Data toolbar). When adding from PointSet/Polygon manager, user will have a selection box to choose which kind of object they
want to import from Petrel*

* Load Pointsets (Polygons) window when adding pointsets (polygons) to the 3D scene or Basemap by right clicking on Pointsets
(Polygons) in the tree > Add). The relevant dialog box pops up.

Workflow:

1. Perform the same steps as in Exercise 2.1.1b to set
up an OpendTect project using PetrelDirect.

2. Select Survey < Import < Pointsets/Polygons < B impoperipoineie
PetrelDirect < Polygons (or Pointsets). Select the S =]
Polygons (s) from the Import Petrel Polygons window. 2 I g romd st Suce.pomo 0> 4
. . * 4 use Original Name PickSet Group around tst2del_Surface_Demo © Select ...
3. Create either Link to Petrel* or OpendTect Copy. Note [E5] 0o ©

that the Link fo Petrel option, requires Petrel License to
be able to use the Polygons/Poinsets in OpendTect.

4. Keep the default parameters, Use Original Name and
Hit Run.

* Petrel is a mark of Schiumberger

- 167 -



2.1.2 Basemap

What you should know about the basemap

The basemap utility in OpendTect Pro is a new module for interacting with the
data while presenting a clear overview of the interpretation exercise at hand.
From the basemap the user populates a 3D scene with data elements (inlines,
cross-lines, random lines, 2D seismic lines, Z-slices, horizons, wells, etc.) and / or
pops up 2D viewers. The module also features options for gridding / contouring
and for creating final maps. As the module is brand new in version 6.0 some func-
tionality will evolve as the product matures over time.
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2.1.2a Basemap

Required licenses: OpendTect Pro.

Exercise objective:
Use the Basemap to populate/manipulate the 3D scene.

1. Pre-load 4. Dip steered median filter (optional, see
Exercise 1.3.1b for details).

2. To open the basemap, click on the @ icon or go to
View > Basemap.
3. Add an inline to the basemap and the 3D scene*. This

can be done in 3 ways:

a) Press (once) keyboard | and drag the line to the
correct position : the line humber is shown in the
tree and in the lower left corner.

b) Move the cursor in the basemap to the correct
position; right-click and Add Inline.

c) Right-click in the basemap tree > Add.

: F3_Demo_2015 - [Scene 1]

Utilities Help
X Work Area I Step 0
Z-Scale

Viewer 2D

Stereo Viewing *

Toolbars »

Add Cross-ine
Add In-iine and Cross-line.

600 1200 0 2000 4000m

Basemap Tree a8

Elements
Settings
V] @{in-line!
V| i Cross
v| & Z-Slice
v| @ Seismic Outline

S N T

Color

The basemap can be used: 1) to populate a 3D scene; 2) to pop up
2D viewers; and 3) as standalone utility, e.g. when creating output

) Basemap - Scent
Basemap Processing | Synchronization | He

To insert a new node after the random line is drawn:

Hover over the random line until it shows up in bold and
then shift + click.

To delete a node ctrl + click on it.

M o= I 2D Viewers .
maps. All options are controlled from the Synchronization menu. . |Basemap Tree ﬂ_g
Workflow cont’d:
4. Move the inline to a new position: hover over the @ 5
inline until it shows up in bold; left-click and drag to
the new position*.
5. Add a crossline with pressing (once) keyboard C. + s
6. Add arandom line pressing keyboard R; Left-click
to add corner points and double-click to end the line.
62 — ///—/— —

[] 4000 8000m

*If the basemap is synchronized with the 3D scene (as in this exercise) you can also re-

position elements using all options supported in the 3D scene, e.g. miss2 sept = 4w |
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Workflow cont’d:

&0 A wen ,
5 4| Add
7. Right-click on Well in the basemap tree b
and select Create Group. & h| FProperes...

=l Remove All

8. Add F02-1 and F03-2 to the group.

% Select Basemap parameters (= o 5
9. nght-C"Ck on the GI'OUp and select Well symbols |!oilwe|| |+] size [5 | 71 Display Projection
Properties.
For the sake of the exercise let's assume

these wells are oil wells: select the

corresponding Well symbol and change
size to 5.

10. Repeatthe exercise for F03-4 and FO6-1: 562
Give another well symbol to these two, say :
oil and gas.

507.

0 4000 8000m
e —

[

Workflow cont’d:

11. Add other elements (horizon, contour, shapefiles, ...)
and change the basemap settings (right-click on
Settings). Basemap Tree a

Elements Color

12. To create final maps you can process your horizon -
before printing: under the Processing menu you will find

; T Py v In-line
options for filtering or gridding. Basemap Synchroniz . -
e Filtering T i Cross-line
= Gridding ... - Z-slice

] F3_Demo

@ Cube Outline
~ Random Line
1] 2D Line

@ 3D Horizon
< Contour

~4 2D Horizon
FaultStickSet
A Well

i PointSet

[ Polygon

¥ Shapefile

=] Image

FE Annotation
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2.1.3 PDF3D

What you should know about PDF3D

The PDF3D plug-in supports the capture of a 3D scene in OpendTect and to save
the captured information in PDF format. The 3D PDF file can then be viewed,
rotated, zoomed, and manipulated in Adobe’s free Acrobat Reader software that
is installed on most computers. PDF3D thus greatly improves communication of
complex seismic interpretations. The PDF3D plug-in to OpendTect allows volume
sections, horizons, wells and interpretation features to be embedded within a
secure technical report.
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2.1.3a PDF3D

Required licenses: OpendTect Pro.

Exercise objective:
Grab a 3D scene with PDF-3D for sharing via Acrobat Reader

N [ || s
- SEG-Y
Workflow: “* Save scene
‘g4 Save scene as...

1. Prepare the scene you wish to capture and
press the drop down sign adjacent to PDF-
3D icon 1. Select Save scene as...

2. Specify the Output PDF file name (e.g.
Example_pdf3d) and select Half the
resolution for the horizons.

= Save scene as - oIEN
Output PDF file name [\Example_pdf3d.pdf O Select ...
Select horizon resolution | Half v

[T] set password for open exported PDF3D

QoK || cancel | @) Help

Workflow cont’d:
Preferences
Categories: 3D and Multimedia Options
. . . Commenting - Renderer Options

3. Open the file in Acrobat Reader v8 (or higher). Documerts Prefered Renderer

gﬂ‘efs' ‘ [ Enable hardware rendering for
) o ageDislay _

4. Ensure that double-sided rendering is enabled. Rt ok i maeno

Accessibility Preferred 3D @‘!l Rendering Mode:

5. Use the left most icon on the toolbar to zoom, pan, rotate
etc.

6. Use the tree to toggle elements on and off.

Q Views
R 4 model
£ [ OpendTect Scene -- dGB
=i Well: F03-2

7 [ Log: F03-2.1
% Track F03-2
% (¢ In-Line: 425
3] ¢ Survey box
=1 ¢ Horizon: Demo 0 --> FS4
& Horizon: Demo 0 --> F:
& PDF3D-SDK Lights From File
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2.1.4 Thalweg tracker

What you should know about the Thalweg tracker

A Thalweg is a geologic term to describe the path of a river as it flows through a
valley (Thalweg is a German word; Thal means valley and Weg is path). A Thal-
weg tracker operates in a similar way: it follows the path of least resistance. It
does this by adding only the best matching position per iteration. The tracker can
be used to track 3D bodies and / or horizons and is typically used for detailed seis-
mic facies mapping e.qg. for tracking channels.

The Thalweg tracker tracks samples in an input seismic cube based on certain
user-specified constraints. Initially the user points a single seed position. The
seed is considered to be a cube of unit size and the next sample to be tracked is
chosen from all available samples along the 'faces’ of the seeds. In the first iter-
ation, all six neighboring samples along the six faces of the initial seed act as can-
didates for tracking. Only the best matching position is added. In the next
iteration, all samples neighboring the two currently accepted positions now act as
candidates and again only the best matching position is added. This process con-
tinues until it is no longer possible to add candidates that meet the tracking con-
straints.

A Thalweg tracker adds only one position per iteration. If you choose to accept
more than one position per iteration, the Thalweg tracker becomes a margin
tracker. Thalweg and margin trackers are typically used sequentially. For
example in the exercise hereafter we first use the Thalweg tracker to track a chan-
nel. Once the channel is found we change the settings to track the channel mar-
gins.

The output of a Thalweg tracker is a Point Set that is typically converted into a
"snapped" horizon. All tracking attributes can be saved with the horizon tracked in
this way. The tracking attributes can also be used for further analysis in the Cross-
plot tool.
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2.1.4a Thalweg Tracker

Required licenses: OpendTect Pro.

Exercise objective:
Track a channel (and its associated margins) using the Thalweg tracker.
Elements Color
Workflow: Scene 1
.,‘lg,‘:_
. i i & zs| Addand Select Data
1. Add an inline with default data in the @ Vol Add at WellLocation
~ Ra__Add Color Blended
scene.
= Thalweg Tracker | =8 Eon = |
2@
2' Laun(:h the Thalweg tra.Cker from the \npmcube[r‘é i’] 4 Dip steered median fiter [+]|© select
Ana|y5|5 menu (Ana|ySIS > Tha|Weg Area subselection |100/300-750/1250 (463 samples) [© setect..|
tracker) or click onl, icon. siart Poston (niGr) 2(me) (&) vaie
Event to track ® Minima Maxima
3. The default data volume for this tin Treshos toxThreshold
survey will appear automatically in e seactt
) Amplitude Sum Scaler 1 Amplitude Sum Step (ms) 1
the Input Cube field. i TR ———r—
1/1000 ok ot Appicaie 0.000 |=
The Thalweg tracker is not a conventional B
tracker: it is using a weighted voxel e
> X A Output horizon [-][© setect .| ®acs [
approa_oh tO tra.Ck.Se|Sm|C faCIeS- 7] Snap to event; Search gate (ms) -4 4
Hence it is not limited to map channels. (Grestenoron
©) Close|
Workflow cont’d:
4. Move the inline to 365: click on the inline 425 and type in inj425 [Sistep1_{5] 4 mup | [ 4500
365 in the Slice Position toolbar, or use the basemap and ) ;'1
drag the inline to the wanted position. ® | scenen
& = In-line
m
B . . . =4 TOb steered me....
5. Pick an event: press % icon and pick a seed at crossline | @
647 at 1024ms.
o365 St 1 (24| [ = 5 @ 5 B 2y G L | 4500 [ 0 [nasemics [ i
e » D —— e e— — ©
Fe, - — — e e
o ~EYT
/ = mputcube () [&] 4 Dip steered median fiter ] |© select
= Avea subselection 100/300-75011250 (463 samples) © select |
= = — = Stat Postion (niCr) (365 |[647 | 2 ms) 1024 (R vaue: 5220
Min Throghew®™ 10478 Max Threshold O
. Ampitude Sum Scaler 1 Ampltuge Sum Step (ms) 1
——— S Scheque | MaxNeCels  Celoperiemion  Cutoficriera  Cuofivave | (]
G, e 9 Show Ports
S 0 f»"s’;:f:—‘f-"_ Outputorzan [ (@ sdeci] acs el
The software will snap to the nearest event (Minima or [~ [, e
Maxima, as chosen by the user) automatically for the = o]
picked position and fill the corresponding fields. - TN
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Workflow cont’d:

! Thalweg Tracker =&]
> < [k
(4
Input cube 4 Dip steered median filter B
Area subselection | 100/300-750/1250 (463 samples) e Select ..
Start Position (Inl/Crl) | 366 647 Z(ms) 1024 m Value: -5239
Event to track @ Minima Maxima
6. Keep default values for P p— N
- . in reshol - iax reshol
Amplitude Scaler, Amplitude
. Amplitude Scaler 1
Sum Scaler and Amplitude
Amplitude Sum Scaler | 1 Amplitude Sum Step (ms) 1
Sum Step (ms). .
Schedule Max Nr Cells Cells per iteration Cut-off criteria Cut-off value | @
[11]1000 =K Nofhppicable 0.000 ‘ =

7. Schedule: set the values as
shown in this screenshot.

8' Press the TraCk bUtton to V] Show Points | Display Settings

start reading the input Erori e —— e
volume and tracking.

V] Snap to event; Search gate (ms) -4 4

IS

[

The first row of the schedule table represents the thalweg settings e.g. Max Nr Cells = 1000
and Cells per iteration = 1.

Workflow cont’d:

9. Once the processing is finished, it will display the result as color-coded points.

= Thelweg Tracker [E=2 608 =]
ol A

input cube (&) (] (4 Dip steered median fiter [] [© select..]
Area subselection |100/300-75011250 (463 samples) © select
Start Positon (I/Cr) 385 647 | 2(ms)[1024 | [R] Value: 5239

Eventto track ® Minima © Maxima

Min Threshold |-10478 Max Threshold |0
Ampltude Scaler 1

Amplitude Sum Scaler 1 Ampiitude Sum Step (ms) 1

Schedule Max Nr Cells Celss per iteration Cutoff criteria Cutoftvaue | (4]
1/1000 4 +[Not Appicable 0,000

[ Track | [ViewLog .|

7 Show Points Display Settings ...

Output horizon [+] [© select .| @dcB [
7] Snap to event Search gate (ms) -4 4
Create horizon] 3

@ Close

Output of the extracted channel.
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Workflow cont’d:

10. If you are satisfied with the results, specify the Output horizon name. Optionally, toggle
on Snap to event, to output a horizon snapped to the nearest Minima or Maxima in a user

defined Search gate (default is [-4 +4] ms).

11. Press the Create horizon button.

=)
————

C——— e ——

= Thalweg Tracker (=5 (Eo8 <=
% E
input cube &) [is] (4 Dip steered median fiter [] [© setect .|
Area subselection | 100/300-750/1250 (463 samples) © select .
Start Position (nCrl) (365 647 Z(ms) (1024 | [R] Value: 5239
Eventto track @ Minima Maxima
Min Threshold |-10478 Max Threshold [0
Ampltude Scaler 1
————— —— i Ampitude Sum Scaler |1 Amplitude Sum Step (ms) 1
— % Schedule Max Nr Cells Cells per iteration Cuteoff criteria Cut-oftvave | (d]
= ———— ol
— = 1/1000 =N I Notac 0.000 ‘_
[ Track | [View Log .|
71 Show Points [Display Settings .|
Sl —-
9l Snap to event Search gate (ms) -4 4
(Create horizon]
%’J © Close:
Finished Tracking
L] -
Workflow cont’d:
= % 3D Horizon
=[] Channel-1 -
v| Amplitude [ ]
. . . . ¥| Amplitude Sum [ ]
12. The horizon will appear in the tree as well as in the scene. 7 Thickness i
¥| Cell Number n
V| Iteration n
. . ] Schedule r
13. Turn off the Show points display. 7 2 vahies ]
—_— ——————— —— —
e —— | /@ Thaweg Tracker ==
> B e k:
£
input cube (&) (5] (4 Dip steered median fiter [][© setect..|
Area subselection | 100/300-750/1250 (463 samples) © select..
Start Position (nCrl) (365 647 2(ms) 1024 | (K] Value: 5230
Event to track @ Minima Maxima
Min Threshold |-10478 Max Threshold [0
Amplitude Scaler |1
Ampltude Sum Scaler 1 Amplitude Sum Step (ms) |1
Schedule Max Nr Cells Cells per iteration Cuteoff criteria Cutoftvave | (4]
1/1000 =0 “INotApp 0,000 I=
[ Track | [ViewLog_..]
Output horizon | Channel-1 [*][© select .| @dcB [
9] Snap o event Search gate (ms) -4 4
[Create horizon| ‘
U
© Close:
Finished Tracking
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Workflow cont’d:

14. To track the margins of the channel, add a second schedule step and set the
parameters as shown in the figure. Turn on Show points and press the Track button

) Thalweg Tracker =)
*m %l
input cube &) (&) 4 Dip steered median fiter [] [© select..]
Area subselection | 100/300-750/1250 (463 samples) © Select .
Start Position (InlCrl) (365 647 Z(ms) 1024 | [&] Value: 5239
Eventtotrack ® Minima © Maxima
Min Threshold |-10478 Max Threshold |0
Amplitude Scaler |1
d Ampltude Sum Scaler |1 Amplitude Sum Step (ms) |1
=
Schedule MaxNrCells  Cells periteration  Cut-off criteria Cut-off value
J1] 1000 o[ ot Appiicable 0.000 =
22000 =12000 = Percentage | -[5.000 -1
[ Jievion
Output horizon | Channel-1 [*][© select .| @acB [ 3
71 Snap to event Search gate (ms) -4 4
Create horizon)
© Close:
Finished Tracking

Workflow cont’d:

and merged into a single horizon.

Several horizons can be created |

1 Thalweg Tracker

~a{=JE

Crossplot is a utility to
perform analysis on the

extracted dataset (e.g. if
you use an acoustic
impedance (Al) volume,
you can analyze
iterations with Al data).

Display Settings control the
display and color coding of
the points of various
extracted attributes along the
Thalweg.

% Display Properties N =&

Attribute to display |Iteration B

o B s

HiRainbow =

Q) Close

Input cube 4 Dip steered median filter

Ar€a subselection | 100/300-750/1250 (463 samples)

Start Position (In/Crl) 365 647 Z (ms) [1024

Event to track @ Minima Maxima
Min Threshold -10478
Amplitude Scaler 1

Amplitude Sum Scaler |1

Max Nr Cells
11000 | I
22000 | 2000

Schedule

Cells per iteration

[] |© select...

(R ] value: -5239

Max Threshold |0

Amplitude Sum Step (ms) 1

Cut-off criteria

Cut-off value @

0.000
=] 5.000 : =

= |Not Applicable

*|Percentage

: Track ]:View Log_.]

7| Show Point,

Display Settings .|

Output horizon  Chapr€l-1

v Snap to event;

Finished Tracking

[+] |© select...| @ dcB [+

Search gate (ms) -4 4

i i%lose
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2.1.5 Raytracer

What you should know about the Raytracer

OpendTect Pro's ray-tracer is a 1D ray-tracer that computes the angle of incid-
ence at various interfaces in an elastic, horizontally-layered earth model. The ray-
tracer is used among others by the SynthRock plug-in to compute pre-stack syn-
thetics (P, S, and multiples). OpendTect Pro users do not need a SynthRock
license to make good use of the ray-tracer. Ray-tracing is used in the conversion
from offsets to angles e.g. when computing mute functions, angle stacks and
AVA attributes.
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2.2 Commercial Plug-ins

OpendTect supports free and commercial plug-ins. The latter are only available
under the OpendTect Pro license. Commercial plug- ins are used for specialized
and advanced tasks. dGB and 3rd party vendors ARKCLS, Estimages, The
Visual Wavefield Project, Geo 5 and LTrace provide commercial plug-ins for
OpendTect.

Unless you are working on the F3 Demo training data set commercial plug-in
require FlexNet license-keys. You may wish to contact info@dgbes.com to
request an evaluation license.

Users can create their own commercial OpendTect Pro system by picking and
choosing the plug-ins they need. Logical sets of plug-ins have been combined
into packages for typical G&G tasks. These packages are licensed at discounted
prices. The following packages are available:

» Geophysics: Attributes & Filters This package contains OpendTect Pro
and the following plug-ins: Dip Steering, Neural Networks, Faults
& Fractures, Fluid Contact Finder, Seismic Spectral Blueing, Seismic
Feature Enhancement, and Workstation Access.

» Geology: Sequence Stratigraphy. This package Contains OpendTect
Pro and the following plug-ins: Dip Steering, HorizonCube, SSIS, Well Cor-
relation Panel, Seismic Spectral Blueing, Neural Networks and Workstation
Access.

» Geophysics: Inversion & Rock Properties. This package contains
OpendTect Pro and the following plug-ins: Dip Steering, HorizonCube,
Deterministic Inversion, Stochastic Inversion, Seismic Coloured Inversion,
Seismic Spectral Blueing, Seismic Net Pay, SynthRock, Neural Networks,
and Workstation Access.

» Geoscience.This package contains OpendTect Pro and the following plug-
ins: Dip Steering, HorizonCube, SSIS, Well Correlation Panel, Neural Net-
works, Faults & Fractures, Fluid Contact Finder, SynthRock.

This manual follows a similar sub-division for training the commercial parts of the
software:

o Attributes & Filters.
e HorizonCube & Sequence Stratigraphy.
e Seismic Predictions.

Before starting the training exercises let’s first give short descriptions of the com-
mercial plug-ins per software vendor.
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2.2.1 dGB Plug-ins

As well as creating the open-source OpendTect software itself, dGB Earth
Sciences also develops closed-source plug-ins for OpendTect. See: dGB

website.

Dip-Steering

HorizonCube

The dip-steering plug-in allows the user to create a (dip-)
SteeringCube which contains local dip and azimuth inform-
ation of seismic events at every sample location. The cube is
essential for structure-oriented filtering (aka dip-steered fil-
tering), and improves resolution of numerous multi-trace
attributes (e.g. Similarity) by honoring and following dipping
reflectors. It also features unique attributes like Curvature
and Dip. Finally, a SteeringCube is an essential input to the
HorizonCube

HorizonCubes impact all levels of seismic interpretation.
They are used for:

» Detailed geologic model building,

» Low frequency model building for seismic inversions
» Well correlation

» Sequence stratigraphic interpretation system (SSIS).

A HorizonCube consists of a dense set of correlated 3D
stratigraphic surfaces. Each horizon represents a (relative)
geologic time line. Horizons are created either in a model-
driven way (stratal / proportional slicing, parallel to upper /
lower), or in a data-driven way via a unique dip-steered
multi-horizon auto-tracker.
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The Well Correlation Panel plug-in is used for picking well
markers and correlating markers guided by seismic evid-
ence. In combination with the HorizonCube, the interpreter
can use the slider for detailed seismic-steered correlations.

Well Correlation
Panel

The Neural Network plug-in supports Supervised and Unsu-
pervised Neural Networks. The main application of Unsu-
pervised NN is clustering of attributes and/or waveforms for

Neural Networks seismic facies analysis. The Supervised approach is used
for more advanced seismic facies analysis, to create object
"probability" cubes such as TheChimneyCube® and
TheFaultCube® and is used for inversion to rock properties
(e.g.: porosity, Vshale, Sw etc.).

The Faults & Fractures plug-in supports special attributes, fil-
ters and tools for analyzing faults and fractures. Included are
among others: Thinned Fault Likelihood, Smoothed Seismic,
Un-faulting, automatic fault-plane extraction, fracture density
and fracture proximity. In combination with dip-steering also:
dip-steered attributes and filters (SOF), and curvature attrib-
utes.

Faults & Fractures

Sequence Strati- The SS/S plug-in (Sequence Stratigraphic Interpretation Sys-

graphic Inter-  tem) is an add-on to the HorizonCube. SSIS supports full

pretation System sequence stratigraphic analysis, including automated

(SSIS) wheeler transforms, systems tracts interpretation and
annotations.

FCF is a seismic hydrocarbon detection technique where the
Fluid Contact seismic traces are stacked with respect to the depth of a
Finder mapped surface (common contour binning). The objective is
to detect subtle hydrocarbon related seismic anomalies and
to pin-point gas-water, gas-oil, oil-water contacts.
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Velocity Model
Building

SynthRock

The VMB plug-in is used to pick up RMO velocities from pre-
stack Common Image Gathers. RMO velocities are used to
update the 3D velocity model in PSDM workflows. VMB sup-
ports picking on semblance gathers and picking of pre-stack
events for input to the PSDM- Tomography plug-in. Two
VMB modules are supported: Vertical update and Horizon
update. Models are constructed from combinations of grid-
ded/smoothed RMO velocities, interval velocities and 3D
body velocities (e.g. Salt body velocity).

The SynthRock plug-in is a forward pseudo-well modeling
and probabilistic inversion package supporting wedge mod-
els, stochastic models, pre- and post-stack synthetic seis-
mograms and cross-matching (HitCube) inversion.
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2.2.2 ARK CLS & Earthworks Plug-ins

ARK CLS make the following commercial plug-ins for OpendTect. See: ARK CLS

website.

Workstation
Access

Seismic Spectral
Blueing

Seismic Colored
Inversion

MPSI Determin-
istic Inversion

The Workstation Access plug-in is used for direct data
access to and from OpenWorks/SeisWorks and GeoFrame-
IESX.

The Seismic Spectral Blueing plug-in is a technique that
uses well log data (sonic and density) to shape the seismic
spectrum in order to optimize the resolution without boosting
noise to an unacceptable level.

Seismic Colored Inversion enables rapid band-limited inver-
sion of seismic data. SCI is rapid, easy to use, inexpensive,
robust and does not require expert users.

Deterministic inversion (by Earthworks and ARK CLS)
includes a 3D model builder for constructing a priory imped-
ance models using well log and seismic horizon data; a 2D
error grid generation module for providing spatial inversion
constraints and a model-based deterministic inversion mod-
ule. Even better deterministic inversion results can be
obtained if the low frequency model is built in OpendTect’s
volume builder using HorizonCube input.
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MPSI Stochastic
Inversion

Seismic Net Pay

4

Seismic Feature
Enhancement

Frequency Shap-
ing

\

Spotlight

©

-

Stochastic inversion includes the MPSI (Multi- Point
Stochastic Inversion) ultra- fast stochastic inversion module
for generating multiple geo-statistical realizations and the util-
ities for processing the multiple realizations to represent the
inversion uncertainty for lithology, porosity, saturation or
other attributes as probability cubes. This plug-in group also
requires the purchase of the deterministic inversion plug-in

group.

The Net Pay plug-in is an add-on to Seismic Coloured Inver-
sion to compute net pay and net-to-gross from thin and not
so thin reservoirs. Net Pay is based on BP technology.

The Seismic Feature Enhancement plug-in is a flat-spot util-
ity that enhances the signal of consistent flat events and
reduces the "noise" of the channel reflections.

Frequency Shaping is an innovative technique that integ-
rates well data into your seismic analysis. Two operators are
simultaneously derived using acoustic impedance logs and
reflectivity, once applied to the seismic data they effectively
broaden the amplitude spectrum of the seismic data at both
ends, low and high.

Spotlight adds quantitative interpretation capabilities to the
standard SCI workflow by rapidly combining up to 4 different
coloured seismic datasets into a single cube that resembles
the behaviour of a given elastic attribute. The relationship
between the input data and the desired output is established
from prior well log analysis.
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2.3 Attributes & Filters

OpendTect’s attribute engine can be extended with various plug-ins that allow
computation of advanced attributes and filters. As OpendTect’s user interface is
built dynamically, information about plug-ins (and certain attribute options in the
user interface) is only visible if the plug-in is installed and a valid license key is
available. (As stated before this is no issue when working on F3 Demo).

In this Chapter you will learn how to:

Remove random noise (Dip-Steering).

Sharpen edges (Faults & Fractures, Dip-Steering).

Visualize faults (Faults & Fractures, Dip-Steering).

Extract fault bodies (Faults & Fractures)

Extract Fault planes (Faults & Fractures)

Enhance the vertical resolution (Spectral Blueing).

Enhance amplitude anomalies (Optical Stacking (free), Fluid Contact
Finder, Seismic Feature Enhancement).

Visualize seismic patterns (Neural Networks).

Create a Chimney Cube (Neural Networks).
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2.3.1 Dip-Steering

What you should know about Dip-Steering

The dip-steering plug-in allows you to create and use a (Dip-) SteeringCube. A
SteeringCube contains at every sample position the dip in the inline- and cross-
line directions of the seismic events. These dips can be displayed as overlays on
seismic sections. Please note that you should display the cross-line dip on an
inline and the inline dip on a cross-line (right-click menu in the tree). In 2D, the
SteeringCube contains the apparent dip in the line direction.

The SteeringCube is used for:

 Structurally-oriented filtering (e.g. dip-steered median filter)

» Improving multi-trace attributes by extracting attribute input along reflectors
(e.g. dip-steered similarity)

» Calculating some unique attributes (e.g. 3D-curvature, and variance of the

dip).
e Dip-Steered auto-tracking of single horizons or multi-horizons as is done by
the algorithm that creates HorizonCube.

S ==

From a SteeringCube several valuable attributes can be computed. Most of these

attributes, which require SteeringCube are grouped under type Dip inside
OpendTect’s attribute set.
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B W AR -

|Dip -

Inl/Crl stepout

Dip
Constant velocity | Dip Angle
FaultDip
Fracture Attributes

Velocity (m/'s]

Output | Mean curvature b

Steering Data IT]E |"‘é 2 Steering BG Detalled o G Select |

For example, OpendTect supports computation of a whole family of volume
curvature attributes. These attributes are useful in the interpretations of frac-
tures, geo-morphological features and drainage patterns. Other attributes that
can be computed from a SteeringCube are:

» The polar dip or true dip: the dip is measured from the horizontal and the
range of the dip is always positive and given in usec/m or mm/m.

» The Azimuth of the dip direction is measured in degrees ranging from -180°
to +180°. Positive azimuth is defined from the inline in the direction of
increasing crossline numbers. Azimuth = 0 indicates that the dip is dipping
in the direction of increasing cross-line numbers. Azimuth = 90 indicates
that the dip is dipping in the direction of increasing in-line numbers.

Detailed vs Background SteeringCube

In this training, you will be creating several SteeringCubes. The differences
between these cubes are in the algorithms used to calculate them and the use of
filtering. SteeringCubes called 'Detailed' are unfiltered or gently filtered, while
those named 'Background' are heavily filtered. Detailed SteeringCubes contain
details such as dip associated faults or sedimentary structures. Background
SteeringCubes contain only the structural dip.
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Examples of (left to r/ght) Or/g/nal Se/sm/c (Fu/l stack), Detailed Steering and
Background Steering

These Steering Cubes have distinct applications:
Detailed SteeringCube

e Dip & Azimuth attributes

» Curvature attributes

o Guide multi trace attributes (Similarity)
Background SteeringCube

» Dip Steered Median Filter

e Diffusion and Fault Enhancement Filter
» Ridge Enhancement Filter

[ Original Seismic Data ]

l

[ Detailed Steering ] [ Background Steerlng]
i Dip steered Median
H P Fllter
i | Similarity |
________________ [ [ Dip Steered Diffusion ]
| Detailed Attributes | ! Fllter
| Analysis y i
———————— V—— i Fault Enhancement
L l e Filter
T T TN Dio. Azimuth \ - N Fault enhanced seismic
| Dip-steered : I anlc'l,’(:u:IvT::lure || Other - | S
| Similarity | | - !|  Attributes | C d Similarit
S J \__Ettfl_b_u‘_lg-ft___, l\ ) L mprove imilarity |
____________________
Ridge Enhancement
Filter
Sharp faults
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In OpendTect there are two different algorithms available for creating Steer-
ingCubes (e.g. BG Fast Steering and FFT). Coming few exercises will be carried
out using the BG Fast Steering algorithm (based on the phase of seismic signal).
More information about the SteeringCube can be found in the dGB Plug-ins Docu-
mentation: UserDoc.
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2.3.1a Steering Cube

Required licenses: OpendTect Pro, Dip Steering.

Exercise objective:
Compute a SteeringCube.

Workflow:

1. Bring up the Create Steering Seismics window:
Processing > Dip Steering > Create > 3D.

Processing | Scene View Utilites CLAS Help
Create Seismic Output ~ »
Create Horizon Oufput  +

L Wells v
(Re-Start Batch Job ..

Dip Steering v
= GMT Mapping Tool
& HorizonCube r
Madagascar ..
ssIs ’

Track Unconformity .
Set Default 3D SteeringCube

. 1,1,1; the dip is computed within
3. ;Zgﬂ;hea?eﬁ;:x?lﬁuiamn stepout for the PCA a small cube of 3x3x3 samples
galg A around each sample in
consideration.
@ Create Steering Cube = O X
Input Cube L:’L “E} 1 Original Seismics b | © Select | Steering algorithm PCA = |
Volume subselection [100/300-750/1250 (463 samples) © Select ... Filter size (sample) (ink1 |3 |crll (321 2 |
Use fault dips O Yes @® No Maxdmum dip (us/m) 800
With planarity O Yes @ No
Output Steering | O select ... [ Filter result  Median
Batch execution | Single Process ¥ 4.4 Options ...
€3 Close OHe\p
Workflowcont'd:

# Create Steering Cube
Input Cube L:L *’E} 1 Original Seismics

Volume subselection |100/300-750/1250 (463 samples)

Use fault dips O Yes @ No
Qutput Steering -
Batch execution Single Process v | 4.4 Options ...

| & select ..

| © select ...

© Select ...

- o X

Steering algorithm PCA v
Filter size (sample) inl:1 5| |crl:l (5 |Z:1 s

Maximum dip (us/m) 800
With planarity O Yes ® No

[] Filter result Median =
Filter stepout (sample) inl:2 2 al2 |2 :2:5 3:
Dciose | @b

When adding Planarity, the output steering cube contains an additional Planarity
component along with the Inline Dip and Crossline Dip. The Planarity attribute
returns the quality of the steering cube and is used by Unconformity Tracker,
Inversion + tracker and for HorizonCube creation.
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Workflowcont'd:

time run this process.

6. Give the output SteeringCube a name (e.g. PCA111_MF225) and click OK.

@ Create Steering Cube

Input Cube £}, &, (1 Original Seismics

Volume subselection [100/300-750/1250 (463 samples)

~| © Select ... Steering algorithm PCA -
© select ... Filter size (sample) linl:1 & ol :: Z:1 B

T Use fault dips O Yes @® No Sodaainiiol(Ge/ m)j Boo
Tip: It's recommended to @ O
use the SteeringCube cutpet sterin [FRTLT TS @ 2 Fltr result Median -
pargmet_ers:[ r|]r_1 its name, tch oxsiion [T T Filter stepout (sample) [in:2 (2] otz 3]s 2
as done in this exercise. | Son [0
@ Positions - o X
Specify Positions
Volume subselection Range Ml 2 =2
n-line Range 420 2l step |1 1
Cross-line Range 300 2| (1250 % Step |1 ]
Time Range (ms) 0 21848 2 Step 4 2
@ok | Dcancel  @Help
Workflowcont’d:
7. Add default data (i.e. 4 Dip acenel,
ian fi i PRI Add Defak Data |
- & Crof
stc_een_ed meaf.'ar_*a filter) by right & o Add and Select Data
clicking on inline 425. @ Volu  Add at Well Location ...
of 2RI5"L Add Color Blended

8. Once again right-click on
inline 425 to display the
Detailed SteeringCube (select
PCA111_MF225 from
Steering tab).

W' In-line

5 WEEd
v 4 op I L

Tip: It's recommended to display
the Crossline dip component of the
SteeringCube on an inline and vice-
versa.

v grc‘)_ss-[ine Display * | Volume Builder Attribute
& Zslice i 2 e
® Volume Duplicate € HorizonCube Display
. Reset Manipulation - .
~ Random Lir " . Systems Tracts Display
2D Line * Correlate with Wells _.. I
# Select - [m] X
Select Layer 2
Filter |*
O stored 2 Steering BG Detailed
l_.| 3 Steering BG Background
@ Steering .
3b Steering FFT225 MF113
Attributes PCA111_MF225
s
| Component Crossline Dip 'l
QOK | Qcanoe\ eHelp
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Workflowcont'd:

9. Use the Pastel color-bar.
10. To co-visualize seismic and cross-line component of dip, right-click on the
PCA111_MF225 in the tree > Display > Change Transparency and set the transparency

to 50%.
o | v @ E 2 b O

~ 425
[FPCALLL MF225.. B
[J4Dips  Select Attribute

@ Cross-line Save Color Settings
® Z-slice Use Saved Color Settings
@ volume Move >
7 Random Line | Display * M Histogram ...
Zi2Dlne = Remove B Amplitude Spectrum ...
3D Horizon F-K Spectrum ...
' 20 Horizon | Change Transparency ..
;F"“'t = 20 Viewer |
Faultset =
FaultStickSet T2 Viewer - Wiggle
@ Attribute transparency - m] X
Transparency 1
| ©ok | € cancel
Workflowcont'd:

11. Additional step: Go to Processing > Dip Steering > Filter > 3D and apply
Recursive Gaussian filter using the stepout of 5, 5, 2 to achieve smoothly

looking results.

Processing Scene View Utilities Help ~. N .
| ms@smkm . g} "".iiq Eil, T B # Filter Steering Cube o %
A welis : Input Steering Data [PCALL1_MF225 -] |© select ...
(Re-)Start Batch Job ...
cowo .. Volume subselection [100/300-750/1250 (463 samples) | | © select |
‘A MGS Destriping ... |
- gm B oo A FiIterIRemrsiveGaussian =
25 Faults and Fractures ~ * Filter v ... — =
= GMT Mapping Tool ... Import » ‘ |Fllter stepout (sample) |in|:5 ;J Icrl:S i‘ ‘2:2 [;H
@ HorizonCube » Track using Inversion ...
1 Madagascar.. Set Defaut 3D SteeringOube .. Output Steering | PCA111_MF225_GF552 -| | © select ...
Batch execution |Single Process ~ |4+ Options
. °Run Ioclose . OHelp

Tip: Recursive Gaussian filter is extremely fast and is available for all OpendTect Pro users.
If you're using a free version of OpendTect, for additional smoothing we recommend applying
the Average filter, instead of the Median one. Median filter was already applied during the
steering cube computation to remove spikes (step 5 of this exercise).
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2.3.1b Dip & Azimuth

OpendTect Pro, Dip-steering

Exercise objective:

Compute Dip and Azimuth attributes from a SteeringCube.
Workflow:

LUEIEEN Processing Scenes View U

. . . . . § Attributes il & 20 ..
1. Go to the Attribute engine: Analysis > Attributes > 3D or click N —

on the .| icon > 3D EX Gross piot Data ;
2. In the attribute set window, select Dip attribute.
3. Select 2 Steering BG Detailed as input and Polar dip as

output.
4. Specify a name for the attribute (e.g. Polar Dip) and Add as

new (optionally save it).

= Amedte S0 30 = =8 =)
Fie
Pt YDA WME
Ariase 504 | <not saved> op <] op B[z
Polar Dp Steering Data [ fE8] 2 Steenng B Detased [0 seea
+
+
+
Ia.«m.gr Name Polar Op mnmbl
Savean Cose @) (@1
Workflow cont’'d: (30 Forizrz
4 20 Honz
Fault Add at Sections Only
~£i'é';3"¢' Add Color Blended
H Track New
5. In the 3D scene, Load horizon A i oz
Demo 1 --> MFS4 by right-clicking PP
on 3D Horizon in the tree. T =
> Demo 0 > F54 < =
B | Demo 3 > Top Foresets < g
Demo 4 > Truncation
Demo 5 -> FS7 &
Demo 6 ~> FS8
o g
Area subselection | 100300-7501 260 {463 samples) ©) Sedect .
© Concel| [@ tisp
P ining_v&\SurfacesiDema_1_—_ MFS4.hor
e I (TS
e Dipiay * |4 Volume Buider Attribute
F:nﬂ-ckSet Tracking * | Gontour Display
® Body Tools * | Horizon Data
6. In the tree, right-click on the loaded B EE=E
. . By
horizon and follow Add > Attribute :
: : Stored
select the Polar dip attribute. The ; =
. . eenng
attribute is calculated on-the-fly.
Y
- - - =
Alternatively, you could process the FPolar Dip attribute as
horizon data and afterwards add it (see the sectionon [©5¢] [0 cancel @ e |

Spectral Decomposition).
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Workflow cont'd:

7. Change the colorbar to Grey scales and the range to 0 to 70.

Workflow cont'd:

8. Save the attribute to the disk by right-clicking on it's name (i.e. Polar Dip), and
selecting Save as Horizon Data.

= .
= gogg:_::guin“} MES4 = Output selection == @
il Polar Dip . .
= ﬁ? Select Attribute » Specify attribute name
2D Honizon Move v

Fault Display l Attribute | Polar Dip
]
@ Body

; Tools © I

Well
* PickSet = Remove O Cancel L OHHP l
Pt

Try displaying the Azimuth attribute in the same way as Polar Dip. What differences do you see between

the two?
“ Attribute Set 3D = e
File
*P e ¥R NAE -
Altribute set | <nol saved=> Dip [=] |oip -2
Polar Dip Steering Data ='; B | 2 Steering BG Detailed ~| © Select ...
Azimuth

Output | Azimuith -
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2.3.1c Dip-steered Similarity

Required licenses: OpendTect Pro, Dip-steering.

Exercise objective:

Compute a Similarity attribute with and without dip-steering.
Workflow:

1. Go to the Attribute engine: Analysis > Attributes > 3D or
click on the | icon > 3D.

In the attribute set window, select Similarity attribute.

Keep the default Input Data 4 Dip steered median filter and
default time gate [-28 +28] ms.

LUETEEN Processing  Scenes  View Ut

% Volume Builder
Ei Cross-plot Data
Well

= Attribute Set 30

Steering None

[

File
2P AR
Aftribute set | <not saved> <Al Zlﬁj 2
Input Data |4 Dip steered median filter [+] | © Select ..
Time gate (ms) -28 28 |
Extension | Cross =]
Stepout [inl1 =] [erl
Steering |None -
Workflow cont’d:
4. Select Extension: All Directions.
5. Keep the default stepout, i.e.inl:1; crl:1.
= Attribute Set 3D (=% E=R |
File
st ER XTI T 1IN
Attribute set | <not saved= <All> [=] | Simiarity 2
Input Data |4 Dip steered median fiter [*]|© setect |
Time gate (ms) |28 28
[Extension NISTETesm—— )|
[stepout i1 = et =]
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Workflow cont'd:

6. Specify Steering: Full and select 3 Steering BG Background.
7. Choose Output statistics: Min.
8. Give aname (e.g. FS_Similarity) and Add as new.
Time gate (ms) -26 28
Extension All Directions T|
Stepout inl1 erl:1
Steening |Full v}
Steering Dala aé -\‘b 3 Steering BG Background 3 © Select .
|
$
+

| Output statistic Min

| Attribute Name | FS_Similarity Add as new'|| a

Save on Close

lo Close | 9 Help

Workflow cont'd:

9. In a similar way, define a non-steered Similarity attribute by

selecting Steering: None.

10. Give it a name (e.g. NS_Similarity) and Add as new. Optionally save the
attribute set. Click on Close.

WS _Similarity
Time gate (ms) -28 28
Extension All Directions T|
Stepout inl1 er:1 =
Steering None "1 |
3
|z%
—
Output statistic Min :v
Attribute Name | NS_Similarity Add as new'|| F |
Save on Close
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Workflow cont’d:

11. Display seismic data on inline 425 by

Elements
Se

Y i
right-clicking on In-line > Add and @ Cr|__Add Default Data
Select Dat L4 Add and Select Data
elect Lata. o ® Vol ™ Add at Well Location .
Under the Stored tab select 1 Original - onAdd Color Blended
Seismics.
= Seleet [E=={Eon =)
Select first layer
1 Orgna Semics :
4 Dup steered median filter
Steering 5 ChimneyCube E
7aAl Cube Sid
Attributes 7b Al Cube from HorizonCube
8a PorosityCube from HC-NN
:-&' 80 Gamma from HonzonCube il
5"::: Filter | *
[E5] 0 om @1

12. Select inline number 425 in the tree,

go to the top toolbar, change it to 250
and press enter.

1 Original Seismics

Zf Survey Analysis Processing £
&Gl WE -
In-line 250 [${step 1 [ 4 mp
Workflow cont’d:
13. Load first the steered similarity attribute (i.e. FS_Similarity) by right-
clicking on inline number 250 > Add > Attribute.
= Select =e=s
Select Layer 2
= W In-line
5% orone IR [ s
¥ 1 Onginal 9 Atbwte | WS- Smiarty
¢ E:r::ss line L splay * |4 Volume Processing Attribute €555
oo i
c
B
[Co] 0o (0

14. Similarly, load the non-steered similarity attribute
= W Indine
SWE
U FS_Simiarty

& 1 Original Seismi  Display v

“§ Volume Processing Attribute

(i.e. NS_Similarity).

= Select

[E=8 Foy ===
Select Layer 2

Stored

FS Sim\lams ]

Steering
S

(G oms (one
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Workflow cont'd:

15. Change the color-bars of bath the similarity attributes to Similarity.

=¥ In-line
=@ 250
EI[NS_Similarity 06 [ oo | Simiariy ]
¥ FS_Similarity
¥ 1 Original Seismics

16. Compare the two similarities by ticking on and off the upper attribute (here
NS_Similarity).

What is the influence of dip-steering?

i '.‘-'u-" f .’*&ll .. ”J' i

Inline 250: Non-Steered Similarity (left) and Steered Similarity (right)
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2.3.1d Dip-steered Median Filter

Required licenses: OpendTect Pro, Dip-steering.

Exercise objective:

Remove random noise from the seismic data using Dip-Steered Median Filter (DSMF).

Workflow:

1. Go to the Attribute engine: Analysis > Attributes > 3D

LIEUEEY Processing Scenes  View Ut

“4 Volume Builder
Ei Cross-plot Data
Well

or click on the. | icon > 3D.

Workflow cont’d:

2. Select the attribute: Dip
steered median filter.

Attribute set | <not saved=> <All> [+]| Dip steered median fiter é] ?
3. Select Input Data: 7 DSUF Input Data 1 Original Seismics 1[0 seleat.|
Original Seismics. Stepout

4. Set the Step-out to 1! 1 Steering Dma:é “glas-.eenngec Background -] |© select. |
(the optimal step-out will
be evaluated later).

5. Select the Steering Data:
3 Steering BG background.

1] &l e

6. Give a name (e.g. DSMF
for Dip Steered Median Attribute Name [DSMF] Add as new [
Filter) and Add as new.
Keep this attribute set
window open.

Save on Close
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Workflow cont'd:

7. Now in the scene, in the tree, right-click on In-line and choose

Add and Select Data.

Elements
Scene 1
' |In-ling!

2D i

Color

i Cross| Add Default Data

L X4 M Add and Select Data

@ Volum  Add at Wel Location -
~ Randi - adq Color Blended

8. Select 1 Original Seismics from Stored tab and press | ° % 1 Original Seismic

OK.

9. In the tree, right-click on inline number (i.e. 425):

Add > Attribute.

@ Cross-lin  Display '

= Select [E== g ==
Select Layer 2
5
4 Dip steered median filter
Steering 5 ChamneyCube
TaAl Cube Std
Attributes 7bAl Cube from HorizonCube
— 8a PorosityCube from HC-MN
fs) 8b Gamma from HorizonCube
J 0 1 Sienilache on FEFE caicmae i
-
.r=P_ Filter  *
(O e @
W In-ine
el o
710 § Attribute

“% Volume Builder Attribute
@ Z-slice Buplcsse € HorizonCube Display

@ 30 Horiz @ Lock Treeitem

" 2D Horz = Remove from Tree
Fault

® volume Reset Manipulation
) ) %' Systems Tracts Displa
’T/ Random 4. Correlate with Wells ... G i
2D Line

Workflow cont'd:

10. Select DSMF from Attributes tab.

11. Go back to the Attribute Set window and
click the attribute evaluation tool icon ‘h
to evaluate the step-out.

12. Specify Evaluate: Stepout.

13. Set the initial value “0-0",
increment “1-1”, and Nr of steps “5”.

14. Press Calculate.

Moo E=Eer =)

Select Layer 2

Stored [
Steering

@ Attributes
Y
Y
[©ox](© concel] (@ e ]
% Evaluate attribute El@
Set parameters
| Evaluate Stepout E||
[iiial value [0 0 |
|Incremem 1 1 |
Nrof steps 5 =
Slice

Store slices on 'Accept’

@ ccen] [ @ e |
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Workflow cont’d:

15. Once the computation is done, move the slider to change the stepout value and see the

impact in the scene.

16. Assess which step-out is best (removing random noise, but not too much smearing)?
Once chosen, press Accept and close the attribute set window.

i RE T2

scene.

Sy P P LT 4 AT

Tree scene 1 .
e ["om ES
py
o IR e
.-
;-
ot
B

= Erubate stsbute res |
- Use the keyboard arrow keys, so |
- 'O e you can focus your eyes on the

Workflow cont’d:

17. If you are satisfied with the parameters, you may want to process the attribute definition as
a volume. Follow: Processing > Create Seismic output > Attributes > Single attribute > 3D

or click on the ¢ icon.

[7 Survey Analysis Procgsing Scenes View Utilities Help
Lo IR Wi Create Seismic Output * Attributes » |+ single Attribute y I
o425 Blstelio [ i Horizon Quiput b | 2D <=> 30 * | Muiti Atribute ..

(R Batchilob = Angle Mute Function ... MultiCube DataStore
Tree scene 1 B o ~ . ) -

" Create Volume Attribute
Quantity to output DSMF
Volume subselection  100/300-750/1250 (463 samples)
Pass

Mull traces @ Discard

Scale values: Shift/Factor

S[Ea]

=

|© Select

Output Cube DSMF

[-](© seect..| (@ cavs

Batch execution Single Process L] {4 Options ]

|C) Cancel| | @ Help |

The processedattribute volume will appear as a Stored Cube (in Seismic Manager).
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2.3.1e Mathematics

Required licenses: OpendTect.

Exercise objective:
Analyze the noise removed by the Dip-Steered Median Filter using the Mathematics attribute.

Workflow:

Note: This exercise uses the attribute setfrom the previous exercise. ‘

1. Define a new attribute (in addition to DSMF of previous exercise) of type Mathematics
and write the formula: ‘filtered — original’ and press Set.

Basic z| | Mathematics ZH z

I MathFunctions E sqgrt (Square root) 3 Insert
Formula (like 'nearstk + c0 * farstk’) | filttered - original | Set

| For filtered' use  DSMF [~

|For ‘original’ use [1 Original Seismics] EI

2. Use the previous attribute definition (i.e. DSMF) for filtered and the stored volume 7
Criginal Seismics for original. Give the attribute a name (e.g. Noise) and Add as new.

Workflow cont'd:

3. Right-click on inline number 425: Add > Attribute.

4. Select the Noise attribute.

W In-line

- [ Add
< DSMF _
¥ 1Onginal 5 Display " % Volume Builder Attribute
e — ATESD € HorizonCube Display
& Z-slice Reset Manipulation =
@ Volume Correl . - Systems Tracts Display

W Sdeet =3 o =
Select Layer 3

Stored  [pSMF

Steering

fs

=Y
Q Cancel: | @ Help |

Use the same color-bar for original seismic, DSMF seismic and Noise for a fair comparison.

| 4500 [T W 4500 [ Seismics Bl
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Workflow cont’d:

Your result should look like this.
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2.3.1f Dip-steered Diffusion Filter

Required licenses: OpendTect Pro, Dip-steering.

Exercise objective:

Workflow:

Enhance low-quality seismic data near faults using a Dip-Steered Diffusion Filter.

1. Start the attribute engine , | .
2. Open the Default Attribute set..

3. Select Dip-steered diffusion filter and press OK.

" Default Attribute Sets =R =R ="
Select default attribute set

Filter *

Evaluate Attributes

AVO attributes from Intercept-Gradient

AVO attributes from Near-Far

dGB Evaluate Attributes

Dip-steered median filter

Dip-steered diffusion filter =

« n »

;O Cancel | @ Help

Workflow cont'd:

4. In the pop-up window set 7 Original Seismics as input
BG Background as input steering, and press OK.

seismic and 3 Steering

" Attribute set definition

Select Seismic & Steering input

Input Seismic Ilép 'e=»| 1 Original Seismics

Input Steering [-_é &> 3 Steering BG Background

@\ [O Cancell ‘ {9 Help ‘

~ |© Select..|
(=] Select .|
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Workflow cont’d:

5. The attribute is defined.

= Attribute Set 3D

B2
File
PP NE R W
Aftribute set <not saved> [<Al= - | [Position - ? |
Dip-steered diffusion fiter Input attribute | Minimum similarity = O Select ...
Stepout inl:1 S oA
Time gate (ms) 0 0
Steering | Full .
Steering Data % “’g 3 Steering BG Background - D Select ...
L |
Operator | Max "
b
Output attribute | Dip-steered median filter =] |© Select ...
—
Attribute Name  Dip-steered diffusion filter [Add as new| []_
7| Save on Close g iCIuse 3 Help )
T f
Workflow cont’d:
Scene 1.
ln-line

Add Default Data
6. Keep the attribute set 3D window
open and add the Dip-steered
diffusion filter attribute in tree on

inline 425.

Add at Well Location ...
Add Color Blended

= Select

Select first layer

Stored Dip-steered diffusion filler
Steering

&)

=Y

(O col (@)

ol
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Workflow cont'd:

7. Go back to the attribute set 3D
window, and click on the attribute
evaluation icon 'm to evaluate the
step-out of the Dip-steered diffusion
filter attribute.

) Evaluate attribute [E=8ECR &=

Set parameters

8. Specify Evaluate: Stepout [Evaluate [stepout - |

| Initial value 0 0 |

9. Set the initial value “0-07,
increment “1-1”, and Nr. of steps “5”. [ increment 1 1 |

Nr of steps 5 -

Slice

10. Press Calculate.

Store slices on 'Accept’

(@)

Workflow cont'd:

11. Once the computation is done, move the sliders to change the stepout value and see
the impact in the 3D scene.

5200

asn [l 200 71 05w
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Workflow cont’d:

12. Evaluate which step-out is best (removing random noise without creating too many
artefacts)? Once chosen, press Accept and close the attribute set window.

Evaluate | Stepout ~
Initial value 0 0
Increment 1 1
Nr of steps * [calculate |

Slice U

[] Store slices on "Accept’

Stepout [2,2]
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2.3.1g Dip-steered Fault Enhancement Filter

Required licenses: OpendTect Pro, Dip-steering.

Exercise objective:

default attribute sets in two forms:

can be modified.

Remove noise and sharpen edges/faults with the Fault Enhancement Filter (FEF).

The Fault Enhancement Filter is a combination of dip-steered median filter and
diffusion filter, modifying the seismic volume to enhance fault visibility.

Based on a similarity threshold, the data is smoothed (DSMF) away from the faults

and sharpened (DSDF) at the fault location. The filter is released with the software as

* Fault Enhancement Filter. All basic attributes needed as inputs for the filtering are
shielded and the user can only control the amount of smoothing (dip-steered
median filter) versus sharpening (dip-steered diffusion).

* Fault Enhancement Filter (expert): The full attribute set definition is shown, which

Workflow:

1. Start the 3D attribute set window
by clicking on } |

2. Click on default attribute seticon

3. Select Fault enhancement filter
and press OK button.

= Aftribute Set 30
Faa

ol JCR N ICIE Y T
Atnbute sat | <not saed> <Al | T | (7
Ingut Data > | D Selet
Time gt (e |25
Extenpon Crons
Sepont w1 4 [en1 3

Stewing Nooe

' Default Attribute Sets = | @ [

Select default attribute set

Filter *

AVO attributes from Intercept-Gradient
AVO attributes from Near-Far

dGB Evaluate Attributes

Dip-steered median filter

Dip-steered diffusion filter

Fault enhancement filter b
P m v

© Cancel| | §J Help |
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Workflow cont’d:

4. Select the 1 Original Seismics as
input seismics and 3 Steering BG

= Attribute set definition

Background as input steering and

press OK.

s
Select Seismic & Steering input
k=]
Input Seismic keb| | 1 Original Seismics || © Select
Input Steering [ fi&)] 3 Steering BG Background -||© select

W © Cancel| | @ Hep |

This will create a fault enhancement
filter attribute for you.

Keep this window open and proceed
to the next step.

Fault enhancement filter (FEF)

/| MathFunctions
Formula (ke ‘nearstk + c0 * farstk’)  Similarity > 0 ? DSMF : DSDF

For 'Similarity’ use | Similarity >
Value for 'c0" 0.7
For "DSMF’ use | Dip-steered median fiter (DSI ~ |

For 'DSDF" use | Dip-steered diffusion fiter (DS ~ |

i 'sqrt (Square root)

Insert_|

Workflow cont’d:

120-400 and crosslines 350-600.

= Select

+ Right-click on Z-slice in the tree to ST
add stored 1 Original Seismics.
Steering
@ [Zsical o
® V¢ Add Default Data
@\ Add and Select Data s
p %u_'ﬁgﬁo\or Blended B e -

folo e

1 Oviginal Seismics

4 Dip steered median filter

5 ChimneyCube

7aAl Cube Std

TbAl Cube from HorizonCube
8a PorosityCube from HC-NN
8b Gamma from HorizonCube

! 20!{0 Cancel| | 9 Help

Once it is loaded, again Right-click on
Z-slice number 924 to change its position.

=n EoH 7%
Specify the element's position

= Desitioning

4 @ Z-slice
+ (41924
T Add v In-line Range 120 400
® Volume Display * M Histogram
~ ?grldnr Duplicate = Position Gl Bae] 350 600
ine Reset Manipulation 2
< i L‘o\'.;:rrre;.lémj # Grdines . Z (ms) 1640 3 [ Scrol.. |
+ 20 Horl 4¥ Properties
Fautt | = Remove from Tree Resolution » [ = Apply
FaultStickSet - -

0 Cance\-: | @ Hep J

7. Load the default seismic data to a small area of the Z-slice at 1640 ms, between inlines
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Workflow cont'd:

8. Apply the Fault Enhancement Filter to the constrained Z-slice at 1640 ms.

Right-click on Z-slice number 1640 to add the FEF attribute.

&% Volume Processing Attribute

= & Z-slice
S8l 1640
v 1 oL
® volume Display
~ Random Li Duplicate
- gg I.‘!ﬂef Reset Manioulation |
= Select
Select Layer 2
Stored
Steering
&)
—
‘=

Fault enhancement filter (FEF)

=S

[ © ok I O Cancei| | @ Help

Workflow cont'd:

9. Compare 1 Original Seismics with the FEF
attribute on the constrained Z-slice 1640 ms.

Make sure to use the same colorbar
for both.

4500 Il 4500 |rasSeismics

BN Rainbow

1 Rainbow Plus
I8 Red-White-Black
I Red-White-Blue
# SandShale

range

B Similarity

1 SunRise [
1 Tasty 1
M UVQs Example (5-Classes) =

Did you get clear enough differences
between criginal seismicsand FEF?

Original Seismics (left) and FEF Seismics (right) displayed on Z-slice at 1640 ms.
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Workflow cont’d:

Evaluation of constant c0

A critical parameter of the Fault Enhancement Filter is c0. If the similarity
value is higher than the cO0 value, then the Dip Steered Median Filtered
Seismic is used and otherwise the Diffusion Filtered Seismic is used.

10. Go back to the attribute set window, e o e (S8 HoB =5
and click on the attribute evaluation SETENEER

icon 'F?, to evaluate the constant cO0. :
’ Evaluate |c0 -

| Initial value 0.1 |

. I 0.1
11. Use Initial value: 0.1, Increment: 0.1, | nerement |

Nr. of steps: 9 and press calculate. |Nr of steps 9 [ calculate |

(@ Accept] | @ Hep |

Workflow cont’d:

Evaluation of constant cO

12. Move the slider to assess which constant shows the best results (more faults visible and
less noise)? Press accept to save the constant c0.

SiwabEanT-<B
BT e i e F s
Teew scene 1
2 |omeres
é

-
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Workflow cont'd:

Fault Enhanced Similarity

13. Open the Attribute set window and create a new dip-steered similarity attribute using

the FEF attribute as input. Use the default values for rest of the parameters. Name it
FEF_Similarity and Add as new.

= Retribute Set 30 = R <" |
File
* Pt ¥R B -
Aftribute set <not saved> <All> - | [Similarity 2] |2
Fault enhancement fiter (FEF input Data |Fault enhancement fiter (FEF) *| | D Select ...
FEF_Similarit
- ! Time gate {ms) -28 28
Extension |Cross -
Stepout inl:1 et
Steering | Full >
Steering Data fes| &) 3 Steering BG Background - [© seeat
&
\ 4
izt
—
Output statistic [Average -
E | atrie tame FeF_simiary |[aas new fim
Save on Close | @ close| | @ Help

Workflow cont'd:

Fault Enhanced Similarity

14. Create yet another dip-steered similarity attribute using the 7 Original Seismics as
input. Use the same parameters as the previous step. Name it FS_Similarity and Add

as new.
= Attribute Set 30 =Rl
File
2Pt R B -
Aftribute set <not saved> <All> - | [Similarity =] |2
Fault enhancement fiter (FEF Input Data |1 Ongmnal Seismics *| | © Select..|
FEF_Similari
FS_é\mﬂarﬂy" Time gate (ms) -28 2%
Extension |Cross -
Stepout inl1 T e
Steering |Full zl
Steering Data fea| [ 3 Steering BG Background - [© seeat
&
. 4
24
—
Output statistic [Average -
7 | Atiribute Name FS_Similarty " Addas “e'"-h.
Save on Close low;e @ Help
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Workflow cont’d:

Fault Enhanced Similarity

15. Apply one-by-one the FS_Similarity (calculated using original seismic) and the
FEF_Similarity (based on the Fault Enhancement Filtered seismic) to the constrained

Z-slice at 1640 ms.

>

Don't forget to use identical
Similarity colorbars!

Dip-steered similarity from Original Seismics (left) and FEF Seismics (right)

Tip: Both Fault Enhancement Filter and Fault Enhancement Filter (expert)
can be accessed from the ‘Default Attribute Set' using the Drawer
from the row of icons at the top.

' icon

[E=3 Eom m

= Default Attribute Sets
Select default attribute set

Filter *

Evaluate Attributes z

AVO attributes from Intercept-Gradient L

AVO attributes from Near-Far I

dGB Evaluate Attributes

Dip-steered median filter

Dip-steered diffusion filter

Fault enhancement filter

Fault enhancement filter (Expert) o
m

« »

) Cancel| | {9 Help
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2.3.1h Unconformity Tracker

Required licenses: OpendTect Pro, Dip-Steering.

Exercise objective:
Create two horizons: 1) a seismic event constrained by a few manually picked positions;
2) an unconformable event constrained by well markers.

Workflow:
1. Pre-load the default seismic data set (4 Dip steered median filter).
2. Add an in-line (Add Default Data)
3. Add the stored Random Line called: “Random Line through wells”
4. Add all 4 wells o
5. Go to 3D Horizon > fi:“li‘ e
New > Track Unconformity ... -EV:I%“ NMI — Auto and Manual Tracking ..

Track Unconformity ..

¥ FO8-1
¥ FO3-4
¥ FO3-2

Thalweg Tracker ...
With Constant Z ...

Traditional trackers follow amplitude and phase. Unconformities do not exhibit consistent
amplitude / phase behavior and can thus not be tracked with a conventional tracker. The
unconformity tracker flattens the dip field using a constrained inversion-based algorithm.
Constraints are given in the form of picked positions and (optionally) a confidence weight
volume.

Workflow cont’d:

6. In the Unconformity tracker window, select the input steering cube for the tracking: 2.
Steering BG Detailed.

Ideally, use a detailed steering cube (see Exercise 2.3.1a) calculated on enhanced seismic.

7. Optionally, limit the output  Uncntormty mcr B
extend by using the Steering Data .,‘='> B Iz Steering BG Detailed » 6 select..|
Volume sub-selection. Volume subselection Ilm_um-;aofusu (463 samgles) e Salacl..l

Pickset Color  Options Horizon
8. Optlonally, Change thE Hnrimnj- Edit ... Ihri.\r'»mn-:h.\knmh-,:fm\f.n.\int1I
. Horlzon 2
names of Pickset and dortson 3
Horizon by double clicking Hortzon &
on the respective fields.

{[1][ % b

7| Execute in Batch | 4.} Options ... Processing parameters ...

O Run | | D close | @ Help
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Workflow cont'd:

9. Click on the Pick Seeds icon ««* and
pick a few points (minimum 3) on the
event you want to track.

10. Optionally, pick more points on in-lines =
and cross-lines. Alternatively, open an

existing pick set with interpreted points [Epr— =]
by clicking on the corresponding icon: = selectmarkers from one o more el
et =
E -
11. For the second horizon press the L :3: ;
wells icon 4 | and select the FS7 B/
marker from all wells. £ mest1
Wells ¥ = Fllter *
Picksel  Color  Options Horizon a5 E‘
Horizon 1 Constraint 1 - Edit.. Surface constrained by Const B ~van !
Horizon 2 F - Edit... Surface constrained by FS7 ral

Haorizon 3

Qox | (O cancel

Workflow cont’d:

12. Select Processing parameters ... and read the information for each of the parameters.*

' Processing parameters
Apply faull dips ) Yes @ No

|

seect | Create

O

Gonfidence weignt i) i -
Flip weight
Confidence Power |6
Number of Horizon updates 10
Advanced GG Sover parameters
Number of CG Solver ltarations 200
Solver residual error 0.01

Preconditionning fiter stepout inl& = cr6 =

FEEEEEER

Inversion operalor weight 0

Reset

o
i
o
§

* A good “Confidence weight” volume example is the Planarity volume.
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Workflow cont’d:

13. Close the Processing parameters
window and start processing by

pressing

14. When the batch process is finished
Close the window and Add the new
horizons to the tree.

15. Add a random line to QC* the horizons.

16. Improvements can be made by (if
needed): adding more picks; adding a
confidence weight volume and by
changing the inversion parameters.

*Tips: Change the color bar of the random line to grey scale; Show the horizons at sections
only; Change the line thickness (Horizon -> Display -> Properties); Move and rotate the
random line to check whether the horizon is following the events properly.
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2.3.2 Attributes for Faults & Fractures

What you should know about Faults & Fractures in OpendTect

The Faults & Fractures plug-supports a collection of attributes, filters and tools for
visualizing, manipulating and analyzing faults and fractures. Some of the tools in
this plug-in can be found elsewhere in the system, e.g. in the attribute engine, oth-
ers are only available through this plug-in. In combination with dip-steering the
plug-in offers additional dip-steered and dip-derived attributes and dip-steered fil-
ters (Structurally Oriented Filters) such as fault enhancement filter and dip-
steered median filter.

Important fault attributes are:

» Thinned Fault Likelihood (developed by the Colorado School of Mines)
» Dip-steered similarity (best applied after fault enhancement filtering)
» Polar dip (directly computed from a (dip-)SteeringCube)

Special fracture attributes are:

» Curvature attributes (points up flexure of reflectors without fault throw)

» Fracture proximity (measures the distance to the nearest fault / fracture)

» Fracture density (measures the number of faults / fractures within a user-
defined radius)
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2.3.2a Thinned Fault Likelihood

Required licenses: OpendTect Pro, Faults & Fractures.

Exercise objective:

Workflow:

2. Select 3D

Create Thinned Fault Likelihood attribute.

1. Launch the Faults and Fractures Control Center by clicking this

=

3. Select the Thinned Fault Likelihood attribute from the list and press Go...

= l Attributes
ALEl

i I Filters

i \‘\\ Planes

% Tools

' Faults and Fractures 3D Control Center

Available Attributes
Fault Likelihood (FL)

Thinned Fault Likelihood (TFL)

Create TFL from FL
Basement Fracture

Convolve (Edge Enhancement)

Curvature

Dip/Azimuth Attributes
Fault Dip/Azimuth
Fault Painter

Finger Vein Attribute

Fracture Density/Proximity
Gradient/Azimuth of Curvature

Semblance
Similarity

IOCIose | 3 Help

==

~ jcon.

Workflowcont'd:

3. Specify the Input Cube 4 Dip
steered median filter.

4. To speed up the process set
Volume sub-selection to inline
120-400, crossline 350-600,

z range 1400-1848.

5. Choose Advanced Settings to

Create Thinned Fault Likelihaod - oIEN
Input Cube & 4 Dip steered median filter v| | © Select
Volume sunsslecnori 120/350-400/600 (113 samples) © Select
Output Cube| TFL ]| © sewect | @cBYS

Batch execution Single Process

view the parameters.

Keep a large Z stepout
(recommended)

6. Keep the default parameters,
as shown in the image on the
right and Close the advanced
parameters dialog.

Filter size (inlfcrl/sample) inl:2
Maximum dip (us/m) 800

With planarity () Yes

Fault strike scan range in degrees 0

Strike scan smoother 16

Fault dip scan range in degrees 25

7. Provide an Output Cube
name, e.g. Thinned Fault
Likelihood, and press Run.

Smoothing along dip/strike
increasesthe continuity of a fault
plane. Over smoothing may also

enhance outliers.

Dip scan smoother 20
Velocity (m/s) 2500

Apply thinning (® Yes

- |4} Oplions

-

O

Ocise| @Hen

@ Advanced parameters for Thinned Fault Likelihood — & II

crl2

® No

< 360

65

No

s [z:32 &

+ Nrsteps |25 s

+ Nrsteps & =

@1
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Workflow cont’d:

8. When processing is finished, display the Thinned Fault Likelihood on inline 200.
* Right-click on inline > Add Default Data.
* Change the inline number to 200. In-iine 200 [~ |Step 1 [
* Right-click on inline nr. (i.e. 200) > Add Attribute; Under the Stored section, select
Thinned Fault Likelihood.

9. Apply semi-transparent color bar (e.g. Chimney) on it for better visualization.

10. The result should be similar to the one shown below.
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2.3.2b Volume Curvature And Others

Required licenses: OpendTect Pro, Dip-steering.

Exercise objective:

Workflow:

3D.

1. Start the 3D attribute engine: Analysis > Attributes >

Compute and compare various attributes that pick up faults and fractures.

@) Survey m Processing Scene  View  UMilit

Ly 5 O 2o
\ ; & Volume Builder ... M
r In-
J Ei Cross-plotData »
Tre A wells *
El{ & Layer Modeling »
= Fluid Contact Finder
i Neural Networks »
. ossis »

Z, Thalweg Tracker ..
1 Velodity Model Building  *
Well Correlation Panel

STy Y

Workflow cont'd:

4. Press Add as new.

2. Select Similarity attribute from the list of attributes.

3. Keep all the parameters by default and give it a name, e.g. Non_steered_Similarity.

r = .}
& Attribute Set 3D = | ]
File
> AL 3
o AR LY 15
Non-Stasred Simitarty Inpul Data |4 Dip steered median fiter [+][© seea..
Time gate (ms)|-28 |28
Extension | Cross [=]
Stepout inl:1 4 o1
Stuering | None =
t
4
-
Output stasistic | Average
aribute Mame [rion-Sieerea Simiariy ][l as new |
| Save on Close Ocmse' £ Help
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Workflow cont’d:

7. Press Add as new.

6. Type in a new name: Steered Similarity.

5. Change Steering to Full with 3 Steering BG Background.

File

& Attribute Set 3D

Non-steered Simaany
Slaered Similanty

7| Save on Close

at N NL Y S

Afiribute set| <not savec>

<All> =| | Simitanty

Input Data 4 Dip steered median fitler

Teme gate (ms) 26 28

Extension | Cross

=2

&

Stepout |ink1 5 el &

Stearing | Full

Stosring Data (] [ Steering BG Backorouna *|[© Sewc.. |

Outpud statisic Average

Mricute Nasmel Steare Semilarity 434 85 now | il

=]

[=][© satect..]

(@ Cose | [ @ Hew

Workflow cont’d:

8. Select Curvature from the list of attributes.

9.
Curvature.
10. Press Add as new.

Change output to Most pos curvature and type in a new name, e.g. Most Positive

= Attribute Set 30
File

Aftribube sel <nol Saved>

Non-steered Similarity
Steered Similanty
Most Positive Cusvature

¥ Save on Close

24

ol A NN UL T A

7

InCrl stepout |2
Constant velocity & Yes o

Velocity (mis) | 2500

Output [Mast pos curvature | =

Steering Data % ‘i=> 3 Steering BG Background

[=][© seteat.

Attribute Namelr.last Positive Cunvature

| = )

Lo (=) ]

Q Close | | (3 Help 1
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Workflow cont'd:

11. Change Output to Most neg curvature and type in a new
Curvature.

12. Press Add as new.

name, e.9. Most Negative

o Artribute Set 30

File

2PN R AE -

Adfribute set| <not saved> <Al [=] cunrature
Non-steered Similarity
Stegred Similanity

Mos! Positive Curvature
Most Negathe Curvature

Inlicy stepout 2
Constant velocity @ Yes No

Vedodity (m/s) | 2500

Steering Dala Fé fi&] 3 steering 86 Backgrouna

Attribute Mame | Most Negative Cur ature

] Save on Clase

PSET=)
=] [2
[+](© seeat
| [24 35 new il
(@ 5e) (@ e

Workflow cont'd:

13. Select Dip from the list of attributes.

14. Change Output to Polar dip and type in a new name, e.g. Polar Dip.

15. Press Add as new, Un check Save on close and Close the window.

& Attribute St 3D
Filo
& [ [ .2 =
UeeRa NAE

Fon-steered Simiariy steering Data (5] fiy] |3 Steering BG Backgroung [=]|© setea.|
Steerad Similarity —
o3t Positive Cunvalure Oulput Polar dig -
Lost hagative Curvature
Polar Dip

24

—_

Atibute Name [Potar Bip |[aa es ne] i

[

FED T
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Workflow cont’d:

16. Right-click on Z-slice in the tree > Add

and Select Data.

17. As visualization of the full z-slice will

take some time, we will limit the inline
and crossline ranges. So, press Cancel

in the pop-up window.

18. Right-click on the Z-slice number in the

tree > Display > Position.

Elements. Color
Scene 1

&' In-ine

i Cross-line

& [Z-slice

@ volume _ Add Default Data

PellE L0 Add and Select Data

2D Line  Add Color Blended
& 2N ok

= Select
Select first layer
Stored
Steering
@ Attributes | Poloar Dip
o
5

MNon Steered Similarity
Steaered Similarity
Most Positive Curvature
Most Negitive Curvature

Q0 ][Q carce] [ @ e |

Elements

Color
Scene 1

W In-line

W Cross-line

= i Z-slice

T age v

7 |
@ volun IR 1, wistogram .
~ Rang Duplicate

720U ReselManipulation N
T P 120N Gridines .
0ck Treeitem
s 204 @

Fault = Remaove from Trae

Fautstigkset |
& Body

Wwell

4¥ Properties ..
Resolution  *

Workflow cont’d:

19. Position Z slice 1640ms between

inlines 120-400 and crosslines 350-600

and press OK.

20. In the pop-up window select Non-

steered Similarity from Attributes tab.

21. Press OK to display it in the scene.

[ @ Positioning [E=EERT)

Specify the elements position

In-line Range 120 = (400 =

Cross-line Range 350 600 =

[ - Apply

! Select

=

Select Layer 1

SEe
. Steered Similarity
Steering | Most Positive Cunvature
Most Megitive Cunvature
@ Attributes | Poloar Dip

&
=

| QoK | kQCanceJ‘ [ ) Help J
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Workflow cont'd:

= ; Z-slice
S]] 1644

22. Right-click on the Z-slice 1640 in the tree > Add > ® Voume  Display
Attribute. -~ ?;TIU:ET Duplicate
@ 3D Hor

4 20 Hor & Lock Treeitem
Fault |== Remove from Tree

Reset Manipulation

L “& Volume Builder Attribute

= Select =0 MoR(F>=
Select Layer 2
Stored [Non Steered Similarit ]
. i . ) Steered Similari
23. In the pop-up window select Steered Similarity Steering | Most Positive Cunvature
. Most Negitive Curvature
from Attributes tab. ® Attiibutes | Poloar Dip
. L i
24. Press OK to display it in the scene. B
=
[© < ][ concsl] [ @1

25. In similar way display the rest three attributes.

Workflow cont'd:

26. Now you can compare them by checking/unchecking the attributes.

27. Click on an attribute in the tree to make it active and change the
color bar to Similarity. Do the same for all the attributes.

28. The result should be similar to the one shown below. Display and
compare the different attributes. What do they highlight, and why?
Which attributes are best under what circumstances, and for which
purpose (fault or fractures)?

nr
-

ESE 2 1]

B

5% gl
A

4

- .

-

¥
g
.8

A
b

-y

’b"}
y
- o B

A Y S TR IR
Steered Similarity Most Negative Curvature

0.78 1[I |0.941¢m Simiarity

B Rainbow_classes
I 8 Red-White-Black
8 Red-White-Blue
® SandShale

| SandShale-none
I 1 Sgismics

1 SunRise
o Ta 3
W UVQs Example (5-Classes) ~
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2.3.2c Bodies

Required licenses: OpendTect Pro, Faults & Fractures.

Exercise objective:

Create and rank fault bodies from a fault discontinuity attribute volume.

Workflow:

Click on the Faults and Fractures icon -
2. In the Faults and Fractures control center: Select Voxel Connectivity tool in the Planes
module.
3. Press Go. = Faults and Fractures Control Center =&

Plane Tools

o | Attributes

AE)

i Filters

K}\\b‘ Planes

% Tools

Extract Planes
Extract Skins
Fault Throw

©) close | | @ Help

Workflow cont’d:

4. Define the first step:

a. Select Fault_Likelihood_Thinned_from_DSMF_seis as Input Cube
b. Give a Name for this step and click Ok.

oy

Edit step =] x |

Input Volume

Input Cube LE’} = |uIt_LikeI\hood_Thinned_from_DSM F_seis v |6 Select ...

Name for this step| Fault_Likelihood_Thinned_from_DSMF_sei: |

©OK | @ Cancel @ Help
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Workflow cont’d:

= Edit step - olEN

Voxel Connectivity Filter

5. Define the second step:
a. Select the Voxel Connectivity

Filter step and click on . [ Keep Values larger than ~|
b. In the Edit step window, Keep [ Value 08 |
Values larger than 0.6. Connectivity [Full (26 neighbors) v
c. Set the body size threshold to |[Keep bodies larger than [voxels] 100 = |
100. | Kept output Body size V|
d. Set the Kept output to Body-
size.

i . Rejected output ' Undefined value ' Value
e. Give a Name for this step.

Click on OK.

Name for this step Extract Fault Bodiesl

@ Cancel @ Help

Voxel Connectivity Filter is a special tool to create continuous bodies based on the
amplitudes in a stored volume. A voxel is defined as the volume around one sample. It is
thus linked to the survey bin size and sampling rate.

Workflow cont’d:

6. In the next Volume builder main window, give a name to the Volume builder setup.
7. Make sure the box Process on OK is toggled on and press OK.

! Volume Builder: Setup ===
Available steps Used steps D
Body shape painter - Fault_likelihood_Thinned_from_DSMF_seis " d
Lateral Smoother Extract Fault Bodies 3 |l\_.1
Smoother

Horizon-based painter - Simple
Horizon-based painter - Advanced =l
Velocity gridder I *
Input Volume

WellLog Interpolator

Fault Painter
HorizonCube-Well Interpolator
Voxel Connectivity Filter

Lo

On OK, store As  Extract Fault Bodies -| [O Select...‘

e

If the Process on OK box is toggled on, pressing OK will prompt you to save the Volume

Builder setup and specify an output volume name. You can also save and retrieve setups
with the icons: = and “=. Processing is then started from the Processing menu, option
Volume Builder ...
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Workflow cont’d:

8. In the Create output window, the active Volume Builder

-

setup is selected by default. In-ine Range| 120 2 400 %

9. Reduce the volume to process: press Select and specify

. . ) Cross-line Range| 350 2| 600 =
Inline, Cross-line and Time ranges as shown.

Time Range (ms)| 1400 = 1848 =

10. Specify a name for the Output cube and press OK.

=) Volume Builder: Create output - B “
|VOIume Builder setup | Extract Fault Bodies v| © Select ... "‘ Edit ...
Volume subselection  120/350-400/600 (113 samples)

|0utput Cube  VCF ranked fault bodies v| © Select ... |#ICBVS -

Batch execution Single Process ~ < Opfions

) Cancel @@ Help

Workflow cont’d:

11. To display the created volume, click on Volume in the tree and select Add to add a
volume viewer to the 3D scene.

12. Click on the new tree item and go to Display > position. Set the viewer to the ranges
specified in the previous slide either using the menu.

Alternatively use the *s icon.

¥ Z-slice

® Volums i —
e Add @ Positioning - olEl
+/ 2D Lii Add Color Blended
“ 3D Horizon

Specify the element's position

In-line Range| 120 |2 400 < |85
;Gjll‘jﬁqee Cross-line Range| 350 & 600 3
03] 343-50. _ o -
<l <righ, Add N Z Range (ms)| 1400 < 1848 3
~ Random . JGTTEIINN 1 Histogram ... : :
A gg I;Img Duplicate i¥ Properties ... QoK | @ Cancel @Hep
orz9  Reset Manipulation
1 2D Horiza p—— osition ...
Fault o Lock Treeitem
FaultStic. == Remove from Tree
® Body
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Workflow cont’d:

. . = -olEN
13. Select the volume you just created in the ' s
. - Select Layer 1
pop up window and click Ok.
. ® Stored P-Impedance_rel_F03-4 s
14. Select a color bar (e.g. Extremes). Adjust steeri Spec Decomp FFT
teering System Tracts
transparency as needed and ensure that A
. . . Attributes \."elocl_ty madel (INT)
undefined values are displayed with 100% ™ Valocity model (RMS) .
transparency. “ : 2
= Filter *
To edit the colorbar: see Exercise 1.2.2 SOk [Ocacs [G1eh

[i I | |I

Segmentation None =]
Undefined color | ] Transp |100% =
Marker color [- ]
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2.3.2d Planes

Required licenses: OpendTect Pro, Faults & Fractures.

Exercise objective:
Extract fault planes from a Fault Likelihood volume.
Workflow:
1. Click on the Faults and Fractures icon =g .
2. In the Faults and Fractures control center: Select Extract Planes under the Plane
Category' “ Faults and Fractures 3D Control Center - [m] X
3. Click on Go. Pians Tools
I Altibules Extract Planes
A Voxel Connectivity
i i Filters
‘\:\ %, Planes
L
}5 §;
@ e
Workflow cont’d:

4. In the Fault Skin Processing settings window create an input Fault Likelihood cube.

‘= Fault skin processing settings ol e =-
Fault likelihood cube &) &) - [© select .|
Volume subselection - 6 Select ...

¥ Use Recursive Gaussian filter for pre-conditioning
Minimum Fault Likelihood: For Skin 0.10 7 ForSeed 0.50 2
Maximum delta: For Likelihood 0.10 [T For Strike 15 -| For Dip 5
Minimum Skin size 1000

Velocity (ft/s) 10000

@Rrun | [ ©ciose | [ @ Help
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Workflow cont’d:

5. Select 4 Dip steered median filter cube and keep the processing parameters by default.
6. Restrict the volume subselection to inline 100-400, crossline 300-750, z range 1400-1848.

Volume subselection 100/300-400/750 (113 samples)

+ ¥ Advanced Settings

Output Cube F1|

Batch execution |S‘|ngle Process " . .. Options 1

2 Create Fault Likelihood = !
Input Cube F% "B, 4 Dip steered median filter - Ie Select l

- |© select..]

LORun || @ ciose || @ Help |

'« Positions [?Hﬁ]
Specify Positions
Volume subselection | Range = i{:}!_ 3‘ lg
In-line Range| 100 < 400 s |Step 1 —
Cross-line Range| 300 < 750 S |Step 1
Time Range (ms)| 1400 2| 1848 C |Step 4 :

[ @ox | @ cancel| [ @ e

Workflow cont’d:

7. Select the processed Fault Likelihood volume.
8. Press Run to extract fault skins.

Fault skin processing settings
Fault likelihood cube (| ) FL

Volume subselection 100/300-400/750 (113 samples)

Minimum Fault Likelihood: For Skin 0.10 2 ForSeed 0.50 %

Maximum delta: For Likelihood 0.10 2 For Strike 15
Minimum Skin size 1000

Velocity (ft/s) 2500

| Use Recursive Gaussian filter for pre-conditioning

- ForDip 5 —

===~

[© select .|

| ©run | © Close H @ Help |
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Workflow cont’d:

9. A set of fault skins is now displayed in the 3D scene along with Fault skin QC window.

0y Dl B e e » BB o v Sl S S0 T L ED A B
8 fault sin OC slar=l|
W No Skins sedsct
- . kil
PR TN B
/ St T h
{ . oA -
! . Ld ry
i
I - e s
| " | % show Skins ] Hide extracted .
Y O / ®
Y . .t " / Display |Skin Size 1
\ o
\\ ] / we B Wiun [Desa Ay
| . e Selction color | [N | (5 e E.
s 8 Extract Selected ... | Merge <€
68
4
§ 20}
1%9 5000 10000 15000 20000
Skin Size
Filter Criterla (Skin Size -] @ Inside © Outside ) Keep Selected
Total number of skins: 112 Number f skins In range: 112
@ Finish | | D < Back

Ho Skins selected

Workflow cont’d:

10. Select an individual fault by clicking on a skin (it turns green) and Extract Selected as an
individual fault plane.

o I, BEIWY W L.

8 Faultsin 0C

i, N
- ~. W
S TN -
- R - \\

f/ - &
/ . . h
i
wi . . e .
\ . /.‘ %1 Show Skins ¥ Hide extracted iy

\ e s
| \ Lt e / Display Skin Size ™ bt
\ B / A
\ T / we B Wiun [Desa i
| ~— S Selection coor [N (Mime E.

Filter Criteria | Skin Stze. = @ Inside Outside # Keep Selected
Total mumber of skins: 112 Number of skins In range: 112
@ insh | | O < pack
1 Skin salocted, use Shift-Click to select more
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Workflow cont’d:

11. Select several skins using Shift + left mouse click.
12. Check the Merge option and extract the skins as one fault.

o B, BTV W AL P T B NV ESSY
8 Fault skin QC =R ICh =]

) Show Skins ¥ Hide extracted
Display [Skin Size =
weo B Wae  [Crasel
Selection color | [ | | B8 Lime:
Extract Selected ... /| Merge

A=

A= 9>

o
§ 24
201
1%9 5000 10000 15000 20000 29410
| Skin Size
Filter Criterla Skin Size. = 9 Inskde Outside ¥ Keep Selected
Total number of skins: 112 Number of skins In range: 112
| @ rinsh | [© < Back| | @heip |
4 skins solected
H -
Workflow cont’d:

13. Select all skins using Ctrl+A.
14. Extract all skins as a Fault Set.

G su

Fa BEPN W IR P P PRS- T B NIV« BN TS
2 Fauitskin QC AR

! Show Skins ¥ Hide extracted
Display [Skin Size -
weo B Wiz [Crastel
Sedection color | [ | |5 Lime:

[ Extract Selocted .| 1 Morge
[24
10000 15000 20000 28410
Skin Size:
Filter Criteria [Skin Size -] ® Inside ) Qutside ! Keep Selected

Total rumber of skins: 112 Humber of skins In ranges 112
| @finsh | |© < ack| | B e |
116 Skins solocted

. 7 v

SuFANE

an,
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2.3.3 Ridge Enhancement Filter (REF)

What you should know about the Ridge Enhancement Filter

The Ridge Enhancement Filter is a post-processing filter for fault attribute
volumes, such as Similarity. It sharpens the attribute response such that faults
are more clearly visible.

The ‘Ridge Enhancement Filter’ is delivered with the software as part of the
default attribute set.

The set calculates similarity attributes at 9 locations surrounding the evaluation
point. Then it compares the differences between similarity values in 4 horizontal
directions. The direction perpendicular to a fault usually exhibits the largest dif-
ference and is therefore output as the Ridge-enhancement attribute. The effect is
a sharper outline of the faults.

Similarity

time-slice

Semilarity s calculated as the average of
b trace-pairs at 2 locations surrounding
tee evaluation poinl

The default attribute set is based on Similarity. With only minor modifications, this
attribute can also increase resolution of other attributes like curvature, or volumes
as fault probability volumes.
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2.3.3a Ridge Enhancement Filter

Required licenses: OpendTect.

Exercise objective:
Compute the Ridge-enhancement filer attribute for improved fault visualizations.

Processing Scenes View ULl

Atributes. [ ;
Workflow: -
“& Volume Builder ...
Ei Cross-plot Data v
Wel 12

1. Start the 3D attribute engine: Analysis > Attributes > 3D.

& Layer Modeling

= Fluid Contact Finder ...
Meural Networks
SsIS &
Velocity Model Building  *
Wel Correlation Panel ...

Workflow cont’d:

= Default Attribute Sets == EoB T

2. Open the default attribute set . Select default attribute set

Filter |*

. . Evaluate Attributes

3. Select Ridge Enhancement filter (Expert). AVO attributes from Intercept-Gradient
AVO attributes from Near-Far
Workflow - Data Enhancement (dGB)

Ridge enhancement filter (Expe
4- Press OK Fault enhancement attributes

Leflevuse . | Lnes #: Saaman
B

"
0 Cancel ) Help

5. Select 4 Dip steered median filter for Input seismic and 3 Steering BG Background for Input

Steering.
i Attribute set definition =N Ech |
6. Press OK.
Select Seismic & Steering input
Input Seismic =N I"" ] 4Dip steered median filter EI 6 Select
= =
Input Steering ié) le 3 Steering BG Background E| e Select...

0 T € Help ]
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Workflow cont’d:

7. Keep everything default with the default name Ridge enhancement filter.

8. Uncheck Save on close and then Close the window.

élla
od B 21T 2

Attribute set | <not saved>

Similarity
Calculated_or_Stored_Simi
Dip-steered median filter (D
Dip-steered diffusion filter (
Fault enhancement filter (FE
Similarity on FEF
RS_+1_0

SecondDe rivative_Inline
SecondDervative_Crosshing "
SecondDernvative_Diagonal |
SecondDervative_Diagonal El'
RidgeEnhancementF ilter

<Al

For ‘inider’ use SecondDerivative v

For 'clder’ use SecondDerivative v
For 'diag_oneder’ use SecondDerivativev

For 'diag_twoder' use SecondDerivative~

- olEl|

Attribute Set 3D
v| Mathematics ~ 2
/ MathFunctions ~| sqrt (Square root~|  Insert ] <+ o
Formula (like ‘'nearstk + c0 * farstk’) max(inkder cider,diag_oneder diag_twoder) Sat

Laplace on similarity [—
< > Aftribute Name RidgeEnhancementFilter Add as new| [l
o
Workflow cont’d: Elements Colol
Scene 1
& Indine
9. Right-click on Z-slice in the tree > Add and '_-:g’;f'j:'”e
@ Volume  Add Default Data
Select Data. D" 0 o Soert Dola |
2D Line  Add Color Blended
i AN Uae
10. As visualization of the full z-slice will take = Select ==

some time, we will limit the inline and
crossline ranges. So, press Cancel in the

pop-up window.

11. Right-click on the Z-slice number > Display

> Position.

Select first layer

Stored

RS_1_-1

RS_1-1

RS_11
SecondDerivativa_inline

@ Antributes | SecondDerivative_Crosshine
SecondDerivative_Diagonall

Steering

=
=
.Elamenls
Scene 1
! In-line
W Cross-line
& Z-slice
) 9241
v+ Add
© volur IRCETTRNNNNN 1 Histogram
~ Rand  Duplicate
2DLil  pacet Manipulation
® 30 Hy teset Manipulalion | 4 Gridiines
® pp B Lock 33 Properties
Fault| ® Remove from Tree Recobaion
FaltShirkSat Tl
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Workflow cont’d:

12. Load Z slice 1640ms between inlines 120-
400 and crosslines 350-600.

" Positioning EI@

Specify the element's position

In-line Range 120 = |400
Cross-line Range 350 = 600
Z (ms) 1640| = ‘ Scroll ...
v Apply|

I OOK ||O Cancel||9Help |

13. In the pop-up window select Ridge
enhancement filter from Attributes.

14. Press OK to display itin the scene.

™ Select

Select Layer 1
Stored

Steering
@ Attributes
=

~]

|=>.

fo | @ =)

RS_-1_-1 -
RS_1 -1
RS_-1_1
SecondDerivative_Inline
SecondDerivative_Crassline
SecondDerivative_Diagonall
SecondDerivative_Diagonal2 o
|RidgeEnhancementFilter 1
Laplace on similarity

) cancel | @) Help

Workflow cont’d:

15. Once the slice is displayed, click on its attribute in the tree to activate it and change the

color bar to Grey scales.

16. The result should be similar to the one shown below. Compare it with the attributes of the

previous exercise.

= OpendText V6.Blpres- 2150821 mink: F3 Dema_2015 - [Scene 1
Surwy Analysis Processng Scones View Uttes Holp

267968 [ -
5|

- 236 -




2.3.4 Frequency Enhancement (Spectral
Blueing)

What you should know about Seismic Spectral Blueing

Seismic Spectral Blueing (SSB, by ARK CLS) is a technique that uses well data
to shape the seismic spectrum, to optimize the resolution without boosting noise
to an unacceptable level.

The workflow is as follows: an Operator is designed for SSB using both the seis-
mic and well data. This operator aims to shape the seismic amplitude spectrum
such that it becomes similar to that of the well reflectivity spectrum. Once the oper-
ator has been derived, it is converted to the time domain and simply applied to the
seismic volume using a convolution algorithm. As the SSB technique uses both
seismic and well data, one of the main prerequisites of this workflow is to have
good quality well-to-seismic ties.

Typically, the aim is to design an operator at the zone of interest (target). It is
therefore best to identify a time gate for this interval before proceeding ahead with
the SSB workflow. Ideally one should use a good interpreted horizon in the target
zone to guide the seismic traces and well data (log traces). In this manner, the
various gated log traces should have sample values over a similar geology.
However, for this training exercise, in our case we will just use a window interval
instead.

Here is the workflow for how to create and apply these techniques in OpendTect:

Seismic: Amplitude-Frequency plot
Smoothing of seismic mean

Well: Amplitude-Frequency plot
Global trend of well plot

Design operator

Apply Operator

Quality Check

NookwN -~
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2.3.4a Spectral Blueing

Required licenses: OpendTect Pro, Seismic Spectral Blueing.

Exercise objective:

Workflow:

1. Go to the Attribute engine:
Analysis > Attributes > 3D or click
on the ! icon > 3D.

2. Choose Spectral Blueing attribute
from the drop-down list.

%/ Survey Analysis

L [l W e

Attribute Set 3D

Increase the vertical resolution ofthe seismic data with Seismic Spectral Blueing (SSB) technique.

3. FEIE;CtD t‘.' Original Seismics as “Alb | [SpectalBleing 2
nput Data.
P |\anrtDa[a 1 Original Seismics v| | Select |
4. Keep the default Single Operator
option selected. ® Single Operator O Time Variant
) Input wavelet [.‘;) v Select ...
5. Click Analyze and Create ... to
launch the SSB Module.
Workflow cont’d:
- Seismic Spectral Blueing: F3_Demo_2015 - Untitled - olEM
File View Tools Help
In order to design an SSB operator, I SHESE hEEszprPEH0
it is mandatory to analyze the 0 0
seismic and well data spectra by 1
. . . ] elect Input Data ?
loading some seismic traces and v — et =
time converted acoustic impedance | | ., '":"‘f’e‘s'"': '"”“:;"“’“S
% elact races
We" |ogs 5 Select Seismic 1 Original Seismics
404 3D Survey Area
® Full Start End Inc
. [ . 20 Sub | In-iine: |3
6. Click onthe (X} icon to pop up -
the Select Input Data window. . Load Traces
0 2" NumTrarm a0 [ 100
7. Keep 1 Orjgjna,‘ Seismics as o L Clear Traces  Clear Unselected Traces 120 Selected
selected seismic. Time
0] Select Horizon
Range Absolte
8. Click Load Seismic to load 40 o Ful O Honzon  fssant 500
random traces from the selected | ¢ o End 1500
seismic. a
. 20
9. Keep the default Sub option for T =
Time Range and enter 500 0 ; ; . R : — : ‘
0 0 40 &0 a0 100 0 20 40 &0 80 100
Start) and 1500 (End). Tim () .
( ) (End)
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Workflow cont’d:

10. Switch to Input Well Logs tab.

11. Click Load wells.

12. Select the well F3-04 and the
P-Impedance log.

13. Keep the default Sub option for
Time Range and enter 500
(Start) and 1500 (End).

14. Close the Select Input Data

window.

Select Input Data

Input Seismic | Input Wel Logs

Define Format

FieldWells/Logs” Base Horz Time

-

Horz: In-Line  X-Line

Select Input Data

Input Seismic  Input Well Logs

Reload Wells Load ASCIl We Define Fomat.
FielkdWells'Logs Top Base HozTime HorSic InLine X-Lind
] fieid 5 1841
1F02-1 256 1460 undefined |2 33
Pdmpedance 250 1460
Pdmpedance_rel 256 1460
1F03-2 0 1841 undefined 122 B84
Pdmpedance 0 1841
Pimoedance rel 0 1841
. 5 1813 undefined 442 100
5 1813
(Clear Wells| Clear Unsele( mpedance_rel -5 1813
Time: F06-1 0 1625 undafinaa 244 38
PAmpedance 0 1625 SelectAl Log
—
= Pmpedance_rel 0 1825 Generate Al Log
Range
< B
® Sub Clear Wells  Clear Unselected Wells  Reshow Wells
Time
U Help Select Horizon.
Range Absote | Re
Full Honzon gt 500 500
@S OMakers gy isoq  |660
& Help % Close

Right-click on a well either

generate a new acoustic impedance log if it is not

to select another or to

available.
Workflow cont’d:
[ & Seksmic Spectral Blueing: F3_Demo_2015 - Untitled = = ﬂ
File View Tools Help -
THHEL2EP DANEE B2LPEO

15. Once the seismic and well data
are loaded, you can see various
curves displayed in different
plots.

Take your time to scroll through
this window: left-click on any

curve and in the lower left
corner find out what does it
represent.

16. Right-click on any plot to see a
menu that allows to change
various display options, show a
legend, etc.

Zoom Dﬁie (C m+.WneeI or Shift+MB1)
Move Data (Ctr+MB1)

Unzoom/Unmove Data (MB2 or Shift+MB1)
B Unzoom AlVRe :

Show Legend

Display Options...

Screenshot 4

X Axis 4

Y Axis *

Help

100- ¥

g
S 60
g
<
4
20
T T T T
50 100 0 100
Freq (Hz) Freq Hz)
Log Input (time domain) LLog Input Detrend (time domain)
6000000
0054
5500000
5000000
a k e g4
il g
4500000 - 'k
4000000 | i ]
ﬁ JU 005
3500000 o -

T T
0 500 1000

Time ims}
|Dale iterm: Average (70.801, 90 816)

T
1000
Time (ms)

T
L 500

-239-




Workflow cont’d:

17.

18.

19.

20.

Click on A to pop up the
Design Controls dialog.

Smooth the average amplitude-
frequency spectrum of seismic
data displayed on the Seismic
Mean plot.

Uncheck the Full Range option
for Fit Well Log Curves and
enter 125 Hz as the High Cut
frequency, thus limiting it to the
Nyquist frequency of input
seismic.

Observe changes on the Global
plot.

- Seismic Spectral Blueing: F3_Dema_2015 - Untitled =

File View Tools Help

MMecp saleE Bz L LE 0
Raw Seismic

Design Controls

Smooath Seismic Mean

FitWel Log Cuves
Low Cut High Cut

Smoothing Operator Length 5 [EHz

Ful Range 0 SHz[125 [ Hz
Beta: 03439
Design Operator
¥ Auto Cale 2
2 A 6046 [ : |z 112
Auo Cak.  Num Zero X 20

Energy. 909496 %

QC Against Input Seismic

& Help * Close

Amp (48)

2 ] |

- Eix'w
N I||'1:il‘l;. '.l l' I
i."-'r"n'l‘h ”||

o IEN

Seigmic Mean

T T
50 100
Frog (Hz)

1 10 100 1 10 100
Freq (Hz) Freq {Hz)
Workflow cont’d:
- Sefsmic Spectral Blueing: F3_Demo_2015 - Untitled = ‘:'n
File View Tools Help -
21. Tweak the Low and High Cut LT R LE- LR ER L i .
parameters of the Design 3 oo
Operator such that the residual /_’_A,\
operator (blue curve on the , 06
Residual Operator QC plot) | 1/ i ol
stays 0 in the frequency domain, z /
with a quick drop on both sides. 101 02
22. save the operator B by giving o] \ ‘ W\/U ]_J'wa
it a name. This operator is saved T———— T T
50 100 100 50 0 ) 50 100
as a wavelet. aq o 69
/ N
23. Save [ your session (optional). E Desonconios L
301 Smooth Seismic Mean
| Smoathing Operator Length: 5 M2
Fit Well Log Curves
Low Cut High Cut
100 - Full Range 0 + Hz 125 & Hz
Beta 03439
Design Operator
Low Cut High Cut
150 = Auto Calc. Full 8 + Hz 60 + Hz
The SSB operator is stored as a wavelet e el —
and can be visualize in the wavelet oo w0 By 999575 %
manager. Ll QG Against Input Seismic
& Help # Close
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Workflow cont’d:

a View Seismic - ~IEd

- | mine 442 :|Step 1 [= WellTolerance 1 km | [ Cross Hair @, € [l ™

The effect of the_ parameter tweakln_g 5 o7 \mine 442 - 1 Original Seismmice 5
of the Des|gn Operator is = Ij":f‘uz ) 9"!'0 Q?U _QIQO 10‘00 10‘10 10|20 10|30 10|40 1-*]'_

immediately visible in View Seismic
window which can be popped up by
clicking on and is updated
automatically.

« = Blueing

= Crosshine

Property Editor & x
- =
Hints & x
Zoom: (Cirl+Wheel)
Honizontal zoom:(Ciri+Alt+Wheel)
Vertical zoom: (Ciri+Shift*Wheel)) o70 980

¥ = 1 Oniginal Seismics

¥ | F03-4 : P-Impedance

Herizontal scroll: (Alt+Wheel) <

990 1000 1010

T T T T T T T T T T T T

1020 1030 1040 10fw

>

Workflow cont’d:

24. Close the SSB module and return to the Attribute Set 3D window.

25. Check if the newly-saved operator is selected.

26. Specify the Attribute Name and Click Add as new.

- Attribute Set 30
File

e AR TN LY 1
Aftribute 58t <not saveds= <Al> +| Spectral Blueing

S5B_on_Oriinal_Seismics Input Data | 1 Original Seismics
Analyse and Create

® Single Operator O Time Vanant

Input wavedet i | Spectral Blueing Operator_sb

Attibite name | SSB_on_Oriinal_Seismics

Add as new

i Save on Close

Close

- oEN
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Workflow cont’d:

27. Right-click on In-line in the tree and
chose Add and Select Data.

28. Select 1 Original Seismics from Stored
tab and press OK.

Elements Color
Scene 1

N |In-line
@ Crosg_Add Defautt Data

PRI Add and Select Data
@ Volur  Add at Well Location
~ Rand  Add Color Blended

= AN e .
= Select =R EoR ="
Select first layer
9@ Stored 1 Oniginal Seismics -
3D UVQ 6 biased Texture+Energy +SystemsTrac
Steering 3D UVQ Texture+HC attribs+ Energy disk
4 Dip steered median filter
Attributes 5 ChimneyCube
7a Al Cube Sid
% 7b Al Cube from HorizenCube v
Filter *
O canca] @ e

Workflow cont’d:

= iy In-ine
&) 4251
ggl Add [ Ambwe |
¥ Cross D\Spl_av " Volume Builder Attribute
; Sjl'ce Duplicate & HorizonCube Display
U Reset Manipulation = .
3 - Syste Tracts Di
~ fagd.ﬁ Display Prestack Data » psiomsiTiects Display
54 Cormelate with Wels

29. Apply the SSB attribute on inline
425 and compare the result to the
original seismic data: Right-click
on In-line 425 in the tree and
follow Add > Aftribute.

v 4 g Lock Treeitem
2D Lir == Remove from Tree
% 3D Horeor
= vl Demo 6 —> F58

30. Select SSB_on_Original_Seismics
from Attributes tab and press OK.

= Select
Select first layer

@ Attributes

o

Stored

55B_on_Original_Seismics

Steering

@ Cancel | | @ Help
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Workflow cont’d:

30. The results should be similar to the ones shown below.

1 Original Seismics SSB on Original Seismics

31. Compare the original seismic and the SSB seismic: tick on and off the overlaying
attribute in the tree.
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2.3.5 Flat-Spot Detection

Various methods have been developed to detect locally horizontal seismic
events, which do not follow the stratigraphy of the geological layers. These
events are potentially Direct Hydrocarbon Indicators, since fluid contacts will
most often be perpendicular to the pressure gradient, regardless of the structural
dip. Multiples will most often also not follow the local stratigraphy, and are a false
positive for these detection methods, since they will also be enhanced should
they be horizontal seismic events.
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Optical Stacking
What you should know about Optical Stacking

Optical stacking is released as a free (open source) attribute in OpendTect. His-
torically optical stacking was the first stacking method to enhance hydrocarbon
anomalies that emerged in seismic interpretation software systems. Optical stack-
ing stacks seismic traces that are on either side of a 2D profile. The 2D profile
should ideally be oriented such that depth contour lines are crossed per-
pendicular to the line direction. The traces in the stacking direction can be expec-
ted to have similar fluid effects (same hydrocarbon columns) hence subtle
hydrocarbon effects are enhanced.

2D profile for
optical stacking
cutting across
contour lines

Stack stepout in
perpendicular direction
to the 2D profile
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2.3.5a Optical Stacking

Required licenses: OpendTect.

Exercise objective:

Workflow:

1. Right-click on 3D Horizon

® Body  Track New
select Demo 6 --> FS8. el

2. Launch the Attribute Set 3D

. Fault Add at Sections Only
in the tree >=Add... and Fault  Add Color Blended ..

Create with Constant Z ..

Enhance the amplitude anomaly on a random line with optical stacking.

Aroa subselection 1007300-TS0/1 250 (463 samples) © Select

Qo || D) Cancal | ighHeip
Daey_201515urtacesDomo_6_—_FS8 hor

window. 7 Suvey Analysis S e
o Bl % ch e

2D... I
AT 1

3. Choose Volume statistics
attribute from the drop-
down list.

Aribute 500 <nol s>

4. Specify parameters as |
shown on the image to
define an RMS amplitude
give it a name and press
Add as new.

Save on Closa.

*Pe ¥R A AR

=] Vohama Statisics /7
Input Dt 4 Dip steered median fler ] O Seloct
Tima gatn (ms) 28 28 7] Aliow edgn effocts
Sheapo | Cybndes =
Swopot w0 3 o0 2
Min e of vakd traces 1
Oufipnd statestic RMS bl

Stoaring Nors -

Adtribute Hame RMS_Ampl A os v [

G Closa | | i Mo

Workflow cont’d:

5. Right-click on Demo 6 --= FS8 > Add >
Attribute.

6. Choose the RMS amplitude and click OK.
Optionally, change the color bar for RMS
amplitude to Rainbow Plus.

7. Right-click on Random Line in the tree >
New > Interactive ...

= Annotations

“® 30 Horizon
7 -

2o I | TR
! 2D Horizor 3 At

Fault D] " Volume Builder Attribute
FaultSticks Trecking ' Contour Display
® Body It ' Horizon Data
L wel Workflows *
i PickSet |kl Save
[ Polygon | g Save as

= Prestack E &) ook ropitem

== Remove from Tree

oot S
Select Layer 2
sered  IEEST
Steering
@ Adtributes
B
[ @0k | @ cancel | @tep
O Tine Add Default Data
@ 3D Horizon | Add Stored .
+ Demo 6 >
¥ RMS_Ar Add Color Blended »
@ 2D Horizon

From Existing
From Polygon
From Table
From Wells

Fault
FaultStickSet
Body
Well

¥ PickSet
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Workflow cont’d:

8. Pick arandom line going

through the structure where the

amplitude anomaly is seen.

Using the left mouse button,

click on the map to inserta
node.

9. Right-click on a newly picked
random line in the tree > Save
as ... and type in a new name.

~ Random Line
Gl Randd
<40 o
20 Line
® 3D Horz
| Demo
¥ RM

Fault

Display Li
Duplicate

Creale 2D Gnd ...

o DT
'2DHGm Save as ..

Save as 20

amplitude map
e

= Save Random Line 2.
Select oupul Random Ling

Filnr *

i

Examgle mndom contour demo 1 > MFE

Export_Poiy! AL
Ftandam Line 1 {Irining marssal)
e el <

FaultStic & Comelate with Wels .
® Body | g Lock Treeitem Hama Optical Stncking
gt G Eort o Google KhL [T
.D Polygon == Remove from Tree
Workflow cont’d:
= Survey Analysis
10. Launch the Attribute Set QL 2; 12
3D window. %L
h T 1
11. Choose Volume statistics | L
attribute from the drop- e R L L T —
down IISt nm;;:,q,,lp. i Inpust Dt 4 D stened midisn fier -. O Salact
Tima gate (ms) 0 o < Miow adge offocts
12. Specify the following Sheps (Opecs sk
parameters to deﬁne an Mml!‘:i::x -J % Derocbon @ Porpondeculsr Limo
optical stack: 4 Dip Oukut sttt e
steered median filter as : stooring il
Input Data, [0, 0] 'rlme 7 Sivering Duta g 3 Steering BG Background =| | © Saedoct
gate, Optical stack Shape, —
Stack stepout of 15, Full
Steering by 3 Steering BG e Coteatslck s
Background. e o] LOrw

Stack stepout of 15 is equal to 375m at the bin size of 25m.

- 247 -




Workflow cont’d:

® Volume
»  Rendom Line
ight-cli T | YT
13. _nght click on the random g 2o ta Deply A T
line in the tree > Add > > @ 30 Horh giféf;fnp . @ HorizonCube Display
Attribute :gﬂ Create 20 Grid . i} Systoms The =

49D Hori ® Saveas ..
. ! Fault Save as 2D ...
14. Choose the optical stack o TS S
attribute from the Attributes mwg oot oo KL

list and click OK. [ Polygor == Remaxs from Tree

»

15. Optionally evaluate the
Stack stepout parameter.

LOK |[@Gucal [ @tas.|

Compare the optical stack attribute to the input seismic data.
Discuss the results: What events have been preserved, what events have been enhanced, why?

4 Dip steered median filter - Optical Stack
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2.3.5b Seismic Feature Enhancement

Required licenses: OpendTect Pro, Spectral Feature Enhancement.

Exercise objective:
Enhance the amplitude anomaly on a random line with Seismic Feature Enhancement (SFE).
Workflow:
Processing Scenes View Utiies CLAS Help
. Atribut v = = = . @
1. Go to Analysis > ARK CLS = taSEXT-o=@
pegs . . % Volume Builder .. i &
Utilities > Seismic Feature Cross-plot | Cotor]
Wells >
Enhancement. ey _‘
. . Seismic Coloured Inversion
2. Keep all the SFE windows open AKX Ut * |\ Seismic Spectral Blueing ...
. ilities L b
and go to the OpendTeCt main < Fluid Contact Finder ... Ei
window. Neural Networks -
-~ Load RandomLine Geometry = = I’
3. Right-click on Random line in PR e
the tree > Add Stored .... < 3D Horizon Fiter |+
< 2D Horizon |~ Add Color Blended *
. Fault MNew 3 Example random contour demo 1 -> MFS4
4. Choose the random line created ERkSiS-CE = r—— v
in the previous exercise 2.3.5a Ropdom Line through wels exended | (9
and click OK. >
of OK 8 Cancel @ Help
...S\Locations\235a_Optical_Stacking.rdl
Workflow cont’d:
= ~ Random Line
. . . Q7] 235a_Optic....
5. Right-click on the random line name v 4 Dip ste..| A 5
in the tree > Display > Position. el la_Histogram
@ 2D Horizon Duplicate 2 Properties ...
Fault Reset Manipulation Resolution *
Fault Stick Set Create 2D Grid 3 ™
S Body @ Saveas ... osmon... "
Well nsert Node
“ Pickset Saveas2D ...
6. Keep the Random lines window open. - Random lines - oIEl
This window lists In-line and Cross-line Specify node positions
positions of all nodes of the selected
random ”ne YOU Wl" need thlS Enter X/Y or InlCrl positions .NodeomsideSurvey
information in one of the next steps. £ u [oineBISINC rose ne iy
Node 1 620677.22... 60812238... 390 902
Node2 62182286... 60796052... 324 946
Mode3 622531.80... 60783996... 275 973
Node 4 62324967... 6077769.4... 249 1001
Node 5 624182.83... 6076595.0... 201 1037
Node 6 62478343 60756865 .. 164 1060
Node7 62522516... 60741983 104 1076
|Node 8 .
Z range (ms) 0 1848
of OK 88 Cancel @ Hebp
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Workflow cont’d:

7.

10.

11.

Go back to the SFE main
window and Click on Select
Data icon =.

Clickon Input Volume in the
Select Data window

Choose 4 Dip steered median
filter in Select Volume window
and click Select.

Click on OutputVolume in
the Select Data window.

Enter a new name of the
output dataset and click
Select.

File Seismic Process Help

Seismic Feature Enhancement - untitied

= Select Volume

D H|=|0= > 5
8 Select Data ? n
Seismic
| Input Volume... I
Qutput Volume...
Traverse
Select...
Inline Crossline Insert
1 Delete
@ Help X Close
= Select Data * HEl
Seismic
Input Volume... 4 Dip steered median filter

Traverse
Select
Inline Crossline Insert
1 Delete
& Help X Close

* IEN
Fier

1 Onginal Seismics -~
3D UVQ 6 biased Texture+Ene
3D UVQ Texture+HC atiribs+ E
4 Dip steered median filter

5 ChimneyCube &
<

>

Filter options
& Help = Cancel
=B Select Volume  ? n
Filter:
1 Onginal Seismics ~

3D UVQ 6 biased Texture+Ene
3D UVQ Texture+HC atiribs+ E
4 Dip steered median filter

5 ChimneyCube -
< »

| Name Enhanced Seismic |

| Filter options

@ Help x Cancel

Workflow cont’d:

12. Enter manually the random line node positions in the Traverse section from Step 6.

ks Random lines

Specify node positions

- oIEN =

Select Data

» IEN

4 Dip steered median fitter

Table from Step 6 Seismic

Input Volume..
Enter X/Y or InVCrl positions . Node outside Survey

Output Volume..| Enhanced Seismic

X Y In-line Cross-ine |*

Node1 62067722 . 60812238 (390 902 Traverse
Node? 62182286, 60796052, (324 945 Select.
Node3 622531.80.. 6078399.6... |275 973 Inline Crossline
Node 4 62324967.. 6077769.4... |249 1001 1390 902
Node 5 62418283 . 60765950, (201 1037 2 324 946
Node6 62478343 60756865... [164 1060 32715 a73
Node7 62522516.. 6074198.3... |104 1076 4249 1001
Node 8 5 201 1037

6 164 1060
Zrange (ms) 0 1848 7 104 1076

« OK | §8 Cancel @ Hep @ Help

13. Close the Select Data window.

14. Close the Random lines window.

Alternatively, digitize the

picking a polygon that you can select as input
for Traverse by clicking on Select button.

random line by
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Workflow cont’d:

=B Seismic Feature Enhancement - untitled - olEN
File Seismic Process Help
15. Click on Aperture Designicon @ in D= ® =[@-> » =
the main SFE window. !

= Aperture Design 7 IEl
16. Enter 375 m and 75 m as Traverse Aperture Contral |sRaramedirs,
normal and parallel aperture sizes. A’:":;:g:f o ipse & Scal
17. Close the Aperture Design window. Disply idesmated

Traverse
Normal

Aperture
Size

(in project
spatial units)

sm

All traces inside the ellipse are
stacked and the result is output at the
center of ellipse.

Traverse Parallel Aperture Size 75 =
(in project spatial units) =

Qutput 3D Swath Width
# Auto Custom: 0.0 meters
Additional Decimation

Inine 1 % Cross-ine |1

Workflow cont’d:

18. Preview SFE results by clicking on p icon in the main SFE window.

19. Display Seismic by clicking on = :: icon if it is not displayed yet.

= Seismic Feature Enhancement - untitied — © [IEEN a Seismic Display - oIEl
File Sesmic Process H
el =0 > " | Separate display  Display Enhanced lll ?
Proview SFE Original seismic section
? ZIO d‘ﬂ E:ﬁ 8|0 1(|)U 1%0 1?0 1‘50 1?0 2?0 2[21‘1 2?0 Z(ISO 2Ian
— 400
500
— - - L 600
Startsthe SFE processing fr Preven SRR - = : =
700
= Sesmic Feature Enancement - untitied — © I3 - -
SFE processed section
File Semic Process  Help
oy 0 20 40 60 80 100 120 140 160 180 200 220 240 260 280
@ =a=spT = P P P I I WP PPN TP PP P T P P T P
R S e ] = ==
51057 G n 1
o157 e T Sogmu 1 4004 400
16:19'59: Processing Traverse Segment No 2 ]
16:20 00 Processing Traverse Segment No, 3
16:2002 Processing Traverse Segment No. 4 500 500
162003 Processing Traverse Segment No 5
16:20:05: Processing Traverse Segment Ho, 6 ]
182007 SFE Processing complete 9
600 — 600
700 = 700

Paps up e kot ispays e« ERETERAR
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Workflow cont’d:

20. Start Processing by clicking on ) iconin the
main SFE window.

21. Click Overwrite to output SFE results along the
traverse.

Question E3

e This process is about to write seismic data and will
over-write any data already in your output volume

This process may run for a long time

Press 'Overwrite' to continue or 'Cancel to abort

Cancel

22. Optionally, follow File > Save As ... to save your
session.

/= Seismic Feature Enhancement - untitled — & | x|
File Seismic Process Help

D@ za= D] =

16:19:57: Start SFE processing

16:19:57: Preview mode Start Processing
16:19:57: Calculating 3D swath coordinates

16:19:57: Processing Traverse Segment No. 1
16:19:59: Processing Traverse Segment No. 2
16:20:00: Processing Traverse Segment No. 3
16:20:02: Processing Traverse Segment No. 4
16:20:03: Processing Traverse Segment No. 5
16:20:05: Processing Traverse Segment No. 6
16:20:07: SFE Processing complete

Starts the SFE processing or restarts hm

F= Seismic Feature Enhancement - untitled = = IIESM
m Seismic  Process Help

O New CsN |==| p ) ™

@ Open_  Ctl+O T
& Save Ctri+S &

D swath coordinates
- averse Segment No. 1
Exit faverse Segment No. 2

16207007 Processing Traverse Segment No. 3
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2.3.5¢ Fluid Contact Finder

Required licenses: OpendTect Pro, Fluid

Contact Finder.

Exercise objective:

Enhance the amplitude anomaly associated with a structure with Fluid Contact Finder (FCF).

Workflow: ® 3D Horizon
12D Hol  Add

1. Right-click on 3D Horizon in the tree > Add ... Fault Add at Sections Only ..

i ga‘éﬂs Add Color Blended ...

. ody

2. Select Demo 6 --> FS8 and click OK. L Well Track New ...

“ PickSe Create with Constant Z ...

' Select Input Horizon (s) o] @] =]

w - Filter =

[[1>Demo 0 —>FS4 <

[7] Demo 1 --> MFS4
Demo 2 --> FS6

] Demo 3 —= Top Foresets

[”] Demo 4 --> Truncation
Demo 5 --> FST

7| Demo 6 —> FS8

\I”1 Demo 7 --> shallow

- a

x

¢4

Area subselection 100/300-750/1250 (463 samples) (© select .|

\0 Canceil [ €9 Help

...aning_vB\Surfaces\Demo_6_--__FS8.hor

down list and Select 4 Dip steered median filter

Workflow cont’d:

3. Open the attribute window g"?l'

4. Choose Similarity attribute from the drop-
data as input.

5. Set the time-gate to [-12, 12] ms.

B. Select Steering as Ful| |*ess s
and use 3 Steering BG | "5
Background.

7. Specify Output
statistics: Min.

8. Name the attribute Min .
Sim and Add as new. 9

®

3 |S!m||amy

| |2

-] |© Select..|

| Input Data |4 Dip steered median filter

[Time gate (ms) -12 12 ]

Extension |Cross

Stepout |inl:1 = e

]

Steering Data Lé & | 3 Steening BG Background

Steering | Full

=] |© Select...

| Qutput statistic  Min

| Attribute Name | Min Sim Add as new] )

-253 -




Workflow cont’d:

4 ® 30 Horizon

9. Display the attribute on Demo 6 --> FS8 by + {7l Demo 6 > Fs8

right-clicking on Z values in the tree > Select T S CEtEE b
Attribute > Attributes > Min Sim. Fonsl]  SemesHoizon Do | eedD 2] Mg
s ?.:;:‘ Tools *|  Stored 2D Data »
# PickSet| MoV | Atributes 2D
[ Polygon Steering 20 Data »

Workflow cont’d:

10. Create a new polygon by right-clicking on DS';'.';;E;

i 8P Add ...
Polygon in the tree > New. | ;\nmg:;ic
11. Name the new polygon: Bright Spot.

' Create New Polygon = -5
Name for new Polygon Bright Spof] |

Color | NN | (= OiveDrab -

[@0x] (O cancel (@ e |

12. Draw the polygon using left-click, as shown =
in the image. "PP% & Ctrl + Z to undo the action.
< | Ctrl + Left-click to delete a seed.

13. Right-click on the polygon in the tree (or in
the scene) > Close Polygon.

14. Right-click on the polygon in the tree > Save. ;

2-[2 Polygon
1] Bright Spo
= Prestack Even  Display »
#- Annotations Calculate Volume
| Close Polygon
#l Saveas
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Workflow cont’d:

15. Go to Analysis > Fluid Contact Finder (or click on the ___1#4'—" | Analysis | Processing Scene V

: ol Aftributes L

icon).
& Volume Builder ..
Ei Cross-plot Data »
& Wells 12

16. Select the Demo 6 --> FS8 horizon, leave the default Input & Layer Modeing ’
Cube 4 Dip steered median filter. fiid Contarl Findens
17. Click on Select for Volume subselection and choose Bright
Spot polygon created earlier.
= Fluid Contact Finder - Mam window = e o o eloEs
Horizon S| Demo 6 = FS8 - |© Select | P Specily Posiion
Analysis type @ Poststack © Prestack
— Volume subselection | Polygan -
Input Cube Seh ‘Eh| 4 Ow steered median fiter - | D Select
vome o — Folygon Bright Spot - [© seiect . I
Inine/Cross-line Step 1 H 1
Z range around horizon -184.8 1848
Time Range (ms) 0 Do1848 D Step 4
Include amgitudes | ANl -
Contour Z division 0 1848 Step & OCancel @ Help
QRun Q) Close | | ) Help

Workflow cont’d:

later. Also leave the Z range around horizon as default.

For the first test, contour Z division as the entire Z range of the survey. This can be restricted

18. Click Run to start the extraction and clustering of the data

" Fluid Contact Finder - Main window

Horizon g Demo 6 --> FS8
Analysis type @ Poststack © Prestack

Input Cube ;_“:; ; 4 Dip steered median filter

Volume subselection P: area 100/945-286/1134 (463 samples)
Z range around horizon -184.8 184.8
Include amplitudes |All =
Contour Z division 0 1848 Step 4

* | © Select |

* | Select ...
[O Select..._.

OCIose] [ ) Help

oo
e |
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Display types available in FCF analysis window:
Stack: traces are stacked along depth/time
contour bins and plotted as a 2D profile. The
display can be flattened on a horizon. The
stacked traces can be stored as a 3D volume if
Flattened is checked.

Single Z: traces belonging to a single contour bin
are displayed in a 2D viewer.

Directional: FCF-stacked amplitude at the
harizon as a function of the distance to a selected
position and the azimuth sector.

ST e R——
w . RN R PR T g e N Rt

: Rege— -.\gﬁ-
LTS AN traces lying along a particular contour (in 3D) on the ?-3 8

e,

= P Cantact Fider - Amabysn
Distribution of horizon Z vahies

sfas 5 54

550 5653
Vien
L = m—| L
Stack
Stacking
Wrte Cude

(SR ] (O cwse] [ @ e

The image on the left (not from F3 Demo
survey) illustrates the FCF stack concept.

Workflow cont’d:

e pp——
19. Choose Display type as Stack, uncheck
Flattened and click Run. o
This window will remain open so that e o
several FCF analyses can be run. ——— )
O Chse| | @ Heip
20. The FCF stack shows stacked | [T i ! ] i
traces along common contour (i 5 5 e e i T I
bins of Demo 6 --> FS8 = s =t ) ) ) b
horizon. The possible fluid , ’ i) 0 5= l
contact is highlighted: observe _ - ———— = S
the drastic amplitude change = P — y iy e ——
at the flank of the structure. R 5 1 e | 11
= = ! et HC-Water Contact !
=5
— [
T —
___"—‘k—:-—_:_._ —
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2.3.6 Seismic Object Detection Using Neural
Networks

What you should know about Neural Networks in OpendTect
Neural Networks in OpendTect are used for:

1. Visualizing seismic patterns along horizons and in 3D. This is a qualitative
approach using an unsupervised Neural Network (aka clustering or seg-
mentation).

2. Visualizing seismic objects such as chimneys, faults, salt domes, anom-
alies, etc. This is a two-class classification approach using a supervised
Neural Network (aka object detection).

3. Predicting rock properties such as porosity, fluid content, etc. Thisis a
quantitative approach using a supervised neural network.

4. Predicting lithology classes. This is a multi-class classification approach
using a supervised neural network.

This chapter deals with visualizing patterns and objects. How Neural Networks
can be used e.g. to predict porosity from inverted acoustic impedance and poros-
ity well logs is described in the chapter on rock property predictions.

What you should know about supervised Networks in OpendTect

The supervised network is a fully-connected Multi-Layer Perceptron (MLP) with
one hidden layer (i.e one layer between the input node and the output neurons).
The learning algorithm used is back-propagation with momentum and weight
decay. Momentum is used as a filtering of the step directions in the gradient
decent algorithm, which has a positive effect on training speed. Weight decay is a
method to avoid over-fitting when training. Weights are multiplied by a weight
decay factor to reduce the weight values, which results in smoother functions with
improved generalization properties. The program sets the number of nodes in the
hidden layer. In practice, supervised training, the user is teaching the network to
distinguish between two or more pointsets.
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What you should know about unsupervised Networks in OpendTect

The unsupervised Neural Network is the Unsupervised-Vector-Quantizer (UVQ).
This Neural Network is first trained on a representative set of input vectors (attrib-
utes extracted at different locations) to find the cluster centers. Each cluster
centre is then represented by a vector. Before the network is saved, the software
sorts the cluster center vectors on similarity. This has the advantage that in the
application phase colours are distributed smoothly over the cluster centers res-
ulting in smoother images which are easier to interpret. In the application phase,
each seismic input vector is compared to all cluster center vectors yielding two
possible outputs: Segment (or Class) and Match. Segment is the index of the win-
ning cluster center. Match is a measure of confidence between 0 (no confidence)
and 1 (input vector and winning cluster vector are identical).

The unsupervised segmentation approach reveals areas with similar seismic
responses and is used extensively as an easy-to-use and quick interpretation
tool. Clustering can be achieved using waveform and also using multi-trace attrib-
utes such as similarity and curvature in the hope of picking up fracture- density
patterns.

More quantitative analysis of UVQ results is possible with the aid of (stochastic-
ally) modeled pseudo-wells (e.g. de Groot, 1999).
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Waveform segmentation

Unsupervised segmentation of data can be done in two modes: horizon-based
and volume-based. The exercise in this section follows the horizon based (or 2D)
approach, which is also called waveform segmentation because the input to the
network is a waveform (= time-gate) extracted along the horizon. A 3D- seg-
mentation scheme is very similar. However, be aware that, in 3D, only attributes
not directly related to the phase at the sample location should be used. If phase
sensitive attributes like amplitude are used, the results will look very much like the
original seismic data.

For waveform segmentation to be successful you need a good reference horizon
to work from and preferably a layer-cake setting. Furthermore, it should be real-
ized that due to convolutional effects the results are influenced by variations in
the over- and underburden. Variations on the waveform segmentation theme are
possible. For example clustering waveforms from near-, mid- and far-stacks incor-
porates AVO effects.

OpendTect supports two ways to create a horizon-based unsupervised seg-
mentation: The Standard Neural Network method and the so-called “Quick UVQ”
method.
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2.3.6a Waveform Segmentation - Quick UVQ

Required licenses: OpendTect Pro, Neural Networks.

Exercise objective:

Workflow:

1. Right-click on 3D Horizon in the tree > 20 HC
Load... > Choose Demo1 2 MFS4.

Visualize seismic pattern on a mapped horizon using Quick UVQ waveform segmentation.

Scene 1 - Select Input Horizon (3] - olEN
@ In-line Bt el
@ Cross-ine Filor *
: Z-shice r T
Veolume channed- =
~ Random Lino Demol = F54
G Demo 1 —> MF54
% 20 Line Demo 2 —> FS6 =
30 Horizon Domo 3 = Top Foresots =
Demo 4 —> Truncation
Faul | Ada a1 Sections Only Demo 5 -2 FS7
Faus Deeno & > FS8
@ Bogy| /00 Cokr Blended e e =
P wen | Treck Now
= Pickg Creata with Constant Z Aroa subsalaction | 1007300-75011250 (463 samples) © Select
> Polygon
S Prestock Evonts -
s Rhotabons Ojceecsl i@}

2. In the tree, right-click on Demo1 2 MFS4
> Workflows > Quick UVQ.

omo_2015\SurfacesiDomo_1_-_ MFS4 hor

“ 3D Horizon
kdl Demo 1 —> MF.

v Z values Add '
“ 20 Horizon Display b

Fault Tracking '

FaultStickSet Tools »
® Body IETTETE Create Flattened Scene
;":’:&'Sel wl Save Compute Horizon Curvature ...
D Polygon # save as Write Flattened cube ...
& Prestack Events & Lock Calculate Isopach ...

« Annotations Delete from Database Calculate Volume ..

Pick Horizon Data ...

Quick UVQ ...

# Remove from Tree

Workflow cont'd:

to disk.

5. The time gate describes the investigation window.

3. In the Input Cube field the default 4 Dip steered median filter volume is already selected.

4. Number of classes describe how many clusters the waveforms will be divided into.

6. Optionally, a polygon can be used for sub-selection. Also, the neural network can be saved

7. Click OK to train a neural network and produce results.

= Quick UVQ

uvaQ on ‘Demo 1 --> MFS4' (unshifted)

Number of classes 10

Time gate (ms) -8

Polygon subselection

Save network

=NEr=
Input Cube IEI [E 4 Dip steered median filter

24

=)

- e Select...|

| OOK I[O Cancel :@Help ‘

In practice, we always predict less
number of classes (e.g. 5) to get a
regional understanding of a
depositional system. We then
increase the number of classes to
predict details.

Time gate can be adjusted relative
to a horizon. In this case, -8ms is
used considering a horizon is not
perfectly snapped to a peak/trough.
The focus is mostly below the
horizon by setting 24ms.
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Workflow cont’d:

8. A NN training window will pop-up. If the training is above 90% and flat, then you can press

OK button.

=

NN training [91]

Train Segmentation Neural Network [November9 2015 14:12:21]

Sample -8

_Average Match (%
100'_ ch (%

Sample -4
Sample 0

75

Sample 4

50

Sample 8
Sample 12

5]

Sample 16

Vectors trained 6400

Sample 20
Samnle 24

Pause .. Clear

) Cancel (@ Help

- olEd

It will start applying the
results on the input
horizon.

1 [11%)] Apply UVQ Neural.. — &
| |

1%

. 0 Pause . OAbort

Applying Neural Netwo Positions handled 72632

Workflow cont’d:

9. Once the NN processing is finished, you will see a NN Info window and two grids, (Class

10. Click Display... to show class centers

and Match) which are already displayed on the horizon.

= NNinfo

"Quick UVQ' Neural Network

Type:

Number of classes: 10

Tip: If you are satisfied, you may
want to save them as Horizon Data
by right-clicking on each ofthem.

Vectors classified: 2889
Class 1 vectors: 182,
Class 2 vectors:
Clasa 3 vectora:
Class 4 vectors:
Class 5 vectors:
Class 6 vectora:
Class 7 wectors: 1
Class 8 vectors:
Class 9 vectors: 1
Class 10 vectors: 233,

% 3D Horizon

Average macch:
Average macch:
Average match:
Average macch:
Average match:
Average match:
Average match:
Average macch:
Average macchi
Average match:

Center3  Centerd

-1540.89...

=¥ Demo1-—>M... =
|¥| Class n Input node relative imporcances:
[¥] Match 3] ey —
— Centerl Center2
| Z values 0|
-_—— . . sample -8 976.1010... -1006.50...

Sample -4 54.67016.. -1973.59..

and Close the Info window.

.

Sample 0 1924.287.. 1702.556...
Sampled 4646.966.. 4714.869..

Sample 3 1654.428.. 455.1835..

-1949.19...
971.1319... 3495.81...
3954.554... 5872.40...

2603.379... 2770.36...

Save Report ...

-2237.13..
-795.735..

==

Unsupesvised (segmentation/clustering)

0.903918
0.909172
0.91659
0.822117
0.919409
0.9206
0.909738
0.920202
0.908917]
0.904034

Center5 Center6 Center7 Center8 Centes”

239.771.. -539.130.. 377.387.. -1313.70.. -2817.7

621.897.. 111735 -849.821.. -2028.79.. -1928.2]

2886.94.. 2141.79.. -593.750.. 1B8.953.. 2156.68

5027.39.. 2849.06.. 1592.54. 2039.47.. 2750.72

2438.40.. 231.057.. 1532.06.. 495.336.. -932.29

»

) ]

Qo] @rer)
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Workflow cont'd:

¥ 3D Horizon

11. To match the colors, click on the Class grid, and choose Rainbow v -
color bar. :

12. Optionally, click on the color-bar icon in the class center if you want
to change the color scheme there also.

Colors are not matching....

SN

= “Quic

Workflow cont'd:

13. Your results may look like this.

[tea mem] 3.47.9.G8 [

For segmentedresults such as UVQs, we preferto use a segmented color bar. You can always
change a color bar through manager (Survey > Manage > Colour tables).
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2.3.6b Waveform Segmentation - Standard UVQ

Required licenses: OpendTect Pro, Neural Networks.

Exercise objective:

Visualize seismic patterns on a mapped horizon using the standard unsupervised neural
network method

Workflow:
1. Open the Aftribute set window » | and select the default attribute set ' named
Workflow - Unsupervised Waveform Segmentation.

2. It will pop up a window asking to provide Input Seismics, the default volume is
automatically selected. Press OK.

s Attribute set definition - oiEN
Select Seismic input
Input Cube b ‘i, | 4 Dip steered median fitter v | © Select

) Cancel | §J Help

This default attribute setis designed to extract each samples within the time window
[-100,+200]ms (with a step equal to the z step of the survey) regarding the application sample.

Uncheck Save on Close and close the Attribute Set 3D window.

-~ Attribute Set 3D - olEN
File

PPS DR W

Alftribute set <not saved> <All> ~| Reference shift v P

Sample -100 ~ Input Data 4 Dip steered median filter v| | © Select ..
Sample -96

Sample -92 Shift ink0 % cd0  Time (ms) -100

Sample -88

Sample -84

Sample -80

Sample -76

Sample -72

Sample -68

Sample -64

Sample -60

Sample -56

Sample -52 %
Sample -48

Sample -44

Sample -40

Sample -36 A
Sample -32 z4
Sample -28

Sample -24 —
Sample -20

Sample -16

Sample -12

Sample -8

Sample -4

Sample 0 v Aftribute Name Sample -100 Add as new [l

Use steering () Yes (@ Mo

@ o
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Workflow cont’d:

Q
3. Start the 3D Neural Network plugin by clicking the a—3 icon.
@

4. Select the option Pattern recognition [PickSets].

= Neural Network management

Neural Network Manager 3D

Create New Network:

- oIl

Get:

Pattern recognition [PickSets] .. | Stored Network ...

Property prediction [WelData] ... From Job file ...

Active Neural Network

Input

Store

© Close |

Qutput

@ Help

Workflow cont’d:

5. Set the analysis method to Unsupervised.

6. Select Samples within the window [-8,24]ms.

random pickset.

Click on Create button... to generate a

e Design Neural Network

Analysis method () Supervised (@ Unsupervised

Input training data set (8 Extract now Retrieve stored

u~ Select input attributes
[] Sample -28 ~ | |:gas:
| Sample -24 ‘RMS velocities:
Sample -20 ‘FFST:
| Sample -16 3D Body
[] Sample -12 Slumped body:
[v] Sample -8 :3D body:
[v] Sample -4 test 2
[ Sample 0 ‘onlap:
[v] Sample 4 :Chimney YES:
v| Sample 8 Chimney NO
[w] Sample 12
v Sample 16
[v] Sample 20
| Sample 28
[] Sample 32 -
< >

Number of classes 10 '+

Sedect Pick set | Create ...

©OK | ©Cancel @ Hep
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Workflow cont’d:

8. Create a pickset containing 1000 picks
along the horizon Demo1 2 MFS4.

9. Click OK.

s Random Pick Set Creation

Create new PickSet

| Name for new PickSet Random Pickset on Dem¢

Display color [l ™ RoyalBiue

|Numnerof picks to generate 1000 '+ |

Geometry Volume v

Volume subselection -

© Select

@ cancel @ Help

Workflow cont’d:

10. The pickset will appear in the list. Make sure that the correct set is selected.

11. Click OK.

Analysis method

Input training data set (® Extract now

[a] =  Select input attributes

Design Neural Network
Supenised (8 Unsupervised

Retrieve stored

Select Pick set  Create ...

[] Sample -28 ~||.gas
[| sample -24 RMS velocities
[] Sample -20 FFST:
Sample -16 3D Body:
[] Sample -12 Slumped body
[v] Sample -8 3D body:
(v Sample -4 test 2
V] Sample 0 onlap
v Sample 4 Chimney YES:
v Sampie 8 himpey NO
[v] Sample 16
[¥] Sample 20
Sample 24
LI Sample 28
[ Sample 32 v

<

MNumber of classes 10

>

© conca

@ Help
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Workflow cont’d:

12. A spreadsheet with statistics will pop up. Click on Run.

et

Input Data

B X Y: Y [ qmmp b o = show100.0% ]

T2 ] Show InvCrl

_ ol

<

X-Coor Y-Coort Z (ms)
Training data 61677... 60830...
Training data 62585... 60804...
Training data 61697... 60828...
Training data 61251... 60806...
Training data 61153... 60860...

1620

1264
724
1152
780

*Samplk Sample Sample Sample Sample Sample

-10459 -698
-7480  -1746
-7010 4590
-6935 1666
-6251  -1353

2869 1187 -2389
9410 9385 2672
5938 573 3880
8804 2889 -5435
1831 -1610  -3702

© Close

S ks
-5961 €
-395 T
5909 -€
-2451 3

169 3,
>

) Help

Workflow cont’d:

13. This will start the neural network training. After the Average Match curve becomes flat,
click on OK. Training with a 90% (match) is considered as a good prediction.

Ay

100 Average Match (%)

NN training [93]

O Sample -8

O Sample -4

75

Sample 0
Sample 4

50

Sample 8
Sample 12

25

Sample 16
Sample 20

train data

. Sample 24

Vectors trained 26100

[T] on OK, save as

Train Segmentation Neural Network [November9 2015 15:42:36]

Pause ...

© Cancel @ Help

_—) |

Clear ...

= Select
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Workflow cont’d:

14. The trained neural network is now active, with
appropriate input and output.

15. Click on Store .. to save the neural network to disk.

16. Click on Info...

=

Neural Network management — O n

Neural Network Manager 3D

Create New Network Get:
Pattern recognition [PickSets] ... Stored Network ..
Property prediction [WelData] - From Job file ...

Active Neural Network

Input Output

Sample -8 ~ | | Segment
Sample -4 Match
Sample 0

Sample 4

Sample 8

Sample 12

Sample 16

Sample 20 ~

@ Close || @ Help

Workflow cont’d:

17. NN info window will pop up. s
18. Click on Display to show Class Centers.

19. Close the NN info and the NN Management
windows.

Center 1

1048

4040

1903

4134

2183

10828

Center2  Center 3

1300,

G289

3060

2480,

1865,

50038,

ervised (segmentation/clustering)

1235

41193

7385

-2060.

-2520.

-4423

Centeed CenderS Cenlerd Cenler7 CentesB Cenderd Cenber 10 *
8008 . -1680.. -1202.. 4428. 1BS69. 2221 STIT2
518.22.. 95423 B7726.. 45561 17845 T203. MTZ
9481 AP 1876 55248 29338 7105 16435
4027, 403T.. 4143 3620 -1308.. 3252 3D
3813 4273 -44B3 2036 79379 -1066. -2387

25265.. 13900.. 64492.. 15418 37204 53454 -1182

Soariet

= = « class centers o[- e Samvl o
[ Sample -96
Q ] I
- Sample -92
K 25 5 75 Y]
I T Sample 68
I 7T 7]
VLol Sample -34
x. \ N ! fl \ .
- 0 { Sample -80
L
o 77 7] 7 I 7
IS (Y (
\
Y
.
'z Class ™
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Workflow cont’d:

20. Add a 3D horizon Demo1 2 MFS4
in the tree. Apply the neural
network to the horizon by right-
clicking on the horizon name in the
tree > Add > Attribute.

21. When prompted to select data,
select Segment attribute from
Neural Network tab.

22. As Segment appears in the tree
change the color bar to Rainbow.

I 2D Line

@ 3D Horizon
7| Demo 1 —> MFS4 =
| (Segment) m

+ Zvalues n
@ 2D Horizon

* = 3u Honzon

« #|Demo 1 —> UFS

41 Zvalues Add *H Atribute

;D Horizon Display * % Volume Builder Atinbute

ault Tracking Contour Display

FaulStickSet Tools Horizon Data
@ Body Waorkflows B

Wel . :
# PickSet .
> Polygon @ Saveas
Bs Prestack Ever g  Lock Tresitem
Annotations = Remave from Tree

S Select =k

Select Layer 3

stored [Seoment ]

Match

Steering

Attributes
@ Neural Network
-
=3

T

Workflow cont’d:

23. Your results may look like this.
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2.3.6c ChimneyCube

Required licenses: OpendTect Pro, Dip-steering, Neural Networks.

for steering Data and click on Ok
and close the Attribute window.

Exercise objective:
Create a ChimneyCube with the supervised Neural Network approach.
©y Survey Analysis Processing Scenes
e EA R = .
Workflow: Q - N E m
d ! Step 0
q [ 1 -
1. Open the attribute editor using the a I icon a Elements Color
and open the default attribute set NN fce‘r:ji:e
ChimneyCube via the . icon and click <4 # Cross-line
W Z-slice
on Ok. | @ Voume
- Attt Se1 30 _=Enm
I [t eaa nae
s = octout s - ONEM T
Select dafaull afinbute set - =
Filar *
Workfiow - NN Chimney Cube
# Workfiow - NN S8t Cube
3 Workfiow - NN Slump Cuba ~
- | [0%] oo [ @reo
B tete N Asd s e [l
+ G on Closa Dt | @l
Workflow cont’d:
= Attribute set definition - o IEd
2. A F_’Op .up messag? will prom pt for Select Seismic & Steering input
seismic and steering data. Please
select 4 D.lp steered median filter for Input Seismic a,‘:’; ‘& 4 Dip steered median filter v |© Select ...
seismics and 2 Steering BG Detailed | |, steering (& ‘&l 2 steering BG Detailed v [© select ...

@ Cancel @ Help

l

- Attribute Set 3D - olEN
Fie
sd RE XTI Y 15
Amributa set | <not saved> <AB = Simianty =] |2
Ingat Data 4 Dip steared median filer * O Select
Time gate (ms) -40 40
The attributes in this set Ertorsion [HiTor 0 dogrons =
should help dlfferentlate Trace positions k0 3] el 2] & im0 3] a1 3
chimneys and background I — i
. . . . Stuering Dats IS, & 2 Steoring BG Dotaed v &
noise. Visual inspection of rusiio e
the data shows chimneys s ¥
- =4
present around inline 290 =
and 690. The chimneys oA S
. : gnalNoise Outpat statistic Max
Down 100ms {SignalMoi
tapplear as Vertlcal el - ke Amribate Nome Similarty [-40,40) Paralel Acd as new | il
rais 50 o [Oo=] o
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Workflow cont’d:; [& save Attributeas — = IEIN|

Select oulpul Aliribute

Filler |*

. 30 UVQ Aftribs Texture + HC ~

3. Save the Attribute set as NN GhimaeyCube stvibdos
ChimneyCube Training and click on Ok. Demo atributes 38
FaultCube attributes ~

Inversion attributes
MyFirstAttribute v
< >

Name NN ChimneyCube Training|

& Cancel ed Help
(] (]

4. Add default data (i.e. 4 Dip steered [Tree scene 1 8|
median filter) by right-clicking on inline. Elements Colot

Scene 1.

MV Add Default Data

& Z-sli Add and Select Data

‘ Volu  Add at Well Location .
- ;‘5” Add Calor Blended
5. Click on the added inline number 425 T

and change it to 690 by entering it in the

Inl box. Qiewe|tibm=zhh-o<i
[ s - em | G
Tree scene 1 ] -
b 1

Workflow cont’d:

6. In order to pick chimneys and DE';I;SE: Add ... |
differentiate them from the background e New > [ Empty .. |
noise, two picksets are needed. X Prestack Events Generate 3D ...
Annotations Generate 2D ...

7. Click on Pickset in the tree > New
Pickset > Empty. In the pop-up you will -
give a name to this as Chimney_Yes. JP
_¥/Chimney_NO
8. Repeatthe Step 7 and create another

pickset called Chimney_NO.
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Workflow cont’d:

9. Highlight the Chimney YES pickset and
pick locations in the scene that appear
as chimneys.

10. Repeat the process for the Chimney NO
pickset, pick locations where chimneys
are not expected. Save both picksets by
right-clicking on their names.

11. Scroll to another inline using the
4== icons to make more picks. Save
both picksets.

Workflow cont’d:

12. Open the 3D neural network by
clicking on the c:ea icon.

13. Click on Pattern recognition.

Neural Network Manager 3D

Create New Network: Get:
[Pattern recognition [PickSets] | || Stored Netwark ... |

Property prediction [WelData] ... | From Job file ... |

Active Neural Network

Input Output
Store ... Info ..
@tep |
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Workflow cont’d:

14. Set Analysis method to Supervised. Deselect attributes with prefix “NoNN”from the list.
Select Chimney_Yes and Chimney_No picksets made by you. Specify 30% of the data for
test set and press OK.

) Design Neural Network o[@])[=

Analysis method © Supervised | Unsupervised

Input training dataset @ Extractnow |© Retrieve stored

O Select input attributes @~ Select output nodes
7] Similarity [-40,40] Parallel = 11000 between MFS4 and FS8: &
9] Similarity [-40,40] Diagonal B :1000 between FS7 and FS8: £
¥] Down 100ms {Similarity [-40,40] Parall: :1000 between FS6 and FS7:
] Up 100ms {Similarity [-40,40) Parallel} 7] :Chimneys yes!
] Down 100ms {Similarity [-40,40) Diago
] Up 100ms {Similarity [-40,40] Diagonal “fingerprint input:
9] Similarity [-40,40] AllDir :gas:
¥] Down 100ms {Similarity [-40,40] AlIDir :1000 Random on Demo 1-> MSF4:
¥] Up 100ms {Similarity [-40,40] AlIDir} :Random line through wells:
7] Simple Chimney Attribute :Selected Points from Well:
NoNNInput PolarDip Misclassified [NN]:
] RMS [-40,40] :RMS velocities:
7] Down 100ms {RMS [-40,40]} islumps-1:
] Up 100ms {RMS [-40,40]} - :Slump-2b: -
« i ) « i D
Percentage used fortestset 30 | %

Non-standard number of hidden nodes 14

[©o] (@ conce] (@ 1o

Workflow cont’d:
- Input Data - olEN|
B X Y, Y [ qmup b o = snow100.0% 2 [EE T showivc 27 2| B3

X-Coor Y-Coon Z(ms) " Similar Similari Down1 Up 1001 Down1 Up 100 i

. . e n Training data 62870 60BB9.. 58681 0368.. 0347 O7T61.. 0846.. 0711 0812
15 A SpreadSheet Wlth StatIStlcs WI" Training data 62703... GOB89... 9873 O0570.. 0455.. 0.789.. 0557.. 0601 0225,

pop up, here you may edit and Training data 61568... GOBSS.. 818.82 0603.. 0.835. 0967.. 0822 0955. 0.889
| th tribut b Training data 62833 G0BAO.. 53202 0621 0585 0.760.. 0856 . 0.700.. 0.678
ana .yze € attri U es by CI'O..SS- Training data 62226... G0BBT... 132162 0.621... 0480.. 0577.. 0.766.. 0636.. 0.542
plotting them against the Chimney ¢ ’
YES and NO picksets. After Ockse || @Hop

investigating, click Run.

o2 000

= HN training [6] [E=REcR == |
Train Neural Network [November16 2015 17.59:39)
(] l T
0.5] 0.5
L. . [ 025
16. The neural network training will
begin.
£V v
Vectors trained 20600 Pause Clear
On OK save as U
7| Save misclasstied [@ok ] (O cancel] [ @ Hein

-272 -




Workflow cont’d:

17. As the training of the neural network runs, the normalized
RMS and % Misclassification curves will decrease. In order
to avoid overtraining of the neural network, click OK as
soon as the normalized RMS curve becomes flat.

18. If the training graphs become flat and are not changing, you
may proceed and click OK button.

= Nritrasing (4] = e
Train Neural Network [November16 2015 18.01:18]
e
1
07
0 ST £
[
0 | ‘ 025
| sop— 0
o 0
A Ho
cﬂ I_ = ¢ — 2]
Vectors trained 54100 Resume | [ Clear
On OK, save as =
7| Save misclassied Q) Cancel | i Help

Stopping points for neural
network training

Error

Error

Error

Leveling
‘ STOP
Train set lterations
Test set
Overtraining
; &STO
Train set lterations
Tes! sel
A JsTor?
/_\\‘STOP
Train set Herations
Test set

Workflow cont’d:

You can press clear to restart the training, for example if
the neural network becomes over-trained

The colors of the input attributes change during the
training. The colors reflect the weights attached to each
input node and range from white via yellow to red. Red
nodes have the most weights attached and are thus more
important to the network for classifying the data.

Colors are very useful indicators on how to tune a network
and discard attributes that may take up a lot of CPU time
without contributing to the final result

Stopping points for neural
network training

Error

Error

Error

Leveling
‘ STOP
Train set lterations
Test set
Overtraining
) ‘STO
Train set Herations i
Test set
A JsTor?
f\\\‘STOP
Train set Rerations
Test set
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Workflow cont’d:

19. Optionally, Store the Neural Network (you will need to

provide a new name).

20. Close the Neural Network Management window.

21. Test the training results on your data. Add the neural
network attribute named Chimney YES by right-
clicking an inline (e.g. inline 690) in the tree.

“ wnne
a [7]/425 —_— -
W4Dpste  AK r i Atbde
@ Cross-line Display ' & Volume Builder Attribute
¥ Z-slice Duplicate @ HorizonCube Display
® Volume _ Reset Manipulation % Systems Tracts Display
~ Randomline |4, conetate with Wells . -
= 20 Line .
® 3D Horizon o Lock Treetem
-4 2D Horizon | = Remove from Tree

Craate Now Notwork: Gt
Pattem [PickSets]
Proparty prediction [WelData] From Job file ..
Active Neural Network
Input Output
Similanty [-40.40 | [[Chimney_YES]
Samilarity [-40,40 | [Chimney_NO|
Down 100Mms {Si | | Classification
Up 100ms {Simé | | Confidance
Down 100ms {54
Up 100ms [Simik +
< >

Stora . Info ..

oreo

Select Layer 2
() Stored (Chimney_YES
. Chimney_NO
() Steering Classification
O Attributes Confidence
| QOK ||0(:ancel| @ Help

Example of chimney display on inline 690. The red arrow indicates
increased likelihood of chimneys.
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Workflow cont’d:

22. If you are not satisfied with the
output, go back and change the
location of your picks using the
Misclassified NN pickset (generated
automatically) by right-clicking
Pickset in the tree

== = - Q’\\ \ -

Misclassified NN pickset (in red) on inline 690

5 loafiasee - O R
Select input PickSet (s)
[=] - Fiter *
¥ |Pickins [] Chimney_NO =
G [] Chimney_YES

[ Poly " l [¥] Misclassified [N}

S Pres ts [[] Random Picksat on Demo
+ Annotations

-2

© Cancel @ Help

... 2015\Locations\Misclassified__NN_ pck

Workflow cont’d:

Create Output Volume

23. When satisfied with the results, the
final step is to output the
ChimneyCube volume as a seismic
cube that is stored on disk via
Processing > Create Seismic
Output > Attributes > Single
Attribute > 3D ...

Sunes View Utilities Help

| Create Seismic Output | Attributes ________+|.. Single Atribute ___» JPI8
Create Horizon Output> 20 <=> 3D * Mulli Atiidate ... r
(Re-)Start Batch Job Angle Mute Function ... MultiCube DataStore .. |
~ Dip Steering + B Bayesian Classification .. = Along Horizon v
= GMT Mapping Tool ... From Well Logs .. " Between Horizons  + |

# HorizonCube »  Prestack Processing g
Y] Madagascar . Velocity .
! ssIS »  Volume Buider ...
mmEyGure—————————  Re-sort Scanned SEG-Y

ip steered median filter

L2 Create Volume Attribute _ o
uantity to output Chimney_* = _
24. Select the Chimney YES attribute v:m:mm ° Yes | SR
from the list, give the volume an o o o
appropriate name and click OK. S

Output Cube| ChimneyCube ) |0 Sekct | CBYS

Batch execution Single Process =) L Options ..,

- Select -8

Stord Chmnay_YES

Chimoay_NO

Adrituies Casainicabon
® Nours otwory | COTTeRCE
s

[ 0w om
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2.4 HorizonCube and
Sequence Stratigraphy

The HorizonCube is a step-change technology that opens the door to drastic
improvements in understanding the geological meaning contained in seismic
data: 3D sequence stratigraphy, seismic geomorphology with data driven stratal
slicing, improved geologic models, wells correlation, low frequency modeling for
better seismic inversion etc.

Today, seismic interpreters can look forward to the following benefits:

Low Frequency Model Building & More Accurate, Robust Geological
Models

In standard inversion workflows, the low-frequency model is considered the weak-
est link. Highly accurate low frequency models can be created by utilizing all the
horizons of the HorizonCube, allowing a detailed initial model to be built.

In a similar fashion rock properties can be modeled. Instead of using only a few
horizons all horizons of the HorizonCube are used, resulting in greatly improved
rock property models.

Rock Property Predictions

The highly accurate low frequency models can be used to create geologically cor-
rect Acoustic Impedance (Al) and Elastic Impedance (El) cubes using
OpendTect’s Deterministic and Stochastic Inversion plug-ins. To complete the
workflow, the Neural Networks plug-in is used to predict rock properties from the
Acoustic Impedance volume, avoiding the use of oversimplified linear models
which cannot accurately describe most rock property relations.

These advanced tools bring a high degree of precision to traditional seismic work-
flows, resulting in better seismic predictions and more accurate input into the
reservoir management decision-making process.
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Sequence Stratigraphy (SSIS plug-in)

The SSIS plug-in works on top of the HorizonCube plug-in. Users can inter-
actively reconstruct the depositional history in geological time using the Hori-
zonCube slider, flatten seismic data in the Wheeler domain, and make full system
tracts interpretations with automatic stratigraphic surfaces identification and
base-level reconstruction.

Well Correlation (WCP plug-in)

The Well Correlation Panel plug-in is an interactive tool for correlating well data
and for picking well log markers in a consistent manner. The tool supports dis-
playing and manipulating multiple wells with logs, markers, and stratigraphic
columns, plus the connecting seismic data (2D lines, or Random lines from 3D
volumes) with interpreted horizons, faults, HorizonCube and interpreted systems
tracts.

Systems Tracts A0 Wheeler Diagram Well Correlations

Sequance Stratigraphy

GeoMode!

iH
L

Pre-drill Geo-hazard Identification Uncomnventionals

Uncenventional
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HorizonCube Applications
In this Chapter you will learn how to:

» Create data-driven and model-driven HorizonCubes.
e Truncate HorizonCubes.

» Extract horizons from a HorizonCube.

» Track single horizons from a Steering Cube.

o Correlate between wells.

» Wheeler transform data (= flattening).

* Interpret systems tracts.
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2.4.1 HorizonCube

What you should know about HorizonCubes

» HorizonCubes consist of a dense set of (dip-steer) auto-tracked, or
modeled horizons.

» HorizonCubes exists for both 3D and 2D seismic data sets.

» Horizons are first order approximations of geologic time lines.

» Horizons can never cross each other.

» There are two types of HorizonCubes: Continuous and Truncated.

* In continuous HorizonCubes all horizons exist everywhere; when horizons
converge the density of the horizons increases. This tends to happen along
unconformities and condensed sections.

* In truncated HorizonCubes horizons stop when they get too close together.

» Using HorizonCube density it is possible to convert continuous Hori-
zonCubes to truncated HorizonCubes.

 Flattening on horizons in a HorizonCube is called a Wheeler transform.

» Depositional trends and systems tracts are easier to interpret in a Wheeler-
transformed, truncated HorizonCube. Model building (interpolating well logs
guided by horizons) is easier in a continuous HorizonCube.

e HorizonCube sliders are used in OpendTect to:

* Analyze the depositional history.
« Identify and extract horizons from the dense set of horizons.
» Extract 3D bodies from iso-pach thicknesses or attribute responses.
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Details

In standard seismic interpretation workflows, a coarse 3D structural or sequence
stratigraphic model of the sub-surface is constructed from a limited set of mapped
horizons. The number is limited because mapping horizons with conventional
auto-trackers, based on tracking amplitudes and similarities, is a time consuming
practice. In particular, mapping unconformities - primary targets in sequence
stratigraphic interpretations - is cumbersome with conventional trackers, as amp-
litudes tend to change laterally along such surfaces. HorizonCube maximizes the
amount of information that can be extracted from seismic data by significantly
increasing the number of mapped horizons (figures below).

Seismic section to illustrate the difference between two trackers: conventional vs.
dip-steered: (A) Conventionally tracked event based on seismic amplitude and
waveform similarity, (B) the same event has been tracked using the dip-azimuth
volume (SteeringCube).

A HorizonCube consists of a dense set of auto-tracked seismic horizons. The
auto-tracker tracks the pre-computed dip-azimuth field that is supplied in the form
of a (dip-) SteeringCube. The steering data generally determines the quality of
the resulting HorizonCube.

The auto-tracker used to track in a dip-field works for both 2D and 3D seismic
data. Tracking in a dip field has several advantages: Firstly, the dip field is con-
tinuous. Even if amplitudes vary laterally, the dip continues. Second, the dip field
can be smoothed before applying the tracker, which enables the controlling of the
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detail that needs to be captured. The auto-tracker is applied to a target interval
and generates hundreds of horizons that are separated on average by a sampling
rate. The result is called a HorizonCube. The comparison between conventional
amplitude based tracking and dip-steered tracking with SteeringCube is presen-
ted in the figure above.

The following exercises are showing an application in 3D. The workflows are very
similarin 2D.
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HorizonCube Types
Two types of HorizonCubes are created in OpendTect:

o Continuous HorizonCube: Contains events (or horizons) that do not ter-
minate. All events are continuous throughout the entire volume. They may
come very close together (at unconformities and condensed sections) but
they can never cross each other.

» Truncated HorizonCube: Contains events that terminate against other
events.

Both cubes have their own applications for visualization and also for model cre-
ation. The advantages are also briefly explained in the following pictures.

Two types of HorizonCube based on their geometrical configuration.

Continuous HorizonCube Truncated HorizonCube
Applications: Applications:
» Low Frequency Models » SSIS
» Geologic Modeling » Wheeler Transformation
o Attribute Visualizations in o Attribute Visualizations in
3D 3D

HorizonCube Modes
A HorizonCube can be created with two different modes:

» Data driven: The data-driven mode creates a HorizonCube that is guided
by the SteeringCube, in turn computed from the seismic data. Thus it will fol-
low the geometries of seismic reflections. It is the preferred mode to build
accurate sub-surface models and interpret the seismic data within a geo-
logic framework. There are two data-driven modes: tracking and multi-hori-
zon inversion. In the tracking mode, a 3D auto-tracker tracks in a dip field. In
the multi-horizon inversion, we follow the principle of unconformity tracker
(2.3.1). In both cases the start (seed) position is fixed.
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» Model driven: The model driven mode is a way of slicing the seismic data
relative to the framework (input) horizons. There are three model driven

sub-modes:

Input horizons

Automated horizons

Linear Parallel Parallel
interpolation to upper to lower

Three different model-driven modes to create a HorizonCube.
HorizonCube Tools

The following tools are available in OpendTect for performing different manip-
ulations on the HorizonCube:

» Add more iterations: To fill “gaps” in the HorizonCube.

» Convert to SteeringCube: Convert the HorizonCube into a dip-azimuth
volume (SteeringCube).

» Edit: Use either error-based or linear-based methods to edit eventsin a
HorizonCube.

» Extract Horizons: Extract horizons from the HorizonCube (stored as hori-
zon data).

» Get Continuous HorizonCube: Converts a truncated HorizonCube into a
continuous HorizonCube.

» Grid HorizonCube: Use various algorithms to fill unwanted holes in extrac-
ted horizons.

» Merge HorizonCube: Merges multiple HorizonCubes either vertically or lat-
erally. The vertical merge is useful for bigger surveys. For instance, if you
have three packages, you may run package 1 on machine 1, package 2 on
machine 2, and so forth. Then you can merge the HorizonCubesvertically to
get a single output. This will speed-up the processing time when compared
to running a single HorizonCube with three packages.

» Add or Recalculate 2D Line (2D HorizonCube): Modify the HorizonCube
by adding more 2D lines or add further horizons and faults.

» Modify or Recalculate 3D Package (3D HorizonCube): Modify a Hori-
zonCube by adding more horizons/faults.

» Truncate HorizonCube: Operation to remove parts of the HorizonCube
based on the event’s density (number of events within a defined time gate).
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HorizonCube Inputs

The following section explains the required inputs to process a HorizonCube.
Requirements include a pre-computed SteeringCube and framework horizons,
whilst fault (planes or sticks) are optional.

Pre-Computed SteeringCube

SteeringCube is a dip-azimuth volume and can be considered as the heart of the
HorizonCube.

A good-quality SteeringCube will usually result in an equally good-quality Hori-
zonCube. However, our experience suggests that in order to create a good Hori-
zonCube, one is required to pre-compute possibly 2-3 different SteeringCubes
and evaluate them by varying the HorizonCube parameters. The best Hori-
zonCube is then picked by quality controlling the results. Understanding the Steer-
ingCube is thus paramount towards a successful HorizonCube.

The simplest way to understand the SteeringCube is to first know the seismic
data that you are dealing with. Visualize the seismic data by scrolling the
inlines/crosslines or in a volume. Focus on an interval of interest and check the
areas of good and bad quality. Get an overview of whether the data quality is
poor, fair or good. If it is poor, you can expect a poor SteeringCube and thus in
turn a poor HorizonCube output. Another way of looking at the SteeringCube is to
look at the geologic complexities. If the data is too complex geologically e.g. con-
tains flower structures, you might not be successful.

In all cases, we suggest various workflows to improve the seismic data. There are
three major workflows that have been tested around the globe and are found
always a useful step to create a SteeringCube:

1. Smooth the seismic data by applying a mild post-stack dip-steered
median filter (2.3.1e Dip steered median filter). Such a filter improves the
quality of seismic at a sub-volume scale e.g. area of 3 by 3 traces.

2. Improve the vertical resolution of the seismic by sharpening the wavelet.
We normally use the Seismic Spectral Blueing (a method to enhance the
vertical resolution) operation to do this. (2.3.4 Seismic Spectral Blueing).

3. Apply a band pass filter on the seismic data to discard the high frequency
noise. It is often a valuable step if you are dealing with a high frequency
noise and you want to create a HorizonCube which follows the major seis-
mic events only.

Computationally, creating a SteeringCube is a slow process if dealing with a data-
set of several GB’s. Therefore, it is advisable to pre-process the SteeringCube
before you do anything else. You can run such processing by splitting the jobs on
multiple machines.
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To read more about the best settings and parameters for computing a Steer-
ingCube, please go to the exercises section of this chapter.

Which SteeringCube algorithm is suitable for HorizonCube processing?

In our experience, the FFT (Fast Fourier Transformation) algorithm of dip estim-
ation is preferred for horizon tracking or HorizonCube processing with a draw-
back of slowness. We recommend using the BG (phase-based) algorithm for data
conditioning and attribute analysis. This implies for both 2D as well as 3D seismic
cases.

What are the best parameters to start experimenting with various 3D Steer-
ingCubes for HorizonCube?

Case 1: Assuming that the zone has a main frequency ranging between 25-
40Hz.

To create the initial detailed SteeringCube, the following parameters are good to
start with:

» Calculation [inl, xI, z] = [2,2,5]
* Filtering [inl, xl, z] = No filtering if the input data is already smoothed through
dip- steered median filtering (DSFM).

You can then progressively filter this output and process the corresponding Hori-
zonCubes e.g.: (using as input the SteeringCube [inl, xI, z] = [2,2,5])

» Create several filtering results [1,1,3], [1,1,5], [1,1,7],... (if the data is not
noisier).

» Or create several filtering results [2,2,3], [2,2,5], [2,2,7], ... (if the data is
noisier).

Case 2: Assuming that the zone has a lower main frequency e.g. 20Hz or below.

To create the initial detailed SteeringCube, the following parameters are good to
start with:

o Calculation [inl, xI, z] = [2,2,7]
« Filtering [inl, xI, z] = No filtering if the input data is already smoothed through
dip- steered median filtering (DSFM).

You can then progressively filter this output and process the corresponding Hori-
zonCubes e.g.: (Input SteeringCube [inl, xI, z] = [2,2,7])

» Create severalfiltering results [1,1,3], [1,1,5], [1,1,7],... (if the data is not
noisier).
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» Or create several filtering results [2,2,3], [2,2,5], [2,2,7], ... (if the data is
noisier).

What are the best parameters to start experimenting with various 2D Steer-
ingCubes for HorizonCube?

The settings for the 2D are much similar to 3D seismic datasets. The only dif-
ference is that the calculation and filtering step-outs are Traces and Z- samples.
Therefore you can use the same suggestions as before.

Framework Horizons

Framework horizons (2D/3D) are the conventionally mapped horizons (3D grid-
s/2D horizons) that serve as a geologic constraint to form a vertical boundary for
a HorizonCube. Note that at least two framework horizons are needed to form a
package/sequence. The HorizonCube is always computed between two or more
framework horizons. So, if three framework horizons are provided, you will get a
HorizonCube with two packages only.

The data-driven HorizonCube is dependent on provided framework horizons. It
uses them as a relative thickness boundary that cannot be crossed by an auto-
mated HorizonCube event. Nevertheless, the automated events may be con-
verged at the framework events. In some cases, such convergences could
highlight key geologic features: pinch-outs, terminations, levees etc.

Notes and Tips

» A horizon with holes will result in a HorizonCube with holes. Thus, it is sug-
gested to fill the holes by gridding horizons with undefined areas.

» Two horizons might have different geometries (boundary ranges). In such
case the lower boundary would be used as an outer boundary of the Hori-
zonCube.

» Two horizons are also used to define an automated start position (a seed
position) to track events. Tracking can in that case be started from the
depositional centre which is the position with the thickest isopach value.

Framework horizons should be free of holes and should not cross. Optionally,
they may stop at the faults. This is the Data Preparation done via the Hori-
zonCube Control Center.
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Does HorizonCube follow the framework horizons while tracking in a package?

The framework horizons are used to calculate the starting points for various iter-
ations. However, the tracked horizons do not follow the framework horizons while
tracking. It follows the dips within the frameworks. The tracker only makes con-
vergence of the tracked events with the framework if the dips are making such a
case.

Can both framework horizons have different geometries?

We do not recommend using such horizons. You may end up with unexpected
results such as HorizonCube stopping at a bigger hole, no HorizonCube, or you
may not be able to process a HorizonCube because the start position lies in a
hole. We recommend using the horizons that have common spatial geo-
metries/extension, grid spacing, no holes. OpendTect has several tools to per-
form such actions.

I have two horizons crossing each other. | want to use them a frameworks for Hori-
zonCube. Can | solve the crossings in such horizons?

Yes! See the data-preparation tools available in the HorizonCube control center.
Fault Planes & Sticks

Fault Planes (3D) or faultsticksets (2D) are optional inputs that can be used when
creating a HorizonCube. Faults serve as structural boundaries along which the
throw is automatically computed using the input framework horizons and a given
fault plane/stick. In OpendTect, there is an additional data preparation step to
make the framework horizons “water-tight” with the faults. There is no limitation
on number of faults or sticks. One can still process a HorizonCube for the inter-
vals where the faults are absent.

The 3D HorizonCube Creator dialog will require Faults whereas the
2D HorizonCube Creator dialog will require FaultSticksets as an input.
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2.4.1a Data-driven HorizonCube

Required licenses: OpendTect Pro, Dip-steering, HorizonCube.

A — Tracking based data-driven HorizonCube

Exercise objective:

Create a continuous, data-driven HorizonCube in order to understandthe depositional
history of a prograding system using principles of seismic sequence stratigraphy.

icossing Scenes View Utilities H

Create Seismic Output ¥
WO I'|(f| ow: Creata Horizon Output »

(Re-)Start Batch Job

1. Go to Processing > HorizonCube > 3D... .
2. Select the Create a HorionCube option and click the =

Go.. buttonin the HorizonCube 3D Control Center.

= HorizonCube 3D Control Center mi=)
Pre-load ...
Active HorizonGube - B Select Redoad

Create a SteeringCube

4 Fiiter a SteeringCube
B, Processn
‘ Convert to SteeningCube
Create 2D Seismic Lattice

Create Horizons from SteeringCube

)
Interpolate Logs along a HorizonCube
| /\f A | Analysis

¥

Workflow cont’d:

3. Select the horizons Demo 0 2 FS4, Demo 4 2
Truncation and Demo 6 = FS8. Click on OK.

' Horizon sorter (=N O]

Select horizons

" 4

¥| Demo 0 --> FS4 -
Demo 1 —-> MFS4
Demo 2 —> FS6
Demo 3 --> Top Foresets
¥| Demo 4 —> Truncation
Demo 5 —> FS7
¥| Demo 6 —> FS8 v

Qok |[© cancel
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Workflow cont’d:

4. We will create a data driven HorizonCube in

this exercise, i.e. the type that follows the

Tracking.

5. Click Settings... in the HorizonCube Creator
3D window.

6. Set the Steering Datato

3b FFT 225 MF113 and Start at to: Center.
Check the Apply to all packages option and
click OK.

# HorizenCube Creator 3D =
|Read horizons ...
Faults -

e

© Select...| [ Clear |

HorizonCube calculation mode

Horizon Mode
Demo 6 —> FS8 Data Driven: Tracking 1
Demao 4 —> Truncation Settings ...

Demo 4 —> Truncation Data Driven: Mulii-horizon inversior ~

Demo 0 —> F&4 Settings ... e
Area subselection 100/300-750/1250 © Select ...
Output HorizonCube ~ | Select
Analyze ... |
Balch execution |Single Process =) |4k Options ...

O Run ) Close | @ Help

= Package 1: Demo 6 --> FS8 & Demo 4 --> Truncation

[ EoR ==

Calculation mode - Data Driven: Tracking

Steering Data ) [ 3b Steering FFT225 MF113 - |'O select .. |

Start at: |Center |

Processing parameters

Processing parameters include settings such as
spacing at start position, number of iterations etc.

v Apply to all packages

_QCancel | @ Help |

Workflow cont’d: ! HarizonCube Creator 3D =R R ="
Read horizons ...|
Faults - 0 Select ... | Clear
HorizonCube calculation mode
Horizon Mode =
A Demo 6 —-> FS8 Data Driven: Tracking =
8. Click Select for Area subselection and Demo 4 —> Truncation Selings o g
set to inlinerange to 400 — 450.
CIICK OK Demo 4 —-> Truncation Data Driven: Tracking -
Demo 0 > FS4 Seftings ... .
Area subselection 100/300-750/1250 ) Select ...
9. G |v§ an appropriate name, e'g'_ Output HorizonCube| HorizonCube_FFT225MF 113 -] |© setect .
HorizonCube _FFT225MF113, in the |
Output HorizonCube field and click Batch execution [Single Process -] [ 4.+ options -
Run' ORun OCbse:j @ Help ]
‘! Positions Pf|:_| oy x|

Specify Positions

Area subselection Range

Cross-line Range 302 &

J@ =2

1240

QoK ][O cencel| | @Hep |
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Workflow cont’d:

10. A Batch Processing window will pop up. Wait for the message Finished Batch
Processing and close the window.

@) Progress Viewer o || B &

00= ?

Steering Cube: 3b Steering FFTZZ5 MFI13

Event Type: Continucus

Number of Iterations: 1

Maximum Hole Size: 1éms by 100 traces

Maximum Event Spacing: léms

Initial Event Spacing: Bms

Start Position: 425/771

Start At: Center

Start Position: Center : In-line 425, Cross-line 771
Stepout: In-line: 1, Cross-line: 4

Top Horizeon: Demo 6 --> FS8

Bottom Horizon: Demo 4 --> Truncation
Nr Events: 1

In-Line Range: 400-450

Cross-Line Range: 302-1240

Process: 'Creating HorizonCube'

: 0% (185.185/s) (4m:18s)

1:1= 1% (16666.667/s) (3s)

| 12% (6250/s) (7s)

[RRRRRRRR -

Running process od_process_horizoncube.exe with PID 2864.

Workflow cont’d:

Elements Color

11. Add inline 425 in the scene
and select the attribute
4 Dip steered median filter.

 Add Dafault Data

Add at Well Location ...
Add Color Blended
“ 3D Horizon

! Select ol e
Select first layer

Filter =
9! Stored 1 Original Seismics -

4 Dip steered median filter
) ) o ) 5 ChimneyCube
12. Right-click the inline number (i.e. 425) Attributes | Ta Al Cube Std

and select Add > HorizonCube Display e oube

Q4 Darnciha iha feam HC KA

Steering

TV e QoK |||@ cencel] | @ Hep |
o 4,25; Ard "4 Astribute
@ Cross.ij  Display * | & Volume Builder Attribute
¥ Z-slice Duplicate € HorizonCube Display
® Volume Reset Manipulation % Systems Tracts Display
~ Randon 4+ Correlate with Wells .
2D Line
Lock Treeitem
@ 30 Hori © R 1I .
1 2D Hor] = Remove from Tree
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Workflow cont’d:

13. Select the HorizonCube_FFT225MF 113 that
you just created.

14. To explore HorizonCube display options
right-click on the HorizonCube in the tree >
Display > Properties. Close the window.

4 ¥ In-line
- [7] 425
[¥]|HorizonCubg ==~ 27"~ **~ ]
] 4 Dip steered Select HorizonCube  » 1

¥ Cross-line Move v

@ Z-slice Display * [ Properties..
® Volume Reload

~ Random Line = Remove

AN ina

/% Select 3DHorizonCube o -E-
Fitter *

> Continuous_HC_Full < -

Continuous_HC_Full_Trim —

Horizon FFT 225 MF 113_truncated | R‘

HorizonCube_FFT225MF113 =

Inversion based HorizonCube i

Inversion based HorizonCube Backup

Proportional_HorizonCube -

r] E——T] | »

@0k ] ©cance|| @tep |

...\Surfaces\HorizonCube_FFT225MF113.hci

___

! HorizonCube display options =5 FoR =<
Fill between lines ) Yes @ No
Use single color () Yes @ ho
Transparency | | 0
Line width 1 = Spacing 1 S
Horizontal resolution 2 trace *

| Truncate HorizonCube 2 (events per sample interval)
Top [} 0
Base {0 a7
] Link to ColorTable
I"| Lock Top/Base distance
| Apply to all
[ save as Default © Close [O—Hﬂh

Workflow cont’d:

G- E G

15. Open the HorizonCube slider by

Control Center 2D ...
Control Center 3D ...

clicking the 1531, icon. ~| HorizonCube Slider ..
! HorizonCube 3D Slider ...

16. Observe and QC the results of your
HorizonCube by using the Top and
Base sliders.

The HorizonCube slider is a very useful tool
to investigate your data and to make detailed
observation of the depositional history of your
sedimentary basin.

8 [] Link to ColorTable

J [] Lock Top/Base distance
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Workflow cont’d:

17. Observe how gaps are present in the prograding clinoforms. This is due to the
HorizonCube being created with only one iteration. Iterations can be added later.

18. The gaps are filled by finding the gaps | = baorven Advenced cptions el o=

- - @ Continuous events. Truncated events
based on a given advanced setting. -
1a Min/Max @ Fixed spacing

Advanced settings can be accessed
i R Spacing at start position (ms) 8
by Processing >HorizonCube > 3D > Frs
> N paces larger than 16 (ms)
Create > Settings > Processing o T G
parameters. Masmum Nr of terations 1 2
Stepout inl1 2 er4 2

QoK || Ocancel| | @Hep |

Workflow cont’d:

19. Open the HorizonCube 3D Control Center with theq icon.

20. In the Tools menu, select Add More Iterations and click Go.

' HorizonCube 3D Control Center [ o =
Pre-load ...
Active HorizonCube  HorizonCube_FFT225MF 113 -
|

[Add more iterations

4 7 Check crossings between Horizons
» Processin | | Edit a HorizonCube
‘ ’ Extract horizons

Fill holes in a Horizon
Filter HorizonCube

& . Get Continuous HorizonCube
M _._' Analysis || Grig HorizonCubes

Merge HorizonCubes
Medify/Recalculate HorizonCube

Trim horizons against Faults
Truncate HorizonCube
Tools |
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Workflow cont’d:

21. Leave the Extra Iterations option to 1, for each package.

22. Save with a new name, e.g. HorizonCube_FFT225 MF113_2it, and click OK.

Input HorizonCube HorizonCube_FFT225MF113
Mode

Iterations finished  Extra lterations
1 ft
= | 1 1

Package 1 |Data Driven: Tracking

a k|l >

Package 2 Data Driven: Tracking

Output HoﬂzonCubel HorizonCube_FFT225MF 113_2it - | ’9 Select l

- Execution Options ...

LQOK | [© cancel| | @ Heip |

The first column lterations finished shows how many iterations have already been processed. The
tracked HorizonCube events from previous iterations will never change, only new events can be

inserted between already existing ones

Workflow cont’d:

23. See the difference between output images of lteration 1 and Iterations 2.

Note the gaps are filled by adding more data-driven horizon during the 2"? [teration.
Further gaps can be filled by adding one or more lterations.
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Workflow cont’d:

24 Change the active HorizonCube
either by right-clicking the
HorizonCube in the tree:

or by selecting it in the
HorizonCube control center

Elements Color
Scene 1

=iy} In-line
-1-[¥] 425

Al Horizoor 191
QL) Sslect HorizonCube + | HC _trim_D0-06_dms_Siter

: zc':hs;'""e Move * | HC_trim_DO0-D6_4ms_3iter_Truncated
® Volume Display * | v HorizonCube FFT 225 MF 113
~ Random Lin  Reload Proportional_HC

2D Line %/ Remove

@ 3D Honzon "]

' HorizonCube 3D Control Center o - '
Pre-load ... |
Active HorizonCube [HorizonCube_FFT225MF 113 ~ ) Select Reload |

Create a SteeringCube

Filter a SteeringCube

Create a HorizonCube

Convert to SteeringCube

Create 2D Seismic Lattice

Create Horizons from SteeringCube
Interpolate Logs along a HorizonCube

| Processin

’
l ,f | Analysis
% Tools

Go ..

I ) Close L & Help J

-294 -




B - A Global Inversion based data-driven HorizonCube

Exercise objective:
Create a continuous and data-driven HorizonCube based on inversion algorithm to
understand the depositional history of a prograding system using principles of seismic
sequence stratigraphy. L TR
i Create Seismic Output  » = ’J_';‘i
. Create Horizon Output  » —
Workflow: . .
(Re-)Start Balch Job
1. Go to Processing > HorizonCube > 3D... e ’
= GMT Mapping Tool
¥ HorizonCube 4 2D ..
2. Select the create a HorizonCube option and click the | Yeeose ,
Go.. button in the HorizonCube 3D Control Center. T
= HorizonCube 30 Control Center =N EcR =" ]
Pre-load ...
Active HorizonCube ~ | Select .. Reload
‘ Create a SteeringCube
-‘ Processin
) onvert to SteenngCube
Create 2D Seismic Lattice
Create Horizons from Sweenn.g(;ube
I//! | Anatysis L e
% Tools
© Close 3 Help
- ¥ Horizon sorter = || (=) @
Workflow cont'd: Select horizons
3. A data-driven HorizonCube is created in a package - -
defined by top and bottom horizons. At least two o] -
. . . emo 1 --> 4
horizons are required. Select the horizons Demo 0 2 Demo 2 —> FS6

FS4, Demo 4 2 Truncation and Demo 6 -2 FS8. Click N oD ks

| Demo 4 --> Truncation
on OK. Demo 5 —-> FS7
¥| Demo 6 --> FS8 -

! HorizonCube Creator 30 =
Read Nonzons.

4. Optionally, Faults can be selected

Fauls - O Select .. Chaar

HorizonCube calculation mode

Horizon Mode
Demo & --> FS8 Data Driven: Multi-horizon inversi =
Demo 4 —> Truncation Seltings ..
Do 4 > Truncation Data Driven: Multi-horizon inversi =
In the HorizonCube creator, you Domo 0 > FS4 Sattngs ..
Choose an algorlthm’ SEttIngS Etc Area subselecton 100V300-750/1250 (463 samples) £ Select
Output HorizonCube = | Select ...
Analyze ..
Batch execution Single Process - | {r Options ...

QG Run | © Chose || @ Help
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Workflow cont’d:

5. We will create a data driven HorizonCube
using inversion based algorithm. Data Driven:
Multi-horizon inversion is defined by default.

6. Click the Settings button for the upper most

package.

7. Set the Steering Data to
PCA 111.

8. Click on the Processing Parameters.

™! HonzonCube Creator 3D
Read horizons ..

Faults 6 Select ...

HorizonCube calculation mode
Horizon Mode

Demo 6 —> FS8

o &

Clear

Data Driven: Multi-horizon inversio =

Dermo 4 —> Truncation Saltings ..

Demo 4 —> Truncaton

Demo 0 —> FS4 Settings

Area subselection 400/302-450/1240 (453 samples)
Output HorizonCube N
Analyze

Batch execution Single Process = | |4k Options ...

Drata Droven: Mulli-honzon inversio -

6 Select ..

© Select _..

:Onun © Ciose || @ Hep

= Package 1: Demo 6 --> FS8 & Demo 4 --> Truncation o ]
Calculation mode : Data Driven: Muli-horizon inversion
Stearing Data -.‘__l> e FCMH -] © Select ...
Initial Moded type | Proportional
In each package, we will be using a same initial Evont sampling method (Spacing at maximu thickness =
model (Proportional). Each proportional horizon will Spacing (ms) 4 ;
be updated using the defined processing St ot
parameters. Apply to all packages option will set
:
the same settings to all packages. T
| @ok || ©cancel|| @Hep
Workflow cont’d:
= Fault dips will be calculated from Sl =)
interpreted fault planes and merged with RTINS LS i)
reflection dips from the Steering Cube if
toggle is Yes. Confidance woight [ &) - create | ()
+ Confidence weight assigns weights to )
the Steering Cube. Planarity is a good @
confidence measure that can be
. MNumber of Horizon updates 10 ‘6
calculated here, or in the Faults &
Fractures plugin. Advanced CG Solver paramelers 0
+ Confidence power increases the Number of CG Sohver Hteraions 200 2 (7]
contrast between planar and non-planar Solver residual aror [0.07 )
features. Preconditionning filer stepout inl6 2 cidd 2 0
+ Number of horizon updates are
typically between10 or 20. HeSUIon QPeceter oA LD 9
= Number of CG solver iterations are Resol
used to solve the gradient equations. @ Hep

- Pre-conditioning smoothing reduces
spikes in the output horizons.

CG — Conjugate Gradient

In this case stick to the defaults, hence

press Close to continue.
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Workflow cont’'d:

9. We will sub-select the processing area to

400 — 450 in-lines.

10. Provide an output name: Inversion based

HorizonCube.

- P
Spacily Pustons

v st 3 | Raege

i Barge 80 = 4]

Cross-ien Barge 30 3 1750

11. Press Run to create this HorizonCube output.

FREREETRI=IRIRIRELI*]] 100%

t 2016, 14:11:48

: T8 (47.755/%) (03)

14:11:49

ished: di 11 okt 2016,

asing done.

Finished batch processing.

[E5]ows am
o

‘= HorizonCube Creator 30
Read horizons

Foulls - Clear

HorzonCube calculation mode

Haorizon Mode -

Demo 6 --> FS8 Data Driven: Muli-horizon inversi =
Demo 4 --> Truncation Setlings i

Demo 4 --> Truncation Data Driven: Muli-horizon inversi ~

Demo 0 > FS4 Seltings ...
Area subselection 400/300-450/1250 (463 samples) D Select .
Cutput HorizonCube | Inversion based HorizonCube] - I D) Select ...

Analyza

Batch execution |Single Process - | |4 Options ...

(DR ][O coce | [ @ o

Workflow cont’d:

12. When processing is finished, Add inline 425

in the scene and select the attribute
4 Dip steered median filter and OK.

i Select

Elements Color

Sc

& {Inlipes
W Cro
& 7-sl

Add Default Data

Add and Select Data
ol

" Ral Add at Well Location ...
. op| Add Color Blended
@ 3D Honzon

Select first layer

13. Right-click the inline number and select Add

> HorizonCube Display

Scene 1
4 iy In-line
4 v 425
Add »
Display
Duplicate
Reset Manipulation

« | Alfribute

* W Volume Builder Attribute

€ HorizonCube Display
Systems Tracts Display

¥ Cr¢
75
® Vol
~ Ra g

Vert. Res. E o
Correlate with Wells ...
10D B Lock Treeitem
Fa == Remove from Tree
FaultStickSet

T 2D o
@ 3D

9 Stored 1 Original Seismics

4 Dip steered median filter =
5 ChimneyCube

7a Al Cube 5td

7b Al Cube from HorizonCube
8a PorosityCube from HC-NN
8b Gamma from HorizonCube

Steering

ibutes

I O ox IO Cancek] .

© Help l

- 297 -




Workflow cont’'d:

14. Select the

HorizonCube Inversion based

HorizonCube that is just created.

15. To explore HorizonCube display options

(S e e e

Filter *

> Continuous_HC_Full < =)
Continuous_HC_Full_Trim

Inversion based HorizonCube
Proportional_HorizonCube_Full =
Test_HC_ful_Inversion
Tesi_HC_full_Inversion_v2
Test_HC_full_Inversion_v3
Test_HC_full_Inversion_v4 =

OCanl:BI_I @ Help

_faces\Inversion_based HorizonCube.hci

X80

- - . . = HorizonCube display options F=2Eon
right-click the HorizonCube in the tree > e
Display > Properties. Close the window. Vow s cokor @ Yos | B NG
Transparency [ | o
Line width 1 = Spacing 1
Horizontal resclution 2 trace ©
Truncate HorizonCube 2 (events per sample inferval)
Scene 1 Top [} /]
4 iy Indine 1
e 'J'_425 Base 0 137
YU Select HorizonCube . ACHDEETIED
9 Crossin Move 0 | Lock Top/Base distance
Z Display + [ Prop 5

i N ' o

~ Random == Remove =

- 2D Line Save as Defaut \ © Hep

Workflow cont’d:

= OpendTect Pro VE.0.4/wing F3_Demeo_2018,_rainingvé - [Scene 1] =
™ Surwy Analyss Processng Scene Vew Ubkbes Help o x
QUCABEXAT-A0ASEeR Fo K@ TG L nwews o =iy s

Tron scens 1

4 Elemants
Soena 1

» @ Inding
a4z

@ Crossdne.

@ Z-sice

@ Volemo

~ Random Ling
20 Lo

® 30 Horizon

4 20 Horizon

Fantt
FanltStickSat

AP Y Y

=

=
&
£

LallFr m30 98

425531 (B11372, GOB1EIS, B3S)

¥ Imversion based Horzond.
¥ 4 Dip stoured median fer

-
Calof

v _
Value =293 {4 Dip steored median fller)  In-line: 425

cqmup oo |

[froe mee] 1.67.9 GB E"
|

An example of this HorizonCube

overlain on inline 425.
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Workflow cont'd:

= Eg(@ - B R
16. Open the HorizonCube slider. Contrd Contor 200

Control Center 30

~} HorizonCube Slider ...
TZonGu fer .

17. Observe and QC the results of your
HorizonCube by using the Top and
Base sliders.

The HorizonCube slider is a
very useful tool to investigate
your data and to make detailed
observations of the
depositional history of a
sedimentary basin.

Workflow cont’d:
Optional Steps (Filling the gaps):

You may want to fill the holes by taking some events from a HorizonCube and re-

computing the packages using the horizons. This workflow is presented in the following
slides.

18. Choose the events defining a gap from this HorizonCube. Use Top slider to know
which events are needed (e.g. events 86 & 91).
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Workflow cont’'d:

19. Open the HorizonCube manager.

20. Copy the inversion based HorizonCube with
a new name since we will be changing this
one and the other one will be our backup.
Once done, close the HorizonCube

manager.
T btanage 30 Horizeriabe = e
Fiter * iy HorizonCube data
> Continuous_HC_Ful < A= *

Contirvous_HC_Full_Trim
Inversion based HoriZonCube
Inversion biased HorizonCube 15t
Inversion based HorizonGube 2nd
Inversion Bised HonzonCube copy
based HorizonCube copy v2
rtional_HorizonCube_Ful
Test_HC_ful_lnversion
Tost_HC_ful_lmvarsion_v2
Test_HC_ful_imversion_vi

el

=

'-.rSul\ey'lm Processing Scene View Utites Help

47 SelectSetup e = iz @ @
= = == o
e L | s | § ei' s
Import .
Export
| mManage , Atribite Sets
e ' |® Bodies
Exit Color Tables
=, Cross-plot Data
o | $Crssine |5 Fauns
:i;:“ \ FaullStickSets
- me
”,
lq O Line ™ Goometry 2D
20 Ling =, Honzons
[T 4 ® 30 Horzon |+ Layer Properbes
~ < [7] Inv__0091 | 7, PickSets/Potygons
8- | 2 values ™ Probability Density Functions
- . ';Wz_g?feﬁ Random Lines
values .
2D Horizon | T4 Seismics v
&~ Fault & Seismics Prestack r
FaulStickSel  Sessions
® | @ boty B, Strasgraphy
H b Wel A, Winslots
: PickSet . Wels
E [ Patygon
5 Prestack Eve @ HorizonCube 2D
‘" Annctations *, Neural Networks 30
5515 " [
=/ Copy HorizonCube f=e
Input HorizonCube Inversion based HorizonCube ~ | D) Select ...
Package Range 1 Sl
Area subselection 400-300-450/1250 (280 samples) O Select ...

Outpat HorizonCube  Imversion based HorzonCube backup| = | © Select ..

O o

Workflow cont’'d:

21. From the HorizonCube manager,
extract events 86 & 91 from the
selected HorizonCube. >

22. The base name will be set as a prefix
with an automatically generated suffix
(e.g. Inv_0086 will be a name of the

output horizon). Press OK.

23. Once done, close the HorizonCube
manager. At this moment, we are
ready to modify an existing
HorizonCube using these two

horizons.

= Extract Horizons from HorizonCube
Selact by

SRICE %"

Package @ Event

Salect Evantis) | ¥ Event 8 (Inl: 400 to 450 Crl 30016 1250 )
Event 87 (Inl: 400 to 450; Cri- 30010 1250 )
Event &8 (Inl: 400 to 450, Crl 300 to 1250 )
Event 89 (Inl: 400 to 450; Cri- 30010 1250 )
Event 90 (Inl: 400 to 450; Crl- 300 to 1250 )
| Event 91 (Inl: 400 to 450; Cri: 300 to 1250 )
Event 92 (Inl: 400 to 450; Cri- 300 o 1250 ) -

Area subsalection 400°300-450/1

Base Horizon Name I

250 (274 samples) B Select

0%

(B0 (oo
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Workflow cont'd:

24. Open the HorizonCube control
center.

»‘-:;;IC\E,': z’lllr 1KY,

Control Center 3D ...
1 HorizonCube Slider ..
¥l HorizonCube 3D Slider ...

25. Set active HorizonCube to Inversion = Horizandiube 30 Control Center ERRC %"
based HorizonCube.
Active HorzonCube  Inversion based HonzonCube - O Salect .. Reload
26. Go to Tools and Select 3" e o
Modify/Recalculate . . « A e ot
Edit a HorizonCube
Extract horizons
4 Get Continuous HorizonCul
27_ Press Go_ |‘/{‘| Analysis Gr:!IIoulnznnCu;s e
- — e | miossty Racacuate ine |
S—— — T
K-
Facli O Setect Cnai
= O Cuse || @ Hap
Ofn | Do || B
Workflow cont'd:
(= [ — == E.
28 Select the HOI’iZOhCUbEZ lfnversfon Input HorizonCube  Inversion basad HorizonCube » | ) Select ...
. Read horzons ...
based HorizonCube.
Faults - © Select ... | Clear
29. Read horizons: (e.g.) Inv_0086 HorzonCube caculon mode
Horizon Mode Action
and InV_0091 Demo 6 —> F58 Data Driven: Muli-horizon in = [Keep -
) Dema 4 —> Truncation Settings
! Horizon sorter [ — .:|. (=] .'E
St oo Demo 4 > Truncation Data Driven. Wuli-horizon in - Keep -|
Demo 0 > F54 SHmngs ..
.-
Demo 5 —> FST -
Demo 7 —> shallow
Im2_0103
+| Inv__0086 L
+| lnv__ 0091 I
Trim_D0 --> FS4 Analyze .
E:E—Eﬁ 7: 'rl'rqu:cailon - Balch axecution | Single Process = | | &k Oplions ...
[©0K ][0 comei L LD

We will only select the horizons
which we extracted in the previous
steps.
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Workflow cont’'d:

= HorizonCube Creatar 30
30. We will choose Action keep for the Input HorizonCube  Inversion based HorizonCube - |© Select l
first package and compute for the Read horizons .. |
rest of packages. Fauts - [© select .| [ Ciear |
HorizonCube calculation mode
31. Ensure that the three packages for P Frow o —
compute have the same algorithm Demo & —> F&B Data Drven: Mubi-hori - Keep 3]
i.e. Data Driven: Multi-horizon Demo 4 > Truncetion | Sefings ..
Inversion. Demo 4 --> Truncation | Data Driven: Multi-hori vlCompn.ls ~
Inv__0D0B6 [ Setlings ... | =
32. Run
Inv_0086 Data Driven: Muti-hori ~ | Compute -]
Inv__0091 \ Settings ...
Optionally: You may choose a ;’;;?Lm {D"“ °$$f_"‘“°”'l%,
different algorithm and settings e ) '
.y e ..
(such as start position) for each o )
package. It depends on the nature Boeh scudon gl Prviees ! (b e
and data quality in a package. [©rwn ] ©cose|[ @ter |

Workflow cont’'d:

33. Once the processing is finished, Reload the HorizonCube: Inversion based
HorizonCube.

34. The results may look like this after filling the gaps:

Scene 1
4 i@ In-line
4 [V 425
. m; Select HorizonCube  »
@ Crossdine]  Mow *
& Z-slice Dispiay
® Voume Reload

~ Random L == Remove
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2.4.1b 3D Bodies From HorizonCube

Required licenses: OpendTect Pro, HorizonCube.

Exercise Objective:

Visualize a HorizonCube in 3D by using the 3D Slider - an add-on to perform analysis in 3D
along iso-timelines.

In this exercise we will investigate a prograding system in 3D by making thickness maps and

geo-bodies.
- HorizonCubse 30 Control Center
Pro-oad
Workflow: At HorzonGute | Cantinsors_ G Fl <0 souet | ioknd
1. Open the HorizonCube 3D .: L Procossin | |Make Crosspess of onzonGubo D

Control Center with the @ icon.

2. Select an active HorizonCube ol o
Continuous_HC_Full.

3. Click the Analysis button, Select
the 3D slider and press Go. O come

Keep the 3D slider window open.
You may close the HorizonCube
3D control center window.

- o

@ Hep

Workflow cont’d:

4. Add Default data for inline 425. Tree scene 1 P)

Elements Cailor
Scene 1
b dmm| Add Defaul Dala
W €6 44 and Select Data
* Add at Well Lacation

L XS
Vel
® o i

5. Right-click on the inline number > Add >
HorizonCube Display.

< i In-ine
4 7425
7 4Dip  Add |l Attribute
# Cross-line Display ' |9 Volume Builder Attribute
: i-slhce Duplicate € HorizonCube Display
'olume set Manipulatic h
~ Random Li Reset Manipuiation Systems Tracts Display
B Correlate with Wells ...
- 20 Line

@ 30 Horizor @ Lock Treeitem
1 2D Horizor == Remove from Tree
Fault
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Workflow cont’d:

6.

8.

9.

In the 3D slider window, click on
Change to pre-load the HorizonCube
Continuous HC Full.

In the Pre-load Manager press Load 3D...

Set the Event range from 260 to 310.

Press OK and close the HorizonCube
Pre-load Manager window.

Always preload with limited range when
using small RAM (under 8GB).

Pre-doaded HorizonCube None Change

Display resolation 174 [=] |Pretianguiate shders

Top |} L] Il Save
Display In fll [=] [7] use singhe coler
- HorizonCube Pre-load Manager — O n
fo Horizom Cube preloaded Load 2D
Load 3D ...
Unload
€ Close | @ Help
= Select Horizon Cube -0 “
Input HorizonCube Continuous_HC_Full v| B Select
Select by O Package ® Event
Event Range] 260 < (310 [
Area subselection 103/302-748/1248 (278 samples) © Select ...

© Cancel @) Help

Workflow cont’d:

10. Set the Top horizon display: None and

Base horizon display: In full.

11. Check Link to 2D displays option to see

the HorizonCube events on the sections
within the selected range.

12. Set Display data to Top-Base Isochron.

13. Press the Calculate button.

Note: The scene will be updated
once you press the calculate button.

) HorizonCube 3D Sikder
Pre-oaced HorzonCube Cortruous_HC_Ful Change

|| Dispiay resalution | 14 = | [Pre-nanguiste siders

|l S

Toe .} 261

DCisplay | Hone =

Base m

=

Désplay |Inhull =

Lok e s G

Dispiay data |Top-Giase ochin ~
Calculate | |7 suto-upaste

125606}

Use single color

10000

4 ‘zr"s“ﬂc-?l

0.07903671

#loes 0025 0.05 0.074 0.1 b1l

Data range 0.00054 011019 Tiweshold 0026541

. I ESeismics

TrANSparency Bisaies -

Color semng

Q cies | | @ e
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Workflow cont’d:

Making Thickness Maps

14. Set the top slider to 302 (press ENTER to update) and the Base slider to 310
(press ENTER to update) and click Calculate.

15. The result will appear automatically in the 3D scene on the base horizon after
clicking Calculate.

Example isochron map
between events 302 and 310

Workflow cont’d:

16. Repeat the exercise for the following horizon pairs and observe the shifts in the
depositional center. Press Enter and Calculate every time after updating the numbers
for the Top and Base sliders.

Top: 265, Base 275

Top: 285, Base 302 Top: 275, Base 285
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Workflow cont’d:

Extracting Geobodies

17. For this exercise we will apply a
transparency threshold for all thinner
regions below the cut-off to preserve and
outline of a thicker region.

18. At the bottom of the 3D slider, specify
Threshold = 0.02 (Press Enter) and set
the transparency to Transparent below
threshold. (In the histogram, a thin vertical
red line will appear, which corresponds to
transparency).

& HorizonCubie 3D Slider Lo i) ot
Pre-loaded HoronCube Continuous_HC_Full Change
‘| Dispiay resolution | 14 = | |Pre-tianguiate siiders
Top [} 265 | jo) Save..|
Cesplay Home =
Base ] 275 [jd Save
Dispiay | In hull * | [7] Usae single color
) Link to 20 displays [ Lock Top/Base distance |Creale Body .|
Display data | Top-Base Isochion =
Cabeulate Aute-update
12560
100004
it a2l 0 07903671
3 5000
8
25000
dloos 0025 005 0078 01 0.1101
Value

Datarange 000054 0.11018{ Thresnota 0.02 Fi!anﬂ.mﬂa @sazied =
Transparency disabled
Color semng l _.l ASeismics ~ Transparent below treshold
- Transparent adove Mreshoid

@

Workflow cont’d:

Extracting Geobodies

19. Press the Create Body button.

20. Set mode to Automatic filling, the
threshold value will remain unchanged.

21. Set the Body value option to Above
threshold. Click Run.

22. Close 3D Slider.

5 Horicortube 10 Sder L2 ) ]|
Preinaded HorzonCuce Continuous_HC_Ful Change
H Display resclution | 14 = | |Prenanguiate sisers
Top 265" [l 5w
Display Hone =)
Base 1 275 i S
Display In ful =] 71 U singie csior

Displsy data [ Top-Base Isochien =

Caculate Auto-update
125608
100004
syt T T ]
2 5000
500
hoos 3 005 0073 01 01101
alue
e -

Datarange 000054 0.1101% Theeshold 003

coiorsonng [ I 15sismcs -

Transparent below Mreshiid =

ICEDI D

) |

s Create body from sliders

Body value (®) Above threshold

@ Close | @ Help

Below threshold
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Workflow cont’d:

Extracting Geobodies

23. The body will appear in the scene. If you are satisfied with the geobody you may saveit to
disk by right-clicking on the <New Body > in the tree > Save as..

4 @ Body | I
4 |V||<New Body 1> -
J| <right-¢ Display 3
Well Calculate Volume
~* PickSet W sae
[ Polygon
= Bl Saveas
=y Prestack Even
Annotations g LockTreeitem

== Remove from Tree
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2.4.1c Truncate HorizonCube

Required licenses: OpendTect Pro, HorizonCube.

Exercise Objective:

stratigraphic interpretation.

Truncate a HorizonCube to prepare Wheeler diagrams and perform seismic sequence

1. Open the HorizonCube 3D Control Center with the @ icon.

o~ HorizonCube 3D Control Center -0 n
Pre-load
Active HorizonGube Continuous_HC_Ful v | 0 Selecl Reload
2. Select the Truncate A Firobs na toraon
. Processn Trim against Faults
HorizonCube P A s harsons
. Edit a HorzonCube
option from the Tools Exirect horizons
R Gat Continuous HonzonCube
menu and click Go... y 6Grid HorzonGubes
IL’; | Analysis | Merge HorizenCubes
Modify/Recalculate line
%
Go
There are two types of HorizonCubes:
continuous and truncated O Cise || @Hep
Workflow cont’d:
3. Select HorizonCube FFT 225 MF 113 (created in previous exercise) as Input
HorizonCube.
4. Leavethe area sub-selection and minimum spacing as default.
5. Give an appropriate name, e.g. HorizonCube FFT 225 MF 113_truncated,
and press OK.
= Filter Horizon Cube = EoR = |
Truncate HorizonCube
Input HorizonCube| HorizonGube FFT 225 MF 113 -l © Select ..
Area subselection 102/302-748/1248 (463 samples) © Select ...
Tlp |f thE truncated Maximum density (Nr events per sample interval) 2
HorizonCube includes too Output HorizonCube | HorizonCube FFT 225 MF 113_truncated "l © Select...|
much irrelevant events (noise), Th Excoution Optiors
go back and increase the
Maximum density Q.comy) (bt
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Workflow cont’d:

6. Batch processing window will pop up.

7. Leave the process running until you read the message: Finished batch processing.
= Progress -0 n
OR?
End of process: 'Filtering HorizonCube'
Trimming the output horizoncube ... Done

Saving output for package 2

dTect Vé.0

iting 3D Horiz
Thu 12 Nov 2015,

Saving HorizonCube

: 19% (14.78/s) (14s)

Finished: Thu 12 Nov 2015, 16:51:55

End of process: '"Writing 3D HorizonCube'

Finished batch processing.

Processing ended

Workflow cont’d:

8. After processing, switch to the truncated HorizonCube via HorizonCube 3D Control
Center@ by selecting HorizonCube FFT 225 MF 113_truncated.

9. Close HorizonCube 3D Control Center.

" HerizonCube 30 Control Center o] = ==
[Pre-load .|

Active HorizonCube [ HorizonCube FFT 225 MF 113_truncated r| © Select .| [ Reload |

Check crossings between Horizons
Fill holes in a Horizon
» Processin | | Trim against Faults
‘ B Add more iterations
Edit a HorizonGube
Extract harizons
Get Continuous HorizonCube

’ Grid HorizonCubes
/'f | Analysis Merge HorizonCubes

Modify/Recalculate line
% Tools

Truncate HorzonCube

:Go

[© Closel [ @ e |
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Workflow cont’d:

Elements
Scene 1
PSR i Dot Dota
10. Right-click on In-line in the tree > Add Default Data. Oz et

@ Volur  Add at Well Location ...

~ Rand  pgq Color Blended
I

Elements Colof
- - . e Sc 1
11. Right-click on the inline 425 > Add > ; .‘.’“4-
. . . 5 425
HorizonCube Display, to display the truncated g Add 3 . Attribute
. N @ Cross-  Display * |4y Volume Processing Aftribute
HorizonCube in the scene. Zale ;“"’"“ﬁ“ | e
DRSSyl s Doy
. . . Elements
12. Switch back to the continuous HorizonCube | s
- - - . 5 @ Invline
by right-clicking on HorizonCube name > vl 425 . .
Select HorizonCube, to compare the two @ e Dy sto SECTTETTTTISTIR  HC,trim_D0-06_4ms Sier
ove Y HC_trim_DO-DE_4ms_3iter_Truncated
results. = Disgiay '

ot Ra'“"'ndme Ling | _ Peload v HorizonGube FFT 225 MF 113_truncated
™ 20 Line % Remove Progortional_HorizonCube

‘ The results should be similar to the ones shown below

Continuous
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2.4.1d Horizons From HorizonCube

Required licenses: OpendTect Pro, HorizonCube.

Exercise Objective:
Extract multiple horizons from a HorizonCube.
Scene 1
N In-line
@ Cross-lil Add Default Data
@ Z-slice Add and Select Data
@ Volume Add at Well Location ...
~ Randon  agq Color Blended
20 Line
._ EEﬁonzon 4 ¥ Indine
4 425,
Workflow: w4 o Add * |4 Atrbute
u;:mbscs- EIS,:IBY: * | % Volume Builder Attribute
» L-skce uphcate
1. Add the default data by clicking inline @ e o Uanoden |3 Sytems rts Dol
. e default data by clicking inline in © RO Contate wih wels
the tree. Next, add a HorizonCube © 3D o 8 Lock Treetem
. . 1 = R f Tr
overlay. Select the active HorizonCube ——_—
Continuous_HC_Fullif prompted.
= Moriond e X0 Condesl Contar e ==
Freloss
2. Open the HorizonCube 3D Control e ooncite commne i pa - [ soec.] (icnas
Center with the Q icon. A Gt coss s s
3. Select Extract Horizons under the , o bccite
fools menu and click Go ... sy o s
The active HorizonCube is %M
automatically displayed
D Ciose| | € Help

Workflow cont’d:

4. Scroll up and down using the slider, while
observing the HorizonCube events in the

|— & -:_———._-""—"-

scene. 77— —
— -

— ——

— S —
28 f _—#-__
Lnkio ColorTably |~ Cemieeiae — — —
B __—————-'-‘--"—"-‘
e ——

[Gon ]| cancel | @ e

5. When you locate a horizon you wish to
extract, click on Pick Horizon. A separate
pop-up window will appear. = et osaon B

Cutput 30 Horizon  event_263 - [ setect..| (= acE -

Tied to Leved | == -

6. Give an appropriate output name and click
OK. Base color | NI | | ™ MediumTurquoise: =

Ocancel 16 heip
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Workflow cont’d:

7. Repeatthe exercise a few times for the
events you wish to extract. Then click OK.

8. A separate batch processing window will
open. After the processing is done, the
extracted horizons can be loaded via

30 Line
horizons 3D > Load .. in the tree. D tongen | M
Faull A at Sections Only
FaukStickSet Addd Color Blended
& Boay Track New
Wel Creste with Constant 2
PickSet

= Eanet Hesizen

Pick Horzon

Event Index

23

Link to Color Table

4 Execution Opons

B0 @m

Picked harizons in the slider

= Select Input Hesizon ()

215 chosen

=]

w- Filer *

Demo 7 > shallow -=
4 event_102 =
¥ event_213 [ ]
] event_283

e Pal

Trim_D4 —> Truncation

Trim_D5 > FS7

T D6 —> FS8

Area subselection 103/302-T48/1248 (463 samples) O Seiect

D Cancel| | @ Help
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2.4.2 Sequence Stratigraphic Interpretation
System (SSIS)

What you should know about SSIS

» SSIS is a commercial plugin by dGB that operates on a HorizonCube.
» SSIS supports Wheeler transformations and Systems Tracts Interpretation.

Details

In essence, sequence stratigraphy is used to provide a chronostratigraphic frame-
work for correlation and mapping and for stratigraphic prediction (Emery and
Myers, 1996). Although sequence stratigraphy has proven to be a powerful instru-
ment, and despite major advances in concepts since its introduction in the nine-
teen-seventies, sequence stratigraphy has not lived up to its potential because of
the lack of supporting software tools. OpendTect's SSIS plugin came to the mar-
ket with the aim of filling this gap.

ain e
.. Time-Depth pomy _‘:'ff:;-?-::‘"’" "‘"ﬁ

“.-"j e s?mmg Tracts

Wheeler diagrams and wheeler transforms can be powerful tools to aid in
sequence stratigraphic interpretations. Non-depositional or erosional hiatuses
are visible, the lateral extent of stratigraphic units can be determined at a glance,
and a clear understanding of the lateral shift in deposition over time can be estab-
lished. The Wheeler transform is constructed, by flattening each horizon, thus
enabling the user to study seismic data, and its derivatives (attributes or neural
network outputs) in the Wheeler domain in three dimensions. Previously,
Wheeler diagrams were constructed by hand, making this a time consuming pro-
cess. This is unfortunate because the Wheeler diagram, or Wheeler transform as
its seismic counterpart is called, is a very valuable tool to gain insight and to
extract additional information.
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The Sequence Stratigraphic Interpretation System (SSIS) plug-in to OpendTect
allows interpreters to automatically create a Wheeler transform in which they can
study the depositional history of the area through flattened horizons, showing the
stacking patterns including depositional hiatuses and condensed sections. Using
this added feature, interpreters can make more informed decisions about seismic
facies and lithofacies predictions, thus helping to identifying potential strati-
graphic traps.

SSIS will only be of use if you have already calculated your HorizonCube. If you
created a continuous HorizonCube, you will need to truncate this to see depos-
itional variations in the Wheeler scene. Both creating a HorizonCube and trun-
cating an existing one are covered in the previous section of this training manual.

Lap-out patterns & stratal terminations

While it is not a requirement as part of the workflow to perform this step each
time, but it is considered as a good practice. Annotating the stratal terminations in
your data before making your interpretations can lead the observations towards
proper interpretation.

Annotations are graphical interpretation tools that are available in OpendTect dur-
ing the whole workflow. They can be a great help at the start of an interpretation
when tracking bounding surfaces, or when making an initial interpretation.

The annotations comprise of three basic tools: Arrows, images and scale bar.
The arrows are intended to indicate lap-out patterns or stratal terminations, but
can be used to highlight any feature. Seismic data can be animated with pictures
to make communication easier and more direct with colleagues who are working
on the same project. The scale bar allows you to very easily add scale inform-
ation.

The types of stratal terminations are truncation, toplap, onlap, downlap, and
offlap. They provide diagnostic features for the recognition of the various surfaces
and systems tracts. “Stratal terminations also allow inferring the type of shoreline
shifts, and implicitly the base level changes at the shoreline. For example, coastal
onlap indicates transgression, offlap is diagnostic for forced regressions, and
downlap may form in relation to normal or forced regressions.” (Catuneanu,
2002):
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Downlap Onlap

Downlap
Downlap |
Types of stratal terminations
Stratal Termination|Shoreline shiftBase level
Truncation Fluvial [FR Fall
Truncation Marine [FR, T Fall, Rise
Toplap R Standstill
Apparent toplap NR, FR Rise, Fall
Offlap FR Fall
Onlap, fluvial NR, T Rise
Onlap, coastal T Rise
Onlap, marine T Rise
Downlap NR, FR Fall, Rise
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Onlop ond Baselap

Gaological Model

e & aign of reflection cosfficent
(a)

Wrong pack

A A A

Condermify of refleciion from
hp sondsiond 80 limeshona,

(b}

Shay down when pching Sgaingl %‘ ‘—;
tha dirsction of onlep or downiop

(c]

FIGURE 7.14 Picking criterion—onlap and downlap, (a)
Geolowgice] model: A sandstore of intermediote acoustic im-
pedance is onlapped by shales of low acoustic impedance,
and limestone of high acoustic impedance. The reflection
eoefficient signs are indicated on the diggram. (b) Seismic -
pression; The top sand reflection, the sequence boundary
defined by the onlap, changes polarity due to the varying

ion coefficients bebween the sandstone, lmestone, and
shale. The apparent continuity betwesn the top sand and top
limestone reflections is a potential trap for the wheary in-
terpreter. (c) A general rule when following an onlapped se-
quence boundary is to stay down when picking against the
onlap direction

Truncotion ond Toplap

{a)

FIGURE 7.18 Picking criterion—toplap and truncation. (a)
Geological model: An interbedded sequence subcrops an un-
conformity overlnin by a sand. Signs of the reflection
coefficient are indicated. There is no aooustic-impedance oon-
trast between the sands. (b) Seismic expression: The uncon-
formity has a positive reflection coefficient to the right, no
reflection where if is subcropped by sand, and o negative
reflection coefficient to the left. A potential interpretation pit-
Jall would be to take the unconformity pick along the top
limestone reflection. (c) A general rule when following a sur-
face in the direction of truncation or toplap direction is fo
stap high.

Selecting unconformities
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2.4.2a Stratal Terminations

Required licenses: OpendTect Pro, SSIS.

Exercise objective:
Annotate stratal terminations and lap-out patterns using standard Arrows.

Workflow:
Scene 1
N Indng
1. Add inline 425 using default data. o e e

@ Volur Add a1 Well Location

~ Rande Add Color Blended

20 Line
@ 30 Horizon

Z PickSet

[ Pelygen

3 Prestack Events

x
H [E] Annotations
B

Annotations
Ariere=.

3. Click on Arrows and select New Arrows Group... imo( TP T

& ~
2. Expand the Annotations item.

! annotations | = | (=] -'R‘

Arrows Annotations

4. Name the arrow group to Stratal Termination and Group name | Stratal Termination|

press OK to add this to the tree. _ _
[Go] (0o

OpendTect annotation (arrows, images, and scale) are handy tools to highlight and describe
features of interest. In seismic sequence stratigraphic interpretation arrows are used

traditionally to map lapout patterns and truncations.

Workflow cont’d:

5. Stratal Termination element should be
active in the tree (a click on the name
activates the item). Switch to the right
mode %

6. Now you pick on the seismic inline at
positions where you want to insert an
arrow. First click adds an arrow head.
Rotate and click one more time to pin it. Line color [ | width [5 2

Scale B

» Ctr + Click on the arrow to delete it.
« Change the type, color, width and size of the arrow via right-click on Tree > Annotations >

Arrows > Stratal Terminations > Properties...
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Workflow cont'd:

7. Continue the interpretation on this line.

8. Right-click on Stratal Termination and Save.

Optionally make different arrow groups:
*  Downlaps.

*  Onlaps.

* Truncations.

- Annotations
Sl

H .
Image
- Scale Bar

Bl Saveas..

¥ Properties ...
a Lock Treeitem
w= Remove from Tree
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2.4.2b Stacking Patterns

Required licenses: OpendTect.

Exercise objective:
Evaluate stratal stacking patterns using the HorizonCube slider.
glra.nni
:5:'“” Add at Well Location
Workflow: - n,':: Add Color Blanded
T 20 Line
@ 30 Horizon
1. Add inline with default data (if the line
. . . Scane 1
exists, skip this step). TOre )
1 0 s i Y
. L 'crnssdme”‘" Display 5 -i‘?:mm Frse
2. Add HorizonCube overlay on inline 425. Sl =
' Random Line ms;i;;;'m:la‘r‘l:l’lm; , [ Systems Tracts Display
T e - "
3. If no HorizonCube is selected, it will ask < 0oz 3 -
you to select a HorizonCube. You will oI L
choose Continuous_HC_Full.
1% Select 3D HorizonCube =8 e "%~
Filter "
Common stacking patterns are: Cortmnous_HC_Foll =
. Continuous_HC_Full_Trim —
+ Aggradation et it ol
+ Progradation Truncatad_HC.Fo_Tien x
+ Retrogradation (5]
+ and combination ofthese.
B[ 0o |[ @t |
_2015\Surfaces\Continuous_HC_Full hei

Workflow cont’d:

(@)~ B2k

Control Center 2D ...
Control Center 3D ..

4. Launch the HorizonCube slider.
T

5. Play with the sliders by moving the Top ¥ FortzoiGubs 30 Skders-
Slider & observe changesin the scene.

Link to ColorTable

Lock Tap/Base distance

[Qow ][ @ |

T e —— e T
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Workflow cont'd:

6. For better color contrast, you may want to
change the color scale of the background
image to Greyscale. See the steps below:

inf425 Zistep1 (2 qm mp (2500 | Q4500 [1aseismics

—== —— I Double Tasty
o Vil

Scena 1

) In-line Il Experimental
[¥] 425 I 1 Extremes
/| Continuous HC Full Il W Faults

9] 4 Dio stoerod median . [T]
g Cross-ine
& 7.k

Workflow cont'd:

7. (a) An example illustration of making observations:

*You have also learnt about this zone while doing spectral
decomposition (RGB Blending) & waveform segmentation.

[ Link to ColosTable

[ Lock TopBase distance

[(Ocuse |[ @ Hee
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Workflow cont’d:

7. (b) An example illustration of making observations:

Aggradation to progrdation
(flux dominated)

Link to ColorTable

Lock Top/Base distance

(D0 ][ @

Workflow cont’d:

7. (c)An example illustration of making observations:

Fall with su bsequént

progradation —aggrdation_—

—

[ Link to ColorTable

"] Lock TopBase distance

[ @

S——

Note: The scene is a bit zoomed out.
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2.4.2c Wheeler Scene

Required licenses: OpendTect Pro, SSIS.

Exercise objective:

Wheeler transform (flatten) seismic data and co-render the flattened seismic with
the flattened horizons of a truncated HorizonCube.

Basic concept of Wheeler diagrams (Flat horizons)

Distance (b) Distance
1 1
;/__ 5,
= =1
3
(a) 2D Structural Section (a) 2D Wheeler Diagram

Structural domain horizons / surfaces are representative of relative geologic time (from P.R. Vail)

RGT - Relative Geologic Time

Workflow cont’d:

T Sunvey Analysis  Processing [[EETIEY View Usiities  Help

b Jl e 23 B Hew

New Map View

1. Add Scenes > New [Wheeler]. o S New [Depth)

New [Horizon Flatiened] *
LWhasier)
Elements
Cownn 1 Cascade
W Indine 13
& Cross-ine Propatties
¥ Z-shce Save sceneto IDPDF  »

§ volume

~ Random Line v Scens 1

Tree scene 1

Y

2. If no HorizonCube is active, it will ask to B .
select a HorizonCube, Select i “’“I;T“‘“"'

H . . . -] o Cancel
Continuous_HC_Full. Otherwise, it will use
the active HorizonCube to create a new = Select 30 HorizonCube =R EOR %"
Wheeler scene. Fiter *

Continuous HC Full —
Continuaus_HC_Full_Tnm ;

Prapartional_HorizonCube .
Truncated_HC_Full
Truncated_HC_Full_Trim x

[ @cace || @ten |

_2015\Surfaces\Continuous_HC_Full hci
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Workflow cont’d:

It will launch a new empty scene with a special Tree Scene 2 attached to it.

SRS R Rt BT |

[

Wheeler
Tree

Workflow cont’d:

3. Add a default data in both the normal and Wheeler scenes.

4. Add a HorizonCube on inline 425.

Elements Celor

Wheeler scene: Continuo

& Zslic
@ Vol A0 3t Well Location
~ Fiane Add Color Blended
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Workflow cont’d:

Your display may look like as shown below. Note that viewing a continuous
HorizonCube in Wheeler scene is not interesting. You may want to truncate it to
remove all convergence patterns (next slide).

S| 5 oot

-
¥| 4 Dvp stewred medan Ber 10
@ Cros

Workflow cont’d:

5. Make a truncated HorizonCube display (on-the-fly) using HorizonCube display
properties dialog.

6. Check Truncate HorizonCube, click next to 2 and press Enter from the keyboard.

7. Apply to all to apply the same HorizonCube settings to all displays. When you will
close the dialog, it will apply the same settings to all other scenes.

= HorizonCube display options =N R X"
Fill between lines () Yes @ Mo

B | Evomorns

Whesler scene: Continuous_HC_Full Use single color () Yes @ No

l R In-line
d
¥ 425 Transparency 0
| [E—w
il 4 D3 Select HonzonCube » <
> X = Line width |1 = Spacing 1

e #@ Cross-line Mowe O

& Zsiice l?."'_ "-—-—-—._______\ Horzontal resolubion |3 traces (-
— @ Volume Reload IS

>
~ Random L| = Remove | 1] Tooncate HorizonCube |2 | (everts por sample intera)
20 Line
30 Horizon Top [] ]
Base 47
Link to ColorTable
Lock Top/Basa distance
Saw as Defack B Hop
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Workflow cont’d:

Adjust the display:

8. Make an inline view.

9. Tile the scenes.

10. Change the z-scale of the
Wheeler to adjust the display
according to your view.

Suney Anslysis Processing  Scene [JEEEJ viiies Help

0 - s w1 Work Area .
A ,l. W' “ Ll, perl
| Tree scene 1 Viewer 20
R [comens Sl
e Scene 1
W Indine Toolbars v
¥ 425 ¥ Basemap .
6 E Cummvaus_HC_Fn?

7| 4 Dip steered median filter

QI v ive

% W View Cross-line

r View 2

ﬂ View North
9 /@ View North Z

Verw  Utiies  Help
Howe
Hew Map View
Now [Dopth]
Now [Hoiizon Fiastanad] .
Nowe [Whasior]

Cascade

Ty v
Properties

Save scene to 30 POF »
Scana 1
v Whesler scene: Contmass_HC_Full

= 25009 e
Set 7 scaling factor
IApply LD RGO Wheeler scene: Canllﬂ |
Z stretch 0.03435579

[ XX Fitto scena: [ e To Home ]

V| Save as Default

o=l @m_

Workflow cont’d:

11. Change the perspective -—' view to the orthographic J view.

12. Adjust the scene by co-visualizing both views. You may also need to zoom in.

Tip: Avoid rotating a

scene. Just use:

+ pan (mouse wheel
pressed or

Ctrl+left mouse
button pressed)

* zoom (spin mouse
wheel or
Ctri+Shift+Left
mouse button
pressed).
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Workflow cont’d:

13. Use the HorizonCube slider to slide the E; > B3 27 Vne
events up and down. Now you areready to 7| comweicemero . |
perform sequence stratigraphic COTOLCOS A

] . HorizonCube Slider ...
interpretation.

Link 1o ColerTabia

Lock TopBase Satancy

Ocm | [ @
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2.4.2d Systems Tracts

Required licenses: OpendTect Pro, SSIS.

Exercise objective:
Perform systems tracts interpretation with the SSIS plugin.

This exercise assumes that you are familiar with sequence stratigraphy and
the followings:

* Transgression & transgressive systems tract (TST)
* Normal Regression & highstand or lowstand systems tract (HST/LST)

* Forced Regression & falling stage systems tract (FSST)

Sequence Stratigraphic Models in OpendTect:

Each model has its own name, color code, base-level phase, Top surface name, top

surface color.
- o
* Manage Sequence Models [ = ]r (=] |
Sequence Model Depositional Sequence [V 3
Depositional Sequence Il -
Name Depositional Sequence Il Color
Depositii 2Q e [V
HST Genetic Sequence L
T.R Sequance 3
FSST Channel Stages
Stratal Packages
Lst Sequences
TsT Fluwial Depositional Sequence 2
N-layers
Undefined Mone | Top Undefined
Sequence Boundary is top of FSST ]
[ Add model ... £ Saveas | [Remove model ...

l_o OK ) Cancel ) Help ]

You can also make your own model if you press the Add model button.
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Worklow:

[ Tras sceme 1 o
§ o e
1. Add inline 425 (if it does not exist). I s e iocomn.

R Add Color Blanded

2. (Optional) In Exercise 2.4.2a, you made some annotations (arrows) on inline 425.
You may want to display them in the scene to begin with SSIS interpretation.

Sy Prestack Everts
& Annotations

e Following this, select the ones that you
\mae MW AITOWS group ..

Scal|

saved earlier on.

Workflow cont'd:

Tip: If you intend to study depositional shifts, we recommend

selection of a truncated HorizonCube (which is already pre-
processed).

3. Activate a truncated HorizonCube (Truncated_HC_Full).

*  Launch the 3D HorizonCube control center.g
*  Select the active HorizonCube.

= Monzondisbe 50 Conmal Canter sy

[Preteaa_ |
4. Add the HorizonCube display on inline 425, | s [mmmere o] e
[ | Crate 3 SieeniCude
.Q N o Sevninse
& i Indine 4 ferrs
Rl | - ST
Bibhds - e , |
W Cross-line all 3 DI LS 3503 3 ™
@ Zsice 25 * Ry Volume Buider Attribute Iz/!;” syt
Koo e
T isplay Puatack Datal > Mos Sy iemns Tincls Die lay,

e &t Comelate with Wells ..
4 20 Hoizon | 8 Lock Treeitern
2 Faul == Remove from Tree
FaulStickSet
Eady
A well

WomaLea

ﬁgm
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Workflow cont’d:

If you do not have any Wheeler scene
display, Add a Wheeler Scene*
(Scene > New Wheeler ..) .

Add inline 425 with default data for
the Wheeler tree/scene.

Add HorizonCube display.

Elements Color
Wheeler scens: Continuous

W inhne
i Cros!
& Z-slic
P voiur

~ Rand

Add Default Data
Add and Select Data
Add at Well Location
Add Color Blended

There are two ways of preforming S5IS interpretation:

. Stacking patterns in a normal (structural) scene.

. Or co-visualizing both the normal and Wheeler
SCEenes.

. In this exercise, we will co-visualize both scenes.

5 Suney Analysis  Processing [[EEIIEN View Utiities  Help

—

™ YN New
o A 1o E Hew Map View
€0 > SteplD New [Depth]
Tree scene 1 New [Horizon Flattened] *
4 Elernents
f Scene 1 Cascade
& W Indine Tile .
g Crossdine Properties
| [P 2ok Save scene 10 IDPDF  »
& ® volume
~ Randam Ling v Scene 1
S Q) Indine
=
V| 4 Dip stig : 5
i Cross-line al Adtribute
& Zslice Display b @y Volume Builder Attribute
TR o, .- o
~ Randomline | oo TOOP B Systems Tracts Display
20 Line Dlsnlrlay Prestack Data *
¥ 30 Horizon : Corelate with Wells
4 20 Harizon g Lock Treedtem
Fauht == Remove from Tree
FaultStickSet

* See Exercise 2.4 2c

Workflow cont’d:

& Sumey Frocey

Scene  View Utlties Help

al Aributes L
Q = & Volume Buider nid
Ei Cross-plot Data .
j E A wels .
8. Open the SSIS interpretation window by clicking on this @ = f*’“c”"“‘"“: &
. | . . . . . <= Fluid Contact Finder
icon.” @ An interpretation window will open, with the é S+ Newral Networks
familiar HorizonCube sliders on the left side; Sl e
interpretation column, base level curve, and timeline in & |n S ¢
the white pane on the right. - -
= Interpretation: Systems Fracts Dema =Ngoy %"
ad - L= AN
J HerzonCube: Trencated HC Full
Insart Insert Sequance Model: Depositional Sequance V'
Top Baie Absopte Sysems Sustgraphic Base Level
age (My) Tiscts Sudscet Resa " Fall
Horl:szlci)(r’\;ube =2 ssIS
e Nterpretation
Panel
Link to ColerTable - g
Leck TopBlase ostance Caat Lol *| SewANSuteces . B8
Q0wses | | O Caneat e el
oyt Tt Tpe: Ut -
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Workflow cont’d:

9. Open the Sequence Models selection window

by pr

essing:

View the options of the sequence models
available. For this exercise, the default
model (Depositional Sequence V) will be
used.

Close this window when you have finished
viewing the options.

10. To begin your interpretation, you will use the
HorizonCube sliders:

Slide the top slider all the way to the
bottom while co-visualizing the Wheeler
and normal scenes.

Slowly drag the top slider up until you find
a breaking point that would indicate a
different system tract.

= Interpretation Interpretation 1
ol L 3-F 4"

mnse
Eop Base

a3

Linic ta ColorTable

HerizonCube: Troncated_HC_Ful
ise | Sequence Model. Deposisonal Sequence

Absohute Syites £l
300 (M) Tuacts !

Spra Tescn

Workflow con

t'd:

B vien wiies Hep

Tip: You may want to tile the
scenes vertically.

Hew

Hew Map View
Hew [Depin]
MNew [Horizon Flattened) Ol

I inding 425 =4

Hew [Viheeles]
Cascade

e ™

| Propaies Hodzomal
Scene 1 [ Vorcal |

11. Position the top slider where you intend to insert a boundary.

Save scenw 1o 30 PDF .

¥ Whesler scens: Truncated HC_Ful

Systems Taact Type: Usdebened

Ralatin Geol T &
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Workflow cont’d:

12. Press the insert button which lies just above the top slider. This will
insert a boundary in the stratigraphic column.

= Interpretation: Systems Tracts Demo
T LI-FL

HoizonCate: Trancated_HC_Full

Saquente Medd O

Workflow cont’d:

13. Right-click in the middle of the package that you added and assign
the systems tract.
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Workflow cont’d:

14. The selected systems tract will be assigned.

Systems Taact Tige: HST

Filanin Geol T 197

Workflow cont’d:

15. By repeating these steps, the entire stratigraphic column can be
interpreted and systems tracts are assigned.
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Workflow cont’d:

16. You may want to overlay the inline with the interpreted Systems tract in both scenes.

17. Once done, you may want to Save H this interpretation.

Tree scene 1 L]
Elements Calor
Scene 1
= g In-line
> Ve
1 TN (| sttt
414 Dusplay * W Valume Processing Attribute

@ cossd Duplicate
Z-slice Reset Manipulation
Velume  Display Prestack Data *
~ Randol b Correlate with Wells

& Horz

i Tr:

You can save g ! more than one interpretation per HorizonCube.
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2.4 2¢ Statistical (Thickness) Curves

Required licenses: OpendTect Pro, SSIS.

Exercise objective:

Extract statistical (thickness) curves to express data-driven nature of base-level
variations.

This exercise requires an existing SSIS interpretation and an active* HorizonCube.

In Exercise 2.4.2d, you made some SSIS interpretation. You may want to use them as a
reference interpretation to extract statistical curves.

g

et BRI Do Ce

M AR LY T

m= N

I oodew F o

e g
* Processing = HorizonCube > 3D =___

Workflow:

1. In the SSIS window, launch the statistical curve extraction dialog: S.ll

8 Interpretation: Systems Tracts Demo = | 3|3
ot L A=F 4N
: neal odt | HorizonCube: Truncated_HC_Full

Insent '_ lngen Sequence Model: Depositicnal Sequence IV

Top -
i SystemsTracts Statistics =r o @ '
On 0K, the statistics Min, Max. Median. and Average
will ba calculated within the gren range
Woul be able to switch between the results by
right-clicking on the siatistical cune

Tips on area sub-selection: s ot i sance X
LOx ]| Ocmed |[ @ree
1. Try to plot the thickness = == T e
variations at a given T - e
depocenter vs. coastal regions
8 @ » Mt

per systems tract

“uneigrans

Link to ColorTable * Senence Brunde
2. Compare the two curves by P =]
taking snapshots. @@ —
O G | [ @
Systems Tract Typa: TST Relative Geol Tima: 410
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Workflow cont’d:

2.

perform statistics.

& Interpretation: Systems Tracts Demo =8|
ot L YA=F.%"
: + | HorizonCube: Truncated_HC_Full
Insen Insen Sequence Model: Depositinal Sequance IV
) [33%] Reading =N ECE %"
1 3%
@ Pause || O Abor |
Gridlines read 646
pasts [aepera—y
Top HET POnsat of Bave bavel fall
0 430 [P —
Link to ColoTabla - e * Sesuecon Brunan
Lock Top/Base distance Ciear | Lewel | [Save Al Surtaces .| [l
§ Ow/Saw | | ) Cancel 1§ rop
Systems Tract Typa: TST Relative Geol Time: 410

If you proceed further, it will start extracting data within the sub-selected area and

Workflow cont’d:

3. Once the processing is finished, an Average Thickness curve will appear in red.

= Interpretation: Systems Tracts Demo =) e e
< |2 | A &
E‘ lﬂ E’ X EN
at eledt | HorizonCube: Truncated HC_Full
Insert Insert Sequence Model- Depositional Sequence IV
Top Base Absolute Systems Stratigraphic Baselevel  Average Thickness
age (My) Tracts Surfaces Rise*™—"Fall 12 &7
Top HST3 #orsacors
WEnd of Temgrassion
Top LSTZ End of Ragremich
op FaT2 En ot Base evnl 4
Top HET2 OCcuat cf Base level fall
52 W of Trarugression
Top LET1 End of Regramich,
Tep FSSTH End cf Base eval il
» P HETT #Craat of Base vevel 13l
o 430 #End of Tramgreasion
43 “Unamigreds
Link to ColorTable ® Sequance Baurdery
Lock Top/Base distance Clear | Level *| |Save All Surfaces ... .ﬂ
(@ owsae | [ ©cancel || @Hep |
Systems Tract Type: HST Relative Geol Time: 328
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Workflow cont’d:

4. You may want to change the statistics and plot a different curve. To do that, just right-
click on the curve and choose other stats.
= Interpretation: Systems Tracts Demo =) S

@ 8B XA

HorizonCube: Truncated_HC_Ful

Insert Insedt Sequence Model: Depositional Sequence IV
Top Base Abschute Systems Stratigraphéc Base Level Average Thickness
age (My) Tracts Suriaces Rise® *Fall 12 &7
E op HETY [ -
z ®E0a of Trasagrestion
op LSTZ End of Rageassich
op FEST: Ent ot Base baval o
g HETZ [T e—
> 2 ®Ena of Traesgramicn
233 g LST1 End of Regramsi®
» 27 g FEST1 Ent ot Base boval
g ST $omat ot Base tevel 1y Min
Max
v Average
0 430 » 250) hiFsi #E0a of Tracagramicn Median
Link to ColorTable - e * Segeacce
Lock Top/Base distance Clear Level v | Save All Surfaces s

| @ Okisme | | £ Cancel 1§ Help
Systems Tract Type: FSST Relative Geol Time: 311
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2.4.2f Stratigraphic Surfaces

Required licenses: OpendTect Pro, SSIS.

Exercise objective:
Extract systems tract boundaries as seismic horizons of OpendTect.

There are several ways available to extract stratigraphic surfaces (or horizons) from a
HorizonCube.

In this exercise, you will learn three ways:

1. In SSIS window: one horizon at a time.
2. In SSIS window: multiple horizons.
3. In HorizonCube manager: extract events.

Workflow:

Method 1:

1. In the SSIS window, right-click on the surface name and choose Save as surface.
! Interpretation: Systems Tracts Dema =) -a) E
— IEJ é.l ::I >({ 3
HornzonCube: Truncated HC_Full
Insert Insert Sequence Model: Depositional Sequence [V

Top Base Absolute Systems Stratigraphic Base Level
age (My) Teacts Surlaces Rise " Fall

e LAT1

e PEST

op ==
Rename

(] a0 * L Delete
Hide Surtace Names

Linik to ColedTable * Ses

Lock TopBase distance Clear Lavel 1 | |Save Al Sufaces . | gl

© OxSaw | | © Cancel | [ & Help
Systems Tract Typa: HST Relative Geol Time: 315
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Workflow cont’d:

Method 1:

2.

In save surfaces dialog, specify a Horizon

name and press OK.

“ Save Surfaces

Specify Parameters
Area subselection 103/302-748/1248 {463 samples)

Surface Name: Top HST1

ESSECE =X

Qutput 3D Horizon  Top HST1

~]| © seect .. | | @ acB

Tied to Level —

Base color

[=]

Orange

&

]
L ©Qok | ©cancet |[ @tHew |

Workflow cont’d:

Method 1:
3. It will start extracting a horizon from the HorizonCube. In case, the HorizonCube is
truncated, it will start interpolating the horizon.
& Irterpretation: Systems Tracts Demo =3
> o 8 B X

HonzonCube: Truncated_HC._Full
|- Save Surfaces
Specify Parapatacs

= [0%] Horizon Creator

Systems Tract Typa: HST Relative Gaol Time: 315

=l .
Area subsok .
o
LD Pese || O azen
Outgut TOH| Reading HoszenCuba . Ininas processed 0 hect o8 -
Titd t Leval =
Base coke Orange -l
[« ) Cancel i) Help
Lk to ColorTable - T * sapne
Lock TepBae distance o Lawe

| |Sme a8 Sutaces

Q) OkSave | | ) Cancel £ Hep
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Workflow cont’d:

Method 1:

4. The extracted horizon

~ Random Line
I 20 Line
% 3D Hor=~

4 20 Hol A0
[ A s Soctions Oy |

Fau

Fauks Add Color Blended ...
Track New ...
Create with Constant Z

® 5
= Well
i PickSet

is copied as a general OpendTect horizon to the project
database. Hence, you can display the horizon in the scene to QC it.

e

#! Select Input Horizon (£}

=3 EoR =5

.- Filter *
| ToBeDeleted_Manual
ToBeDeleted_Test_Trck
TODELETE BugTesting
ToDelate_TestBug
| Top FSST1
7| Top HSTY

Training_ 0004
[ Tramning_ 0006 B

T D ~> F54

X ejld

Avea subselection | 103/302-T48/1248 (463 samples) :O Select ..

: B\l il
ta\F3_Demo_2015\Surfaces(Top_HST TR

Workflow cont’d:

Method 2:

1.

1=\ Interpretation: Systems Tracts Demo

B &g

Insert

Top
u]

Base

0 410
Link to ColorTable

Lock TopBase distance

Systems Tract Type: TST

% EN

54 HerizonCuba: Trancated_HC_Full

If you want to save all surfaces, then proceed with this part.

| Sequence Modal: Dapesitionsl Sequance IV

Absolute
age (My)

Systems
Tracts

Stratigraphic
Surfaces

Base Level
Rise *—*Fall

TrgHETE 90w of Base e Tl

Wing of Traragression

End of Fagpasmih
£0a of Basa et 0

#5ran of Basa vl 1t

B ot Tramagressesn

W LSTY Ero of Ragram

oo PEET1 (IS T—— ]

op ST [T p——

1 #6000l Traragrusson

Relatrve Geol Tame: 176

-
® Sesuance Beundey

==l

@ Oksae | [ © Concel || @Hep |
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Workflow cont’d:

MEthOd 2: = Save Surfaces = | B3
Specify Parameters
2. On the left panEI, you see the Area subselection | 103/302-T48/124B (463 samples) © Select
surfaces names that you have R
interpreted. You will have to add ﬂ - S
i i op H!
them to the right. Top HST1
3 [=]
. C
3. For each surface that is added, you wess
will specify the Qutput Horizon PR
wface Name: Top
name. [ 0z F|@ st ] @ace 2
Tied to Level =]
Base color White -
QoK || O Cancel @ Hep
Tip: You can copy the input name for
output horizon, e.g. MFS2 (using mouse
drag over the label and CTRL+C).
Workflow cont’d:
Method 2: ) Sove Sators b
Specify Parameters
4. Following this procedure, you can Arsa subselection | 1037302-748/1248 (463 sanles) O st
add multiple horizons in the list.
Select surfaces 10 save
5. Once done, proceed by pressing the - ?;2552;3‘ i
op 1
OK button. - [roresre
Top LST2
MFS3 -
6. It will output all of them as general
OpendTect horizons and you can QC | e 72 _ .
. . . Output 3D Horizon MFS3 -I € Select ... | ¥ 4GB -
the outputs by displaying them in the 5 -
. Tied to Level -~ x
scene as shown in pt. 4 (Method 1). : -
Base color Lime hd
) cancel £d Heip
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Workflow cont’d:

Method 3:

Directly extract horizons from a
HorizonCube using HorizonCube

manager.
1. Survey > Manage > HorizonCube >
3D

2. Select Continous_HC_Full & press
copy to horizons icon.

SN s Prcessey Scems Vew Lusbes e

B =R

L7 SeerSan
e

= Manage 30 HorizonCube

Filler * 's
> Continuous_HC_Full <
Continuous_HC_Full_Trim

Inversion based HorizonCube

Inversion based HonzoenCube 151

Inversion based HorzonCube 151 Gap filed
Imversion based HonzonCube 2nd

Inversion based HorizonCube copy

Inversion based HorizonCube copy v2
OlHC_Tracking

OIHC_Tracking_Ir2
Proportional_HonzoaCube_Full =

Undefined

: Center :

Free space on disk: 1567 GB

ole s
HorizonCube data
~
—
o
| Dose || @hep

Workflow cont’d:

Method 3:
3. In the pop-up window you may
choose one horizon or multiple
horizons (say Event 4 and Event 6
only) to be converted to general
OpendTect horizons. The Base
Horizon Name is the prefix for the
output horizon name. On OK, it will
start extracting the horizons.

4. Once done, close this window.

Uncheck-all: Ctri+Z or uncheck the list
through the small check box available at
the top of the list.

Group selection: Mouse drag over the
check boxes in the list.

/. Extract Horizons from HorizonCube

-

Select by

103 to 748; Cd
103 to 748; Cd

Al ia Jao. o

Select Event(s) || Event 1 (Inl:
|| Event 2 (Inl

Eaniedellal

=e e

30210 1248 ) ~
30210 1248 )

20040440

| Event 4 (Inl: 103 to 748; Cd
Event 5 (Inl: 103 to 748; Cil

: 103 to 748; Crl:
1030748

Eugnt 7 ol

302 to 1248 )
302 to 1248

kT XEELITE

| Fuant R {inl-

ANT tn TAR- CA

Area subselection | 103/302-748/1248 (219 samples)

IND #n 1748 L

Base Horizon Name

0 oK

0%

[ D Cancel 1 9 Help ]
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Workflow cont’d:

Method 3:

5. To QC the outputs, you may want to
display the extracted events in the
scene as follow:

7 20 Line I
@ [30 Horn 1
& o Lexd

[l ~dd at Sections Only
Faung  Add Color Blended .

Track New .
B
’ o (Creata with Constant 7

/= Select Input Horizon (s) == "%
.- Filer |*

" Horizon_altemative Al
" Harizen_stap1

=
| gg:;gﬁzl;ész_m m
t

| Trim_D4 ~> Truncation o
L= Trim N5 > FST

Area subselection | 103/302-748/1248 (463 samples) 9 Select ]

IO_WH_QM
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2.4.2g Stratigraphic Attributes

Required licenses: OpendTect Pro, HorizonCube

Exercise objective:

Define and understand the HorizonCube/SSIS attributes.

Workflow:

1. Launch the 3D attribute set windc:w."‘fI

2. Select a HorizonCube density attribute.

= Attribute Se130
File

T el
=4 KA N N UL W )3

-2

=] [ © Select
Time gate (m3) -0 8

Injast HorizonCul

We suggestusing a Continuous HorizonCube as an input forthis attribute because it

requires horizons within a specified time gate. The truncated HorizonCube removes such
events and hence this attribute is not suitable for such inputs.

Workflow cont’d:

3. Specify the attribute name and add it as new.

Filg

Attribute Set 3D - olEl
D > &
sl A 2R T 1505
Altribute st <nol Saved= <All= ~ | |HorizenCube Density - ?
HorzonCube Density-8 8)ms Input HorizonCube Conlinuous_HC_Full v ) Select..
Time gate (ms) -8

8

Adtribute Name HorzenCune Densit(-8,8)ms

[#] Save on Close

Aad as new | [ I

@ close || [ Help
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Workflow cont'd:

4. Following the previous steps (2-3), define* a few more attributes e.g.
HorizonCube layers and Systems tract (Common |D, Unique ID, and Isochron)
attributes.

<All> 7| HonzonCube Layer =] ?

Impul HonzonCube  Continuous_HC_Full ZI © Select .

Ni events per layer |10

Note the input HorizonCube <Al [=] [Systems Tract I

fOI' thls attr’ibute iS the Input HorizonCube | Truncated HC_Full B’e Select...]
truncated one because the
interpretation is made on

that input Output SystemsTract (&I RIN] =

Sequence Model : Depositional Sequence [V
HST -1

F35T:2

LST: 3

TST:4

Undefined - &

Select Interpretation |Systems Tracts Dem[ Level 1 2

* Per defined attribute, you will have to specify its name and press the button add as new.

Workflow cont'd:

5. Once you have defined these five attributes, save H the attribute setas e.g.
Stratigraphic Attributes. If the name already exists, then overwrite.

6. Close the attribute set window.

- ———— o
= Save Attribute as =R EER X" e =
Fils
Salect output Attribute
s AR XN T 1S
L ks
Fla [+ [ ———y \-A., =] [Msnzoncuos Dwsey =7
30 UV Attribs Texturs + HC -1 HatnCaba Dansty 35 put HosizonCube | Continuous_HC_Ful 7] [© Seect
ChimneyCube aftributes Crmionms Tooct: G Tine gate fsa) |8 0
delme
Demo sttributes. =
FaulCube atiributes x
FaukEnhancementFilter with Edge presening fit
Irversion atinbutes -
b -
Namea | Stratigraphic Attributes|
L
Q Ok ) Cancel @ Help [
Attt Warow | HomzonCube Densityl 8.8 Add ws vew | [0
) Savw 08 Close @ e

%
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Workflow cont’d:

7. Next you may want to display these attribute on an inline before processing.

Iy in-y
W Cn Add Defwht Data W nane
2. Add and Solact Data « DD
; v;" Add at Well Location > ¥ 4 Dipster 04 v Attribute
pr Add Color Blended @ Cross-line Desplay ' Volume Buider Attribute
- © Z.shce Duplicate @ HorizonCube Display
® Volme Reset Manipuiation s s Tracts Disph
5 ;‘S’I'_"_I"“" ¢ Comelate with Wells =
© 3DHorizon | o LockTreetem
s 20 Horizon | = Remove from Tree

= Select X"

E=EEon

Select Layer 2

g
. HorizonCube layers
Steering | Systems Tracts Common ID
) Systems Tracts Unique ID
Q@ Aftributes | Systems Tracts Isochron

&)
Y

QoK || Ocancel |[ @rep |

Workflow cont’d:

8. Following the same steps, overlay the remaining attributes on the same

inline.
-y Indine
4 @ Inane .

+ 7[435 — - =
@ coesine | [IDERE vl T Systems Tracts Isochron m
# Z-sice Duplicate @ HorizonCube Display Systems Tracts Unique ID i
._v::;»:mlm Resst Manipulsic e Systems Tracts Common D F1

2 Line f"’f""“"‘““""*" HorizonCube layers n
= W Horeon |5 e HorizonCube Density[-8.8]ms 1

" 20 Horzon from e 4 Dip steered median filter i

- Your inline vi look like thi
- our Inline view may Io0K like 1S
@ select ==rcr ew may: ool
— after overlaying six attributes on
Select Layer 2
each other.
Stored [ HorizonCube Density[-8.8]ms
HorizonCube laye
Steenng | Systems Tracls Common ID
Systems Tracts Unique ID
© Attributes | Systems Tracts Isochron
&
QOK | Q) Cancel ) Help
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Workflow cont'd:

9. Your attributes may have a coloured (default undefined values) areas
which could be set to transparent by following these steps.

4500 PV FTa—
Flipped s B
Ranges/Clipping ... &
Cotr
Set as default
/% Manage ColorTable E=NiEE <"

Add, remowe, change color tables

Colortable  Status -]

Porosity Edited

Paorosity-1 Own

Pressure Default

Rainbaw Edited

Rainbow Plus  Default =

Red-White-8l,.. Edited Please specify
Red-White-81... Own

Red-White-81... Own The Edited colortable will be replaced

Red-White-Eiue Defaul 1 i e vill
Rasis” O S DS o s e

TR T — | Soorentaion None 5] Aoon
%‘EE%-;:“ %«1 Undefined color | Tnns
g:"n:'::?:”b“ g::.d - Marker color |
[ Remove . | [ impon .. | [(Sweas.. |
[ O |(Ocns |[ @ne |

Your results may look like this:

HorizonCube Density:
Black regions in this case represents gaps in depositione g
unconformities and condensed sections.

HorizonCube Layers:
This is like an input model containing layer definition per 10th event A
good input for geologicalreservoir modeling.

Systems Tracts Comon ID:

Arepetition of same colour in this case represents the same systems
tract, which has a common ID in this volume  Again, this volume can be
use for modelling or prediction purposes.

Systems Tracts Unique ID:
All systems tracts have their own unique IDs in this volume.

Systems Tracts Isochron:

This is a thickness volume per systems tract. A good product to explain
the base-level variations based on your data. Or adding another
dimension to the Wheeler diagrams when this attribute is used as an
overlay in the Wheeler scenes (e.g. 4D Wheeler diagrams).
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2.4.2h Stratal Slicing

Required licenses: OpendTect Pro, SSIS.

Exercise objective:
Analyze 3D seismic data by slicing through all available data.
WOI’kﬂOW: 5 Survey Analys\sScanB View Utiliies He
Q ] | e . greate ﬁelsmlcgmut * InelB
. . = T reate Honzon Output +
1. Go to Processing > HorizonCube > 3D. § [Teescenel  Resiar Bach Job
E'QS":“'S = Dip Steering v
I B8 1 | o GMT Mapping Tool ...
6 | & CuossiB 3 20
. & Z-slice Madagascar
. = ® voume 7! ssis v
2. In the HorizonCube 3D Control Center
select on Create a HorizonCube RS S e
from the list and click Go... Acke Hoczoncate - [ Seei ] [ R
. Process 5
.43 = Cr o
Creale Honzons from SteeringCube
Ect Hongors from SiearngCube
Inderpolate Logs slong & HorzonCuke
L,,_f; | Anahysis
5
[ D cuose || @ree
Workflow cont’d:
3. In HorizonCube Creator, click on
Read horizons... ! HorizonCube Creator 3D = o %
Eead horizons |
Fault | - © Select .. Clear
HorizonCube calculation mode
4. Check three horizons Demo 4, Horzon Mode E
Demo 6, Demo 7 and click OK.
= Horizon sorter = o0 E -
Select horizons Area subselection - © Select ...
.- Output HorizonCube ]| © Select ..
D 3 —>TopF £ -
v sz 4> T[?.I?!C;Ir;i S _Malyze
gmgi__: ;g?callan i & 1l {F Execution Options ...
¥ Demo 6 > F58
) Do 6.Copied [ QR ][ ©cose || @Hep
F3-Horizon-FS6 :
Qcaed
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Workflow cont’d:

5. The table will be filed automatically with two packages. Select Model Driven:
Proportional for the both the packages. Type in an output name to the HorizonCube
Proportional_HorizonCube and press Run to start the batch processing.

Settings for the proportional
HorizonCube are based on event
sampling (spacing at maximum
thickness and fixed number of events).

¥ HorizonCube Creator 30 o |23
Read horizons ...|
Faults - B select ... Clear |
HorizonCube calculation mode
Horizon Mode

Demo 7 —> shallow IModeI Driven: Proportional v|
Demo 6 --> F5& Settings ... ]
Demo 6 > F58 | Model Driven: Proportional - |
Demo 4 --> Truncation Settings ...
Area subselection 100/300-750/1250 (463 samples) D select ...

Ioulpul HerizonCube Proportional_HorizenCube » |© select...

Analyze ...
Batch execution |Single Process ¥ | |4 Options ...

©) Close| | Help

Workflow cont’d:

6. When processing is finished, set an active HorizonCube: click on Select button in
HorizonCube 3D Control Center and pick Proportional_HorizonCube.

7. Press Close.

= HorizonCube 3D Control Center

Active HorizonCube  Proportional_HorizonCube

Croate 8 StoenngCube

Fitar & SteeringCube

Create a HorizonCube

Comvert to StearingCubse

Creata 2D Seisme: Lalice

Croate Horizons from SteerngCube
Ed#t Horizons from SteeringCube
Interpoiate Logs slong a HorizonCube

Processing

>
(]

Pro-load

- ]

(1)
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Workflow cont’d:

8. Make a Wheeler scene: Scene > New [Wheeler].

9. Load an empty volume in Wheeler scene: Right-click
on Volume in the Wheeler scene tree > Add.

10. Right-click on the wvolume > Display > Position...

11. Set ranges to the full survey : click on the # icon and

[T view utiities Help

New

New Map View

New [Depth]

New [Horizon Flattened] »
New [Wheeler]

Casrada

Wheeler scene
iy In-line
W Cross-ine
& Zslice
@ Volume
~ Randol
20 Lim  Add Color Blended
@ 30 Horzom
@ 2D Horizon
Fault

LB
® volume
v
~| <right-cl Add .
¢ Bandom Lino ke Hsopram
2D Line Duplicate A Properties ...
Rasat Man: G

< 3D Horizon

20 Horizon el e T
Fault a Lock T
FaultStickSet | == Remove from Tree

=" Positioning
Specify the elements position

o

press OK. In-line Range 100 = 750 :E
Cross-line Range 300 & 1250 <
ZRange 0 ST B
Qcumsl | @ew
Workflow cont’d: S
= Select =RECE ="
Select Layer 1
12. Select 4 Dip steered median filter from the list ® Stored [ { Original Seismics =
of attributes and press OK. Steering -:éa._.. :
Ta Al Cube Std
Aftributes Tb Al Cube from HorizonCube
8a PorosityCube from HC-NN
‘Wheeler &b Gamma from HorizonCube
9.1 Simitarity on FEF seismic
s 23 Do teerd Sk e -
2 Finer[r
[G5] (0 coma | @1
L] :| View Indine

13. Click View Z or View North Z to rotate the
volume.

14. In mouse position mode ﬁ , click on section
and pull down to slice through. Slice the
volume upward and downward.

In similar way you may slice in inline and
crossline directions

% | @ View Cross-line
7| ® ViewZ
== b View North
X
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Workflow cont’d:

Optionally a Wheeler Cube can be created as follows: "SUﬁ Ma:s'_f
15. Click on , || icon > 3D tolaunch Attribute Set window. 2 |
16. Select Similarity attribute from the attribute list. "
17. Type in a name, e.g. Similarity, and press Add as new.
18. Uncheck Save on Close and close the window.
= Ansibute Set 30 o
*Pe DN A E
ot 3ot <0t s> e G| T —
Simaarity Input Dkt 4 Dip steered median fillor =| | D Select
.Sn:s.uu --ul” & el 2 .
Stpering None -
+
4
+
Adtribut Name | Similarty ||noo s new] [l
e
Workflow cont’d:

19. Create wheeler volume: go to Processing >

SSIS > Create Wheeler Output

Scene View Utiiies Help
Create Seismic Output »
Create Horizon Qutput »
(Re-)Start Baich Job ...

> 3D.

= Diip Steering ]
= GMT Mapping Tool ..
@ HorizonCube
Madag:
Create Wheeler Output

20

Flatten Horizon/Seismics * m

e

20. Fill the required fields as shown below and press OK to start processing.

= Create Wheeler Volume [o & = g =
Input HorizonCube | Proportional_HorizonCube :| © Select ... Soloct Input Data
Input Data Similarity 7] |O Select I Stored
@ Aribuos
Volume subselection | 100/300-750/1250 (463 samples) O Select ...

2

Output Wheeler Cube Wheeler_Similarity 7] |© Select....| @ CBVS Z| =

1+ Execution Options ...
Ocucal L0
Qo[ @10
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Workflow cont’d:

21. Display the Wheeler Similarity cube in a volume
by selecting the attribute from the Wheeler tab:

22. Click on Wheeler_Similarity attribute in the tree
to make it active and change the color bar to
Similarity.

23. Slice the volume upward and downward for
the z-axis to see geomorphologies.

T select =R Ech "=

Select Layer 1

Stored 6§ Wheeler-stratal-sheing
Steering | Wheeler_Seis
Alftributes

s
O Concel| | @b

o el BURE L
|y 0.85 l .095 1 Seismics
_classes
%y Wheeler scane: Propo | g Rag-white-Black

Red-White-Blue
| SandShale
® SandShale-none
11 Seismics

2 f]

1 SunRise
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2.4.3 Well Correlation Panel

What you should know about Well Correlation Panel

e The Well Correlation Panel is a commercial plugin by dGB.

* Itis used to pick and QC well log markers.

|t can be used to create conventional well correlation panels without seismic
backdrop.

» Typically, however, a random line is created through the wells and the seis-
mic is used as a backdrop to guide the interpretation.

» A HorizonCube, either 3D, or a dedicated 2D version created along the ran-
dom track, can optionally be added to help correlate markers from well to
well.

Seismic and Well locations

Sefsrm: and We|| Iagsfmarkers

o,

Well-Well Correlation

Details

A part of sequence stratigraphic interpretation (next chapter) is to integrate the
seismic information with the well data. This is done in the Well Correlation Panel
(WCP). The panel is an important tool for creating consistent geologic frame-
works. It integrates stratigraphy, well logs, markers, mapped regional horizons,
seismic and horizons from the HorizonCube in one view. It enables the user to
arrive at interpretations that are consistent between the different scales of
(regional) geological concepts, seismic data and well logs.

-352 -



Its primary functionality is to pick (and/or QC) well log markers that are defined
within the (regional) geological or stratigraphic framework in a consistent manner
using seismic correlations to guide the picking. Typically, the user starts with a
random seismic transect connecting the wells in a 3D volume. A well correlation
panel is constructed along this random track and the Well Correlation Panel is
launched.

However, if the user wants to use a HorizonCube to guide the correlations it can
be beneficial to convert the random line into a 2D seismic section and to continue
with 2D mapped horizons and 2D HorizonCube. In that case 3D regional horizons
are converted to 2D horizons (tree option under 2D Horizon) and a HorizonCube
is created along the 2D section. When this is done, the Well Correlation Panel is
launched. Here the user points and QC’s markers.

To use all supported functionality the user should build a stratigraphic framework
that links (regional) well markers to seismic horizons. Both time and depth
domain are supported in the WCP module. OpendTect’s synthetic-to-seismic
matching module is fully integrated and is used to align all wells optimally before
picking/editing markers. WCP supports various display modes including but not
limited to: wells only; wells plus seismic; equidistant; connecting markers; filling
stratigraphy. Unique is the capability to display the dense set of horizons from the
HorizonCube and use of the HorizonCube slider to guide detailed correlations.
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2.4.3a Well Correlation Panel

Required licenses: OpendTect Pro, Well Correlation Panel, HorizonCube.

Exercise objective:

Create a well correlation panel and QC the well markers using the seismic data
and a HorizonCube to guide you.

Workflow:

1. Launch the Well Correlation Panel (WCP) window: Analysis > Well Correlation Panel,
or via the =" icon.

&7 Survey Processing Scene

Q |+l Attributes v
AL
Tre ‘% Volume Builder ...
Q Ex Ei Cross-plot Data >
- L Wells v
| == Layer Modeling 4
‘ = Fluid Contact Finder ..
) = ¢ == Neural Networks v
5. 8818 4
- Z, Thalweg Tracker .
. = 1 Velocity Model Building »
< . Well Correlation Panel ...
Workflow cont’d:
. . = Well Correlation Panel =
2. Select data type: 2D line. Wel oy © You @ No
3. For Input data, select Seis FESIEIES
and select the line name Input Data |Se:5 E"O Select .| |Create from Wells‘_
Well Correlation-Line. A
4 At the bottom Of the WindOW Trace subselection R Line 0'6-1448 (463 samples) 6 Select
select all four wells available
in the list.
5 Press OK Select Well(s) to be projected on data
7 - Fiter "
v F02-1
7| FO3-2
v FO3-4
¥ F0B-1 L+ )
Pl
0 Cancel| | @ Help |
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Workflow cont’d:

6. Change the seismic color spectrum to Grey scale: click on VD and from the top bar
spin the color to Grey scale.

= el € Line: Line R =
SlRF et A x Agha B o 2 o | Mesr [rasosmes H| oot
itoms T Fiz1 Fo TR - [ o4
(r=2 - (=== 1 Greyn ] =
Elements. Colot |Zma am A Grurple b
o ||| o HorzonCube L

| Matteo terrain cube red
| Matleo larrain linear

— ) =
. I | View |Wets & Seismicsx] |, K 1] Keep zoom ratio -} @

Gamma Ray 41 56838199AP1 Porosity 0 28062165F raction Marker Top Foresets MD 1101 33m TVD 1101 33m TVDSS 1071 33m TWT 1077 00ms.

Workflow cont’d:

7. Overlay the seismic data with the HorizonCube: right-click on HorizonCube in the tree
and select Add Display.

Choose the 2D HorizonCube “HeorizonCube SC-FFT-frunc Random line between wells”.

! Well Carrelation Panel - Line: Well correlation-Line E=N EOR =%~
Qe A= Ag [ e 7 s | s | moreyscaes

Tree items & A

Elerments

[t —
« m | View Wels & Sesmicsx] | ¥ Keep 2o0m ratio {} '
TreNr=471 (611381, 6083730, 1844) Val=-1811 (Seis), Ret/'SP=1e30
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Workflow cont’d:

8. Now display a Gamma Ray (GR) log on all
wells: click on the well properties icon
A from the WCP window.

9. Inthe Log 1 tab, you may select Gamma
Ray log with a SandShale color bar.

o 5 =
R X ¥
‘Well properties},

Colof| |-28212
Porasity
- 006 04

" Display properties of: F02-1

Sefect Wel F03-2

-

Panel 1 [=] Number 1
Display well stratigraphy

Log2 | Markers
Selectlog Gamma Ray -

Log 1

Specify data range Z|

Log range (min‘max) -2.8 133.4539 [ Logarithmic

Style [ Well log 7] Seismic
Line thickness 1
Line color | [ | = Black
Fill Lef of log [=] 171 singie cotor
Fillwith Gamma Ray q flip color table

133.453¢

Apply 1o all wells|
Save as Defaul © closa | | @ How
Workflow cont’d:
10. In the Log 2 tab, leave the log selection to
None.
. /= Display properties of. F02-1 [l @ =
11. Press Apply to all wells to display S =
the Gamma Ray log on all wells displayed in Pael[1 g Mmben
the panel. '
Display well stratigraphy
. . Log1 | Log2 | Markers
12. Close this window. Select log (TN -
) 0
i 1
r I | = Dark -
Save as Default ©) Close | & Help
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Workflow cont’d:

13. Now start interpreting the depositional trends and possible systems tracts boundaries
by moving the HorizonCube slider €} up and down.

0 Well Camelation Panel - Line: Well comrelation-Line =0 ol =3
L . - A rizomn v L]
SlaresramAstrm B e ? (@] THe muononcie [
Trea items s Fi2-1 Fo6-1 F032 FO34
i | =] =
Elements. [ |
7 =vD
4 20 Horizon

265
Link to ColorTatde
Lock Top/Base distance
: osmes] (¥
Gamma Rey—roooroororr cre TVD.666.04m TVDSS:636.04m TWT.666.00ms

Workflow cont’d:

14. To edit the markers: click on the

15. Add a new defined boundary as a marker by clicking on %"
In the pop-up dialog, give a new name and color to the new marker and click Ok.

8 Well Cormelation Panel - Line: Well correlation-Line =3 ol i

Ql&etam “xw M E el 79 BB~ |mrionzencuse Bl os®
Tree flems s Fo21 FO6-1 Fez o4
Elements Colod e [Tm e e

i (%] A P
, | View Wels & Seismicsx] | & Kaep zoom ratio [} '

« i
Trehr=198 (606869, 6079406, 424) Val=-04 (Sais); RelSP=1a30
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Workflow cont’d:

16. Once the marker is added in the list, it will become an active marker: click in the well
area to add a marker. To delete a marker, use CTRL + mouse click on the marker.

17. When done with the marker interpretation, press Ok/Save button in the markers dialog.

.-Euww Comelation Panel - Line: Well comelation-Line = 100 bl
Qe A=A E o ? @ Bl % [muonzoncue [
Ll Fi

Tree items

8
3
o138
L

1

;-
IR 1E
i

il
il
[

2

l
I

F 1
View Wels & Saismics’s] ‘ .__!; Keep zoom ratio |} .

« i v
Trchr=100 (606073, 6070226, 1704)  Val=1585 (Seis),  Rel/SP=1e30

- 358 -



2.5 Seismic Predictions

This chapter deals with Quantitative Interpretation possibilities in OpendTect
using commercial plug-ins developed by dGB, ARK CLS & EarthWorks. These
plug-ins cover a wide range of seismic inversion and forward modeling methods.

In this chapter you will learn how to:

» Perform relative (band-limited) acoustic impedance inversion with Seismic
Coloured Inversion (SCI) plug-in.

» Perform model-driven absolute acoustic impedance inversion with
Deterministic Inversion (DI) plug-in.

» Perform stochastic inversion with Multi-Point Stochastic Inversion (MPSI)
plug-in.

» Predict porosity from inverted acoustic impedance and porosity well logs
using Neural Networks plug-in.

The inversion plug-ins (SCI, DI, MPSI) can be used to invert to (Extended) Elastic
Impedance volumes using the same work flows described in this Chapter. For
more extensive training in inversion, please contact dGB at info@dgbes.com.

Training of SynthRock, dGB’s plug-in for simulation of pseudo-wells and HitCube
inversion (matching stochastic pseudo-well synthetics against measured seismic
responses) is not included in this manual. A separate training manual exists. For
more information, please contact dGB at info@dgbes.com.
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2.5.1 Relative Impedance Inversion (SCI)

What you should know about Seismic Coloured Inversion (SCI)

e SClisaplug-in by ARK CLS.

It enables rapid band-limited inversion to Acoustic or (Extended) Elastic
Impedance.

» The SCI operator matches the seismic amplitude spectrum to the well log
spectrum.

» Default trends can be used in the absence of well logs.

e The workflow is very similar to Seismic Spectral Blueing (see section 2.3.4).

The workflow is as follows: an operator is designed for SCI using the seismic and
well data. Once the operator has been derived, it is converted to the time domain
and simply applied to the seismic volume using a convolution algorithm.

Our aim is to design an operator at the zone of interest (target). It is therefore
desirable to time gate the selected traces prior to generating well log spectra.
Ideally you should use a good interpreted horizon in the target zone to guide the
well data (log traces). In this manner, the various gated log traces should have
sample values over a similar geology. However, in our case we will just use a win-
dow interval instead.

Here is the workflow on how to create and apply these techniques in OpendTect:

Seismic: Amplitude-Frequency plot
Smoothing of seismic mean

Well: Amplitude-Frequency plot
Global trend of well plot

Design operator

Apply Operator

Quality Check

NookrwN~
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2.5.1a Coloured Inversion

Required licenses: OpendTect Pro, Seismic Coloured Inversion.

Exercise objective:

Invert the seismic data to relative acoustic impedance using SCI plugin.

Workflow:
1. Launch the Attribute Set 3D window.

2. Choose Colored Inversion from the
Attribute list.

3. For Input Data click Select and choose 1
Original Seismics.

4. Toggle the Single Operator option to
create a global SCI operator.

5. Click on Analyze and Create ...
to launch the SCI main window.

x| N>
2D ..
3D .

Amibute Set 30

P ¥ E A R -

P s T -2

gt Data 1 Crignal Seismics [0 seea

Workflow cont’d:

In order to design an operator with the SCI application, it is first necessary to select
and analyze the seismic and well data spectra. This is achieved by loading some
seismic trace data and well log impedance data (in time).

6. Click on 3 to pop up the ]

Select Input Data window.

7. Check if 1 Original Seismics
is selected.

8. Click Load Seismic to load

the default 40 traces.

9. For Time Range toggle Sub
and enter 500 and 1500 ms
as range Start and End
respectively. o]

Ete Yiew oo Hep

T HMMeE

A NS
T IUJ

Select Input Data

Input Seismic  Input Wel Logs

Select | Traces | GC

Select Seismic... | 1 Onginal Seismics

30 Survey Area
®Ful Stan End Inc
Sub | Inine: 1 7
X-ine:
T
Load Traces 100

Hum Traces: (407

Clear Traces  Clear Unselected Traces 0 Selected

Time
Sekct Horzon
Range Absolte
Ful O HOMZON  Spart 500

5 s |
s Ena [1500

Help ~ Close |_

Log Inpit (Jee domair) = Time (ms): T5.0783 Amp: 14 4262
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Workflow cont'd:

10. Switch to Input Well Logs tab.

a Select Input Data
it Setsme

Define Format...

FieldWells/Logs Top Base HorzTime HorzSrc In-Line X-Lin
H ect Input 3 ?
11. Click Load wells. = Sy -
Input Seismic | Input Wel Logs
Reload Wells Define Format._.
12. Select the well F3-04 and choose FaawelsLogs Top Base HoaTme HozSie iniine XL
P-Impedance log. > Btz 250 1460 undeined w5
Pmpedance 256 1460
Fapp T neetel 250 oA wndefined 722 8
13. For Time Range toggle Sub and CemneAlLop. Pigedsmce 0 1841
enter 500 and 1500 ms as range Y 3 w9
- Pdmpedance_rel b
Start and End respectively. B e 125 undefined M43
L f Pimpedance rel 0 1825
Clear Wells
14. Close the Select Input Data Time x ’
i Clear Wels  Clear Unselected Wells  Reshow Wells
window. Seecttior | S
Range Select Honzon.
Full Range Absolute
® Sub Full O Hofizon  sa |00
You can add, generate new log from * S DAk eng 15
select input data window. Right click on @ Help 0 =
any of the wells, then you can chose to
add or create a new Al logs.
Workflow cont’d:
IA,:\d'-'a'\tec(cn‘.'ols ¥

15. Click on the advanced controls icon :m
to choose the seismic sampling rate for
the well log data resampling.

16. Go to Time Domain tab.

17. Log Data Resampling should be set to
Interval Source: Seismic. Once set,
close this dialog.

Frequency Domain | Design Operator Well Logs Info | Parameter Test

Data Conditioning
Hormalisation
Interval Source

d Nomalhse G Seismic (7 User

Taper Ends Using Papoulis Windowing
7| Taper Traces Taper Length: |48 ms

7] TaporLogs  Tapes Langth: |48 s

Log Data Resampling

Interval Source
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Workflow cont’d:

a Seismic Coloured Inversion: F3_Demo_2015 - Untitied = © HESN
File View Tools Help
DEoEE & B 'IEII‘"""‘;’ B2 P LEe
R Sefsrie’ Seamic Maan .
- Design Controls +
. = e g |
18. Click on A& to pop up the PV g s %
Design Controls Dialog. =R E
Alpha® .0 555 9
Desspn Operator <]60
19. Smooth the amplitude- ¥ Ao Gale -
i i ¥ Auio Calc. Num Zero 40
frequency plot of seismic qata e cel ten 2 i [ .
by setting an appropriate QC Aganstinpt Sersmic 50 100
. Hal = Close Fraq (Hz)
Smoothing Operator Length — T —— e
(keep an eye on the Seismic 1, 1000000 -
Mean curve). 4000000
H ] £ o
2000000 |
0 Jothortrmilitn
o B i
1000 1500 1000 1500
Time (ms) Time (ms)
Individal VWells Gabal
aca | o™y 1 T ¥
Raw Seismic - Freq (Hz): 3.4821 Amp (dB). 37.5567
Workflow cont'd:
As a rule of thumb, any Operator (time
domain) larger than 200 is too high. You
can adjust the operator by changing the
number of zero crossings.

20. Tweak other parameters (low cut, e —— SRS SIENE
high cut) of the design operator OMMEP DNNEE 8 2[Remows =
such that it overlaps the seismic : oo e
bandwidth (check inthe Seismic G ey kil
Mean curve) and the residual w{ At 08
(Blue curve in QC) is nearly zero. RS s i

.m} Aasts Cale Ful L;wcm He Ful ‘;:"cuj ¥

21. Save the Operator [ and o ST SR S R
optionally you can save the % A
session[H] . - Tl

| I{" Energy. 39.9037 %
"’Oé. . IF QE Against Inget Seismic
22. Close the SCI main window. \ [ | Cone a
‘ | N § l ‘ s oo [
£ od e f s . —
ST ——— X (@0 ] [ @
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Workflow cont'd:

23. You will return to the attribute set
window.

24. The input wavelet will already be
selected for you.

25, Give a name to the new attribute
and Add as a new.

ik

»

A 30

Autribute Set 3D

Ue o E W E - -
Frrers sncis = Colurea mweesien il
gt Cata 1 Ognal Sweamics [ sewa

Analyse and Croate

Acd s eem| [0

) S o Close Qo || @ e
Workflow cont'd:
- Attribute Set 3D - = IEN
29 ¢ efala wan
FREPRPEN e — wiCis - | Colowsdimasion -7
gt Cata | 1 Oripingd Sessmics GCET
26. Save the attribute set by clicking
d iCDn_ It wareetet ke, | 301_s0 v | seieat
+
*
+

¥ S on Close

G cone
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Workflow cont’d:

27. A new window will pop up, Name
your attribute set and press OK.

e Save Attribute as - o IEl

Select output Aftribute

Filter |*

3D UVQ Attribs Texture + HC Al
ChimneyCube attributes
ChimneyCube Training
Demo aftributes
FaultCube attributes
Inversion attributes

mv first attibute set
< >

X d

Name |Color Inversion |

: @ cancel || & Help

Workflow cont’d:

28. Add an inline in the tree (Inline >
Add).

29. Right-click on the empty attribute
for inline 425 and follow Select
Attribute > Stored Cubes > 1
Original Seismics.

30. Right-click again on inline 425 and
select the color inversion attribute
that you have just created (Select
Attributes > Attributes > Seismic
Color Inversion).

Trea scene 1 ]
Elements Color
Scene 1
W/ In-lins

@ Cros Add Default Data
% Z-slic  Agdand Select Data
® veur Ad 3t Well Location

~ Ram
Add Calor Blended

L
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Workflow cont'd:

31. Now you can see the results, and compare it with original data

b. Colored Inversion of the Seismic
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2.5.2 Absolute Impedance Inversion (DI &
MPSI)

What you should know about DI and MPSI

The Deterministic Inversion (Dl) plug-in inverts the seismic data using an a priori
impedance model. The output is an estimate of the mean impedance at each
sample location. The prior model is created first using stochastic parameters (vari-
ograms) extracted from the data. Then a 2D error grid volume is constructed to
get spatially variable constraints. Finally the model, error grid, seismic volume
and wavelet are used to create the mean impedance volume.

The MPSI (Multi-Point Stochastic Inversion) module starts after the deterministic
inversion. Many realizations of the impedance inversion are computed starting
from the mean impedance volume (from DI) using the stochastic model para-
meters input in the a priori model building step, and a user-defined NScore trans-
form. Several utilities can then be used to convert the realizations into
geobodies, or probability volumes.

Variogram Analysis
What you should know about variograms

Variogram modeling is free (open source) in OpendTect. It is included in the com-
mercial part of this training manual because variogram parameters are necessary
inputs for deterministic and stochastic inversion described hereafter.

A variogram describes the spatial continuity of a variable. The inversion model in
the upcoming exercises will be constructed in three zones or layers bounded by
two horizons. These horizons are represented in the wells by the FS8 and FS4
markers.

Both horizontal and vertical variograms will be computed for the packages above
FS8, between FS8 and FS4, and below FS4.
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Horizontal semi-variograms

Horizontal variograms are computed from grids (attributes) stored on horizons.
The attribute used for this analysis is the inversion target, impedance maps.
Nevertheless one should not forget that stationarity is a basic assumption in vari-
ogram analysis. Stationarity implies that the variograms analysis should be per-
formed on trendless data. An average impedance map extracted from a
broadband mean impedance volume is very unlikely to show no trends, thus it rep-
resents an improper intput. The closest maps that can be produced, and that
does not contain trend(s) are attribute maps extracted from relative impedance
volumes.
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2.5.2a Extracting Horizontal Variograms

Required licenses: OpendTect Pro, Deterministic Inversion.

Exercise objective:
Extract horizontal variogram parameters from color inverted grids.

Scenes View Utilities Help
Create Seismic Output * |, Th= 0 o8 3
Create Horizon Output_+ Bl es '

(Re-)Start Batch Job . Horizon Curvature .

1. Extract an attribute map using Dip Steering '
. . - i sopach .
Stratal Amplitude. Go to Processing o prieeeng ool .
> Create Horizon Output> Stratal Madagascar .
Amplitude. S5IS ’
# StratalAmplitude o B 2
2. In the pop up window, select the Quantty 2 output C[Esea]
quant'ty tO Output. ‘Window Option @ Single Horizon Double Horizon
) Select o I‘:.!en_%_rk”
3. In the Attributes section, select SeeaGumte e
Seismic Colored Inversion. S
@ Aftributes E
: -
See exercise 2.5.1 on how to define the Coloured C
Inversion attribute.
Ouly)
4. Hit OK. [ (@ o] [@ e |
[__“ Execution Options ... |
@‘Ocanml: _. @ Hep
Workflow cont’d:
5. Keep the window option as [r— =)

default, i.e Single Horizon.

Quantity to output [SEISMIC Color Inversion 'I D Select .. |

Window Option @ Single Horizon Double Horizon

6. Select the target horizon: Demo

0 --> FS4 Horizon. Horizon i) [Demo 0 > Fs4 *| (& setect..]
7. Set offset top: -20, bottom: 20 ZomamaTe 2 s n |

ms. Area subselection 226/645-314/695 (463 samples) (© setear|
8. Select the amplitude option to option fliax___ ]

output: Max.

Output fold as an exira aftribute ) Yes @ No

9. Name the attribute.

Aftribute Name  Stratal Amplitude |

10. Start the process: click on OK. i Execaution Orlions
I gg OK || € cancel| | g Heip
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Workflow cont’d:

11. In the tree, Right-click on 3D Horizon
and select Load.

12. Select the horizon Demo 0 --> FS4
and Hit Ok.

13. Add attribute at horizon location:
Right-click on Demo 0 --> FS§4 > Add
> Horizon Data.

# Annotations

< (30 Honzgm

@ 50 Horizd I
Fault Add at Sections Only
Fault Sticl  Add Color Blended ...

Track New

Create with Constant Z ...

k Pickset

% Select Input Horizon (s) =i E)

W - Filter =

7| Demo 0 —>FS4 A=
Demo 1 —>MFS4 -
% Demo 2->FS6 E |
= Demo 3 => Top Foresets e
Demo 4 —> Truncation F
Demo 5> FST —
Demo & —>FS8
Demo 7 == shallow

Area subselection 100/300-750/1250 (463 samples) fO Select

‘OCanr.el: & Heip

Dema_2015\Surfaces\Demo_0_—__FS4.nor

pET
=@ Zve ol Attribute
@ 2D Horiz  Display ' % Volume Processing Attribute
Fautt | Tracking " Contour Display
oies = g oionData |
ody
Well ‘ Workflows ©
¥ Pickset (& Save

[ Polygon | & Save as
& Prestack g | oo

Delete from Database
# Remove from Tree

Workflow cont’d:

14. Select the Stratal Amplitude attribute
you just created.

15. Hit OK.

= | B i |

Select one or more attributes to be displayed
on the horizon. After loading, use ‘Page Up’
and ‘Page Down’ buttons to scroll.

Make sure the attribute treeitem is selected
and thatthe mouse pointer is in the scene.

»
) Horizon Data

[® - Filter *

Thickness-to-Dem4
testhorizon
|¥] Stratal Amplitude

| gox |Ocancel
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Workflow cont’d:

16. Right-click on Stratal Amplitude in the tree.

17. Follow: Tools > Variogram.

With this option, you access the horizontal
variogram. It allows you to analyze lateral
variability of your data around the horizon. This
information is in particular used when building
the background model for broadband seismic
inversion.

18. Hit OK.

= @ 3D Horizon

B4 Demo 0 -
[ <right-c... 11
%Seled Aftribute
@ 2D Horizon ~ Move
Fault Display
gal(;" Stick:  Save as Horizon Data .
b d W?al\v Filtering ...
* Pickset  %® Remove Gridding ..
O Paygon T

Set Z values

5 Prestack Ev

-
™ Semi-variogram parameters o | B et

Specify semi-variogram parameters

Maximum range (m) 1992 <

Max number of pairs per lag distance 1000 <

O Cancel: l GHeIp

Workflow cont’d:

In this window, the objective is to fit a variogram model (Green) by setting it's sill and range
that best fit your data (Blue curve). Try to achieve a good fit at least for smaller lag distances.
Mind the impact of number of pairs per lag on the smoothness of the data extracted curve.

19. The analysis can be done in different
directions; Inline, Diagonal,
or Crossline (i.e. the analysis is
anisotropic) : change the direction and
observe the impact on the variogram.

20. Modify sill and range, using the
sliders, to fit a variogram model to the
data.

21. Choose out of the three available
variogram models; Exponential,
Spherical and Gaussian.

Variogram parameters are used for example
when building the initial model for MPSI
inversion.

™
8 Variogram analysis lr|eE) ES

Variogram analysis

Direction: [Inline -

sill
294
o 2.5 ?
: }
= N
=
B 15
i
_E 1 = in
2 05
' 500 1000 1500 1q
Lag distance (m)
0.296 _
|range {ak 253 |

Variogram model | exponential .~

spherical

| gaussian Q ciose | | 3 Heip I
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2.5.2b Extracting Vertical Variograms

Required licenses: OpendTect.

Exercise objective:

Workflow:

Extract vertical variogram parameters from impedance well logs.

Processing Scenes View Utilities Help

1. To extract P-Impedance logs from various wells: Go to Analysis > Cross plot
Data > Well logs vs. Atfributes.

data extraction.

3. Select Impedance logs
associated with the wells.

4. Toggle Extract in time and set
step: 1 ms.

5. Extract between Markers:
FS8and FS4.

6. Select log resampling method
as Take Nearest Sample.

7. Set the radius around wells to 0
and press OK.

[1 Original Seismics]
[3D UVQ 6 biased Texture+Energy+SystemsTracts]
[3D UVQ Texture+HC attribs+ Energy disk]

[4 Dip steered median filter)

[5 ChimneyCube]
[7a Al Cube Std]

I7b Al Cube from HorizonCube]

4 - Wel

¥ FO2-1
4| F03-2
7| F03-4
7] FO6-1

Extract Between Markers

Attributes > t@ = ;: > @
% Volume Builder A
oo : @) Specify [==5=)
| Cross-plot Data * | Welllogs vsAttributes ..
Well r Aftributes vs Attributes . Which attributes do you wantto use?
& Layer Modeling 2 Open Cross-plot ... :
= Fluid Contact Finder ... G2 |[Ox ][0 canc]
Neural Networks v
Ss8I18 >
Velocity Model Building *»
Well Correlation Panel ...
Workflow cont'd:
= Attribute/Well Cross-plotting E=REcE ==
2. Select all wells that will be used for - Attribute

u - Log

Density
Sonic
Gamma Ray
Porosity
[#] P-impedance ]
P-Impedance_rel

= | |2 Extractin time _ Step {ms) 1

selected zone | Fs8

> {F54

Distance above/below (m) 0

0

Log resampling method | Take Nearest Sample +

Radius around wells (m)

Filter position

© select...

Ocam:el &9 velp

-372 -




Workflow cont’d:

@ Well attribute data [ESREE =)
. B XY, Y x@aep = Showmunssi-ﬁ. | Show InlCl ‘5‘,‘[._-‘.
8. Cross plot table window : —
Well data F02-1F03-2F03-4 F06-1
ops up.
p p p X-Coord Y-Coord Z(ms) * MD{m) | PImpedance |
F03:2 619101 5089481 592 58991998291
9. Select P-Impedance F03-2 619101 6089491 593 590.91996291
F03-2 619101 6089491 594 59191996291
Column. 032 619101 6089491 595 592.91998291
F03-2 619101 5089481 595 5939198291
. : : 032 619101 6089451 597 59491998291
10. Click on this ﬁ icon F03-2 619101 6089491 598.01 595.91996291
to start the variogram FNL2 A1a40d AnAadal 20001 586 01608201 e -
analysis. [(©.cose ] [ @rew )
well: FO3-2

11. Variogram parameters
window pops up. 'ﬂ'_'c- Semi-variogram parameters [ﬂ@g‘

Specify semi-variogram parameters

12. Click OK.

Maximum range (msec) 50 5

The vertical variogram parameters used here are comparable

3 X . . Step (msec) 1 =
to the horizontal variogram analysis of Exercise 2.52a. The

main difference is in the number of available data points. Min number of pairs per lag distance 10 |+
Variogram analysis requires a minimum number of pairs per
lag distance and therefore sufficient data must be input in EOK Ho Caan @ Her ]

orderto obtain a representative variogram.

Workflow cont’d:

13. The variogram analysis can be [ varogram anysis =18
done for either all the wells e
(recommended) or for one particular Source: [AIWells
well. il
1.751
o 15
14. Modify sill and range, using the § . e
sliders, to fit a variogram model TE o W@H
(Green) to the data (Blue). s VP
P 20 40 5

Lag distance {msec)

15. Choose out of the three available 0% | |

- . |ranqe ] 21
variogram models; E)_(ponentlal, o TR
Spherical and Gaussian.

[Goms) (@]

It's recommended to use the same model for this vertical variogram analysis, as used previously for
horizontal variogram analysis (Exercise 2.5.2a).
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2.5.3 Porosity Prediction using Neural Net-
works

What you should know about Neural Networks for Rock Property Pre-
diction

» This is a supervised approach using a Multi-Layer-Perceptron neural net-
work.

» The network will find the optimal (non-linear) mapping between seismic
attributes (usually impedance logs) and target well log attributes (porosity,
gamma-ray, Vshale, Sw ...).

» The network is trained on data points extracted along the well tracks.

» Part of the extracted points are used as test set to determine the optimal
point to stop training and avoid over fitting.

e The trained network is applied to (inverted) seismic data.

» The input data (inverted seismic) needs to be scaled to match the scaling of
the input data set that was used in training (logs).

Details

In the exercise that follows, we will convert seismic information to porosity using a
neural network inversion workflow.

As in the chimney cube exercise (see Chapter Seismic Object Detection using
Neural Networks), we will use a supervised neural network to establish the (pos-
sibly non-linear) relationship between seismic response and porosity. The main
difference from the previous exercise is that we will now use well information to
construct the training (and test) sets.

The input consists of acoustic impedance values from the Al volume and the ref-
erence time, i.e. the two-way time at the extraction point. The reference time is
included to capture a possible porosity trend with depth (time).

Theoretically we only need the Al value at the evaluation point as input to the
neural network but this assumes that the inversion process has completely
removed the wavelet and that there is perfect alignment of Al and log responses
along the entire well track. To compensate for potential inaccuracies we will
extract more than just the Al value at the evaluation point. Instead we will extract
Al in a 24ms time window that slides along the well tracks. The corresponding
porosity values from the depth-to-time converted and resampled logs serve as tar-
get values for the neural network.

Porosity prediction is a relatively easy process. The workflow is schematically
shown below:
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Seismic data :f De"“esi‘:::rlbute )

~ s

Attributes along well tracks
+ target log response

v

© TrainMLP
Network

U
Y [

Trained MLP
Network

All traces

>
T
1
<

Predicted log
property cube

Log property prediction workflow

This workflow can be used to create log property cubes such as a Porosity Cube
and a Vshale Cube.
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2.5.3a Neural Network Prediction

Required licenses: OpendTect Pro, Neural Networks.

Exercise objective:

To convert seismic information to porosity using a neural network inversion waorkflow.

Well data Preparation

1. Well(s) need to be available in the survey. If they are not available: import wells (track,
logs, markers, optionally time-depth curve or checkshot).
2. Tie well to the seismic (see exercise 1.5.1).

¥ Attribute Set 3D

ELER TR T 1S

[ Losd Atribute o
- . . Select input Attribute
2. Click on file> Open set , or click on =¥ R

Workflow:

1. Open attribute set window Aag.

Filter *

3. Select the saved set ‘Inversion IMF Pre-stack amplitudes
. . Inversion attributes
attributes’ and Hit Ok. ReF =]
sdtest 85—
Segmentation attributes (waveform) _K'
Segmentations attributes (Dip-steered 3D)
Seismic Spectral Blueing and Coloured Inver: -

@ cancel| | @ Help

S.0NAttribs\I nversion_attributes.attr

Workflow cont’d:

4. Open the neural network plugin with the§ = icon
> 3D or go to Analysis > Neural Networks > 3D.

,
& Neural Network management Lo [ o) e

Neural Metwork Manager 30

Create Mew Network: Get

5. Select Property prediction [Well Data) from the [Patter recognition Picksets]..] | Stored Netwark)
Neural Network manager.

Property prediction [WellData] From Jobfile ... |

Active Neural Network

Input Output

[Oows] (@re
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Workflow cont’d: > bt

Input training dite st ® Cxtvact now

6. Data selection window pops up.

7. Select the input attributes as on
the picture.

8. Select the target quantity among
the available well logs: Porosity.

9. Set the percentage of data to be
used as test set: 40%

Percontage

on-standand number of hidden nodes

Retrieve stored

Wehs touse | ¥ FO21
¥ Fo3a
¥ Fo3a
¥ Pos1

Extract between [Stanoldatar = |cEndof dutax

Target comtains @ Qrdinary el log vatues

Lithoiogy codes | pietunce sbovefbelows [m) & o
o o test set. 30 % PP —s
Vertcal cameiing matnos [ Take Neseest samele =
G ox | O concel [@nee
s ——

Workflow cont’d:
=S| EoH ==
v -
Wells to use [[¥] F02-1
¥ F03-2
J| F03-4
F06-1
10. Select all the wells. -
11. Limit the extraction window as shown on
the picture.
Extract between |FS8 -] [Fsa =
12. Select Average Vertical sampling method _
Distance above/below (m) 0 0

and Press OK.

Radius around wells 0

I OOK I oCancel GHelp
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Workflow cont’d:

An optional step is to QC the extracted data set (tested and training) by plotting
Acoustic Impedance (Y) versus Porosity (X)

13. Highlight Porosity column and press X .

14. Highlight Al O column, and press Y+

15. Click on F.:.

r
& Input Data

la-@&

B[XY

Y qmmp b g

m== | Show 100.0%

: ] Shownlicd =7 |£

Training data 619101 6089491 59648 0506
Training data 619101 6082491 597.49 0597

Test data 619101 6089491 60049 (06
Test data 619101 6089491 601.49 | 0.601

Data Set Training data

\

Training data 619101 6089491 59849  05980...
Training data 619101 6089491 59949  0.5990..

Test data 619101 6089491 60249 06020..
Training data 619101 6089491 60349  05030...

41899...
42000...
4209738
42218...
4239096
4278733
4323147
4369237

42389.. 44136.. 45165..
4278584 444391, 4542655
43230.. 4470581 4566731
436911... 4404539 4587762
44137, 45167 46046,
44440 . 4542741 4607702
4470698 4566790 46080...
4494653 4587793 46081..

X-Coord Y-Coord Z(ms) *Referen Acoustic| Acousticl} Acoustic) Acousticl Acousticl Acousticl Acousticl] Porosity
3828565 4006971 |Eliki-NN
40765... |40326.. [CRRENLRS
4151797 40541 |EREV:EN
41098... 40731... |ERLTENS
40070... 40914, JERELIES
40327... | 411723 JEkihlEE]
40542... 41429... [ERikEE
40732... 41675, [Ereilee]

0.3501...
0.3501...
0.3486. .
0.3445..
0.3388..
0.3219...
0.3248...
0.3409.,

[©rn] (Q 0w (@vee]

Workflow cont’d:

16. Cross plot window pops up.

17. Click on * in previous window to
move Y column and see how other
attribute plot against Porosity.

18. Close cross Plot window.

19. Press Run in Previous Window.

B <NLA train/test datas Cross-plot

show 100.00%+ [} Y2 BothData Sets +| |Seeector

- =075
Pix)
8
oln
Sam

=

0.228

028

0275 03
Potwsity

¥ Selected 0

0325

035

0.3
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Workflow cont’d:

20. The balancing data window pops up.

step.

In this step, you have the option to balance
your data. If the data is not properly sampled,
balancing is a recommended pre-processing

21. To continue, Press OK.

# Data preparation

=

Specify data preparation for Porosity’

64
= 407
3
[
05259 0.25 03 0.35 0.3902
Value
Balance data @ Yes No

Data points per dass B

Percentage noise when adding |1

Datarangeto use |0.2243 | 0.39196

. ©) cancel| ‘_“ Help |

Workflow cont’d:

22. The Training data window pops up.

23. To continue, Press OK.

= NN training (20

Traln Neural Network => 'Porosity’ [September27 2016 15:42:03]

2

Normalized RMS
ST TR P —
| () Acoustic Impadance
0.75 7% =
| b () Acoustic impedance -8
0.5 5 -
Acoustic Impedance -4
[ 0.26
Acoustic Impedance 0
/

L
(
@

Vectors trained 21600

On OK, save as

N
) Acoustic Impedance 4
) Acoustic Impedance 8
)

Acoustic Impedance 12

Recume Clear

O co

& Help
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Workflow cont’d:

24. Back in the Neural Network, Output
property is highlighted.

25. Click on Info to see summary

Of Neural Network characterisation.

) Neural Network mar it

[ENEI=

MNeural Metwork Manager 3D

Create New Network: Get:

[Paltem recognition [PickSets] [Stnred Network ]

[Property prediction [WeliData)...| | [ From Jobfie.. |

Active Neural Network

Input Output

Reference time »
Acoustic Imped:

Acousticimped: =

Acoustic Imped:

Acoustic Imped:

Acoustic Imped: _

Arniimbio lnnmn i

<« [.m 3

(@

Workflow cont’d:

26. Neural Network info (report) pops
up.

27. Click on Save Report (optional).

-
B NN info

Type: Supervised (direct prediction)
Hidden layer has 4 nodes

Traiming ssats:

Humber of used input vectors: T49
Humber of invalid input vectors: O

Borosity
Data meas
Data

Mean lute errer:
Maximum absolute erzer:

Tast scats:

Humber of used input vectors: 483
Humber of invalid input vectors: 0
Poreaity
Data mecan: 0.287607
Data scandard deviacion: 0 18

@ Close

[ B iy

[@ree |
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Workflow cont’d:

28. Store the Neural Network.

& Neural N rk manag I‘:‘@&

Neural Network Manager 3D

Create New MNetwork Get:

[Pattem recognition [PickSets] .| | [Stored Network ..

|Property pradiction [WeliData]...] | [ FromJobfie.. |

Active Neural Network

Input Qutput

Reference time | ([EEEET R
Acoustic Impeds

Acoustic Imped:| =

Acoustic Imped:

Acoustic Imped:

Acousticimped: _

Anniiatia e s de

«.m r

Workflow cont’d:

29. Give a name to the Neural Network
output.

30. Press OK.

= Save Neural network as @E‘ﬂ
Select output Neural network
Filter | *
[ChimneyCube i
NN Porosity training
NN-Test

«

UVQ 10 classes [-12, 24] ms on MFS4 E
UVQ 10 classes [-12, 60l ms on FS8

UVQ 10 classes [0, +24] ms on MFS4
Volume-based segmentation between FS7 and
Volume-based segmentation between FS8 and ~

X e 0

[T r

Name |Neural Network]

_.emo_201

©) cancel gHeIp

S\NLASINN_Porosity_training.nn
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Workflow cont’d:

31. Create Porosity Cube.

32. Create seismic output using:

¥ Sumvey Analysis amssing Scene View Utilities
Croato Sismic Quput_b | tites T ngepmeute LY
! [ 0. |

&
&

q
“-
4
=

A I_ e .
Inine 425 =

Tree scene 1

Elements
[Scene 1]

= § In-line
-] 42¢

i Cross-
¥ Z-slice

Help

Create Horizon Qutput  *
b Wells 4
(Re-)Stant Batch Job ..

2D <=>3D
Angle Mute Function ..
P4 Bayesian Classification .

Multi Attribute ...
MultiCube DataStore ...
* Along Horizon >

Dip Steering 3 From Well Logs ... ™y BetweenHorizons
i »
= GHT Mapping Tool RS TEAATEEE
Velocity 3
Hi n >
e Volume Builder ...
Madagascar

Re-sort Scanned SEG-Y ...

81 ssis

Workflow cont’d:

33. Select quantity to output

34. New window pops up.

35. Togagle Neural Network.

36. Select Porosity.

37. Press OK.

B Create Volume Attribute = G

Quantity to output

[Z]] © setea..
| Volume subselection - (& setect

=E—

o Select

Select Quantity to output

B \Porosity | f ]
~| | © Select...| | @ CBVS
Attributes '

|pns .
@ MNeural Network 1

QoK | [© cancel| [ @ Heie |

e

:0 concel ] [ @ relp |
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Workflow cont’d:

38. Give a name to the output Cube.

39. Press Ok.
(@) Create Volume Attribute [E=SETS)
Quantity to output | Porosity Z| @
Volume subselection |- m
Mull traces @ Discard Pass
[7] Scale values:  ShiftFactor
Output Cube [Porosity =] (© setect.| @i cavs
Batch execution |Single Process |~ 4.+ Options .|
Workflow cont’d:

40. To apply the output on an inline to perform
QC by giving Right click on Inline > Add
and Select data.

41. In the selection window, under the Neural
network category, select Porosity and
Press OK.

Elements Color
Scenel
N In-lin
@ Cross Add Default Data
@ Z-slicl Add and Select Data
® volur Add at Well Location ...
~ Rand Add Color Blended
I 2D Line
r'!f\" Select ESE)
Selectfirst layer
Stored
Steering
Aftributes

@ Neural Network

=

2y

| OOK ||0Cancell gHelp]
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Workflow cont’d:

42. The Porosity prediction result display on Inline 425 should look like the image below.

2.6 Machine Learning

This chapter deals with the Machine Learning (ML) capabilities within OpendTect
Pro using the commercial ML plug-in developed by dGB.

In this chapter you will learn how to use the ML plugin to:

» Perform Log-to-Log Prediction for Density.

Perform Log-to-Log Prediction for Porosity.

Perform Lithology Classification using Well Log data.

Predict Seismic Bodies using Supervised 3D Models.

Predict Fault Locations using the Unet 3D Fault Predictor.

Predict Rock Properties using a combination of Seismic Data & Well Logs.
Predict Seismic Features using a Seismic Image-to-Image Workflow.

Fill blank traces in Seismic Data using a Seismic Image Regression Work-
flow.

More information on these topics an be found online in the Machine Learning_
Chapter of OpendTect Pro & dGB Plugins Documentation - 6.6.

We also have an extensive playlist of Machine Learning videos on our YouTube
Channel.

For more information, please contact dGB at info@dgbes.com.
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https://doc.opendtect.org/6.6.0/doc/dgb_userdoc/Default.htm#machine_learning.htm?TocPath=3%2520Machine%2520Learning%257C_____0
https://doc.opendtect.org/6.6.0/doc/dgb_userdoc/Default.htm#machine_learning.htm?TocPath=3%2520Machine%2520Learning%257C_____0
https://doc.opendtect.org/6.6.0/doc/dgb_userdoc/Default.htm
https://www.youtube.com/playlist?list=PLusfAjN1yKjEFrJmQzyquzRHOMuVS5kqH

2.6.1 Well workflows

TheWell Log Prediction workflows in this section are Supervised Machine Learn-
ing workflows and require only well logs as inputs.

The target logs are used for generating/predicting missing logs.

Log Prediction produces continuous logs.
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2.6.1a Log-Log Density

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:
To predict missing logs using the log-log prediction tool, which is part of the machine learning
plugin. In this case, we want to predict the Density log.

Well data Preparation
Well(s) need to be available in the survey. If they are not: import wells (track, logs,

markers, optionally time-depth curve or checkshot).

Workflow: -

% Machine Learning Control Center - [m]

1. Open the Machine Learning Control Center with the &, icon.

Survey |F3 Demo 2020

~ Workflows

Neural

L8

» [ @ EL R e

X

2. Click on Wells. &3 v
-l Lithology classification
3. Select Log-Log prediction, and Hit Go. ES@ismic I
b Tl

0
Workflow cont’d: [Emseroon ] v | e
<Input D>
Output Deep Leaming Example Data | =1 © Select .|
4. Press Select - Input Data in the "Log-log prediction”
window. Select @ icon in the “Target Log Definition™.
» . T . urvey Log Name pelts @
5. In the "Specify Log Data to predict” window, Select ) "
Survey?, Target Log (e.g. Density), and the Wells that
will be used for the data extraction.
The well FO2-1 is not selected, and will be used as a Byt
blind well.
€ ciose @ o
6. Press OK. P——— Frre
Survey F3_Demo_2020
F3_Demo_2020_old
Target log
= - * )
[ F02-1 O
[ F03-2
(4 Fo3-4 L
[ FO5-1 1]
* The option to select data from other surveys is available only in commercial projects S P
0K Cancel
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Workflow cont’d:

7. “Deep Learning: Target Log definition” survey p— Wells
window pops up.

1 F3 Demo 2020 Density [3] 'FO3-2', 'FO3-4' and 'FOG6-1'

A new data from different survey”* can be
added by clicking on g icon.

8. Press Proceed [Input Data Selection].

% Select Input Logs - m} X

P~

" o Input Logs ® Specify now O Read Saved Setup
9. In the "Select Input Logs” window, Select - o
logs that will be used to predict ‘Density’ log Fier | |
P [ Density_BLT ~
(e.g. Sonic, Gamma Ray).
[] Litholog (10=sand 15=silt 20=silty shale 30=<
10. Press OK. [ P-Impedance
[J p-Impedance_rel
[] Porosity
-
-

>

€ cancel

* The option to select data from other surveys is available only in commercial projects ‘

T JJ&"E

@ Proceed [Input Data Selection] >> | €3 Close

Workflow cont’d:

11. “Input Log Selection” window pops up.

Input Logs can be madified in here. Keep the
default parameters as indicated in this window.

12. Type a new name for the Ouiput Deep Learning
Example Data (e.g. DL_Example_Density_st10).

% Input Log Selection

- a x

13. Press Proceed. - =
Survey Input Log 1 Input Log 2 -

1 F3 Demo 2020 Gamma Ray ~ Sonic ™|

Stepout from center log sample |10 S
Extract between <Start of data> | <End of data> o
Log sampling Z Step (m) [0.1524 |

Edge/Gap Policy ® Exclude incomplete O Add data

Qutput Deep Learning Example Data |DL_Examp!eLDensity_5t1l] | ~ | © select ...

Dcose | =y @
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Workflow cont’d:

14. The Train tab get activated. Train the
extracted examples data using suitable
learning algorithm. Keep the defaults

‘o . ’ 2 Log-log Prediction - u] X
parameters, “Scikit-learn” platform and e
“Random Forest” Model_ Input Deep Learning Example Data DL_Example_Density_st10 ~ |© select ... I
Different machine learning platforms and
parameters can be tested. Output Deep Learning Model |DL,Mudel,SciLutLearn,RandomForests | © select... |
y . =
7

& 00

15. Specify a new Output model name (e.g.
DL_Model_ScikitLearn_RandomForests).

Type
Ensemble v

Model

16. Press Run. .

Estimators. 100

Max Depth: 50

Reset Back

€iclose @
Workflow cont’d: i Log-log Prediction - o X
Extract Data  Train  Apply
Survey Data Root | C:\Surveys © select ...
17. Press “Apply” tab Survey |F3_Dema_2020
Check all the selected default parameters are 3 Demo.2020.01
OKk.
*The Survey and Training model can be
modified in here.
* 'S
DL_Model_ScikitLearn_RandomForests ()
n
0]

18. Press Proceed.

Name: DL_Model ScikitLearn_ RandomForests.
Type: Log-Log Prediction.

Number of inputs: 2.

Output: Density.

Created by: assia.

ated at: Fri 09 Jul 2021, 16:12:56.
Last Modified: Fri 09 Jul 2021, 16:13:46.
Object ID: 100060.64

[Brroceed>>]| Batese @

* The option to select data from other surveys and training model is available only in commercial projects |
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Workflow cont’d:

19. “Apply training model” window pops up. i

Input log for 'Gamma Ray' Gamma Ray

20. Apply the trained model to a blind
well. Select F02-1.

21. Type a new name for the predicted log
(e.g. Density_Predicted).

22. Keep default parameters and Press
Run to continue.

Log name for 'Density' | Density - Predicted|

Apply to [®] = *

Input log for 'Sonic' Sonic

& 03-4
] @ Fo-1|
O & Fo3-2
[ Fo6-1

<

Extract between  <Start of data>

SR

~ | |<End of data> ~

Log sampling Z Step (m) (0.1524

g/cc (Gram/cm3) £

Dcioe

Workflow cont’d:

23. QC results by displaying the predicted
log adjacent to the recorded log

24. Click on the Well Manager icon A_r.

25. Select the well “F02-1" and the logs
“Density” and "Density-Predicted”.

26. Click on view logs icon g .

] - Fitor - o wl - Loa

=]
Fo3 2

> Fo34 < o

L Fos-1

IS} o

*

Croain
= ol
© Cose || @ tien

Froa space on disk: 2003 GB

Density Density-Predicted
@ Logviewer: D.. — a X & Logviewer: D.. — a X
Density of F02-1 Density - Predicted of F02-1

2 05 21 215 22 2 21 22 23
50 1500 1500
7501 750 75 A%QTSO
100 1000 10001 i 1000
125 gi 1250 12501 % 1250

>
2 2.05 21 215 22 221 22 23
Density Density - Predicted

Dowe
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Workflow cont’d:

If result is satisfactory, go back to the
“Apply training” window, and apply the
trained model to all the wells where you
want to predict density log.

27. Select all wells.

28. Type a new name (e.g. Density
Predicted). Keep default parameters
and Press Run to continue.

P
Input log for 'Gamma Ray' Gamma Ray v

Input log for "Sonic' Sonic v

Apply to [ - ‘* €3
@& > o34 < (|
@ F02-1
& F03-2 o
[ & Fo6-1 W
Extract between | <Start of data> ~ | | <End of data> >
Log sampling Z Step (m) [0.1524 |
Log name for 'Density' |Density -Predicted ~ | gfcc (Gramfem3)
B
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2.6.1b Log-Log Porosity

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

plugin. In this case we want to predict the Porosity log.

To predict missing logs using the log-log prediction tool, which is part of the machine learning

Well data Preparation

logs, markers, optionally time-depth curve or checkshot).

Well(s) need to be available in the survey. If they are not available: import wells (track,

4. “Log-log prediction” window pops up.

5. Press Select - Input Data in the “Log-log prediction”

[<input Data>

Output Daep Laarming Exampis Data |

- . [ n ;— s Tl A4
Workflow: a K@i R[N
. . . . t+, Machine Leaming Control Center ~ — m} ®
1. Open the Machine Learning Control Center with the 2+ iCON. g, . k3 bemo 2020
R LE v Workflows
2. Click on Wells. L3 wells
- = Lithology classification
T - A
3. Select Log-Log prediction and Hit Go. EB8 seismic N
§E Seismic +
.’LWells
b
o Neural
)
Workflow cont’'d: i | Aoy

window. Select @| icon in the “Target Log Definition”. o "
6. “Log Data to predict” window pops up.
7. In the "Specify Log Data to predict” window, Select o
Survey®, Target Log (e.g. Porosity), and the Wells that
will be used for the data extraction. e o
Well F02-1 is not selected, and will be used as a blind e —
Wel I. F3_Demo_2020_old
8. Press OK.
S e —
ITII—‘-FDZ-I C:
:FDB—Q o
FO6-1 0]
* The option to select data from other surveys is available only in commercial projects ©ox | Qe
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Workflow cont’d:

Survey Log Name:

Wells

1 F3 Demo 2020 Parosity [3]'FO3-2, 'FO3-4' and 'FO6-1"

9. “Deep Learning Target Log definition”
window pops up.

10. Keep the default parameters and Press
Proceed [Input Data Selection].
11. Select Input Logs window pops up.

12. Select the Density, Sonic and Gamma Ray
logs that will be used to predict the

eE e

T

% Proceed [Input Data Selection] >> = €3 Close

7+

v ~ Logs to be used to predict ‘Porosity’

Density
Sonic
Gamma Ray
[J P-Impedance
[J P-Impedance_rel
O Ve

‘Porosity’ loq. [ 7a Al Cube Std_AL
Y g 1 Densitv - Prediction ﬂ
13. Press OK. @ ok | © cancal|
Workflow cont’d:
14. Input Log Selection window pops up.
Input Logs can be modified. Keep the default parameters
as indicated in this window.
15. Type a new name for the Output Deep Learning Example
Data (e.g. DL_Example_Data_Porosity_st10).
16. Press Proceed.
= Input Log Selection - [m] X
Survey Input Log 1 Input Log 2 Input Log 3 >
1 F3 Demo 2020 Density ~ Gamma Ray ~  Sonic v
Stepout from center log sample [10 =
Extract between | <Start of data> ~ <EI‘EI of data> ~
Log sampling Z Step (m) [0.1524
Edge/Gap Policy ® Exclude incomplete O Add data
Output Deep Learning Example Datal DL_Example_Data_Porosity_st10 - | 6 Select ...
Dclose || ¥ Ay | @
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Workflow cont’d:

17. The Train tab opens. Select the Machine
learning platform: Scikit-learn (Random

Forests).

parameters can be tested.

Different machine learning platforms and

18. Keep the defaults parameters. Enter new

Output model name (e.g.

Model_Porosity_ from_DEN_DT_GR).

19. Press Run.

#x Log-log Prediction - o
ExtractData  Train  Apply
Input Deep Learning Example Data DL_Example_Data_Porosity_st10 -~ € Select ...

Output Deep Learning Model | Model_Porosity_from_DEN_DT_GR | € Select ...

500

Qcose @

Workflow cont’d:

20. The ‘ML training log’ window pops up. When

the process finish, Click Close.

21. In the ‘Apply tab’ of the Log-log Prediction
window, verify all defaults selected data are

correct.

be modified in this window.

The Survey and the Training Model can

22. Press Proceed.

ST

i Log-log Prediction o
ExtractData  Train  Apply
Survey Data Root | €:\Surveys © select

Survey  F3_Demo_2020
F3_Demo_2020_20jul21
F3_Demo_2020_old

[Model_Porosity_from_DEN_DT_GR

Qe
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Workflow cont’d:

23. The ‘Apply’ created training model
window pops up.

24. Apply the trained model to a blind
well (not used in the training
process). Select FO2-1.

25. Keep default parameters and Press
Run to continue.

26. When the computation finishes,
Press Close.

Input log for 'Density' Density
Input log for ‘Gamma Ray' Gamma Ray
Input log for "Sonic' Sonic
Apply to (] - *
[J® >Fo34<

[E®Fo2a
0 & Fo3-2
0 & Fos-1

Extract between  <Start of data>

Log sampling Z Step (m) |0.1524

S PHTIN

~  <End of data> ~

Log name for 'Porosity’ | Porosity_from_DEN_DT_GR ~ | (Fraction)

B

Oam

Workflow cont’d:

QC results by displaying the predicted log
adjacent to the recorded log.

27. Click on the Well Manager 41 icon.
28. Select the well FO2-1, and the logs
Porosity and predicted porosity:

Porosity-from_DEN_DT_GR.

29. Click on view logs.

3 ;
-] ¥
= 2
.
-

° .
= -
Go=] @

Porosity

i Porosity_from_DEN_DT_GR of F02-1

0.3 0.35 0.4
5001 500
750 750
1000 1000
12501 — 1250
=
0.3 0.35 04

Parosity_from_DEN_DT_GR

0 Close

Predicted-Porosity

%@ Logviewer: Porosityof FO2.. — 0O X

Porosity of FO2-1
0.275 03 0325 0.35 0.375 04

500 [500

750

[750

1000 [Looo

1250 % [1250

0.275 03 0325 0.35 0375 04

Porosity
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Workflow cont’d:

If result is satisfactory, go back to the
previous Step “Apply Training Model”.

30. Select all wells where you want to
predict porosity.

31. Keep default parameters and Press
Run to continue.

32. QC the predicted well porosity logs
as in the previous step.

= Apply Train_Model_Scikit-leam_AL" - [m] X
Input log for "Senic' [Sonic 4|
Input log for 'Gamma Ray' |Gamma Ray =l
Apply to v - i [v Time Sort ﬂ
® F02-1 [
® FO6-1
& FO3-2 [+ ]
@ > F034 < u

Extract between [<Start of data> | |<End of data> |

Log sampling Z Step (m) |0.1524
Log name for ‘Density’ [rain Model Scikit-learn AL ~|

IW‘ € Close I
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2.6.2 Lithology Classification

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

To predict lithology logs using the “Lithology classification tool”, which is part of the machine
learning plugin.

Well data Preparation
Well(s) need to be available in the survey. If not, import wells (track, logs, markers,
optionally time-depth curve or checkshot).

Workflow:

For the purpose of this exercise, we will create a fake :
lithology log using Mathematics (as no lithology log exists *
in the survey)

o=
1. Open the Well Manager A
2. Select All Wells in the “Well Manager”, and Hit N u
Create. -
) Qcose | @Hop
Workflow cont’d:
3. In the “Calculate a New Well Log” window, Specify the parameters as indicated
below to create a fake litho-log:
a. Select: MathFunctions.
b. Type the Formula: GR<407?1:2 . .
Calculate new ogs for 'F02-1', 'F03-Z, 'FO3', 'FO6-1"
c. Hit Set. Mattfuntions - sat(Squrerot) + | Diset | 3
Formula (ike d!\fscn‘) set
d. Select Gamma Ray log. o — T —
e. Select for the Formula Results, Classification
f. Type Name for new log: Litho_Fake.
‘am\aros.ll-s-m '
i . Output sample distance 0.1524 Feat  Intes/extrapolate input logs? No
d. Select Output Unit of Measures: None. o —
[Ead]ow- @
4. Press Calculate.
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Workflow cont’d:

5. Open the Machine Learning Control Center
with the ., icon.

6. Click on Wells.

Survey |F3 Demo 2020

g @B Ty VN

. . v v Workfl
7. Select Lithology classification. |§|§ el OrLDgT(fg prediction
> Lithology classification
8. Hit Go. —_—
3 Seismic
= E Seismic +
S I__Wells
: < Neural
P Networks
€3 Close 9
Workflow cont’d: E
<Input Data>
Output Deep Learming Example Data O select .. )
9. “Lithology Classification” window pops up. Press Select
- Input Data. Select @ icon in the “Target Log Definition”.
10. “Log Data to predict” window pops up. Select:
Survey*, Target Log, and Wells as indicated in the ®
window.
In this case the “Litho_Fake” log will be predicted. -
[ J
The well FO2-1 is not selected, and will be used as a t Qoo
blind well. e
11. Press OK. ey o i o=
Survey |F3_Demo_2020
F3_Dema_2020_20jul21
F3_Demo_2020_old
Toret Lo [ P
[w - . L]
T (=)
_FOJZ
1 FO34 a
* The option to select data from other surveys is available only in commercial projects
(not in the free dema project) [®ox ] [ Qcacel
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Workflow cont’d:

Survey Log Name Wells
1 F3 Demo 2020 Litho_Fake [3]'F03-2, 'FO3-4" and 'FO6-1'

[

I e C]

11. “Deep Learning: Target Log definition”
window pops up.

12. Press Proceed [Input Data Selection].

4 Select Input Logs - [m] *
13. Inthe “Select Input Logs” window, Select Input Logs ® Specify now O Read Saved Setup
the Density, Sonic and Gamma Ray logs. = .
i liter
14. Press OK. :

[] Gamma Ra
[ITitholog (10=sand 15=silt 20=silty shale 30=s
[] p-Impedance

[ p-Impedance_rel

[ porosity

O po psi from DEN_DT_GR
.
<

>
0 Cancel

Workflow cont’d:

15. “Input Log Selection” window pops up.

Input Logs can be modified here. Keep the default parameters as indicated in the window.

16. Specify a new name for the "Output Deep Learning
Example Data” (e.g. DL_Example_Data_Lithology_st10).

% Input Log Selection - [m} X
1 7' Press Proceed‘ Survey Input Log 1 Input Log 2 Input Log 3 >
1 F3 Demo 2020 Density ~ Gamma Ray ~ | Sonic v |l

Stepout from center log sample [10 >
Extract between | <Start of data>  ~ |<End of dErta> w
Log sampling Z Step (m) [0.1524

Edge/Gap Policy ® Exclude incomplete ) Add data

Output Deep Learning Example Date{ DL_Example_Data_Lithology_st10] | | 8 select ...

Breers] O ~aw | @
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Workflow cont’d:

e £ Lithology Classificat - o x
18. Select Training Type New. R
Extract Data  Train  Apply
Input Deep Learning Example Data DL_Example_Data_Lithology_st1 ~ @ Select ... i

Training Type (21 New [ Resume [ Transfer

19. “Train” tab becomes active. Train the extracted
examples using the default learning algorithm
Output Deep Learning Model © select... )

(e.g. Keras (tensorflow). &
ing platform €1
Clear Tensorboard log files 0
Different machine learning platforms and o = ©
parameters can be tested. = o
20. Keep the defaults parameters. Specify a new B
Qutput model name
(Model_Litho_Keras(tensorflow).
21. Press Run.
Ociose @
Workflow cont’d:
2 Machine Leaming training log - [u] X
L —

Trainable params: 34,606

Non-trainable params: 524

22. The Machine Learning training log file pops up.
Otherwise Click on @ icon.

Saving model.

Model saved.

23. Hit Reload to refresh the window.

Process: 'Machine Learning Training'

24, When the processing is done, Close the training 10g =inicnea: wes 21 st 2021, 13:30:37

file. Finished batch processing.

| @ ciose || |# sReload
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Workflow cont’d:

@
25. Hit Proceed in the ‘Lithology Classification- - °
Train” Window. o *
26. “Apply” tab get activated, Verify the Survey and
Model are correct. Otherwise, modify accordingly.
*The Survey, Training model can be T —
modified here. EETTE
Survey Data Root | C:\Surveys O select ..
Survey | F3_Demo_2020
27. Press Proceed. Fa_pene. 20020601
Model_Litho_Keras(tensorflow) -
* The option to select data from other surveys is available only in
commercial projects (not in the free demo projects)
o=
Workflow cont’d:
Input log for 'Density’ Density M
28 ”Appfy Created training model" Input log for 'Gamma Ray' Gamma Ray v
WIndOW pOpS Up. Input log for 'Sonic' | Sonic w
. . Apply to [®] - * '3
29. Apply the trained model to a blind 0@ > Fo34 < =
well (not used in the training
O @& Fo3-2 =
process). Select FO2-1. 0 @ Fas-1 i
30. Keep default parameters. Type a new
Log name for the predicted lithology
|og “Litho Fake Predicted”. Extract between ' <Start of data> v <End of data> v
Log sampling Z Step (m) (0.1524
31. Press Run to continue. Log name for 'Litho_Fake' |Litho_Fake_Predicted -
O close
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Workflow cont’d:

& Manage Wells - a X
W]~ Filter * €3 [w- Log
s B~=. e
- -Impedance
QC results by displaying the predicted B~ I o medance.fe E'
log adjacent to the recorded log N s
+. | Density_BLI e
W g Litholog (10=sand 15=silt 20=silty shal | *
H Porosity from DEN DT GR ”
. A . +
32. Click on the Well Manager “! icon. : |
) % 5 ) X e (Gl b b Import...  Create ...
33. Select the blind well F02-1, Litho Fake @ [suctace coorainate: (evessi oo, canorze.on - 32336
R R - Reference Da vation [KB): 30.00m
and Litho_Fake_Predicted logs. S S s
et (o mrNeS, s, AP
gize: < 1 kB
34 CI|Ck on view IOgS. Last modified: Wed 21 Jul 2021, 13:53:07
o o e
= ol
(2]

Free space on disk: 64.69 GB

Workflow cont’d:

35. Compare the original vs predicted Predicted Litho log  Original Lithe log - Predicted Litho log - Original Litho log

litho-log.

Note: The missing parts at the top ; |

and base of the predicted log are 7

due to missing values in the input

logs. i

SRER . E=l
@
o] =
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Workflow cont’d:

4 Apply ‘Model_Litho_Keras(tensorflow)’ = u} X
If result is satisfactory, go back to the Input log for 'Density’ | Density o
previous step and Apply the trained Input log for 'Gamma Ray' Gamma Ray ~
model to all Wells Tnput log for 'Sonic” [Sonic -
Apply to [] - [* 1
S > F03-4 < =
& F02-1
36. Select All Wells. Keep default @ F03-2 o
parameters as indicated in the . &7 i
window. ’
37 Press Run tO Continue- Extract between <Start of data> v <End of data> v

Log sampling Z Step (m) |0.1524 |

Log name for 'Litho_Fake' |Litho_Fake_Predicted v

(SR ]l G
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2.6.3 Seismic Bodies - Supervised 3D

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

To predict seismic geo-bodies using the “Seismic bodies (supervised 3D)” tool which is part of the
machine learning plugin. In this exercise, we want to predict Chimney location.

Seismic data Preparation
Seismic need to be available in the survey. If not, import seismic, and interpret key
seismic bodies locations (e.g. Chimney yes, Chimney no), or use existing trained model.

ECTIETLT

Workflow:
Survey F3 Demo 2020

. . . e =
1. Open the Machine Learning Control Center with the ** icon. v LJEDEEE
|§ 1? Wells Horizon-based seismic facies
; = Seismic bodies (supervised 3D)
Seismic Image Segmentation
Seismic Image Regression

§ . ~ 49 2D Seismic
Seismic
Horizon-based seismic facies

2. Click on Seismic.

3. Select Seismic bodies (supervised 3D), and Hit Go. Seismic bodies (supenvised 20)
—_— Seismic Image Segmentation
,g' Seismic + Seismic Image Regression
‘LWeHs v Pre-trained models

UNet 3D Fault Predictor
UNet Fill Missing Traces

oy Neural UNet Supersample Bin Size
o  Networks

Using Internal Python 3.7.7

3 ol [(Guacata 1rain  asply
Workflow cont’d: oo O
Output Deep Learning Examgle Data O select [}

4. “Seismic Classification” window pops up. Select Input
Data in the “Extract Data” tab.

- "VU%\ : . Bxample data Locations. Surveys @
5. In the "Class Definition” window. Select @ icon in to
"Add Class Definition”.
£ Chose
6. In the “Select PointSet” window, Select the Survey
and the 15t Class Example Locations (e.g. Chimney yes).
7. Press OK in the “Specify Class Example Locations” ——
W|nd0W i Select PointSet @ 'F3 Demo 2020 - o X
Survey Data Root | C:\Surveys © select ..

Survey | F3_Demo_2020
F3_Demo_2020_20jul21

£ Specify Class Example Locations - o x F3_Demo_2020_old
Survey PointSets Locations ®
1 F3 Demo 2020 'Chimneys yes' 152 ~
]
S * @ )
[ 3D body =
=] [ 3D Body
[ Chimneys no ]
Class Name |Chimneys yes )
L] FFST
[Soc || Dcancel Dlgas
[ Inner points crassplot anomaly
[] Quter rim crossplot anomaly v

[esoo
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Workflow cont’d:

jth—ne;! o - 1|cn—ni?::m 152 - 1 s
8. In the “Deep Learning: Class Definition” Window, Hit
icon (@)|to add more PointSet. B[ Do
% Select PointSet @ 'F3 Demo 2020° - ] *
Survey Data Root | C:\Surveys © select ...
9. Inthe “Specify PointSet” window, Select the Survey Survey |F3_Dema_2020
and the 2" class example locations (e.g. Chimney Entivo v
no).
m] -~ * 1
10. Press OK in the “Specify Class Example Locations” 130 body ~=
. [13D Bod,
window.
L] Chimneys yes o
1 FrsT
[ gas
[] Inner points crossplot anomaly
[l Quter rim crossplot anomaly Y.
[E=] oo ©
- o x
Survey PointSets Locations ®
®
n
Class Name Chimnéys no
@ cancel
Workflow cont’d:
t2 Deep Leaming: Class Definition - a X
Class Example data Locations Surveys (©]
i 1 Chimneys yes [1] ‘Chimneys yes' 152 1 &
11. In the “Deep Learning: Class 2 Chimneys no [l'Chimneysno' 152 1 ®
Definition” window, Verify that the
default selected data are correct. &
Press Proceed [Input Data Selection]. Dcwse
« . . .. ” 2 Input seismics for prediction - current survey - o x
12. In the “Input Seismic for prediction e O B -
window, Select the appropriate 3D o= . 5
seismic cubes, and seismic attributes. T | A
2 Steering BG Detailed
[ 3 Steering BG Background [+ ]
13. Press OK. [ 3a Steering PCA111 MF225 "

[ 3b Steering FFT225 MF113
[] 4 Dip steered median filter
[ 5 ChimneyCube

[] 6 Whaeler-stratal-slicing

7a Al Cube Std

[[] 7b AI Cube from HorizonCube
[]] 8a PorasityCube from HC-NN
[[] 8b Gamma from HorizonCube
<

(o] (0o
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Workflow cont’d:

14. “Input Data” window pops up.

Input cubes can be modified. Keep the default
parameters as indicated in this window.

15. Specify a new name for the Ouiput Deep
Learning Example Data (e.g.
DI_Example_Chimney_st8x8x1674).

= Input Data - ] X
16. Press Proceed. Survey Input 1 Input 2 Input 3 Input 4 f
1 F3 Demo 2020 1 Original Seismics * 2 Steering BG Deta * 4 Dip steered medi - 7a Al Cube Std =]
Stepouts Inl: 8 % ‘Crl: 8 C‘ Z:16 7 Zstep(ms) |4
Edge/Gap Policy @ Exclude incomplete () Add data
Output Deep Learning Example Data |DLExampleﬁChimneyﬁsthleﬁZ*! | ~| © select ...

B 0o v @

Workflow cont'd: L | T 5

Tnput Deep Learnis le Data |DL_Example_Chimney_stBxx1674

Training Type [ New [ Resume (] Transfer

Output Deep Learning Madel | Model_Keras_Chimney

17. Train tab opens-up. Select one of the
learning algorithm (e.g. Keras-tensorflow) to
train the extracted examples data.

Different machine learning platforms and
parameters can be tested. Keep the defaults
parameters.

Model_Keras Chimney).

19. Press Run.

20. Once the computation is done, Close the ML
log window.

© select

[@oee | [ €releos

500
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Workflow cont’d:

21. Select the "Apply” tab. Check all selected

data Ok.

I Seismic Classification
Extract Data  Train  Apply

Survey Data Root | C:\Surveys

Survey | F3_Demo_2020
F3_Demo_2020_20jul21
F3_Demo_2020_old

*The Survey, Training model can be
modified here if necessary.

22. Press Proceed.

* The option to select data from other surveys is available only in commercial projects

- o x
| € salect ...
7
o
=

4.
G 0

Workflow cont’d:

23. In the “Apply created training model” window, Verify, all the default selected input 3D

cubes are correct.

a. To optimize computation time, Modify “Volume sub-selection” and set it to an
area of interest, where Chimneys have been interpreted (e.g. Inline range: 670-
710, Crossline range: 300-1250).

b. Specify a new name for the 3D output cubes: Classification, Chimney yes,
Chimney no, and Confidence.

24. Press Run to continue.

Ex Positions - o X
Specify Positions
Volume subselection Range |

Inline Range[670 2] 710
Crossline Range | 300 50
Time Range (ms) [0 2| 188 2

[Go | Bcarce @

£+ Apply Model_Keras Chimney’

Input Cube ['1 Original Seismics'] E 1 Original Seismics
Input Cube ['2 Steering BG Detalled] B 2 Steering BG Detailed
Input Cube ['4 Dip steered median filter'] E 4 Dip steered median filter

Input Cube ['7a Al Cube Std'] 7a Al Cube Std

Volume subselection |R: 670/300 - 710/1250. (463 sample)

Output prefix Model_Keras_Chimney
[ Output ‘Classification’ [| Chimney - Classification
[] Output 'Chimneys yes' || Chimney - Chimneys yes

[ Output 'Chimneys no' || Chimney - Chimneys no

Output 'Confidence’ | Chimney - Confidence
Batch size 32
£4] Predict using GPU

[-] Execute in Batch 4. Options ...

~ B select ...
~ ) select ...
- E select ...
- O Select ...

© Select ...

© Select ... | W CBYVS
| O Select ... WicBVS
© Select ... |WICBYVS
~| | select ... @

ciose
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Workflow cont’d:

25. When the processing is done, Close the
“Progress Viewer” and the “Apply Model”
windows.

Input Cube ['1 Original Seismics'] & 1 Original Seismics ~| © select ...
Input Cube ['2 Steering BG Detailed’] [ 2 Steering BG Detailed ~| © select ...
Input Cube ['4 Dip steered median filter'] & 4 Dip steered median filter ~| © select ...
Input Cube ['7a AI Cube std'] & 7a AI Cube std ~| © Select ...
Volume subselection R: 670/300 - 710/1250. (463 sample) © select ...
Output prefix | Model_Keras_Chimney v

[ Qutput ‘Classification’ | Chimney - Classification © select... ®CBVS v

[ Output 'Chimneys yes' | Chimney - Chimneys yes -| © select... ®cavs
[] Output ‘Chimneys no' | Chimney - Chimneys no | © Select... =CBVS o
(] Qutput 'Confidence’ | Chimney - Confidence © select... ®CBVS >

Batch size 32

[ Predict using GPU

[ Execute in Batch 4,k Options ..
Workflow cont'd: & Seet -2
Select first layer
Filter |*
QC results: display the predicted ® Stored 1 Original Seismics ~
i ili ) . 4 Dip steered median filter
Chimney Yes probability 3D cube O Steering e
Attributes 7a Al Cube Std
. . . 7b AI Cube from HorizonCube
26. Right Click on the: Scene > Inline > Add 5 e v
< >
and select Data.
[

27. Select the predicted 3D Chimney location Dcancel @
probability (e.g. Chimney_yes), and overlay @ select - 0o X
the seismic (e.g. 1 Criginal Seismic). Select first layer

. R L Filter |*
Modify the Inline number to be within the
. t @ Stored BLI Vs -
|npU range' O Steerin Chimney - Chimneys no
EELIL Chimney - Chimneys yes

28. Right-click on the Inline number, and Type bz C:im"ev'ﬂ'aﬁ:éﬁca”m
in the Inline field: inindss0 2} S e e e e ¥

< >

0 Cancel 9
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Workflow cont’d:

QC results: display the

predicted Chimney and overlay the original seismic on in-line 690.

1200

Tree scene 1 -]
Elements Color ™
Scene 1
v N In-line
v [1690
5 ChimneyCube -
1 Original Seismics 11

i Cross-line

¥ Z-slice

® volume

¢~ Random Line
(% 2D Line

@ 3D Horizon
~4 2D Horizon

~ Fault

W Faultset
FaultStickSet

¥ Shapefile

& Prestack Events
> Annntatinons

<

In-line: 690
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2.6.4 Seismic Unet 3D Fault Predictor

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

To predict fault’s location using the “ Seismic — Pre-trained models - Unet 3D Fault Predictor” tool
which is part of the machine learning plugin. In this exercise, we want to predict faults location.

Seismic data Preparation
Seismic need to be available in the survey. If not, import seismic, and interpret some
“key fault” locations or use an existing trained model.

el DE R L

Workflow: Survey |F3 Demo 2020
E v B0 3D Seismic
. . . — | Horizon-based seismic facies
1. Open the Machine Learning Control Center with the #* LT Seismic bodies (supervised 30)

Seismic Image Segmentation

icon' Seismic Image Regression
ﬁ — v 29 2D Seismic
. . . Horizon-based seismic facies
2. C|Ick on Se|Sm|C Seismic bodies (supervised 20)
Seismic Image Segmentation
. sl Seismic + Seismic Image Regression
3. Select the "Pre-trained models — Unet 3D Fault w» LS Wels v F’f
Predfctor” and H|t GO. UNet Fill Missing Traces
& nNeural UNet Supersample Bin Size
: ® Networks
€ Close 0
Workflow cont’d: B
Input Cube ['Seismic Data'] ~| | © select ...
4. “Apply Unet 3D Fault Predictor” window Apply veriap (%) [In: 10 5] |0 10 (5] [z 10 &
pops up. Volume subselection Al © select ...
Output 'FauItVDIume' ©) Select ...| | CBVS v
5. Select Input Cube (e.g. 4 Dip steered [ Predict using cou
median filter). Use a volume subselection =) Execute In Batch |44k Options ...
to optimize the processing time. o

6. Specify a new name for the “Output
Fault Volume to Cube” (e.g.
Fault_Prob_Unet).

Try running the prediction without the GPU, if it
fails, as a result of lack of memory.

7. Hit Run.

8. When the processing finish, Press
button © to close the Progress Viewer
window.

arning Applier'

srocessing finished successfully
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Workflow cont’d: °

Select first layer
Filter |*

® Stored Chimney - Confidence
Fault_Likelihood_Thinned_from_DSMF_seis

) | O stoering
QC the output fault probability results on the In-line 680. )| e

Velocity model (RMS;
™y locity moded (RMS)

[

9. Right Mouse click on In-line > Add and select Data

> Store. Select the created Fault Probability cube w= QD:_ mj =
(e.g. Fault_Prob_Unet_In680), and Hit OK. 8 = i == Irinqalic B
_Tree scene 1
10. Type in the Inline field: 680, and Hit Enter. el Coler
v 4§ In-line
The same way, add to the display, the existing Thinned v %m_h

likelihood probability display.

11. Right-Click on Inline 680 > Add > Attribute
>Stored. Select the existing thinned fault likelihood
(e.g. Fault_Likelihood_Thinned_from_DSMF _seis),

Attribut -aul
and Hit OK. » Yty met (87
Qo @

Tree scene 1
Elements Colol

Scene 1
v W Inline

v [4680

] Fau\t_LIkeI\ho(xj_Tmmed_fmm_DSMF_se\* -

FTFauN_Prob_onet o

Workflow cont’d:

Predicted fault probability (un-thinned)

¥y Saj S S L& WY

12. Display the predicted fault probability, and
Compare with the thinned fault likelihood.

Time

Note:

The thinned fault likelihood, contains more small
faults and noise. Whereas the predicted fault
probability, contains more faults information and
less noise.

The predicted fault probability is un-thinned.
To be able to make a fair comparison with the
thinned fault likelihood, a thinning needs fo be
applied to the predicted fault probability
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Workflow cont’d:

The next step, is to apply a thinning to the
predicted fault probability.

13. Select: faults and fractures > 3D icon &

m

I - R

-

=
f& Faults and Fractures 3D Control Center - (m] X
14. The Faults and Fractures 3D Control Center Avalable Fitors
window POpS up. Select Filters > Atibutes | |CIPsteered Madian Pier
Skeletonization. Ridg Enbmcare ke
Skeletonization
15. Press Go. i f Filters
‘m} Planes
% Tools
@ e
Workflow cont'd:
& Volume Skeletonization - o X
Input Volume ‘& © Select ...
16. The Volume Skeletonization window pops Volume subselection (690/200-680/1250 (463 samples) © seect..
up. Apply along Inline -
Thrcshold . &
17. Set the parameters as specified in the feeppliestore ¥ D1
Window OuluulCubelThmned_?t_wob_Unel_I()&O_mweshuld I OSelect . | CBVS

a. Volume subselection: Inline range = 680
b. Threshold: 0.5
c. Type a new name for the “"Output
Cube” e.g.
Thinned_ft_prob_Unet 1680 _threshold”

18. Hit Run.

19. The Progress Viewer window pops up.

Once the computation is done, Hit Close

icon [n

i+ Execution Options ...

0w @
a7

Thinning
. 100%

Finished: Thu 22 Jul 2021,
dTect V6.6

13:12:59

Process: 'Attribute volume writer'

2021, 13

Started: Thu 22 Jul :12:55

t_I680_threshold'
5% (364.364(5) (25)
%

Attribute volume writer'
w22 Jul 2021, 13:12:59

End of process: 'Attribute volume writer'

Finished writing output volume to disk at: Thu 22 Jul 2021, 13:12:59

Finished batch processing.

Processing finished successfully.
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20.

21.

Workflow cont’d:

Display: the new thinned predicted fault
probability. Right mouse click on the Inline 680
> Add > Attributes. Select the new thinned
predicted fault probability (e.g.
Thinned_ft_prob_Unet 1680 threshold). Please
make note the name should not contains
characters like ‘.’

Compare with the existing thinned fault likelihood.

Notice that the thinned fault likelihood, contains
more small faults and noise, whereas the thinned
predicted fault probability, output more faults
information and less noise.

Thinned predicted fault probability
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2.6.5 3D Seismic and Wells RockProperty

Prediction

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

To predict rock property using the 3D Seismic + Wells, Rock Property Prediction tool which is part
of the Machine Learning plugin. In this exercise, we want to predict a Porosity cube.

Well data Preparation

Seismic (and/or attributes) and Well(s) need to be available in the survey. If not, import
seismic and wells (track, logs, markers, time-depth curve or checkshot).

2. Click on Seismic + Wells > 3D Seismic

Workflow: “Rlndita

1. Open the Machine Learning Control Center with the = icon .

Survey |F3 Demo 2020

@R R

g " Prohosvmein]
=% Wells Rock Property Prediction
H

3. Select Rock Property Prediction, and Hit Go. ﬁ —
= Seismic +
..LWeIIs
: - Neural
o  Networks
€3 Close 0
Using Internal Python 3.7.7
Workflow cont’d: o
=In| Data= -—g Select ...
4, “Prediction from seismic” window pops up. Press
Select - Input Data. Lot '
5. Select @] icon in the “Target Log Definition”.
The “ Specify Log Data to predict” window pops up.
€ 0lose
6. Select: Survey*, Target Log (e.g. Porosity), and Wells
that will be used for the data extraction, as indicated in the
window. S| 0
The well FO2-1 is not selected, and will be used as a i T O solect..
blind well. Survey |F3_Demo 2020
F3_Demo_2020_20jul21
F3_Demo_2020_old
7. Press OK.
Target Log
=] - * i
F02-1 =
[/l Fo3-2
[ Fo3-4 a
] FO6-1 [0}
* The option to select data from other surveys is available only in commercial projects
@ok|  Scancel
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Workflow cont’d:

3 Deep Leamning: Target Log Definition
Survey
1 F3 Demo 2020

8. Deep Learning: Target Log definition
window pops-up.

*A new data selection from different
survey can be added by clicking on @

i

In the “Input seismic for prediction” window,
Select a suitable 3D data to use as input for
the training e.g. RMS attribute, Q Factor
attribute, Instantaneous phase attribute,
Dominant frequency attribute, Seismic
volume etc.

Input Seismics ® Specify now O
Use 3D data
® - *

=

[J 5 ChimneyCube

[+] 7a Al Cube Std

10. Press OK.

* The option to select data from other surveys is available only in commercial projects

[ 1 Original Seismics A
[] 2 Steering BG Detailed

[ 3 Steering BG Background

[] 3a Steering PCA111 MF225

] 3b Steering FFT225 MF113
|/ 4 Dip steered median filter

[ 6 Wheeler-stratal-slicing

tom HorizonCu

- [m) x
Log Name Wells
Porasity [3] 'F03-2', 'FO3-4' and 'FO6-1" ol
=
o

|°p.oceed [Input Data Selection] >3| €3 Close

Read Saved Setup

O

Workflow cont’d:

11. “The Input Data” window pops up.

Input data can be modified using the drop down selection.
Keep the default parameters as indicated in this window.

12. Specify a new name for the Output Deep Learning Example
Data (e.g. DL_Example_Data_Porosity_stOx0x16z4).

% Input Data

13. Press Proceed.

Survey
1 F3 Demo 2020

Input 1
4 Dip steered medi ~

Extract between | <Start of data>

Log sampling Z Step (m) [2

Input 2

7a Al Cube Std

<End of data>

Stepouts Inl: 0 <

Edge/Gap Policy @ Exclude incomplete O Add data

v

cl:0 3|[z:16 2] Zstep(ms) 4

Output Deep Learning Example Data DLExample,Data,Dorosity,stUxDx16z4 |

[Bproceed > ]| | @ close

| O Select ...

- Apply @
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Workflow cont’d:

[=| x

2 DIL_Example_Data_Porosity_stOx0x1 O select ... ’
O select ... It

14. The Train tab gets activated. Train the extracted —
examples data using the default learning =
algorithm Scikit-learn (Ensemble: Random =
Forests).

Different machine learning platforms

and parameters can be tested.

Keep the default parameters for this

exercise. i Qo @

15. Specify a new Output model name e.g. T mmm——

Porosity_Model_SL_RandomForests. vt e e Mot ooy, it S1_sandomres (@ st ] &

o

°

16. Press Run. =
Dciose @

Workflow cont’d: )

17. Hit Close in the “Machine Learning training log” o
window, when the processing finishes.

18. The Apply tab get activated. The Survey, Training ot : - .
model can be modified here. Keep the default e
selection as indicated in the window. Press P -t
Proceed Survey Data Root | C:\Surveys © select ...

Porosity_Model_SL_RandomForests:

) 16:09:55

[Ermesi>] Qoe @
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Workflow cont’d:

% Apply Porosity_Model_SL_RandomForests’ - a x
Inputmhe['40upstee-edmaduanﬁltev'] 4 Dip steered median filter ~ O Select ...
TInput Cube ['7a Al Cube Std'] 7a Al Cube Std ~ Select .
19. The "App|y created training model” Volume subselection |R: 362/300 - 362/1250. (463 sample) @
window pops up. App|y first the Output 'Porosity’ [Porosity_Predicted_ML_RandomForest: - | € Select .. @cevs -
trained model on 1 Inline. &2 Bomcute notch {5 Optios ..
Dciose
20. In the volume sub-selection, Select — o
Inllne_range 362._Choose an Inline ety Postions
crossing a well with porosity log e.g. . T 1=l
F02-1. N TG
Crossline Range 1250
21. Hit OK Time Range (ms) 1848
22. Inthe “Apply the trained model”, O @
Keep default parameters, Specify a
new name for the output porosity to S Appy Forasity Model SL RendomForess - o x
Cube (eg POrOSity_PrediCted_ML Input Cube [4 Dip steered median filter'] 4 Dip steered median filter | O select ...
RandomForests). Input Cube ['7a AI Cube Std') 7a Al Cube Std ~| © Select ...
- Volume subselection [R: 362/300 - 362/1250. (463 sample) © select ...
23. Press Run to Contlnue Output 'Porosity’ |[Porosity_Predicted ML_RandomForest: - © Select ... @ cBVS ~

Execute in Batch 4,4 Options ...

(S oo

Workflow cont’d:

When the computation finishes, close the Progress
viewer window.

QC results by displaying the predicted Porosity on o Select Layer3 7
the test Inline (e.g. 362) and overlay the crossing Fiter [+
well FO2-1, with the porosity log. R i e T rom DeNE sl B
S Porasity_Predicted_ML_RandomForests
Attributes . Thinned_ft_prob_Unet_I680_threshold
24. Right Mouse Click on the Inline folder > Add ™y i i)
Default Data e.g. Deep Steered Median Filter. :
Type: 362 in the In-line field Change the In-line O @
N0 10 362 inind32 = [o2s [ Wos | mwPorosity

25. Right Mouse Click on the In-line 362 > Add >
Attributes. Select under Stored the new
predicted porosity (e.g.
Porosity Predicted ML_RandomForests), and ™
Hit OK.

26. Modify the Porosity colour limit to (0.25-0.35)
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L] .
Workflow cont’d: @ select Wells - o x

Select Input Wells

=] - Filter |*

27. Right Mouse Click on the well folder> Add, l:g;; =)
Select the well FO2-1, Hit Ok. TR =
[J Fo6-1 oW

28. Right Mouse Click on the Well F02-1 > Display
> Properties, Select Porosity log, Change the
color bar to Porosity. Modify the Porosity color

range similar to the predicted porosity cube Qoncel| @
range (0.25 _ 0.35). ...veys\F3_Demo_2020\WellInfo\F02-1.well

29. Apply to All Wells, and Hit Close.

1@ Display properties o F02-1 - D x
0.25 0.35 | ENPorosity In-Iin' leftlop Centerlog Rightlog Markers Track
Select log Porosity ~
Specify data range ~| O Aip

Log range (min/max) 0.257652 | 0407561 | (] Logarithmic

Style (] Well log [ Seismic [-] Log tube

Line thickness |1 &
Line color [ =B -
Fill Left of log ~ [ single color
Fill vith | Porosity ~| I flip color table
1 Porosity “los s
Log display width (m) 30 |

Apply Current to all wells  Reset all

[ Save as Default Wsave [DCose | wReset @
I 4. R
Workflow cont’d: 2 Pestions - o x
Specify Positions
Volume subsslection [Range - !Jjﬂ
Inline Range [100 = |750 5

Crossline Range [300 =] [1250 =]

If result is satisfactory, go back to the previous
Step and Apply the trained model to the entire

survey. ok I € cancel ‘ @ Help [

30. Go back to the Apply tab > Volume sub-
selection > In-line range and reset of the
entire range.

Time Range (ms) [0 - 188 =

31. Keep all other default parameters and
Press Run to continue.

Py Apply ‘Porosity_Model_SL_RandomForests’ - O X
Input Cube ['4 Dip steered median filter'] = 4 Dip steered median filter v | |6 Select ..
Tnput Cube ['7a AT Cube Std'] 7a AI Cube Std ~| |© select ...

Volume subselection IAII | ) Select ...

Output *Porosity’ | Porosity_Predicted_ML_RandomForests | € Select ... &) CBVS v

Execute in Batch < Options ...

| @run | Sciose
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2.6.6 Seismic Image to Image - Fault Pre-
diction

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

To predict seismic features using the Seismic Image to Image workflow in the machine learning
plugin. In this exercise, we will predict fault locations from seismic data.

Warning 1: To predict real faults use the pre-trained U-Net fault predictor

In this exercise we train a U-Net to predict faults from pre-processed seismic input. The input is
Edge-Preserved Smoothed (EPS) seismic data. The target is a mask volume with ones (faults)
and zeros (no-faults) that was created from Thinned Fault Likelihood (TFL) computed from the
EPS volume. Note that from a geoscience perspective this is not a meaningful exercise because
we do not need a machine learning model to predict a desired outcome that can be computed
directly with an algorithm. The main purpose of this exercise is to learn how to run image-to-
image workflows.

' l '<V// m."/}’l

Input EPS* seismic Target mask (0,1) of TFL* from EPS

*EPS and TFL-mask are NOT delivered with F3. To replicate this workflow first create EFS and TFL (from EPS) in the Faults &
Fractures plugin. Next create a mask from TFL with the mathematics attribute using this formula: TFL> 0.01 27 1:0

Exercise objective:

Warning 2: heavy GPU requirements
In this exercise we create 1008 cubelets of
128x128x128 samples. These cubelets are
extracted from half the input - and target volumes. Al
The trained U-Net is applied to the full volume.
Application is very fast (minutes) but training takes
several hours on a GPU. The graphics card we
used is a Nvidia GeForce RTX 2080 Ti with 11 GB Survey |F3 Demo 2020

et HE RS

£ Machine Learning Contrel Center - [m} X

DDR6 memory. In principle the exercise can also B v "’SD Seis";‘csed e
. w OriZon-ba: selsmic racies
be run on a CPU but then training may take |§ Wl Seismic bodies (supervised 30)
several days. Seismic Image Segmentation
\\"“: e v 20 2D Seismic
Workflow: : Horizon-based seismic facies
Seismic bodies (supervised 2D)
. . — Seismic Image Segmentation
1. O.pen the chhme Learning Control Center B2 scomic + Seismic Image Regression
W|th the E-“, Icon. Wells ~ Pre-trained models
UNet 3D Fault Predictor
- - . UNet Fill Missing Traces
2' CIICK on Sersm.lc. : . Neural UNet Supersample Bin Size
pe Networks
3. Select Seismic Image to Image, and Hit Go. 2
°
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Workflow cont’d:

4. Seismic Image Transformation window pops up.

5. Select Target Data in the Extract Data tab. Click @
on the target data specification.

6. Inthe Select target image seismic window, Select
the Survey and the target cube
TFL_from_EPS_mask

Use O 2D data

@ 3D data

Survey Data Root |fauto/d25/surveys © Select

Survey[ E3 Demo 2010 =

F3_Demo_Deptn 626

9_d25
2019 _Depth_d35
Decimated 2019 d25 =l

Timesot [
original Seismic e 300 e
P-Impedance log cubes
Predicted facies a
Steering BG Detailed
TFL from EPS i
T rom EPS_mask
=t
TFLV6.2
imp Zeros 244 =

Volume subselection |R: 1001300 - 7501250 (463 sample)

Comoms T s

<Input Data>

Output Deep Leaming Example Data

Seisric Data Survey @

oo ota Slection] 55| | €3 Cose

- Ddee @

Workflow cont’d:

7. The Deep Learning: Target Seismics
Definition window pops up.

8. Press Proceed [input Data Selection]

*Additional seismic attributes can be added using the J@l icon . Keep the defaults data. ‘

Deep Learning: Target Seismics Definition

Seismic Data

UTFL_from_EPS_mask F3_Demo_2018

Survey

| @ Proceed [Input Data Selection] >> | €) Ciose

* The option to select data from other surveys is available only in commercial projects ‘
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Workflow cont’d:

9. Select Edge Preserved Smoothed as
input seismic to be used for the prediction

10. Press OK

Input seismics for prediction - current survey

| - " Time Sort ~ § #
7a Al Cube Std 4=
8a PorosityCube from HC-NN
9-8 UVQ6 Hor 4-8 segment J =
Edge Preserved Smoothing line 300

[ v/ Edge_Preserved_Smoothed | E

1l

Gamma Ray log cube from well FO6-1

GR with undef

GR+zeros |

& ok €) cancel

Workflow cont’d:

11. In the Input Data window set the Image dimensions of the cubelets to 128 x 128 x 128
samples. Note: to extract 2D images set one of the dimensions to 0.

12. Specify the Inline, Crossline, Time Ranges and the corresponding Overlap* percentages
to such that we extract approx. 1000 cubelets from one half of the input and target
volumes (see image for specifications).

13. Specify a name for the Ouiput Deep Learning Example Data (e.g.
ML _train_data EPS2TFL_128x128x128) and press Proceed.

2 Input Data v oA °
Survey Input 1 >
1F3_Demo_2018 Edge Preserved Smoothed - d
Images Dimensions |Inl: 128 *| | Cn: 128 =] |Z: 128
Inline Range | 100 2| |425 =| Step |1 = Overlap (%) | 70
Crossline Range | 300 *| [1250 <| Step |1 +| Overlap (%) |60 = 1 Number of |1
Time Range (ms) |0 ~| (1848 2| step |4 Overlap (%) | 60 ~| fStep |204 Number of |8
Total number of Images |1008

Qutput Deep Leaming Example Datal ata EPS2TFL_128x128x128 ~ e Select ...

*Qverlap: if the number of examples that can be extracted from a given range and overlap does not fit exactly, the last example
is extracted from the boundary backwards.
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Example cubelets. Dimensions are: 128 x 128 x 128 samples

Input: EPS

Target: TFL mask (1= fault, 0 = no fault)

Workflow cont’d:

Extract Data | Train | Apply

. . Input Deep Learing Example Data | ML_train_data_EPS2TFL_L: - | | @ Select . )
14. Specify the Ouitput Deep Learning Model T IS R r—
name (e.g. ML_U-

Net_EPS2TFL_1 28x1 28X1 28) Output Deep Leaming Model et_EPS2TFL_128x128x128 -

© Select .

[B) ==

-
.

15. In the Train tab, Select Keras (tensorflow) as r':::‘“:'m':’;:;""“‘ a3
Machine learning platform

v %)

Parameters

16. Select the Parameters tab L=

The machine learning plugin supports two
platforms: Keras (tensorflow) for deep
learning (convolutional neural networks) and
Scikit Learn for all sorts of other machine
learning models (e.g. Random Forests).
Supported models and training parameters
are specified in the Parameters tab.

@ Proceed >> | | € Close @ rep
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Workflow cont’d:

17. In the Parameters tab Select Type U-
Net

18. Set Baich Size to 2. A U-Net needs a lot
of GPU memory in the training phase. If
memory is exceeded, training stops with
an error message. You can then try to
rerun with a smaller batch size. Try with
the largest possible batch size as
training performance increases with
batch size.

19. Set the number of Epochs to 100 (this is
the number of training cycles through all
examples that are offered in batches of

Extract Data | Train

Apply

Input Deep Leaming Example Data | ML_train_data_EPS2TFL_L: ~

Seismic Image Transformation

Training Type v New

Output Deep Learning Model Jet_EPS2TFL_128x128x128 ~

Parameters

Type
[ e "]
Batch Size

2 v
Epochs: 100 |
Patience: 50

Initial Learning Rate (%): 10

Epoch drop (%): 33.33

© Select ]

Resume Transfer

© Select

@) =

-
-

B0

Batch Size). —
Back
20. Set Patience to 50. This parameter
avoids early stopping when the error
does not decrease after this number of
EpOChS' © ciose @ rep
21. Go back to the Training tab.
Workflow cont’d:
22. In the Training tab Press Run Training | Pasameters

23. The Machine Learning training log
window pops up. This window can also
be started by pressing the f=3| icon.
Press Reload to refresh.

Machine leamning platform:
Keras (tensorflow)

Parameters

£500 JE

24. TensorBoard, a program to examine
models and track training performance
is started automatically in a browser.

127/201 [mm
1281201 [um
129/201 [mm

141/201 [um
142/201 [am
143/201 [smanamsasnassaasss

Machine Learning training log

ETA: 1:46
-ETA: 1:4d -
-ETA: 1:43 -

1088:
Ioss:
I083:
I0ss:

.]- ETA: 1:33 - loss:
ETA: 1,32 - loss:
.]- ETA: 1:31 - loss:

> onnes] - ETA 1:17 - loss
| ETA: 1:16 - loss:

..] - ETA: 1:50 - loss: 0.1290 - accuracy: 0.3462
ETA: 1:48 - loss: 0.1286
)~ ETA; 1:47 - loss: 0,1286

- loss: 0.1280 -
loss: 0.1280

ss: 0.1277

:0.1270 -

acouracy: 0.3611

accuracy: 0.3556

accuracy: 0.3600
accuracy: 0.3647
accuracy: 0.3689
acecuracy: 0.3734
accuracy: 0.3775
accuracy: 0.3816
accuracy: 0.3856
accuracy: 0.3897
accuracy: 0,3937
accuracy: 0.3977
accuracy: 0.4014
accuracy: 0.4053
accuracy: 0.4090
accuracy: 0.4127

0.1286
0.1262 -
0.1283 -
0.1280

0.1279

01276

0.1276

01273

273

1272 -
1270 - accuracy: 0.4164
accuracy: 0.4200
accuracy: 0.4235
accuracy: 0.4269
accuracy: 0.4303
accuracy: 0.4337
1266 - accuracy: 0.4370
0.1266 - accuracy: 0.4402
0,1266 - accuracy: 0.4434

=

0.1268 -
1268
1267 -
1267
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Workflow cont’d:

Seismic Image Transformation

Exitract Data | Train | Apply
Survey Data Rool | /autolg25/surveys - | © Select

25. When training is finished, Select the Suvey e Bepth 6.25 =
Appfy tab :.:Esz_a:a_uﬁz?_nzan; M1996A
Maui-NZ_Channels_2018
MOL_Chimney_2019_d25
MOL_Chimney_2019 Depih_d25

26. Select the trained model ML_U- MOl w205
MySurvey

Net EPS2TFL_ 128x128x128 and Press MySunvey2

NexenUK_Buzzard-4D-OBN_2017

Proceed OGDCL_Fatehpur_Ladhana_Blocks_2018 NH

Penobscot_2D_Workfiow_Flattened06

Lo

Time Sot 4 §

ML_U-Net EPS2TFL_128x128x128
TL_U e _SESZTFL_IZEX 128X 128

=i -2l

1YPe SeISMIC IMage | FanSIoMmanon,
Data Type: 3D Volume.

Number of inputs: 1

Qutput: TFL_from_EPS_mask

Created by: cases.

Created al: Fri 08 May 2020, 11:11:57.
Last Modified: Fri 08 May 2020, 12:28:33.
Object ID: 100060.61

O | O

Workflow cont’d:

27. In the Apply window Select the Input Cube Edge Preserved_Smoothed.

28. Specify the Output Cube name that will be created by the trained model, e.g. ML_U-
Net_TFL_prediction.

29. Press Run to start processing.

*
Input Cube [Edge_Preserved_Smoothed] | Edge_Preserved_Smoothed —| © select ...
Apply Overlap (%) |Inl: 10 ~| [Cr: 10 | |Z:10 =
Volume subselection |R: 100/300 - 750/1250. (463 sample) e Select ..
Output TFL_from_EPS_mask' to Cube | ML_U-Net_TFL_prediction - | © select . ™ CBVS = W

v| Execute in Batch | £} Options ...

=

-423 -




Workflow cont’d:

TISEYS7 8T TSMTIUST =]
(38.974/3) (4m:57s)
(35.818/3) (4m: 453}
(31.977/3) (Sm: 408}
(32.208/2) (4m:3ls)
(38.037/8) (4m:158)
(35.885/8) (3m:558)
(32.626/3) (4m:323)
(35.888/3) (3m:308)
(39.657/3) (3m:18s)
(32.601/3) (3m: 463}
(41.071/8) (2m: 478}
(40.578/3) (2m:37s)
(36.023/3) (2m: 433}
(40.634/3) (2m:128)
(41.354/3) (Im:58s)
(36.046/3) (2m:1s)
(35.882/3) (im:373)
(33.960/2) (m: 398}

30. A Progress Viewer window pops up. Applying
the trained U-Net is very fast. The resulting
fault prediction can be viewed e.g. as overlay
on the EPS of inline 425.

Process: 'Deep Learning Applier’
Finisned: Mon 06 Apr 2020, 00:07:06

End of process: 'Deep Learning Applier’
Finished batch processing.

Processing finished successiull

Inline 500 EPS + TFL mask Inline 500 EPS + U-Net Prediction
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2.6.7 Seismic Image Regression (Unet) - Fill
Seismic Traces

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

To fill blank seismic traces using the ‘Seismic Image Regression’ workflow which is part of the
machine learning plugin. The model will have to learn how to recreate an image from example
images containing blank traces. Therefore, we need an input data set in which we have
deliberately blanked some of the traces.

For the purpose of this exercise:

«  We use OpendTect’s attribute engine to
randomly blank +/- 33% of all traces

+  We select examples from one side of the
volume for training the U-Net

+  We apply the trained U-Net to the full
volume, so that we can validate the
interpolation results in the blind test zone

B T

Note: In this exercise we train a 2D Unet but you can equally well train a 3D Unet. The differences between 2D and 3D Unets are
as follows:

1. A 2D model trains much faster (hours vs days)

2. 2D models can be trained on workstations with less GPU / CPU capacity

3. Interpolation results are comparable although 2D interpolation may introduce some striping (like a footprint)

4. Application of a trained 3D model is much faster than a trained 2D model (minutes vs hours)

Randomly blank traces workflow:

To train our 2D Unet regression model we create a data set with 33% randomly blanked traces.
From this cube we extract examples for fraining in a restricted area. The trained model is
applied to the entire volume, whereby the area from which no examples are extracted acts as
blind test area. The real value is of course when we apply the trained model to an area with
real missing traces (which we don’t have in this case). Random blanking (replacing the values
with hard zeros) is done in OpendTect’s Attribute engine and can be done in different ways. In
this case, we will create an attribute set to perform the following tasks:

1. Math attribute with formula: “randg(1)”. This generates random values with a Gaussian
distribution and 1 standard deviation;

2. Apply this attribute to a horizon and save as horizon data;

3. Horizon attribute that retrieves the random values from the saved horizon data. A Horizon
attribute replaces a value at an inline, crossline position with the value extracted from the
given horizon;

4. Math attribute with formula: “abs(value)> 1 ? 0: seis”. We assign the retrieved horizon data
to the variable “value” and the seismic data to “seis”. This attribute assigns values larger
than the absolute value of 1 standard deviation to zero while all other values are given the
value of the seismic data.

5. Additional attributes in the set are used to compare/QC results before and after prediction.
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Randomly blank traces workflow:

Create a new 3D attribute set to randomly blank traces as explained in the following steps.

@ Atibute Set 2D

e
O-wetsEHR Bk

Attritute st <nek saved> <All> - Mathematics SRk AR~
MathFunctions st (Squareroot) ~ | Inset | il |
Formul (like ‘naarstk: + o) * farstk') Set
1. Select the 3D Attributes engine al icon.
2. Create a new 3D attribute set_|
These attributes that will be explained in the
next steps.
3. Save as attribute set @ with the name
‘ML_Random_holes_interpolation’.
i e
T (@] @
Attribute set | wm1._Random_holes_interpolation
random
Retrieve horizon data
Seismic with random missing traces as zeros
difference
Gain_corrected_Filled_Seis_[1425
Gain_corrected seismic
difference between gain corrected seis and ML pred
Randomly blank traces workflow:
4. Create 1¢' attribute with name - e
‘random’ as indicated in the attribute An,,mmfa;m}:mf,’ﬁt"* = e T
set window and Hit ‘Add as new'. - T —— = * W
E random missing | Formula (like ‘nearstk + c0 * farstk’) [randg(1 ) £
difference
5. Set Math attribute with formula: e
“randg(1)”. .
This generates random values with a
Gaussian distribution and 1 standard
deviation:; -
o
Apply this attribute to an horizon and
save as horizon data as indicated in
the next step.
< > Attribute Name |random Addasnew [l
I save on Clase 2]
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Randomly blank traces workflow:

Create a seismic horizon at Z = 1 s. Then apply the random attribute to this horizon and save this
as horizon data. This horizon data will be used in the attribute that does the actual blanking.

6. Create a constant seismic horizon at Z = 1s.

7. Right mouse click on the 3D Horizon < New < With
constant Z.

Output 30 Hoetzon [fire—Ts]

8. Enter Z value (ms)= 1000. Type an Output 3D Horizon e B s
name e.g. Hrz_1s. Hit Create. Dt = -
'Ié rza::' Sel;:l Attribute
9. Display the horizon — attribute ‘random’. Save as D2DU ey
Horizon data. ) e
@ Body = Remove

A B AR PN BT DAL

Randomly blank traces workflow:

Create an horizon attribute that retrieves the random values from the saved horizon data. The
horizon attribute replaces a value at an inline, crossline position with the value extracted from the
given horizon.

10. Create 2" attribute “Retrieve horizon data”
as indicated in the attribute set window and Hit
‘Add as new’.

O st
O sohect ..

11. Select the Input Data that will be blanked ‘4
Dip steered Median filter’.

12. Select the constant horizon “"Hrz_1s” created
in the previous step.

+
L]
E]

13. Select Output “"Horizon Data” and Horizon
Data “random”.

Attt Namme [Retrieve artzon dta Al e [l e
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Randomly blank traces workflow:

Create an attribute that will randomly blank traces as zeros in the input seismic.

14. Create 3" attribute ‘Seismic with random missing
traces as zeros’ as indicated in the attribute set

window and Hit ‘Add as new’. AW VO

Adtribuite set | Random holes. wobin: Basic Mathematics ?

random attewncnons | o (sowsa ooty +| | weert | [ |
15. Set a Math attribute with formula: “abs(value)> 1 s o om0 - 102 =
? 0: seis”. This assign the retrieved horizon data to s bl

the variable “value” and the seismic data to “seis”.
This attribute assigns values larger than the absolute
value of 1 standard deviation to zero while all other
values are given the value of the seismic data.

| =«=

16. Select the previously created attribute ‘Retrieve
Horizon Data’ in the ‘For Horizon to use’'.

it Karme Seisic with random missing traces as zevos | |Ackd o rew (18] e

2 sove on o [Eo=]@

17. Select the seismic you wish to blank in the ‘seis’
(e.g. 4_Dip steered median filter).
Blank traces workflow cont’d: cements color
Seene 1
S; ‘ . Add Default Data
Bl & . AddandSelectData .. N
= . 1 Add at well Location ...
A | Add Color Blended
& Select - o 'S
Select first layer
Filker |*
O Stored f;ﬂuom X .
18. Display the new seismic attribute with S T
blanked traces. Right mouse click on the B [t o

difference between gain corrected seis and ML pred

In-line. Select "Add and Select Data”

19. Select the attribute “Seismic with
random missing traces as zeros” and Hit Ok.

Notice that random traces have been
blanked.
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Blank traces workflow cont’d :

20. Select, "Create a Seismic Output” from the
attribute — Seismic with random missing traces as
ZEeros.

21. In the "Create Single Attribute Volume” window,
keep the default parameters. Type an Output name
(e.g. Seismic with random missing traces as zeros)
and Run.

22. Close the progress window when the processing
finish

23. Display/QC the created seismic

This seismic will be used as input for the next step, ML
Seismic Image Regression prediction.

Processing  Stene View ilites Teraliubis  Help

Create Seismic Ouipt * Attributes b e Single Atribute kD
Create Horizon Output  * D<=>3 ) Muit Attribute Volume ... D |
m =l

s 05 2eros ] |©) Select

Valuine subsedoction [100/300-750/1250 (46: ) © selest ..

‘Quantity to output | Seismi with randam o

Null traces @ Discard Pass
] 5cala values:  Shit
Output Cube |Seismic with random missing traces as zeros - | ) Select .. | CBVS

Balch execution Single rocess {4 Options ...

Grn | Do @

Processing finished sucoessfully.

Exercise objective:

To fill blank seismic traces using the ‘Seismic Image Regression” tool which is part of the machine
learning plugin. The model will have to learn how to recreate an image from example images

containing blank traces.

Workflow:

1. Open the Machine Learning Control Center with the % Ehind H el DL LIS

icon.
2. Click on Seismic.

3. Select the ‘Seismic Image Regression” and Hit Go.

5 Machine Learming Control Center — o *

Survey |F3 Demo 2020

v 0 3D Seismic
LE |§- Wells Harizon-based seismic facies
- > Seismic bodies (supervised 3D)
Seismic Image Segmentation
- Seismic Image Regression
& Selsmic v @@ 2D Seismic
Horizon-based seismic facies
— Seismic bodies (supervised 2D)
?;E Seismic + Seismic Image Segmentation
- LWGUS Seismic Image Regression
~ Pre-trained models
UNet 3D Fault Predictor

Neural

Networks
)

-
]
e
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Workflow cont’d:

4. In the ‘Extract Data’ tab, Press the Select
button. The “Deep Learning Target Seismic
Definition” window pops up.

5. Press the + icon and Select the target

seismic volume (e.g.4 Dip steered median filter).

And OK.

*Note: it is possible to create a Training Set from
examples extracted from multiple surveys. To do this,
press the + icon again and select the target volume to
add to the table below.

6. Press Proceed [Input Data Selection]. The
“Input seismic for prediction” window pops up

Apply

<Input Data> =

Output Deep Learming Example Data O select... | b [

. Dee Laaming Target s Definitien - 0 x
Sesmic Data suvey

x

a

3 1 5 Dciose
£ Selecttarget image - o x
Survey Data Root |C\Surveys O salect ..

Survey |F3_Demo_2020
F3_Demo_2020_20jul21
F3_Demo_2020_oid
My_New_Survey_AL
My_survey_AL

1 Original Seésimics
2 Steering BG Detaled

| 3o D6 Becigroand
3a Steesing PCALLL MF225

Volume subselection (a1

‘Sessmic Data Survey

1 4 Dip steered median fiter 3 Demo 2020 #
=
-
m

[ ot o st o] | @i

* The option to select data from other surveys is available only in commercial projects

Workflow cont’d:

7. Select the input seismic data (i.e. the seismic
with the missing traces as zeros) and Press OK.

8. In the “Input Data” window set the dimensions
of the input features. To minimize processing
time for this exercise, Set the Images dimension
to: 0x128x128, overlap: 0x0x0 and Inline range:
(100 —400).

Note: If the current HW has large amount of GPU and
CPU/computing power, the recommended Image
Dimensions are 128x128x128.

9. Specify the name of the Output Deep
Learning Example Data (e.g.
ML_Ex_FillMissingTraces 0x128x128 ) and
Press Proceed to start the extraction process.

10. When this process is finished Press
Proceed in the “Seismic Image Transformation”
window to continue to the Training tab.

% Input seismics for prediction - current suvey o ox
Input Seismics ® Specify now O Read Saved Setup
- - o
[ Chimney - Confidence: "
[J Fault_Likellhood_Thinned_from_DSMF_seds
[ Foult_Prob_Unet o
[ Filled_Seismic_IL425 7l
Pogaty pregicted M
[ Seismic with random missing traces as 26
I_EV_WH e With random missing traces as 2ercs, ,,

>

=] e
Survey Tnput 1 >
1 F3 Demo 2020 Selsmic with rando -
Images Dimensions Inl: 0 S O 128 32128 3
Inline Range 1003|400 3| Step |1 s Overap (%) 0
Crossline Range 3002|1250 3 Step 1 2| Overap (%) 0
Time Range (ms) |0 (1848 2l sten s =] Overao (%) [0
Output Deep Leaming Examgle Data [ML_Ex_FillMissingTraces_0x128x128 | | © select ...

Quon |~ | @

Toin Aosky
eirost Data O sebet
Ot Dot Lsring Exrol Dk W Ex. FilbirgTraces iuizeatss | @ seoct | (04
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Workflow cont’d:

11. After the training data is selected the
available models are shown. For seismic image
workflows we use Keras (TensorFlow).

12. Check the Parameters tab to see which

models are supported and which parameters can
be changed.

13. Specify a name for the “Output Deep
Learning Model” (e.g.
ML_Unet_FillMissingTraces_0x128x128).

14. Hit Run.

15. Open the processing log file to follow the
progress. When the log file shows “Finished
batch processing”, the Proceed button turns
green. You can press Proceed or Open

the Apply tab.

ExtractData  Train  Apply
Input Deep Learing Example Data ML_Ex_FillMissingTraces_0x128x128 v | © Select. LIRSS

Training Type & New [ Resume [ Transfer

Output Deep Leaming Model ML_Unet_FillMissingTraces_0x126x128 | ~ | © Select ... ]

[

-

400

) 13

Dbroceed >> | E¥Cose @

cose | |4smeont

Workflow cont’d:

16. Once the Training is done, the trained model
can be applied. Select the trained model and
Press Proceed.

17. The Apply window pops up. Here you can
optionally apply to a Volume subselection. Type
an Output name (e.g.
Seismic_ML_Unet_FillMissingTraces_0x128x128)

Note: You can run on GPU or CPU using the Predict using
GPU toggle. Running the application on a GPU is many
times faster than running it on a CPU.

18. Press Run to create the desired output.

19. Close the ‘Progress Viewer’ window when the
processing is finished.

Exract Data_ Train ety
Survey Data Root | €\Surveys O Sefect.

Survey | F3_Doma_1020
F3_Dema_2020 20021
F3_Dermo_2020_okl
y_How,_Surver_AL
My _survey AL

M Unet, Filbissing Traces 0w 280128

Ubiet 7l Missing Traces,

. Aty ML Lnet Filbissnglaces 0128

[EPLTRTERSR| . [ ———— O seet
Apply Overlap (%) [n: 80 30 O 10 30 2010 3

[ — Oselct.

Dracessi firiched successtuly
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Workflow cont’d:

Compare the original seismic data with the Unet predicted
filled seismic results. The line is extracted from the blind test
area.

20. Right Mouse Click on In-line > Add and select Data
> Store. Select the created Filled Seismic
(e.g. ML_Unet_FillMissingTraces_0x128x128), and Hit OK.

21. Type in the Inline field: 425, and Hit Enter.

The same way, add to the display, the original seismic and
seismic with missing fraces .

22. Right-Click on Inline 425 > Add > Afttribute
>Stored. Select the original seismic
(e.g. 4 Dip steered median filter), and Hit OK.
23. Right-Click on Inline 425 > Add > Attribute -
>Stored. Select the seismic with missing traces
(e.g. Seismic with random missing traces as zeros), and =

© Stering

Hit OK.

-

@ za .
2 @ vol  AddstWell Location .. ¥
B Ran  Add Color Blended
& Setect - o x
Select first layer
Filter [+
@ stored Filled_Seismic_L425 "
O Steering Porosity_Predicted_ML_RandomForests
Seismic with random missing traces as zeros
Attributes Seismic with random missing traces s zeros_IL4
Y I Seismic_ML_Unet_FIIMissingT races_0x128x128
PSS ——pe— N
Ous @

=T [l D ¢

-ee scene 1

ements
Scene 1

M W In-line
v [ 425
E] Seismic_ML_Unet_FillMissingTraces_0x128x128
v 4 @ In-line
= » al Auitute | &
H@c Dispiay v W Valume Builder Attribute
Bez Duplicate @ HorizonCube Display
=1 I Reset Manipulation ¥ Systems Tracts Display
T T - o x
Seect Loyer2 Select Loyer 2
Filter |~ il
Douinel Saisnics +® Stored. Fault_Prob_unet L]
T B v
T Ferosey redetes 1. Fandomiorests
7o K1 Cube S0 i [ Sosmic wih randsen wissing traces a5 zerws |
70 A1 Cub tom Horaide & S i randem mizsng aces 5 281,
Do € b [Eel oo @

Workflow cont’d:

24. Compare visually in the blind test
area the:

- Original seismic (4 Dip steered
median filter)

- Randomly blanked traces seismic

(Seismic with random missing

traces as zeros)

- Unet filled seismic
(ML_Unet_FillMissingTraces_0Ox1
28x128)

25. For more accurate comparison,
Set similar colour range for the 3

seismic cubes. Highlight the seismic

cube, Set the colour bar range to (-
8000, 8000).

-so00 [J I3 0D Seismic 1
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Workflow cont’d:

For a better quantitative comparison, create a new attribute ‘difference’ that computes the
difference between the predicted and the original seismic.

@ Aivibuie Sec 30 o x
File

“USYEA WME

26. Select the 3D attribute icon al . Open the s« - Wt 2

A , i Moibiunctiors - st (e o) < Thomt 52 >
attribute set = . Select the attribute set aresinen s ([ e =
“ML_Random_holes_interpolation” T plapla———————=

d¥foronce between gain corol

27. Create a 4" attribute “difference” as
indicated in the attribute set window and Hit
‘Add as new'.

| ==

28. Select the Original seismic (e.g. 4 Dip
steered median filter) for ‘Seis’, and the
predicted seismic (e.g.

Attribute Names dfforence A s e [ e

ML_Unet_FillMissingTraces_0x128x128) for o °
‘pred’
Workflow cont’d:

Display/QC the attribute “difference”. Difference = Original seismic (4 Dip steered median filter) —
Predicted seismic (ML_Unet_FillMissingTraces_0x128x128)

L
Select Layer 2
Filter *
+ o Attibate 5 O Stored | random
* @ Volume Bullder Attribute = Retrieve horizon data
@ HorizonCube Disploy O Steering | seismic with randem missing traces a5 zeros
% Systems Tracts Display @® Attributes

Gain_corrected_Filled_Seis
- Gain_conrected seismic
difference bebween gain corrected seis and M|

@ok | Ocancel @

[N

29. Right-Click on Inline 425 > Add >
Attribute. Select the attribute ‘difference”,
and Hit OK.

Notice the small values of the difference, e e
range (-593, 590). e

30. For more accurate comparison,

Modify the color range to similar range as B 1
the original and predicted seismic [- £ e
8000,8000] oy
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Workflow cont’d (Optional):

For more accurate comparison, apply an RMS gain scaled correction to the original and predicted
seismic, than compute the difference.
Create a new Gain correction attributes to be applied on the original and predicted seismic.

31. Select the 3D attribute icon A% . Open the
attribute set . Select the attribute set
“ML_Random_holes_interpolation”

Ui a Rl -

\L_Random_holes_int <All> Scaling ? &

Inpust Distn | Seismic_ML_Unet_FillMissing Troces (21263128 O et
Type Window.
Gasis RMS

32. Create a 5" attribute
“Gain_corrected_Filled_Seis” as indicated in the

attribute set window and Hit ‘Add as new’ i
33. Select the Input Data -
“Seismic_ML_Unet_FillMissingTraces 0x128x128'

Workflow cont’d (Optional):

For more accurate comparison, apply an RMS gain scaled correction to the original and predicted
seismic, than compute the difference.
Create a new Gain correction attributes to be applied on the original and predicted seismic.

SRR A BAE
34, Select the 3D attribute icon all . Open s = L
the attribute set “®. Select the attribute set

“ML_Random_holes_interpolation”

Input Data [4 Dip steered median fiter © Select ...
Type Window:
Basis RMS

Start ((ms)) Stop ({ms})

Tme Gate 1 0 1848

35. Create a 6 attribute “Gain_corrected e
seismic” as indicated in the attribute set

window and Hit ‘Add as new’ -
B
36. Select the Input Data ‘Gain_corrected
seismic”
< » Adtribute Name Gain_corrected seismic Add as new [l =
e [Eo=]0
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Workflow cont’d (Optional):

Create a new attribute that will compute the difference between the RMS gain corrected original
seismic and ML predicted seismic

37. Select the 3D attribute icon al - e

Open the attribute set = . Select the SR RE A BE
. Attribute set [Random_holes_webind Basic ~  Mathematics. ~| [2]
attnbute Set random MathFunctions | sart (Squareroot) ~  Inset 2% il |
“"ML_Random_holes_interpolation™ ;’fr'mi“"i‘““m‘:‘;m Formd (e et = 0 o) s - e =
- - - e e For‘see’ ues (GolTomctd bl *
Gain_cofrectid seismic For 'pred’ wse Gain_comrected Filled_Seds_IL425

difference between gain cormes

38. Create a 7™ attribute "difference

between gain corrected seis and ML
pred” as indicated in the attribute set
window and Hit ‘Add as new’.

[ SR

39. Select the “Gain_corrected seismic”
as input for ‘seis’ and the
"Gain_corrected_Filled_Seis” as input
for ‘pred’

Attribute Name |difference between gain comected seis and M| Add as new [l =

21 5ave on Close G | @

Workflow cont’d (Optional):

Display the attribute “Gain_corrected_Filled_Seis” (RMS scaled
Seismic_ML_Unet_FillMissingTraces_0x128x128) and the “Gain_corrected seismic”(RMS
scaled 4 Dip steered median filter).

wonlll Wz ] mron st TR R S Y A

40. Right-Click on Inline 425 > Add > Attribute.
Select the atfribute “Gain_corrected_Filled_Seis”,
and Hit OK.

41. Right-Click on Inline 425 > Add > Attribute.
Select the atiribute ‘Gain_corrected seismic”, and
Hit OK.
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Workflow cont’d (Optional):

Compare quantitatively in the blind test area the RMS gain corrected difference between the

original seismic and the predicted seismic.

42. Display the “difference between gain corrected
seis and ML pred” seismic attribute. Right mouse
click on the In-line 425. Select “Add and Select
Data”.

43. Select the attribute "difference between gain
corrected seis and ML pred” and Hit Ok.

Notice the very low values of the “difference
between gain corrected seis and ML pred”. The
range [-0.257, 0.257].

44. For more accurate comparison, display the
difference attribute with similar colour range as the
gain corrected original and predicted seismic.
Highlight the seismic cube, Set the colour bar
range fo [-2, 2].

[Z_ T W= | | 5300 seismic 1 R @R

a00

800, 8O0 1000

i

500
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Appendix - GMT Software

Generic Mapping Tools (GMT)

GMT is an open source collection of tools for manipulating geographic and
Cartesian data sets and producing Encapsulated Postscript (eps) file illustrations
ranging from simple x-y plots via contour maps to artificially illuminated surfaces
and 3-D perspectives views.

In this appendix, we will shortly explain the GMT plug-in and we will create dif-
ferent maps in OpendTect:

To launch GMT tools, go to Processing menu > GMT Mapping Tool. The first time
you launch the GMT mapping tools, a warning message will pop-up: a mapping
tool package needs to be installed in order to run it. This can be downloaded from
the GMT website.

= GMT Mapping Tool = fl =&

You need to install the GMT mapping tool package
before you can use this utility
Also make sure that the environment variable GMTROOT is set to the GMT installation directory
and your PATH variable includes the GMT bin directory

|Download GMT

‘G Continue| |O Cancel|

If OpendTect fails to create a map with GMT, check whether the environment vari-
able GMTROOT is set to the directory in which GMT was installed and whether
the PATH variable includes the GMT bin directory. (Per default: GMTROOT c:\-
programs\GMT4 and PATH ...c:\programs\GMT4\bin...). Environment variables
in Windows can be set from Computer > System Properties > Advanced System
Settings.

After successful installation of GMT package, the GMT user interface will be star-
ted:
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e GMT Mapping Toal - 0

* =
Basemap Contour Fault Wells Locations Polyline Random Lines 2D Lines Coastiine Clipping Advanced
Map overlays
Posted Map title | Basemap
ouerlays will X range | 605381 < [g2es7s
appear here * range | 6073556 | |sognasa +| |Resetto Survey!
in order of Map Width (cm) [24.1944370 Height (cm) |16.9064998 Scale 1: | 100000
Insertion Label interval () (5000 |4 [s000  [2] [] Draw Gridines
Remarks (4 lines max)

-

Chfnge overlays ordj

t| & ® < Delete items in map overlays
Output fie & s | €G] Output postscript file loccation

Create Map View Map Replace Reset

0

When creating postscript maps, the several tabs allow to specify the respective
settings:

» Basemap: used to set the scale of map and other map settings. You do not
need to add itin the map overlays. This is the first and mandatory step into
the creation of maps

» Locations: used to post pickset data (e.g. proposed well locations) in the
map overlay

» Polyline: used to add polygons (e.g. lease boundaries) in the map overlay

» Contours: used to make a horizon contour map

» Coastline: used to draw coastal lines

» Wells: used to post wells in the map

e 2D Lines: used to post the OpendTect 2D-Line(s) in the map

» Random Lines: used to post the Random Line(s) in the map

» Clipping: used to set up polygonal clip path

» Advanced: used to customize the GMT commands
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Time Contour Map at Demo 4 Horizon
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A typical example of a time Contour Map with well locations
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